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Thank you for purchasing the MW100 Data Acquisition Unit. This user’s manual contains
useful information about the instrument’s functions, installation and wiring procedures,
operating procedures, and handling precautions. To ensure correct use, please read

this manual thoroughly before beginning operation. The following manuals relating to

the MW100 Data Acquisition Unit are provided in addition to this one. Read them along
with this manual. The MW100 Data Acquisition Unit Operation Guide (IM MW100-

02E), MW100 Viewer Software User’s Manual (IM MW180-01E), and Communication
Command Manual (IM MW100-17E) are all available on the MW100 Manual CD-ROM.
Manual Title

Manual No. Description

MW100 Data Acquisition Unit
Operation Guide

IM MW100-02E  Describes concisely the handling of the

MW100 Data Acquisition Unit and the basic
operations of the MW100 Viewer Software.

MW100 Communication
Command Manual

IM MW100-17E

Describes the communication command of
the MW100 main module.

MW100 Connecting Ethernet
and Checking the Connection

IM MW100-71E

Explains the procedure to check the
Ethernet connection.

Precautions on the Use of the IM MX100-71E  Summarizes the precautions regarding the
MX100/MW100 use of the MW100 Data Acquisition Unit.
MX100/MW100 Data Acquisition  IM MX100-72E  Describes concisely the installation
Unit Installation and Connection procedures and wiring procedures of the
Guide MW100 Data Acquisition Unit.
MX100/MW100 Quick Start IM MX100-79E  Explains the contents of the quick start
Package Checking the Contents package (/SL1, /SL2, and /SL3 options).
of the Package
Control of pollution caused by IM MX100-91C  Describes control of pollution caused by the
MX100/MW100 products product.
772075 AC Adapter IM 772075-01E  Describes the specifications of the AC
adapter (power supply suffix code “-27).
MW100 Viewer Software User's IM MW180-01E  Describes the functions and operations of
Manual the MW100 Viewer Software that comes
standard with the MW100 main module.

» This manual describes the MW100 Data Acquisition Unit, style number “S3.” The style
number is located on the name plate of the main module (see IM MW100-02E for the
location of the name plate).

*  When configuring an MW100 system, the versions of the instruments used in the
system indicated by the hardware style number and software release number must
meet the following conditions.

» The main module style number must be greater than or equal to the style numbers
of any input/output modules.

» The PC software release number must be greater than or equal to the style number
of the main module.

Certain functions may become disabled on instruments or software that do not meet

these conditions, or the system may not be able to be built.

» The contents of this manual are subject to change without prior notice as a result of
continuing improvements to the instrument’s performance and functions.

» Every effort has been made in the preparation of this manual to ensure the accuracy
of its contents. However, should you have any questions or find any errors, please
contact your nearest YOKOGAWA representative, dealer, or sales office.

» Copying or reproducing all or any part of the contents of this manual without the
permission of Yokogawa Electric Corporation is strictly prohibited.

» The TCP/IP software of this product and the document concerning the TCP/IP software
have been developed/created by YOKOGAWA based on the BSD Networking Software,
Release 1 that has been licensed from the University of California at Berkeley.

All Rights Reserved, Copyright © 2005 Yokogawa Electric Corporation
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Revisions

- DAQMASTER is a registered trademarks of Yokogawa Electric Corporation.

* Microsoft and Windows are registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

» Adobe and Acrobat are registered trademarks or trademarks of Adobe Systems
Incorporated.

» Company and product names that appear in this manual are registered trademarks or
trademarks of their respective holders.

» The company and product names used in this manual are not accompanied by the
registered trademark or trademark symbols (® and ™).

1st Edition: June, 2005
2nd Edition: October, 2006
3rd Edition: October, 2007
4th Edition: March, 2012
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Safety Precautions

About This Manual

Please pass this manual to the end user.

» Read this manual thoroughly and have a clear understanding of the product before operation.

» This manual explains the functions of the product. It does not guarantee that the product will suit a particular
purpose of the user.

» Under absolutely no circumstances may the contents of this manual be transcribed or copied, in part or in
whole, without permission.

» The contents of this manual are subject to change without prior notice.

» Every effort has been made in the preparation of this manual to ensure the accuracy of its contents. However,
should you have any questions or find any errors or omissions, please contact your nearest YOKOGAWA
dealer.

Precautions Related to the Protection, Safety, and Alteration of the Product
» The following safety symbols are used on the product and in this manual.

é Danger. Refer to the user’s manual.This symbol appears on dangerous locations on the instrument
which require special instructions for proper handling or use. The same symbol appears in the
corresponding place in the manual to identify those instructions.)

L Functional ground terminal (do not use this terminal as a protective ground terminal.)

@ Protective grounding terminal
N

Alternating current

—— Direct current

» For the protection and safe use of the product and the system controlled by it, be sure to follow the
instructions and precautions on safety that are stated in this manual whenever you handle the product.
Take special note that if you handle the product in a manner that violates these instructions, the protection
functionality of the product may be damaged or impaired. In such cases, YOKOGAWA does not guarantee
the quality, performance, function, and safety of product.

* When installing protection and/or safety circuits such as lightning protection devices and equipment for the
product and control system or designing or installing separate protection and/or safety circuits for fool-proof
design and fail-safe design of the processes and lines that use the product and the control system, the user
should implement these using additional devices and equipment.

 If you are replacing parts or consumable items of the product, make sure to use parts specified by
YOKOGAWA.

» This product is not designed or manufactured to be used in critical applications that directly affect or threaten
human lives. Such applications include nuclear power equipment, devices using radioactivity, railway
facilities, aviation equipment, air navigation facilities, aviation facilities, and medical equipment. If so used, it
is the user’s responsibility to include in the system additional equipment and devices that ensure personnel
safety.

» Do not modify this product.
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Safety Precautions

Use the Correct Power Supply

Ensure that the source voltage matches the voltage of the power supply before turning ON the power.
Connect the Protective Grounding Terminal
Make sure to connect the protective grounding to prevent electric shock before turning ON the power.
Do Not Impair the Protective Grounding
Never cut off the internal or external protective earth wire or disconnect the wiring of the protective earth
terminal. Doing so invalidates the protective functions of the instrument and poses a potential shock
hazard.
Do Not Operate with Defective Protective Grounding or Fuse
Do not operate the instrument if the protective earth or fuse might be defective. Make sure to check them
before operation.
Do Not Use in the Presence of Flammable Liquids, Vapors, and Dust
Do not use the instrument in the presence of flammable liquids, vapors, and dust. Operation in such
environments constitutes a safety hazard.
Do Not Remove Covers
The cover should be removed by YOKOGAWA's qualified personnel only. Opening the cover is
dangerous, because some areas inside the instrument have high voltages.
Ground the Instrument before Making External Connections
Connect the protective grounding before connecting to the item under measurement or to an external
control unit.
Avoid Damage to the Protective Structure
Operating the instrument in a manner not described in this manual may damage its protective structure.

CAUTION

This instrument is a Class A product. Operation of this instrument in a residential area may cause radio
interference, in which case the user is required to take appropriate measures to correct the interference.

Exemption from Responsibility

* YOKOGAWA makes no warranties regarding the product except those stated in the WARRANTY that is
provided separately.

YOKOGAWA assumes no liability to any party for any loss or damage, direct or indirect, caused by the user
or any unpredictable defect of the product.

Handling Precautions of the Software
*+ YOKOGAWA makes no warranties regarding the software accompanying this product except those stated in
the WARRANTY that is provided separately.
Use the software on a single PC.
You must purchase another copy of the software if you are to use the software on another PC.
Copying the software for any purposes other than backup is strictly prohibited.
Please store the original media containing the software in a safe place.
Reverse engineering, such as decompiling of the software, is strictly prohibited.
No portion of the software supplied by YOKOGAWA may be transferred, exchanged, sublet, or leased for use
by any third party without prior permission by YOKOGAWA.

IM MW100-01E



Conventions Used in This Manual

Unit
k Denotes 1000.
K Denotes 1024. Example: 5 KB (file size)

Safety Markings

The following markings are used in this manual.

A\

CAUTION

Note

Meas. Mode

Setting Mode

IIv

Refer to corresponding location on the instrument. This symbol
appears on dangerous locations on the instrument which require

special instructions for proper handling or use. The same symbol
appears in the corresponding place in the manual to identify those
instructions.

Calls attention to actions or conditions that could cause serious injury
or death to the user, and precautions that can be taken to prevent

such occurrences.

Calls attentions to actions or conditions that could cause light injury to
the user or damage to the instrument or user’s data, and precautions

that can be taken to prevent such occurrences.

Calls attention to information that is important for proper operation of
the instrument.

Indicates a reference.

Indicates items that require you to switch the mode to Measurement

in the procedural explanation of chapter 3.

Indicates items that require you to switch the mode to Setting in the

procedural explanation of chapter 3.
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Chapter 1

Explanation of Functions

1.1

System Overview

MW100 Data Acquisition Unit

The MW100 Data Acquisition Unit consists of a main module equipped with an Ethernet
port, I/0 modules for input and output of signals (these are the same as those for the

MX100 Data Acquisition Unit), and a base plate on which the first two items are mounted.

The main module comes with an HTTP server function, allowing users to easily enter
settings, acquire data, and monitor measured data from a PC using a browser. The
main module also comes with a Modbus/TCP function that allows multiple units to be
connected.

System Configuration

The MW100 Data Acquisition Unit can be flexibly configured for a variety of measuring
environments such as a small-scale system that acquires data on site in a standalone
configuration or a system that allows data acquisition of up to 360 channels using the

Modbus/TCP function.

One-to-one Connection with a PC
This is an example of a system for small scale logging, setting the IP address, and other
tasks.

PC

Using a browser:

» Easy setting entry

* Monitoring of measured
and computed data

Using PC software:

* IP address setting e | 2 ]
e Calibration Hub

MW100 Data Acquisition Uni

) o o o o o o

MW100]

M=l Ethernet port
s

o 1o Jlo 1o Ilo |lo é
=TTy | JUu=, | S ] g LLLLIY N

| .
Input/Output module Main module

Standalone Configuration
This is an example of configuration for an on-site standalone data acquisition system.

PC

MW100 Data Acquisition Unit

o) o o o o o

P
o
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o
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o
3
1
D

o o
e VI e 1

Data display using MW100 Viewer Software
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1.1 System Overview

One-to-N Connection with a PC
This is an example of a configuration suitable for relatively large scale data acquisition
tasks. Connections can be made via Ethernet or RS-422A/485.

ﬁ
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1.1 System Ove

rview

One-to-N Connection with the PC
This is an example in which multiple PCs are connected to the MW100 for performing

data monitoring.
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e ————
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PC
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o
| °
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— 0
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o
————1 |
|
T kT ATk ST, Tl | Hub
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i) o 11O [e]

MW100|

=]
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o [
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1| o —
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MW100 Data Acquisition Unit

Connecting to Modbus Devices
This is an example of configuration of a system with connections to Modbus devices.

MW100 Data Acquisition Unit

[¢] O #lo jlo floO

(client) Lo T o T o i
p=
42 0 U
o Ll o [o) I:::l
IIHIIIIL IIHIIIIL IIHIIIILJIIII. JlIlIIIIIIL
89958 | Hub
o - o - o - o - o} - o - o
= =
55 @] BE@|]
N B o o o o o |lo [cnE
T | T ST U | Jeai=re | JrCestroy | o=y | Jrosir | jie—Uovoog |

Modbus machine (server)

Nofte

Modbus machine (server)

Using the Web monitor or other communcation functions while using the Modbus function may
affect the Modbus communication response.
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1.1 System Overview

Main Module

The main module is equipped with power supply connectors, a power switch, Ethernet
ports, and other devices facilitating supply of power to and control of the input/output
modules, and connection to networks.

It also has Start and Stop keys, meaning that since data can be saved to a CF card, data
can be acquired offline. Data acquisition via serial communication is also possible by
adding the RS-232 or RS-422A/485 serial communication option.

Input/Output Modules

The following thirteen types of modules are available. A screw terminal plate and
separately installed screw terminal block (both sold separately) are available as
accessories for the 10-CH, Medium Speed Universal Input Module, the 10-CH, Pulse
Input Module, and the 10-CH, High Speed Digital Input Module.

4-CH, High-Speed Universal Input Module (MX110-UNV-HO04)

* Minimum measurement interval: 10 ms

¢ Maximum number of inputs: 4 inputs

* Input types: DC voltage, TC, 3-wire RTD, and DI (LEVEL,
non-voltage contact)

* Minimum measurement interval: 100 ms

* Maximum number of inputs: 10 inputs

¢ Input types: DC voltage, TC, 3-wire RTD, and DI (LEVEL,
non-voltage contact)

IM MW100-01E



1.1 System Overview

30-CH, Medium Speed DCV/TC/DI Input Module (MX110-VTD-L30, MX110-
VTD-L30/H3)

* Minimum measurement interval: 500 ms

* Maximum number of inputs: 30 inputs

* Input types: DC voltage, TC, and DI (LEVEL, non-voltage
contact)

A A
MX110-VTD-L30 MX110-VTD-L30/H3
(clamp terminals) (M3 screw terminals)

6-CH, Medium-Speed, Four-Wire RTD Resistance Input Module (MX110-V4R-MO06)

* Minimum measurement interval: 100 ms

* Maximum number of inputs: 6 inputs

* Input types: DC voltage, 4-wire RTD, 4-wire resistance,
and DI (LEVEL, non-voltage contact)

4-CH, Medium-Speed Strain Input Module (MX112-B12-M04 and MX112-
B35-M04)

* Minimum measurement interval: 100 ms

* Maximum number of inputs: 4 inputs

* Input system: floating balanced input (isolation between
channels)

* Minimum measurement interval: 100 ms

* Maximum number of inputs: 4 inputs

* Input system: floating balanced input
(non-isolation between channels)

IM MW100-01E
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1.1 System Overview

10-CH, Pulse Input Module (MX114-PLS-M10)

* Minimum measurement interval: 100 ms

¢ Maximum number of inputs: 10 inputs

« Input types: DI (non-voltage contact, open collector, and 5-V
logic)

* Minimum measurement interval: 10 ms

¢ Maximum number of inputs: 10 inputs

« Input types: DI (non-voltage contact, open collector, and 5-V
logic)

* Minimum measurement interval: 10 ms
¢ Maximum number of inputs: 10 inputs
* Input types: DI (24-V logic)

e Output update interval: 100 ms (shortest)
e Maximum number of inputs: 8 outputs
e Output type: DC voltage, DC current

1-6 IM MW100-01E



1.1 System Overview

8-CH, Medium-Speed PWM Output Module (MX120-PWM-M08)

* Output update interval: 100 ms (shortest)
* Maximum number of outputs: 8 outputs
¢ Output type: PWM

* Output update interval: 100 ms (shortest)
¢ Maximum number of outputs: 10 outputs
* Output type: A contact (SPST)

Base Plate
The base plate is equipped with connectors for connecting the main module and input/
output modules. Six different base plates are available to hold from one to six input/
output modules. By attaching the DIN rail mounting brackets that came with the product
to the base plate, you can rack-mount or panel-mount the MW100 main unit.
IM MW100-01E 1-7
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1.1 System Overview

PC Software
The MW100 Data Acquisition Unit comes with the MW100 Viewer software program that
allows users to view measured data acquired by the MW100. MW100 Viewer consists
of the three software components described below. For a detailed description of the
functions of these software components, see the MW100 Viewer Software User’s Manual
(IM MW180-01E).
When configuring a system using the MW100, the software release number and
hardware style number matching conditions must be met (see “Notes” on page i).

MW100 IP Config Software
Sets the IP address on the MW100. This software is used when setting an IP address for
the first time, or if the current IP address needs to be changed.

=lolx]

e sclct HAHDD i oss s st !
cck | Fostams Serl o ot
W 001 TIEI28451 w00 FED |
wtoor2 TrEn2ses2 oo
MA100P3. TTE123453  MWI00 [ Get an P acress automatically
M 00PS TTEIZ34E MAOO DR |
woes TrEt2ssss oo
woors TrEt2ssss oo Bictiesd |
w7 T o e

MwiooPs TEIZIEE Moo
MiooP Trerzses [wenon b [ et DN nformation sutamatcally
P TTEIZaE0 Moo
oot TEIZIE Moo

[ Register Host Name to & DNS sen

A

MW100 Viewer

Enables you to (1) display measured, computed, and thinning data that has been stored,
(2) read values and perform computation over an area using cursors, and (3) convert the
measured and computed data into various file such as Excel.

Information_Help

di|m ey [mEdal e E

MW100 Calibrator Software
This software is used to calibrate the input/output modules connected to the MW100. The
software does not support the pulse input, digital input, or digital output modules.

MH1D-VAR-MOS

Seralo. am71sser
Colbratetine  200417HS 224047

RTD( ma)s00 m Range

RTD(0.25 ma)600 m Range
RTD(0.25 mayt v Range

o o o o o
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1.2

MW100 Operation Guide

The figure below shows the general flow of operation when the MW100 is installed

initially.

Operations on the MW100

Operations on the PC

Section X.X indicates the referred

Section 2.2 and 2.3 [ ] Section 3
Instal the MW100
and attaching the Set lfp .
main module communication
|Section 2.4 | Section 3.
Wire the input/ Configure the
output modules system
| Section 2.6 to 2.8 | o4 the Installation = |dSetct|on 3.
comcrr?lr}rr:ﬁ:%ttion and Connection acraﬁ{sit?o%
cables Guide conditions
. (IM MX100-72E). | i
Section 2.5 Section 3.
Connect the power Set measurement
cord conditions
Section 2.5 | Section 3.
Turn ON the power MATH settings
switch
L | Section 3.
Digital output
settings
| Section 3.
Alarm settings
|Section 3.
Transmission
output settings
| Section 3
Event settings
| Section 3
Report settings
|Section 3
FTP and e-mail
settings
Section 3.13 |
[
Sta(r:tonnl?)%stgtrﬁ)nr:ent, Starting measurement,
or recording computation, and recording
|
] Section 3
Monitor data and
alarms
Section 3.13 |
[
Stogorpn%austgltrﬁ,mnent, Stopping measurement,
or recording’ computation, and recording
I |
Display and
check data

sections in this manual.

N

Search for all connected MW100s and
configure network parameters such as
the MW100s’ IP addresses.

suojjoungd jo uoijeue|dxgy

w

MW100 system configuration, date/time
setting, CF card setup

H

Select the acquisition interval to be

used, select the recording interval,

set recording start/stop conditions, etc.
5

Input channel settings, input type,

measurement range, measurement

span, etc.

o

MATH channel settings, entry of
expressions, etc.

o

Alarm output, manual DO, Fail output,
and error output settings

B

Alarm level and type settings

Analog/PWM output settings

10 and 3.11

Event/action settings

12

Set up creation of hourly, daily, weekly,
or monthly reports

14

Settings for the FTP server, mail server,
and other network utilities

While online you can start
measurement, computation, and
recording from a PC

16

Measured data and alarm display
settings while online

While online you can stop
measurement, computation, and
recording from a PC

Data display and analysis using MW100
Viewer Software.

See the MW100 Viewer Software User’s
Manual (IM MW180-01E).
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1.3 Functions of the Main Module

The main module is the central component of the MW100 Data Acquisition Unit.

Names and Functions of Parts

Communication status LED

Check the communication status

Top: LINK LED

llluminates orange when ready for communication
Bottom: ACT LED

Blinks green when packets are sent/received

Ethernet port
Used for main unit settings
and network connections
(see 2.6, “Connecting an
Ethernet Cable,” or 3.2,
“Connecting to the MW100.”)

7-segment LED

Displays the operational status of
the MW100 (see “Displays” in this
section, or section 4.1, “7-Segment
LED Error Display”).

Status indicator*
The operational status of the
instrument is indicated by the
illumination of the LED.

CF card slot
Insert the CF card to save
data and perform other tasks

(see section 2_10,““Handling of_the” AR ! MWIOO) Dip switch 1
CF Card,” or 3.3, "System Settings”). S N T J YoosaA ¢ Used to initialize settings,

SwW__on and for other purposes
(see, “Switches and
12345678 E Keys” in this section)

100BASE - TX

[

:

Start/stop keys \ 10BASE - T POWER . ]
Start and stop measurement, s ™~ Dip switch 2
computation, and recording ~| Not used.
(seesection 3.13, “Starting and | [user | [vse=2] RN
Stopping Measurement, Computation, [l L 100- 240VAC~
and Recording”). @

— Power switch

Turns the power to the
MW100 main unit ON
and OFF

User function key

Assign functions to the keys
(see, “Switches and Keys” in this
section)

cooobo
FG_SG SDB SDARDBRDA
OO

™~ Functional ground
terminal

Power supply inlet

Connect the accessory power supply
cord This is listed as a screw terminal
in the power supply specifications.

RS-422A/485 connector (/C3 option)
Depending on installed options, the connector may
or may not be available, or it may be an RS-232
connector (/C2 option, see section 2.7,
“Connecting the RS-422A/485 Interface” or 2.8, Terminator switch (/C3 option)
“Connecting the RS-232 Interface”), Turns the terminator ON and OFF

(see “Connection Procedure” in section 2.7).

*Status indicators
llluminate in the following situations. (See section 3.13, “Starting and Stopping Measurement,
Computation, and Recording.”)

< MEASURE (3 ALARM Alarm activation or alarm hold
2 RECORD 3 MATH Computing (illuminates), computing stop processing (blinking)
|— {1 SERIALRD
’;

eceiving serial communications data
Recording (illuminates), recording stop processing (blinking)
Measuring

1-10 IM MW100-01E



1.3 Functions of the Main Module

Switches and Keys

The MW100 has the following switches and keys. Some are included with options.
Start and Stop keys
User function key 1
User function key 2

Dip switch 1
Dip switch 2

Terminator switch (/C3 option)

Power switch

User Function Keys
Actions set up using the Event/Action function can be executed by pressing the user
function keys on the front panel of the MW100.
The keys are assigned as follows by default.

Key Display Action
User function key 1 USER1 Write to setting values file
User function key 2 USER2 Load setting values file

Dip Switch 1
Used to initialize the MW100 settings and for other functions.
Initialization of IP addresses and other settings

Normal operation

" gk

Fixed IP address (

192.168.0.10) -

" HdHagE]

Firmware update

" Hadanag

" Bigataad

10-Mbps half-duplex Ethernet communication

ilililalitalils

Main unit

Dip Switch 2
Turn all switches ON for normal operation. If the switches are set differently, the
instrument may not function correctly.

i

"~ Hdgaeg

Key Lock Function
You can apply a lock to the functions of the Start, Stop, and user function keys. The lock
prevents inadvertent execution of functions.
P> For setting the key lock, see “Status Information and Processing/Operation” in section 3.3.

Web
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1.3 Functions of the Main Module

Connectors

Displays

The MW100 can come with the following connectors. The actually-installed connectors
depend on the power supply input section specifications and options.

» Ethernet

» RS-422A/485 connector (/C3 option)

* RS-232 connector (/C2 option)

» CF card slot

» Power supply inlet (power supply input section specification: -1M)

» Power supply screw terminals (power supply input section specification: -1W, -2M, -3W)

The MW100 indicates its operating conditions with the following displays.
* 7-segment LED

» Status indicators

»  Communication status LED

7-Segment LED
Displays the MW100 Data Acquisition Unit’'s unit number, operation status, end of
operation, and errors.

* Unit Number Display
Unit numbers can be set from 00 to 89. 7/ - 55 is displayed.

» Display of the Self-Test Operation on Startup
When the power is turned ON the setting of dip switch 1 is displayed 'J,’_-,' followed by
the operation preparation status ,’:-,’,'_- , and then a self check is performed. While the
self check is in progress, the following displays are repeated.
i_'lg - I

| S

» Key Lock Status
A key lock function is included for preventing accidental manipulation of the MW100
front panel keys. The key lock status is indicated by a dot at the bottom of the unit
number. The example shown is for a unit of number 00.
* Keylock release * Keylock

1 1
e L

Unit number Unit number and dot

» Operation Error Display
In error Exxx (where xxx is a three-digit number), the code is divided into two parts
which are displayed alternately. In the first part, the letter E appears in the left digit
with the hundreds digit of the error code to the right, and the second part consists of
the last two digits of the error code.
Example: Error code E234

|
L

[}

-

_._I'l

=

[

Up to three error codes are saved. You can clear one error that is displayed by
pressing the Stop key.

P> For the contents of error codes and their meanings, see section 4.1, “Errors Displayed on
the 7-Segment LED and Corrective Actions.”
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1.3 Functions of the Main Module

* In-Progress Display
The following displays cycle while the CF card is being accessed or while calibration
is being performed. Do not remove the CF card while it is being accessed.

—

- [

T I

P> For the handling of the CF card, see “Handling of the CF Card” in section 2.10.
P> For CF card replacement, see “Saving Data to the CF Card” in this section.

» Access Forewarning to the CF Card
When saving measured, computed, or thinned data, the dots blink before accessing
of the CF card. This indication starts 10 seconds before the access. If you see this
indication, quickly finish the insertion or removal of the CF card.

1, T ", I :
Ll — 7 L, — iy — In-progress display

|J—I—l-BIinking

If you are using the multi interval function, this indication may be shorter than 10
seconds. If the time until the CF card is accessed is less than or equal to 5 s, the time
until access is displayed numerically.

!

- Y- J— — !'— Inprogress display

P> For CF card replacement, see “Saving Data to the CF Card” in this section.

When performing a manual sample, and when saving report data, the dots do not
blink before accessing of the CF card.

» Non-execution Display
If the file division action is not executed, “--nuLL--" is displayed with the characters
flowing from right to left as shown below. Check the execution condition of the file
division.

) ) )
T T T T T L Tl T T T

Operation Modes and Statuses
The MW100 has a Setting mode in which input ranges and other settings can be entered,
and a Measurement mode in which data acquisition is performed. The mode switches
depending on the measurement item of the status information.

Mode Status Info Description
Measurement
Setting mode Stop For entering range, system, communication, and
display settings
Measurement mode Start For data monitoring, computation, and recording

* The instrument must be in measurement mode in order for the status of computation and
recording to be Start.
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1.3 Functions of the Main Module

Measurement
Measured data sampled at certain intervals is acquired by the various input modules.
Acquired data is stored in internal memory. During recording, acquired data is saved to
the CF card according to the settings.
In addition, if an alarm occurs or if the main module receives output commands sent from
the PC, the main module generates signal output instructions to the output modules.

Data Sampling
The relationship between the measurement interval and recording interval is as follows:
The measured, computed, or thinned data that is recorded at the recording interval is
saved to the CF card.

P> For saving data to the CF card, see “Saving Data to the CF Card” in this section.

} Recorded measured and computed data
using thinning recording

} Recorded measured and computed data

} Measured and computed data

" Time (s)

T Measurement interval (MATH interval)
Recording interval

Recording interval of thinning recording

Measurement Intervals

» Synchronization between modules
If set to the same measurement interval, measurements made by input modules in the
same acquisition unit are synchronized.

» Synchronization between channels
On the 4-CH, High-Speed Universal Input Module, the 10-CH, Pulse Input Module,
and the 10-CH, High-Speed Digital Input Module, measurement is synchronized
between channels.
On the 10-CH, Medium-Speed Universal Input Module, 30-CH, Medium Speed
DCV/TC/DI Input Module, Six-Channel Medium-Speed Four-Wire RTD Resistance
Input Module, and 4-CH, Medium-Speed Strain Input Module, measurement is not
synchronized between channels since measurement occurs sequentially by channel (it
can be said to be synchronized within measurement intervals).

Multi interval

Measurement Groups
Three measurement intervals can be set, and measurement channels can be assigned
to each interval. There is a particular order in which measurement intervals can be set to
measurement groups.
P> For a description of setting the measurement interval, see section 3.4, “Setting Acquisition
Conditions for Measured/Computed Data.”

Filters
A first-order lag filter is available. You can select a time constant (time until 63.2% of
the output value is reached) corresponding to the measurement interval indicated in the
equation below.
Time constant = measurement interval x N (where N = 5, 10, 20, 25, 40, 50, or 100)
P> For details on filters, see section 2.9, “Measures Against Noise on the MW100 Data
Acquisition Unit.”
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MATH

Differential computation between channels and linear scaling are possible. Linear scaling
converts the measured values for a specific purpose (scaled values) using the following
equation.

Scale value = (X = SPmin) * (SCmax — SCmin) +SCo X: Measured.v.alue )
SPumax — SPmin min  SPmax: Specified span maximum
SPmin: Specified span minimum
SCmax: Specified scale maximum
SCmin: Specified scale minimum

MATH Types Notation
Differential computation between channels Delta
Linear scaling Scale

Note that the channels included on the 10-CH Pulse Input Module are only available for
integration (TLOG.PSUM).

MATH (/M1 Option)

Expressions using measured and computed data as variables can be entered and
executed on channels dedicated for computation, and the results can be displayed and
saved. Computations are executed every measurement interval (shortest interval is 100
ms).

P> For details, see section 1.15, “MATH Functions (/M1 Option).”

Report Function (/M3 Option)

You can perform statistical computations on measurement or MATH channel data
and display and save the results. The types of reports are hourly, daily, weekly, or
monthly. Reports can be created using the maximum, minimum, average, integral, and
instantaneous values from up to 60 channels.

P> For details on the report function, see section 1.16, “Report Function (/M3 Option).”

Remote RJC (RRJC)

When the item to be measured is located at a great distance, you can set up relay
terminals near the item, measure the temperature difference between the relay terminal
and the input terminal of the input module (reference channel) using thermocouples,
and use the resultant electromotive force as the reference junction compensation of
the temperature measurement. By connecting a copper wire between the relay terminal
and input terminal of the input module, and a thermocouple between the DUT and relay
terminal, you can measure the temperature of the DUT without the need for a large
amount of expensive thermocouples.
MW100 Relay terminal (to be furnished by the user)

Thermocouple*

>. —

| __ Reference channel

_E Copper wire Thermocouple*
£

5o >
‘g‘_ Copper wire Thermocouple*
j=4

»

©

* Use the same type of thermocouples.

Burnout

When the input mode is set to thermocouple (TC), you can set the burnout detection
behavior. Measured values become “range over” during detection.
Detection Behavior Notation
No detection Off
Measured values fixed at +range over Up
Measured values fixed at —range over Down
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1.3 Functions of the Main Module

Range Over

When the MW100 detects a range over (see below) on a measurement or MATH
channel, “+Over” or “—Over” is displayed.

Measurement channel range over

» During DC voltage input, strain input, and resistance (20 Q, 200 Q, etc.), a range
over is detected if the value that is measured on a measurement channel is outside
of the measurable range by more than +5%. For example, when the measurement
range is 2 V, the measurable range is —2.0000 to 2.0000 V. If the voltage exceeds
2.2000 V or goes below —2.2000 V, a range over is detected.

» During high-resolution DC voltage input and pulse input, a value less than 0% of
the measurable range is a negative range over, and a value greater than 105% of
the measurable range is a positive range over.

 If the input type is thermocouple or RTD, excluding the cases where the
thermocouple or RTD has a special range, a range over is detected when the
temperature goes more than approximately 10°C above or below the measurable
range. For example, when the measurement range is set to R, the measurable
range is 0.0 to 1760.0°C. If the temperature exceeds 1770.0°C, “+Over” will be
displayed. If the temperature goes below —10.0°C, “—Over” will be displayed. The
special ranges mentioned here are ranges such as KpvsAu7Fe or J263. If you
are using a special range, “—Over” will be displayed if the temperature goes below
approximately 0°C.

« On channels that use linear scaling, the range-over values, after removing the
decimal point, are above 32000 and below —32000. However, even if the measured
value is within £30000, if it is a range-over value according to the previous range, it
will be handled as a range-over value.

* When you are performing differential computation between channels, if the
measured value is outside of the measurable range, a range over will be detected.
When you are using a sensor such as a thermocouple, the measurable range
when performing differential computation between channels may be larger than the
measurable range when not performing differential computation between channels.

MATH channel range over

See “Math Span” on page 1-67 in section 1.15, “MATH Function (/M1 Option).”
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Alarms

The main module compares the measured values against preset alarm values and
outputs alarm signals based on the result from the digital output module. The following
four types of alarms can be output.

Type Notation Actions

Upper limit alarm H Generates an alarm when the measured value
exceeds the alarm value.

Lower limit alarm L Generates an alarm when the measured value falls
below the alarm value.

Differential upper limit alarm DH Generates an alarm when the difference between
(during differential computation) the measured values of two alarms exceeds the alarm
value.

Differential lower limit alarm DL Generates an alarm when the difference between
(during differential computation) the measured values of two alarms falls below the alarm
value.

Upper limit on rate-of-change RH Generates and alarm when the rate of change in

alarm rising measured values exceeds the alarm value.

Lower limit on rate-of-change RL Generates and alarm when the rate of change in

alarm falling measured values falls below the alarm value.

Delay upper limit alarm tH Generates an alarm when the measured value
remains above the alarm value for the specified time
(delay time).

Delay lower limit alarm tL Generates an alarm when the measured value
remains below the alarm value for the specified time
(delay time).

Alarm Value Hysteresis

You can set a width (hysteresis) to the values used to activate and release alarms. Alarm
hysteresis can prevent frequent activation and release of alarms when the measured
value is unstable around the alarm value.

Upper limit alarm Lower limit alarm

Alarm activated Jj Alarm Alarm release

setting \/ Measured value \/
/ \_ \ / } Hysteresis

t Alarm setting

Alarm release .
Measured vale Alarm activated

Alarm Output Timing

Alarms occur at each measurement interval based on the alarm settings. However when
the measurement interval is 10 or 50 ms, alarms occur at 100 ms intervals based on all
of the data.

Delay Upper Limit Alarm and Delay Lower Limit Alarm

An alarm occurs when the measured value remains below or above the alarm value for

the specified time (delay time). You can set the delay time between 1 and 3600 s for

each channel. Set the delay to an integer multiple of the measurement or MATH interval.
Delay upper limit alarm Delay lower limit alarm

Alarm Delay time  Alarm cleared

setting i

Measured T

Value
Alarm release

Alarm activated

Alarm release .
Measured value Alarm activated
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1.3 Functions of the Main Module

Tag Strings

Messages

Free Message

Upper Limit on Rate-of-Change/ Lower Limit on Rate-of-Change Alarm

The rate of change of the measured values is checked over the rate-of-change detection
interval. An alarm occurs if the rate of change of the measured value in the rising or
falling direction exceeds the specified value.

Upper limit on rate-of-change alarm Lower limit on rate-of-change alarm

.Change in the
/
T P measured value T
o . 8 It l
H L
i 7 £ . 2 ™ Amount of change in
F - Amount- of change in 2 B the setting T1-T2
5 p the setting T2-T 5 A
2 |T v 2 ~.
; : - Change
S 3 N hange in the
computed value
t1 t2 Time— t1 t2 Time—
f———f >
Interval Interval

t2-t1 t2-t1

Alarm Hold/Non-Hold

You can select whether, when factors resulting in output cease to exist, alarms are
cleared when the output factors are cleared, or alarms are held for their full duration (alarm
ACK?).

* When set to non-hold ¢ When set to hold

Alarm ACK Alarm ACK
v
Output cause Output cause
occurrence _ | L occurrence |
ON T 1 ON
Alarm Alarm
OFF — — OFF —

Status lamp Status lamp .

ALARM ©e o ALARM ce
Monitor screen Monitor screen

alarm view e ® alarm view ® @

* By clicking the Alarm ACK button in the browser’s monitoring screen or by sending an
equivalent communication command.

Tag strings can be set for each measurement and MATH channel.
You can select whether to display tag name or channel numbers on all channels.

Message strings set in advance are written to the monitor screen and message summary
per operations of the Event/Action function, communication commands, and buttons on
the browser.

Number of messages: 5 (1 to 5)

When you enter a message in the browser’s monitor screen and press a button during
data acquisition or recording, the message is written to the monitor screen and message
summary.

If you switch the screen after inputting a message string without writing the message, the
input message string reverts to the string prior to the change.

Number of messages: 1 (Free)
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Event Action Function

The event action function is used to execute an action such as starting or stopping the
recording by detecting an event such as an alarm occurrence or digital input.
By linking the Event function and Action function, you can control the operations of the

main unit.

Event Types

The following types of events are available. Some items may not be available depending

on the options installed.

Event Type Notation Start Specification
Digital input DI Channel number
Alarm occurrence Alarm

Alarm on specified channel

Alarm Channel

Channel number, alarm level number

Recording start Memory

Relay action Relay Relay number
Timer event occurrence Timer Timer number
Match time event occurrence Match Time Match time number
User function key User Key Keys number

The following Actions are available. The items that can be set differ according to the
events and event detection method.

Action Notation Detection Method
Edge Level
Recording start™ Memory Start (@) @)
Recording stop™ Memory Stop (@)
Save recorded data in divisions™  Memory Save (@)
Save thinning recording in Memory Save(T) o]
divisions™
Computation start MATH Start O O
Computation stop MATH Stop @]
Clear computation MATH Clear @]
Reset computation MATH Reset (@]
Reset MATH on specified MATH Reset Gr.1 (@]
MATH group number MATH Reset Gr.2
(Gr.1-7) MATH Reset Gr.3
MATH Reset Gr.4
MATH Reset Gr.5
MATH Reset Gr.6
MATH Reset Gr.6
Trigger occurrence on Trigger1 @]
specified number Trigger2
Trigger3
Alarm ACK Alarm ACK (@]
Flag Flag (@] @]
Reset timer of specified Timer 1 Reset O

number (1-6)

Timer 2 Reset
Timer 3 Reset
Timer 4 Reset
Timer 5 Reset
Timer 6 Reset

IM MW100-01E
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Action Notation Detection Method
Edge Level
Write free message Free Message O
Write message Message1 O
on specified number Message2
Message3
Message4
Messageb
Save specified file™ File Save (0]
Load specified file™ File Load @]
Perform manual sample” Manual Sample @]
Divide manual sample file™ Manual Divide (@)

*1 Cannot be selected when the event is Recording start.
*2 Can be selected when the event is User function key. The name of the target file is fixed to
SETTING.PNL.

Conditions in which actions do not execute
Depending on the state of the MW100, actions may not be executed even when events

occur.

Action Conditions

Recording start/recording stop Recording conditions are not valid. (Example:
no data to record)
Measurement paused.

Trigger occurrence recording paused.

Computation start/computation stop Computation conditions are not valid. (Example:
no valid equation)
Measurement paused.

Reset computation/clear computation Measurement paused.”

Reset MATH on specified MATH group number ~Measurement paused.”

Reset timer Measurement paused.”

Alarm ACK Measurement paused.”

Flag Measurement paused.”

Write message Measurement paused.

Load specified file/save specified file Measurement is in progress.

Save recorded data in divisions Divide recording conditions are not valid.
(Example: recording paused)

Perform manual sample Measurement paused.

Divide manual sample file Measurement paused.

* These actions can be executed when the event runs with a user function key.

Even aside from the conditions above, in the case of conditions in which the function
does not run when instigated from a key operation, Web setting, or communication
command, the function (action) is not executed.
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Event detection methods*

Method Notation Description
Edge Edge Edge event
Level Level Level event

* The following limitations exist on the setting.
* You cannot set the same action type for Edge and Level. The following action types are
considered the same.
Memory Start and Memory Stop
MATH Start and MATH Stop
Flag with the same flag number
* You cannot set the same action type for different levels. The following action types are
considered the same.
Memory Start and Memory Stop
MATH Start and MATH Stop
Flag with the same flag number
The setting error above occurs when you switch from Setting Mode to Measurement Mode.

Daylight Saving Time

Timer

Match Time

The internal clock is updated every specified month, week, day, and time.

The Event/Action function can be started according to timer settings.
The following two timers are available. ™

Type Notation Description
Relative Time Timer Relative Time up occurs at the specified time interval
Absolute Time Timer Absolute Time up occurs at a time interval after a specified

reference time™

*1 Operation upon power failure differs. For details, see “Timer and Match Time” in section 5.2.
*2 Also valid prior to the reference time.

The Event/Action function can be started according to the match time setting.
The following three match times are available. " ™

Type Notation Description

Monthly Month Time up occurs every month on specified date and time (hr and min)

Weekly Week Time up occurs every every week on the specified day of the week and
time (hr and min)

Daily Day Time up occurs every day at the specified time (hr and min)

*1 Conditions can be set for no operation. For details, see “Timer and Match Time” in section 5.2.
*2 For information about operation during power failures and time changes, see “Timer and Match
Time” in section 5.2.
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Measurement, Computation, and Thinning Recording Operations
Recording Start/Stop

You can start or stop recording to the CF card using the Start/Stop key, even action
function, communication command, or monitor screen.

Recording Start Action
The operations for starting the recording to the CF card are given below. The recording
start action is set to Direct for thinning recording.

Type Notation Operation

None Off Does not record.

Direct Direct Starts recording when recording start is executed.

Trigger Trigger Enters the trigger wait mode when recording start is executed.

Recording starts when an event occurs.

Recording Stop Action
The following three operations are available to stop recording.

Mode Display Operation

Single Single One file of a specified size is created on the CF card, then recording
stops.

Full stop FullStop Files of the specified size are created until the capacity of the card

is reached, then writing to the card stops.

Rotate Rotate Files of the specified size are created until the capacity of the card
is reached, then if the capacity is exceeded, new data is written
over the oldest data, and the process continues.

Combination of Recording Actions
You can combine the recording start action and the recording stop action to specify the
recording method appropriate for your application.

Start Stop
Single \%_/Jg/_\/\/\
' ' Time (s)
——
File 4
Stop recording after creating a single file
Start Stop
Fullstop I I
’ | | ’ -
; | | Time (s)
File File File 4
Stop recording when there is no
more free space on the CF card
Start
Rotate

| | | »
I I I '

Time (s)

DeIeteT File File

Continue recording by deleting the oldest file when
there is no free space on the CF card
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Start Trigger condition met Stop

—~

.

Time (s)
A

Stop recording after creating a single file

Single
LD
File 4
Start Trigger condition met
Fullstop*
Rotate*

Trigger condition met
v

.

|

Time (s)

File

File )
Trigger-wait status

* The condition for stopping the recording when set to Fullstop and the condition for deleting the file
when set to Rotate is the same as the condition when the recording start action is set to Direct.

Pretrigger Function

When selecting Trigger, a pre-trigger can be set in units of ten percent of the data length.
Writing starts simultaneously with recording, and after a trigger event occurs, the data
remaining after removal of the pretrigger data is written.

*When the pretrigger is set to 30% and

Start
: the recording stop action is Single

Trigger condition met Stop

TiiTI ] File Time (s)
I |
I I
30% before the trigger 70% after the trigger

Trigger point

If the time from when recording is started until the trigger condition is met is shorter than
the pretrigger length, data is written until the data length is reached after the trigger
condition is met.

*When the pretrigger is set

to 30% and the recording

Start Trigger condition met Stop anne
, stop action is Single

~__—

A4

»

Tir;e (s)

[ 1 File
| |
I I

30% before the trigger 70% after the trigger

Trigger point
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Manual Sample Function

When you perform a manual sample, the measured and computed data from specified
channels are written to the manual sample file.

When the CF card is inserted, the data is written to the manual sample file each time
you perform the manual sample. If the card is not inserted, the data is stored in internal
memory and written to the CF card the next time it is inserted.

A manual sample function can be carried out when in Measurement mode.

Performing a Manual Sample

A manual sample can be performed with the following actions.
» By the Event/Action function

* Using icons in the browser’s monitor screen

» Through operation in the Status Information screen

» By receiving a communication command

Action Notation Operation and Notes
Perform manual sample Manual Sample Performs a manual sample and writes to the
manual sample file.

Note

* Anew manual sample cannot be performed while the manual sample file is being written to.
* A manual sample cannot be performed at an interval shorter than the specified slowest
measurement interval.

Dividing the Manual Sample File

The manual sample file can be divided with the actions below. However, if division is
performed at the same time as a manual sample, priority is given to the manual sample.
» By the Event/Action function

» Through operation in the Status Information screen

» By receiving a communication command

Action Notation Operation and Notes

Divide the manual Manual Divide Divides the manual sample file.

sample file* Dividing the file is useful for summaries when the
DUT changes.

* The manual sample file is also divided under the following conditions.
*  When the number of sampled data exceeds 100.
* When the set conditions are changed.

Sample Channels
Measurement and MATH channels can be turned ON/OFF individually. Channels set for
measurement SKIP and computation OFF are not recorded.

P> For sample channel settings see “Recording Channel Settings” in section 3.4.

Data Acquisition Timing

When a manual sample is performed, the latest measured and computed data held are
written as manual sample data. When using the Multi Interval function, deviations in
measurement timing occur due to differences in measurement intervals.

If you perform a manual sample using the Timer or Match Time of the Event/Action
function, data can be acquired under the same measurement timing.

Displaying Data
Manual sample data can be displayed in the browser’s data view screen (only the latest
file can be displayed), or by using the MW100 Viewer Software.
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Saving Data to the CF Card

Save Location

Measured data, computed data, thinned data, recording logs, alarm summaries, manual
sample data, report data, and settings can be saved on the CF card.

Folder Structure
The structure of the data save folder is as shown below.

D CF card
[ conFie ———— Settings folder
E ) DaTA
[C3) DATADOOD
(2 paTADODL Save folders for measured, computed, and thinned data
(=] D?TADDDZ * When the data save folder is set to Auto
@ D.\IATAxxxx
[ MANUAL Manual sample folder

) REPORT —_ Report folder

Folder Name Settings

Select one of the following methods for creating folders for saving measured,
computed, and thinned data. Other folder names are fixed.

Type Folder Name Description
Auto DATANNNNn DATA: Fixed
nnnn: Serial number (0000 to 9999)
Partial XxXxxnnnn xxxx: Any 1 to 4 alphanumeric characters
nnnn: Serial number (0000 to 9999), can specify any start number.
Free XXXXXXXX xxxxxxxx: Any 1 to 8 alphanumeric characters
Date mddhhmmn mddhhmm: Month, day, hour, minute

(m: 1to0 9, X (October), Y (November), Z (December)
dd: 01 to 31, hh: 00 to 23
mm: 00 to 59)

n: serial number (0 to 9, Ato Z)

File Name

This is a list of file names generated by the MW100. A file name other than that of the
setting file cannot be specified.

Type File Name Save Description
Location
Settings Xxxxxxxx.PNL CONFIG XXxxxxxx: Specified when saving

(8 characters or fewer)
Measure- Measurement mddinnnn.MXD  DATAnnnn' mdd% Month/day (m: 1to 9,

ment group 1 X (October), Y (November),
Measurement mdd2nnnn.MXD Z (December), dd: 01 to 31)
group 2 1 to 3: Measurement groups 1 to 3
Measurement mdd3nnnn.MXD M: MATH
group 3 T: Thinning
Computation mddMnnnn.MXD nnnn: Serial number (0000 to 9999)
Thinning mddTnnnn.MXD
Recording log RECORDLG.TXT DATAnnnn"
Alarm summary ALARMLG.TXT  DATAnnnn"'
Manual sample mddSnnnn.DAM  MANUAL mdd*2: Month/day (m: 1to 9,
X (October), Y (November),
Z (December), dd: 01 to 31)
S: Manual sample
nnnn: Serial number (0000 to 9999)
Report Daily Dyymmddn.DAR REPORT D: Daily
W: Weekly
M: Monthl
Weekly Wyymmddn.DAR yymmdd*ZYYear/month/day (yy: last
two digits of Western
Monthly Myymmddn.DAR gz':egf?gg;r)“- 011012,

n: serial number (0-9, Ato Z)

*1. Created in the DATA folder. When the data save folder is set to Auto.
*2. Date the file is created.
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Saving Measured Data and Computed Data

Files can be created for every measurement group. An individual file is created for
computed data. For each measurement group, you can select whether or not to perform
the save operation.

The table below shows the approximate interval over which data can be saved to the CF
card when one measurement interval is used.

Save Channel Measurement Interval Capacity of the CF Card
128 MB 512 MB
10 ch 10 ms 8.8 hours 35.3 hours
100 ms 3.7 days 14.8 days
1s 37 days 148 days

Saving Thinned Data

Data is saved at a specified thinning interval. Thinning time:

4,5,10, 20, or 30 seconds, or 1, 2, 3, 4, 5, 10, 20, or 30 minutes, or 1 hour.
Select a thinning time from the above choices.

Saving Data at Multi Intervals

The recording operation can be specified for each interval group. Multiple sets of data
can be saved simultaneously such as recording an interval around a sudden event while
continuously recording long-term changes in the data.

Trigger 1 Trigger 3 Trigger 1
Start condition met condition met condition met

v

»
Lol

Time (s)

Interval group 1: Trigger (pretrigger 50%)  —— R .
Interval group 2: Direct [ I I I

Interval group 3: Trigger [

Thinning: [

File Division

You can use the Event/Action function, communication commands, or operations in the
browser’s status information screen to divide the file containing measured, computed, or
thinned data at an arbitrary time. After dividing a file, the next file division is enabled 10
minutes later.

Action Notation Operation and Notes

Save recorded data Memory Save Divides and saves the measured or computed data file.

in divisions This action is valid when the recording start action is set
to Direct and the recording stop action is set to Fullstop
or Rotate.

Save thinning Memory Save (T) Divides and saves the thinned data file.

recording in divisions This action is valid when the recording stop action is set

to Fullstop or Rotate.

File Message

You can enter a file message of up to 120 characters common to the measured and
computed data file, and a message for thinned data file. You can view the file message
on the MW100 Viewer Software.
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Replacing the CF Card While Recording
You can replace the CF card while the recording is in progress. Replace the CF card
quickly while the access indicator (in-progress display) to the CF card is not ON. If
the time to write the data arrives while you are replacing the CF card, the data for that
interval is dropped. You can check the time when data is written using the recording
status log in the log information.
The measured, computed, or thinned data files that are divided due to the replacement of
the CF card can be joined using the MW100 Viewer Software.

P> For a description of the CF card access indicator, see “Displays” in this section.

P> For a description of the time when data is written to the CF card, see appendix 8, “Saving
Data to the CF Card.”

Saving Manual Sample Data
Each time you perform a manual sample, the data is written to the manual sample file
saved on the CF card.

P> For details on manual samples: see “Manual Sample Function” in this section.

Saving Report Data (/M3 Option)
Hourly, daily, weekly, and monthly data is written to the daily, weekly, and monthly files
saved on the CF card.

P> For details on reports, see section 1.16, “Report Function (/M3 Option).”

Saving Settings
MW100 setting values can be saved. The contents that are saved are as follows:
* Range, alarm, and MATH related settings
* Media related settings
« Communication related settings
» Other settings
However, when settings are loaded onto the MW100, the IP address, subnet mask,
default gateway, host name, and domain name are not loaded.
P> For details on the saved items, see saved settings in “Recording Structure” in section 5.2.

Format
Initializes the CF Card.

P> For information on formatting the CF card, see “Formatting the CF Card and Checking the
Free Space” in section 3.3.

IM MW100-01E
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1.3 Functions of the Main Module

Communication Specifications
The MW100 can communicate with external devices using its Ethernet or serial
communication port.

Login Function

This function ensures that only previously registered users can obtain access when
communicating with the MW100.

For instructions, see section 3.2, “Communication Settings.” There are two levels of user
access rights as follows:

Level Notation Description
Administrator privileges Admin All functions are available.
User privileges User Measured/computed data, manual sample data, report

data, settings, log information, alarm summaries, and
status information can be obtained.

Administrator privileges are required to switch operation
modes, start/stop computation and recording, or change
settings such as the measurement range.

Ethernet Communication
The MW100 supports the following protocols: FTP, SNTP, DHCP, DNS, HTTP, Modbus/
TCP, SMTP, and MW-specific.

HTTP Function

Web service

MW100 settings and data can be monitored from a PC using a browser.

WebDAV function

A list of files and folders on the HTTP server (MW100) can be retrieved, and files and
folders can be copied, moved, or deleted from a PC using a browser.

DHCP Client Function

The IP address can be automatically obtained from the DHCP server.

SNTP Function

Acting as a client, the MW can obtain time information from the specified NTP server
and SNTP server when the power is turned ON. When acting as the server, the unit
can provide time information to other MW100s connected to the network.

FTP Function

As a client, the MW can send acquired data files to an FTP server. You can set up two
send destinations so that even if one server is down, the file can be sent to another
server. When acting as the server, you can transfer, delete, and otherwise manipulate
files from a PC.

E-Mail Function (SMTP)

Alarm occurrences and creation of data files can be notified via e-mail. Two recipients
locations can be specified.

MW100-Specific Protocol

You can carry out operations similar to the operations on a browser. For the available
commands, see the Communication Command Manual (IM MW100-17E).

Modbus Client Function(/M1 option)

The MW100 can connect to a Modbus server device and load measured data. Using
Modbus commands, the MW100 can load data from the Modbus server at regular
intervals. Loaded data are assigned to the communication input channels (C001 to
C300) of the MATH function (/M1 option). Up to ten Modbus servers can be registered.
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1.3 Functions of the Main Module

¢ Modbus Server Function
Modbus clients connect to an MW100 acting as the Modbus Server, and read from or
write to its internal registers.
Measured data and alarm statuses from measurement channels, measured data
and alarm statuses from MATH channels, data from communication input channels,
and time information are stored in the MW100’s registers. Up to four clients can be
connected simultaneously.

Ethernet
1
&100
a8 [I
L) o 110 |lO é'
DX2000 (with the /IMC1 option) MW100
(Client) (Server)

Using Yokogawa’s DX2000 Paperless Recorder (with the /MC1 option), you can
easily monitor measured data from the MW100.

EtherNet/IP Server Function (Firmware version R3.02 or later)

The Ethernet/IP client can connect to the MW100 acting as the Ethernet/IP server to read
data from MW100 measurement channels and math channels, and read/write data on
communication input channels.

Note

You can download the EDS file, mw100_eds.zip, from the following web site.
http://www.yokogawa.com/ns/mw100/

IM MW100-01E
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1.3 Functions of the Main Module

E-Mail Function

Notification can be made of alarm occurrences and creation of data files by e-mail.
Two recipient locations can be specified. Multiple addresses can be specified for each

recipient location.

P> For details about e-mail contents, see chapter 5, “Specifications.”

E-Mail Types

The following types of e-mail can be generated.

E-Mail Type

Operation and Contents of E-Mail

Alarm notification

E-mail is sent when measurement or MATH alarms are activated or cleared.

Contents:  Channels, levels, and types of alarms that were activated or
cleared, instantaneous values of measurement and MATH
channels (when selected), transmission request time

Report notification

Sends hourly, daily, weekly, and monthly reports via e-mail. When

measurement is started, the report is sent even if recording is stopped.

Contents:  The hourly, daily, weekly, or monthly (selectable) maximum,
minimum, average, integral, or instantaneous values (selectable),
report start and stop date/times, and report status

File creation
notification

E-mail is sent when a measured, computed, or thinned data file, manual
sample file, or report file is created.
Contents:  Created file name and time of send request

Notification of
remaining space
on media

E-mail is sent when the remaining time on the CF card is determined to be

less than the specified time.

Contents:  Total and remaining space on CF card, and the time of send
request

Notification of

E-mail is sent when the power is turned ON.

power ON Contents:  Time power was cut and turned ON
System error E-mail is sent when an operation error occurs.
notification Contents:

Error number and message, and time of send request

Fixed time report

E-mail is sent every specified time interval.

Contents: Instantaneous values of the measurement and MATH channels
(when selected) and the time of send request

Reference time setting:  Set in units of one-minute between 00:00 and 23:59

Time interval: Select 1,2, 3,4,6,8,12,0r24 h

Test

E-mail is sent when test is executed.

If a mail send request occurs during sending of another message, the request
is ignored.
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Subject

The e-mail transmission type is added to the subject. A user-specified string can be
added to the transmission type in the subject.
The following subject topics are available.

E-Mail Type

Subject

Alarm notification

[Alarm Summary] + user specified string

Report notification

[Report Data] + user specified string

File creation notification

[File End] + user specified string

Notification of remaining space on media

[Media Remain] + user specified string

Notification of power ON

[Power Failure] + user specified string

System error notification

[ERROR] + user specified string

Fixed time report

[Periodic Data] + user specified string

Test

[Test] + user specified string

E-mail Retransmission

If e-mail transmission fails, it will be retried two more times at about thirty to sixty second

intervals.
If retransmission fails twice, the e-mail i
not performed if the e-mail type is Test.

s deleted without being sent. Retransmission is

Example of an E-Mail Transmission

» Alarm notification e-mail

From: mwlOOuser@dagmaster.com
Date: Thu,25 Oct 2007 19:57:00
Subject: [Alarm Summary]

To: mwlOOuser2@dagmaster.com,

Alarm Summary
<Time>
DATE 07/10/25 \

+0900 Mail header

mwlOOuser3@dagmaster.com

Date and time

TIME 19:56:32

<Alarm Summary>
001 2h on
004 4H off

when alarm
occurs

Alarm contents

033 2r on 1
IA005 2H off J

<CH Data>

001 1234567 [mV]
004 1234567 [mV]
005 1234567 [mV]

. Instantaneous
A001 123456789 [mV] measured and
IA002 123456789 [mV] computed
. values
END
» Power supply ON notification e-mail
From: mwlOOuser@dagmaster.com
Date: Thu,25 Oct 2007 19:57:00 +0900 Mail header
Subject: [Power Faliure]
To: mwlOOuser2@dagmaster.com, mwlOOuser3@dagmaster.com
Power Faliure
<Power Off>
DATE 07/10/25 1 .
TIME 16:28:28 f Datelt'm?
power failed
<Power On>
DATE 07/10/25 1 .
TIME 19:56:40 J Date/time

END

power restored

IM MW100-01E
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1.3 Functions of the Main Module

RS-422A/485 Communication (/C3 Option)

In a multi-drop, four-wire configuration, up to thirty-two units can be connected. A
dedicated protocol and the ModbusRTU protocol are supported.

Using communication commands, you can send and receive settings, and measured and

computed values.

Modbus Master Function (/M1 Option)
The MW100 can connect to a Modbus slave device and load measured data. The
operation is the same as the Modbus client function. Target devices (Modbus slaves)
are identified with addresses.

MW100(master)

r r r
| Data from slave device . o
T | Serial communication

Data to slave device

>i

Modbus slave device

Modbus Slave Function

Modbus master devices can connect to other MW100s acting as Modbus slaves and
read from or write to their internal registers. The MW100 registers are the same as
those for the Modbus server function.

Modbus master device

= .
| Data to master device . L
— Serial communication

Data from master ' V
device T T T O — ],
=
58 @ |]
o o o =]
nlElﬂlL =] JIIII_IIIIIIIIIIL
MW100(slave) Modbus slave device

P> For instructions on connections, see section 2.7, “Connecting the RS-422A/485 Interface
(/C3 Option).”

RS-232 Communication (/C2 Option)
This is a point-to-point system. A dedicated protocol and the Modbus/RTU protocol are

supported.

Using communication commands, you can send and receive settings, and measured
and computed values.
The MW100 operates as the Modbus master or slave. For information about the
operation, see “RS-422A/485 Communications (/C3 Option).”
P> For instructions on connections, see section 2.8, “Connecting the RS-232 Interface (/C2
Option).”
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1.3 Functions of the Main Module

Log Information

The MW100 operations are recorded in the log. You can view the log using a log file or
communication output.

Saving the Recording Log File
While recording is stopped, information related to operation of the CF card and power
ON/OFF status is saved in text format to a log file with the name RECORDLG.TXT.
For information about log statuses and messages, see the MW100 Communication
Command Manual (IM MW100-17E).
Information Saved to the Log File
* When power is turned OFF or ON

* When CF card is inserted or ejected
* When CF card is formatted
» Upon recording stop or start, etc.
» File creation or deletion

» Triggers

» Time synchronization

» Errors

* Log saving
Example of a Log File

Time indicating when settings were
initialized*

Time after internal clock is reset*

~ Recording starts

— Data file creation
— Recording stops

— Newest information

Yokogawa DAQMASTER MW100 <Record Info>
Date Time Status Message
05/01/01 00:00:01 Power on
07/10/25 09:58:13 Format ok
07/10/25 10:00:03 Create /DATA0033
07/10/25 10:00:00.Record start 1
07/10/25 10:00:05 Mode rotate -T-
07/10/25 10:00:05 (100ms) 1H / 12cells
07/10/25 10:00:05 10CHs 1409KB
07/10/25 10:00:06 Create X2510100
07/10/25 11:00:15 Create X2510101 }———
07/10/25 12:00:15 Create X2510102
07/10/25 12:40:35 Record stop 1
07/10/25 12:41:25 Create ALARMLG
07/10/25 12:14:26 Create RECORDLG —
>>

Termination mark

* When settings are initialized, the MW100 initial time value of 2005/01/01 00:00:00 is set.
After than, if the time is reset, the time after the change is recorded.

IM MW100-01E

1-33

suojjoung jo uoijeue|dxgy H



1.3 Functions of the Main Module

Saving Alarm Summaries
When the recording stop action is activated, alarm summary information is saved in text
format to a log file named ALARMLG.TXT.

Example of an Alarm Summary

Date Time Channel Alarm status*
|
BA | | | |
07/10/25 10:12:13.000 001 1H off * The following are the alarm statuses.
07/10/25 11:14:12.000 001 1H on Alarm number
07/10/25 11:14:12.000 002 3L off Alarm type
07/10/25 11:14:13.000 001 1H off H Oflf_o"‘/OFF

07/10/25 11:14:21.000 001 2H off
07/10/25 11:14:36.000 002 3L on
07/10/25 11:14:36.000 001 1H on
07/10/25 11:14:54.000 001 2H on
07/10/25 11:15:18.000 002 3L off
07/10/25 11:15:22.000 005 4L off
07/10/25 11:15:25.000 005 4L on —Newest information

EN Termination mark

Nofte

While recording is paused during measurement, if the Stop key is held down, the data
acquisition log and alarm summary log are created in the root directory of the CF card.

Log Output

The following logs can be output using communication commands. You can also view the
log information using a browser. For information about log statuses and messages, see
the MW100 Communication Command Manual (IM MW100-17E).

Item Notation Request Type

Operation error log Operation Error Log Max. number of displayed logs
Alarm summary Alarm Summary Max. number of displayed logs
Strain input initial balance result Strain Input Initial Balance Display range

Recording log Recording Log Max. number of displayed logs
Recording status Recording Status Max. number of displayed logs
Message summary Message Summary Max. number of displayed logs
Communication log Communication Log Max. number of displayed logs
Operation log Operation Log Max. number of displayed logs
Computation status MATH Status Max. number of displayed logs
Mail client log SMTP Client Log Max. number of displayed logs
Time synchronization client log SNTP Client Log Max. number of displayed logs
HTTP server log HTTP Server Log Max. number of displayed logs
DHCP client log DHCP Client Log Max. number of displayed logs
FTP client log Client Log Max. number of displayed logs
FTP server log Server Log Max. number of displayed logs
Modbus client log Modbus Client Log Max. number of displayed logs
Modbus client command status Modbus Client Command Display range

Modbus client connection status Modbus Client Connection Display range

Modbus master log Modbus Master Log Max. number of displayed logs

Modbus master command status Modbus Master Command Display range

Modbus master connection status  Modbus Master Connection  Display range

Modbus server log Modbus Server Log Max. number of displayed logs
Modbus slave log Modbus Slave Log Max. number of displayed logs
CIP server log” CIP server Log Max. number of displayed logs
PCCC slave log” PCCC slave Log Max. number of displayed logs

* Firmware version R3.02 or later

P> For the procedure to view the log information using a browser, see “Log Information” in
section 3.15.
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1.4

Functions of the 4-CH, High-Speed Universal
Input Module

This module allows up to four inputs of DC voltage, thermocouple, 3-wire RTD, or digital

input (DI) at a minimum measurement interval of 10 ms.

|

Measurement Input Types

— Input terminal (clamp terminal)

Measurement Range

Measurement Input Type Notation

Do not measure SKIP

DC voltage VOLT

Thermocouple TC

Resistance temperature detector RTD

DI DI

Remote RJC RRJC

DC Voltage

Measurement Range Notation Rated Measurement Range
20 mV 20 mV —20.000 to 20.000 mV
60 mV 60 mV —60.00 to 60.00 mV
200 mV 200 mV —200.00 to 200.00 mV
2V 2V —2.0000 to 2.0000 V
6V 6V —6.000 to 6.000 V
20V 20V —20.000 to 20.000 V
100 V 100 V —100.00 to 100.00 V
60 mV (high resolution) 60 mVH 0.000 to 60.000 mV

6 V (high resolution) 6 VH 0.0000 to 6.0000 V
1V 1V —1.0000 to 1.0000 V
Thermocouple

Measurement Range Notation Rated Measurement Range
Type-R R 0.0 to 1760.0°C
Type-S S 0.0 to 1760.0°C
Type-B B 0.0 to 1820.0°C
Type-K K —200.0 to 1370.0°C
Type-E E —200.0 to 800.0°C
Type-J J —200.0 to 1100.0°C
Type-T T —200.0 to 400.0°C
Type-N N 0.0 to 1300.0°C
Type-W w 0.0 to 2315.0°C
Type-L L —200.0 to 900.0°C

IM MW100-01E
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1.4 Functions of the 4-CH, High-Speed Universal Input Module

Thermocouple (cont.)

Measurement Range Notation Rated Measurement Range
Type-U U —200.0 to 400.0°C
KPvsAu7Fe KPvsAu7Fe 0.0 to 300.0K

PLATINEL PLATINEL 0.0 to 1400.0°C

PR40-20 PR40-20 0.0 to 1900.0°C

NiNiMo NiNiMo 0.0 to 1310.0°C

WRe3-25 WRe3-25 0.0 to 2400.0°C

W/WRe26 WWRe26 0.0 to 2400.0°C

Type-N (AWG14) N14 0.0 to 1300.0°C

Type-XK GOST XK —200.0 to 600.0°C

Resistance Temperature Detector (1 mA)

Measurement Range Notation Rated Measurement Range
Pt100 Pt100-1 —200.0 to 600.0°C
JPt100 JPt100-1 —200.0 to 550.0°C
Pt100 (high resolution) Pt100-1H —140.00 to 150.00°C
JPt100 (high resolution) JPt100-1H —140.00 to 150.00°C
Ni100 SAMA Ni100SAMA —200.0 to 250.0°C
Ni100 DIN Ni100DIN —60.0 to 180.0°C
Ni120 Ni120 —70.0 to 200.0°C
Pt100 (high noise resistance) Pt100-1R —200.0 to 600.0°C
JPt100 (high noise resistance) JPt100-1R —200.0 to 550.0°C
Pt100 GOST Pt100G —200.0 to 600.0°C

Resistance Temperature Detector (2 mA)

Measurement Range Notation Rated Measurement Range
Pt100 Pt100-2 —200.0 to 250.0°C
JPt100 JPt100-2 —200.0 to 250.0°C
Pt100 (high resolution) Pt100-2H —140.00 to 150.00°C
JPt100 (high resolution) JPt100-2H —140.00 to 150.00°C
Pt50 Pt50 —200.0 to 550.0°C
Cu10 GE Cu10GE —200.0 to 300.0°C
Cu10 L&N Cu10LN —200.0 to 300.0°C
Cu10 WEED Cu10WEED —200.0 to 300.0°C
Cu10 BAILEY Cu10BAILEY —200.0 to 300.0°C
J263B J263B 0.0 to 300.0K

Cu10 at 20°C Cu10a392 —200.0 to 300.0°C
alpha=0.00392

Cu10 at 20°C Cu10a393 —200.0 to 300.0°C
alpha=0.00393

Cu25 at 0°C Cu25 —200.0 to 300.0°C
alpha=0.00425

Cub3 at 0°C Cub3 -50.0 to 150.0°C
alpha=0.00426035

Cu100 at 0°C Cu100 —-50.0 to 150.0°C
alpha=0.00425

Pt25 (JPt100 x 1/4) Pt25 —200.0 to 550.0°C
Cu10 GE (high resolution) Cu10GEH —200.0 to 300.0°C
Cu10 L&N (high resolution) Cu10LNH —200.0 to 300.0°C
Cu10 WEED (high resolution) Cu10WEEDH —200.0 to 300.0°C

Cu10 BAILEY (high resolution)

Cu10BAILEYH

—200.0 to 300.0°C
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Resistance Temperature Detector (2 mA, cont.)

Measurement Range Notation Rated Measurement Range

Pt100 (high noise resistance) Pt100-2R —200.0 to 250.0°C

JPt100 (high noise resistance) JPt100-2R —200.0 to 250.0°C

Cu100 GOST Cu100G —200.0 to 200.0°C

Cub0 GOST Cu50G —200.0 to 200.0°C

Cu10 GOST Cu10G —200.0 to 200.0°C

DI

Measurement Range Notation Rated Measurement Range

LEVEL LEVEL Vth=2.4V

Contact input CONTACT 100 Q or less, ON, 10 kQ or less, OFF

Measurement Interval, Integration Time, and Filter
You can select from the following measurement intervals for this module.
10 ms, 50 ms, 100 ms, 200 ms, 500 ms, 1s,25s,5s,10s,205s,305s,60s
The integral time and types of filters applied vary depending on the measurement
interval.
P> For information on filters, see section 2.9, “Measures Against Noise on the MW 100 Data
Acquisition Unit.”

Measurement Synchronization
Measurement is synchronized on each channel.
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1.5 Functions of the 10-CH, Medium-Speed
Universal Input Module

This module allows up to ten inputs of DC voltage, thermocouple, 3-wire RTD, and digital
input (DI) at a minimum measurement interval of 100 ms.

Terminal cover

-—Input terminal (clamp terminal)

Measurement Input Types

Measurement Input Type Notation
No measurement SKIP
DC voltage VOLT
Thermocouple TC
Resistance temperature detector RTD

DI DI
Remote RJC RRJC

Measurement Range

DC Voltage

Measurement Range Notation Rated Measurement Range
20 mV 20 mV —20.000 to 20.000 mV
60 mV 60 mV —60.00 to 60.00 mV
200 mV 200 mV —200.00 to 200.00 mV
2V 2V —2.0000 to 2.0000 V
6V 6V —6.000 to 6.000 V
20V 20V —20.000 to 20.000 V
100 V 100 V —100.00 to 100.00 V
60 mV (high resolution) 60 mVH 0.000 to 60.000 mV

6 V (high resolution) 6 VH 0.0000 to 6.0000 V
1V 1V —1.0000 to 1.0000 V

Thermocouple

Measurement Range Notation Rated Measurement Range

Type-R R 0.0 to 1760.0°C
Type-S S 0.0 to 1760.0°C
Type-B B 0.0 to 1820.0°C
Type-K K —200.0 to 1370.0°C
Type-E E —200.0 to 800.0°C
Type-J J —200.0 to 1100.0°C
Type-T T —200.0 to 400.0°C
Type-N N 0.0 to 1300.0°C
Type-W w 0.0 to 2315.0°C
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Thermocouple (cont.)

Measurement Range Notation Rated Measurement Range
Type-L L —200.0 to 900.0°C
Type-U U —200.0 to 400.0°C
KPvsAu7Fe KPvsAu7Fe 0.0 to 300.0 K
PLATINEL PLATINEL 0.0 to 1400.0°C
PR40-20 PR40-20 0.0 to 1900.0°C
NiNiMo NiNiMo 0.0 to 1310.0°C
WRe3-25 WRe3-25 0.0 to 2400.0°C
W/WRe26 WWRe26 0.0 to 2400.0°C
Type-N (AWG14) N14 0.0 to 1300.0°C
Type-XK GOST XK —200.0 to 600.0°C

Resistance Temperature Detector (1 mA)

Measurement Range Notation Rated Measurement Range
Pt100 Pt100-1 —200.0 to 600.0°C
JPt100 JPt100-1 —200.0 to 550.0°C
Pt100 (high resolution) Pt100-1H —140.00 to 150.00°C
JPt100 (high resolution) JPt100-1H —140.00 to 150.00°C
Ni100 SAMA Ni100SAMA —200.0 to 250.0°C
Ni100 DIN Ni100DIN —60.0 to 180.0°C
Ni120 Ni120 —70.0 to 200.0°C
Pt50 Pt50 —200.0 to 550.0°C
Cu10 GE Cu10GE —200.0 to 300.0°C
Cu10 L&N Cu10LN —200.0 to 300.0°C
Cu10 WEED Cu10WEED —200.0 to 300.0°C
Cu10 BAILEY Cu10BAILEY —200.0 to 300.0°C
J263B J263B 0.0t0 300.0 K
Cu10 at 20°C Cu10a392 —200.0 to 300.0°C
alpha=0.00392

Cu10 at 20°C Cu10a393 —200.0 to 300.0°C
alpha=0.00393

Cu25 at 0°C Cu25 —200.0 to 300.0°C
alpha=0.00425

Cub3 at 0°C Cub3 -50.0 to 150.0°C
alpha=0.00426035

Cu100 at 0°C Cu100 -50.0 to 150.0°C
alpha=0.00425

Pt25 (JPt100 x 1/4) Pt25 —200.0 to 550.0°C
Cu10 GE (high resolution) Cu10GEH —200.0 to 300.0°C
Cu10 L&N (high resolution) Cu10LNH —200.0 to 300.0°C
Cu10 WEED (high resolution) Cu10WEEDH —200.0 to 300.0°C
Cu10 BAILEY (high resolution) Cu10BAILEYH —200.0 to 300.0°C
Pt100 GOST Pt100G —200.0 to 600.0°C
Cu100 GOST Cu100G —200.0 to 200.0°C
Cub0 GOST Cub0G —200.0 to 200.0°C
Cu10 GOST Cu10G —200.0 to 200.0°C
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1.5 Functions of the 10-CH, Medium-Speed Universal Input Module

DI

Measurement Range Notation Rated Measurement Range

LEVEL LEVEL Vth=2.4 V

Contact input CONTACT 1 kQ or less, ON, 100 kQ or less, OFF

(shunt capacitance: 0.01 pF or less)

Measurement Interval, Integration Time, and Filter
You can select from the following measurement intervals for this module.
100 ms, 200 ms, 500 ms, 1s,2s,5s,10s,20s,30s,60s
The integral time and types of filters applied vary depending on the measurement
interval.
P> For information on filters, see section 2.9, “Measures Against Noise on the MW100 Data
Acquisition Unit.”

If the measurement interval is 100 ms, burnout detection is performed on one channel
during one measurement interval. After measurement starts when in the burnout
condition, or after the burnout, burnout detection is disabled for up to ten measurements
(approximately one second).

Measurement Synchronization
Since measurement is sequential, measurement on each channel is not synchronized.
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1.6  Functions of the 30-CH, Medium-Speed DCV/
TC/DI Input Module

This module allows up to thirty inputs of DC voltage, thermocouple, and digital input (DI)
at a shortest measurement interval of 500 ms. It takes up three modules worth of space
when attaching to the base plate.

MX110-VTD-L30 MX110-VTD-L30/H3

Terminal

cover cover

Input terminal Input terminal

(clamp terminal) (M3 screw terminal)
Measurement Input Types
Measurement Input Type Notation
No measurement SKIP
DC voltage VOLT
Thermocouple TC
DI DI
Remote RJC RRJC
Measurement Range
DC Voltage
Measurement Range Notation Rated Measurement Range
20 mV 20 mV —20.000 to 20.000 mV
60 mV 60 mV —60.00 to 60.00 mV
200 mV 200 mV —200.00 to 200.00 mV
2V 2V —2.0000 to 2.0000 V
6V 6V —6.000 to 6.000 V
20V 20V —20.000 to 20.000 V
100 V 100 V —100.00 to 100.00 V
60 mV (high resolution) 60 mVH 0.000 to 60.000 mV
6 V (high resolution) 6 VH 0.0000 to 6.0000 V
1V 1V —1.0000 to 1.0000 V

Thermocouple
Measurement Range Notation Rated Measurement Range

Type-R R 0.0 to 1760.0°C
Type-S S 0.0 to 1760.0°C
Type-B B 0.0 to 1820.0°C
Type-K K —200.0 to 1370.0°C
Type-E E —200.0 to 800.0°C
Type-J J —200.0 to 1100.0°C
Type-T T —200.0 to 400.0°C
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1.6 Functions of the 30-CH, Medium-Speed DCV/TC/DI Input Module

Thermocouple (cont.)

Measurement Range Notation Rated Measurement Range
Type-N N 0.0 to 1300.0°C

Type-W W 0.0 to 2315.0°C

Type-L L —200.0 to 900.0°C

Type-U U —200.0 to 400.0°C
KPvsAu7Fe KPvsAu7Fe 0.0 to 300.0 K

PLATINEL PLATINEL 0.0 to 1400.0°C

PR40-20 PR40-20 0.0 to 1900.0°C

NiNiMo NiNiMo 0.0 to 1310.0°C

WRe3-25 WRe3-25 0.0 to 2400.0°C

W/WRe26 WWRe26 0.0 to 2400.0°C

Type-N (AWG14) N14 0.0 to 1300.0°C

Type-XK GOST XK —200.0 to 600.0°C

DI

Measurement Range Notation Rated Measurement Range
LEVEL LEVEL Vth=2.4 V

Contact input CONTACT 1 kQ or less, ON, 100 kQ or less, OFF

(shunt capacitance: 0.01 pF or less)

Measurement Interval, Integration Time, and Filter
You can select from the following measurement intervals for this module.
500 ms, 1s,2s,5s,10s,20s,30s,0r60s.
The integral time and types of filters applied vary depending on the measurement
interval.

P> For information on filters, see section 2.9, “Measures Against Noise on the MW 100 Data
Acquisition Unit.”

Measurement Synchronization
Since measurement is sequential, measurement on each channel is not synchronized.
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1.7

Functions of the 6-CH, Medium-Speed Four-
Wire RTD Resistance Input Module

This module allows up to six inputs of DC voltage, 4-wire RTD, 4-wire resistance, and
digital input (DI) at a minimum measurement interval of 100 ms.

Terminal cover

Input terminal (clamp terminal)

Measurement Input Types

Measurement Input Type Notation
No measurement SKIP
DC voltage VOLT
Resistance temperature detector RTD
Resistance OHM

DI DI

Measurement Range

DC Voltage

Measurement Range Notation Rated Measurement Range
20 mV 20 mV —20.000 to 20.000 mV
60 mV 60 mV —60.00 to 60.00 mV
200 mV 200 mV —200.00 to 200.00 mV
2V 2V —2.0000 to 2.0000 V
6V 6V —6.000 to 6.000 V
20V 20V —20.000 to 20.000 V
100 V 100 V —100.00 to 100.00 V
60 mV (high resolution) 60 mVH 0.000 to 60.000 mV

6 V (high resolution) 6 VH 0.0000 to 6.0000 V
1V 1V —1.0000 to 1.0000 V

Resistance Temperature Detector (1 mA)

Measurement Range Notation Rated Measurement Range
Pt100 Pt100-1 —200.0 to 600.0°C
JPt100 JPt100-1 —200.0 to 550.0°C
Pt100 (high resolution) Pt100-1H —140.00 to 150.00°C
JPt100 (high resolution) JPt100-1H —140.00 to 150.00°C
Ni100 SAMA Ni100SAMA —200.0 to 250.0°C
Ni100 DIN Ni100DIN —60.0 to 180.0°C
Ni120 Ni120 —70.0 to 200.0°C
Pt50 Pt50 —200.0 to 550.0°C
Cu10 GE Cu10GE —200.0 to 300.0°C
Cu10 L&N Cu10LN —200.0 to 300.0°C
Cu10 WEED Cu10WEED —200.0 to 300.0°C
Cu10 BAILEY Cu10BAILEY —200.0 to 300.0°C
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1.7 Functions of the 6-CH, Medium-Speed Four-Wire RTD Resistance Input Module

Resistance Temperature Detector (1 mA, cont.)

Measurement Range Notation Rated Measurement Range
J263B J263B 0.0 to 300.0K
Cu10 at 20°C Cu10a392 —200.0 to 300.0°C
alpha=0.00392

Cu10 at 20°C Cu10a393 —200.0 to 300.0°C
alpha=0.00393

Cu25 at 0°C Cu25 —200.0 to 300.0°C
alpha=0.00425

Cu53 at 0°C Cu53 -50.0 to 150.0°C
alpha=0.00426035

Cu100 at 0°C Cu100 -50.0 to 150.0°C
alpha=0.00425

Pt25 (JPt100 x 1/4) Pt25 —200.0 to 550.0°C
Cu10 GE (high resolution) Cu10GEH —200.0 to 300.0°C
Cu10 L&N (high resolution) Cu10LNH —200.0 to 300.0°C
Cu10 WEED (high resolution) Cu10WEEDH —200.0 to 300.0°C
Cu10 BAILEY (high resolution) Cu10BAILEYH —200.0 to 300.0°C
Pt100 GOST Pt100G —200.0 to 600.0°C
Cu100 GOST Cu100G —200.0 to 200.0°C
Cu50 GOST Cu50G —200.0 to 200.0°C
Cu10 GOST Cu10G —200.0 to 200.0°C

Resistance Temperature Detector (0.25 mA)

Measurement Range Notation Rated Measurement Range
Pt500 Pt500 —200.0 to 600.0°C

Pt1000 Pt1000 —200.0 to 600.0°C
Resistance

Measurement Range Notation Rated Measurement Range
20 Q (measured current 1 mA) 20 ohm 0.000 to 20.000 Q

200 Q (measured current 1 mA) 200 ohm 0.00 to 200.00 Q

2 kQ (measured current 0.25 mA) 2000 ohm 0.0 to 2000.0 Q

DI

Measurement Range Notation Rated Measurement Range
LEVEL LEVEL Vth=2.4V

Contact input CONTACT 1 kQ or less, ON, 100 kQ or less, OFF

(shunt capacitance: 0.01 pF or less)

Measurement Interval, Integration Time, and Filter
You can select from the following measurement intervals for this module.
100 ms, 200 ms, 500 ms, 1s,2s,5s,10s,20s,30s,60s
The integral time and types of filters applied vary depending on the measurement
interval.
P> For information on filters, see section 2.9, “Measures Against Noise on the MW 100 Data
Acquisition Unit.”

Measurement Synchronization
Since measurement is sequential, measurement on each channel is not synchronized.
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1.8 Functions of the 4-CH, Medium-Speed Strain
Input Module

This module allows up to four inputs of measurement from strain gauges and strain
gauge type sensors at a minimum measurement interval of 100 ms.

-B12, -B35 -NDI

Terminal cover

NDIS terminal
e .
Input terminal

(clamp terminal)

Measurement Input Types

Measurement Input Type Notation
No measurement SKIP
Strain STR

Measurement Range

Strain Input

Measurement Range Type Notation Rated Measurement Range
2000 uSTR 2000 uSTR —2000.0 to 2000.0 pSTR
20000 uSTR 20000 uSTR —20000 to 20000 uSTR
200000 pSTR 200000 uSTR —200000 to 200000 pSTR

Measurement Interval, Integration Time, and Filter
You can select from the following measurement intervals for this module.
100 ms, 200 ms, 500 ms, 1s,2s,5s,10s,20s,30s,60s
The integral time and types of filters applied vary depending on the measurement
interval.
P> For information on filters, see section 2.9, “Measures Against Noise on the MW 100 Data
Acquisition Unit.”

Measurement Synchronization
Since measurement is sequential, measurement on each channel is not synchronized.
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1.8 Functions of the 4-CH, Medium-Speed Strain Input Module

Initial Balancing (Unbalance Adjustment)

When configuring a bridge circuit with a strain gauge, due to the slight deviation in
resistance of the strain gauge, the bridge circuit will not necessarily be balanced even if
the strain of the circuit under test is zero, and the measured value may not be zero (the
value in such cases is called the initial unbalanced value).

Therefore, when taking measurements you must first balance the bridge and if the strain
is zero, obtain a measured value of zero. This is called initial balancing (setting the initial
unbalanced value to zero).

Measured value

/,—1Initial balance

Initial unbalanced value ————>¢~

—= Strain

With the MW100, initial balancing is performed in the £10000 pstrain range.

Initial balance: The value when the command is executed is taken as the initial
unbalanced value, and the measured value is set to zero.

Reset: The value set during initial balancing is reset to zero. The initial
unbalanced value is used for the measured value as-is.

Note

If the measurement range is changed, the initial balancing is reset.

After a range change, you must redo initial balancing.

Initial Balance Selection Items

Type Notation Description
Reset Reset Resets the initial balance values.
Execute Execute Balancing Executes initial balancing.
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1.8 Functions of the 4-CH, Medium-Speed Strain Input Module

Scaling Settings of the Strain Gauge Type Sensor

This is an explanation of scaling settings used to measure physical quantities such as
load and length using a strain gauge type sensor.

The basic relational equation is as follows.
1 mV/V = 2000 uSTR (equation 1)

The following gives two examples, one when the rated input and output are known, and
one when the calibration coefficient is known. (Hereinafter, p-strain will be expressed as
NSTR).

When the Rated Input and Output Are Known

The following specific example provides an explanation.

* Rated input 200N (settoY)

» Rated output 0.985 mV/V (set to K)

In this case, if a 200 N load is introduced, an output of 0.985 mV/V results.
From the relationship in equation 1, if 200 N is applied, it means that

an output of: 0.985 mV/V = 0.985 x 2000 = 1970 uSTR is obtained.

In other words, for each 1N, 1970 ySTR/200N = 9.85 uySTR/N of output results.
Therefore, the scaling settings are entered as follows.

When Measuring at 50 to 150 N

Scale minimum: 50 (set to Smin)
Scale maximum: 150 (units: N) (set to Smax)
therefore,

Span minimum: 50 x 9.85 uSTR/N =492.5 uSTR
Span maximum: 150 x 9.85 = 1477.5 uySTR
would be appropriate settings.
Hence, the measurement range is 2000 uSTR.

Generally, the range is as follows.
Using the symbols explained up to now, after setting the minimum and maximum scale,
we can describe the minimum and maximum values of span as:

Min. value of span = [(K(mV/V) x 2000) / Y(unit)] x Smin (USTR)

Max. value of span = [(K(mV/V) x 2000) / Y (unit)] x Smax (uSTR)

IM MW100-01E

1-47

suojjoung jo uoijeue|dxgy H



1.8 Functions of the 4-CH, Medium-Speed Strain Input Module

When the Calibration Coefficient is Known

An example using a displacement gauge provides an explanation.
» Rated input 20 mm

+ Calibration coefficient 0.003998 mm / (1 pV/V)

Basically, if you can convert the calibration coefficient to the rated output mentioned in
“When Rated Input and Rated Output Are Known,” the previous equation can be used.

Using equation 1,
1 pV/V =0.001 mV/V =0.001 x 2000 pSTR =2 uSTR
therefore the rated output with this sensor when 20 mm is input would be

20 mm + [0.003998 mm/2 pSTR] = 10005 pSTR

in other words, for 1 mm, an output of:
10005 uSTR /20 mm = 500.25 ySTR/mm

can be obtained.

Thereafter in the same manner, if you wish to measure with a scale of 2 mm to 15 mm,
the settings are

Scale minimum: 2

Scale maximum: 15 (Units: mm)
therefore,

Span minimum: 2 x 500.25 ySTR/mm = 1000.5 uSTR

Span maximum: 15 x 500.25 pSTR = 7503.75 uySTR

would be appropriate settings.

Since the measurement range is the 20000 uSTR range, the resolution on the MW100
comes to 1 uSTR, so we round to the following:

Span minimum: 1001 uSTR
Span maximum: 7504 uSTR
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1.9

Functions of the 10-CH, Pulse Input Module

This module has ten inputs for integration of numbers of pulses.

|

o— Input terminal (clamp terminal)

Measurement Input Types

Measurement Input Type Notation
No measurement SKIP
Pulse PULSE

Measurement Range

Measurement Range Type Notation Rated Measuring Range
LEVEL LEVEL 0 to 30000
Contact input CONTACT 0 to 30000

Measurement Interval

The pulse integral value each measurement interval is the measured value. When stable
pulses are input, the upper limit of numbers of pulses and the measured values are
shown below.

Upper Limit of Numbers of Pulses per Measurement Interval

Measurement interval 100 ms 200 ms 500 ms 1s 2s 5s 10s 20s 30s
Upper limit on number 10000 10000 10000 10000 10000 6000 3000 1500 1000
of pulses (pulses/s)™ 10000 10000 10000 10000 10000 5000 2720 1360 900

*1 When using the SNTP time synchronization function, refer to the values on the bottom row.

Measured Values Each Measurement Interval

Measurement Input signal

interval 1 pulse/s 10 pulses/s 100 pulses/s 1000 pulses/s 10000 pulses/s
100 ms Oor1 1 10 100 1000
200 ms Oor1 2 20 200 2000
500 ms Oor1 5 50 500 5000
1s 1 10 100 1000 10000
2s 2 20 200 2000 20000
5s 5 50 500 5000 2
10s 10 100 1000 10000 -2
20s 20 200 2000 20000 2
30s 30 300 3000 300007 —2

60 s 60 600 6000 -2 -2

*2 Exceeds the rated count and therefore measurement is not possible.
*3 When using the SNTP time synchronization function, the values in the upper row are exceeded
therefore measurement is not possible.

Note

*  When using the SNTP time synchronization function, the spacing between the measurement

intervals changes. Thus, the measured value for each measurement interval changes, but
this has no effect on the integral value (TLOG.PSUM).

» If you set the measurement interval to something other than 1 s, the measured value cannot
be displayed in units of seconds. To display in units of seconds, set the measurement
interval to 1 s, or use the MATH function (/M1 option).
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1.9 Functions of the 10-CH, Pulse Input Module

Input Range

Maximum speed: 10000 pulses/s
Minimum input pulse width: 40 us

Input Threshold Level

Filter

Integration

LEVEL
Counts when changing from 1 V or less to 3 V or more

Contact input

Count upon change from contact open to contact close
Contact open: 100 kQ or more
Contact close: 100 Q or less

Anti-Noise Filter
The integral time and types of filters applied vary depending on the measurement
interval.

P> For information on filters, see section 2.9, “Measures Against Noise on the MW100 Data
Acquisition Unit.”

Chattering Filter
Removes chattering of up to 5 ms (can be turned ON/OFF on individual channels)
Turn the chattering filter OFF when measuring on circuits with no chattering.

The measured values from the 10-CH Pulse Input Module are reset every measurement
intervals by the pulse integral value of each measurement interval. Continued pulse
integration is carried out with the pulse integration (TLOG.PSUM) by the MW100 main
module’s integration function.

Even if the MATH function (/M1 option) is not included, channels included on the 10-CH
Pulse Input Module are only available for integration (TLOG.PSUM).

MATH Function |10-CH Pulse |[MATH Function

(/M1 Option) |Input Module |(See Section 1.15) |-Mitation

Yes None No

Operator: Only TLOG.PSUM() can be used
Computation channels: A001 to AO60
Broken-line input channel function: Not
Included Available available

No Long-duration moving average function: Not
available

Modbus master function: Not available
Modbus client function: Not available

Not included [Not available None
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1.10 Functions of the 10-CH, High-Speed Digital

Input Module

The “-D05” module is equipped with ten inputs for measurement of non-voltage contact,
open collector, and 5 V logic inputs at a minimum measurement interval of 10 ms.

The “-D24” module is equipped with ten inputs and measures 24-V logic inputs at a
minimum measurement interval of 10 ms.

Terminal cover

g Llnput terminal (clamp terminal)

Measurement Input Types

Measurement Input Type Notation
No measurement SKIP
Digital DI

Measurement Range

DI (MX115-D05)

Measurement Range Type Notation Rated Measurement Range
LEVEL LEVEL OFF at 1 V or less and ON at 3 V or more
Contact input CONTACT 100 Q or less, ON, 100 kQ or less, OFF

DI (MX115-D24)

Measurement Range Type Notation Rated Measurement Range

LEVEL LEVEL OFF at6 V or less and ON at 16 V or more

Measurement Interval

Filters

Select 10 ms, 50 ms, 100 ms, 200 ms, 500 ms, 1s,2s,5s,10s,20s,30s, or 60 s.

The module detects ON/OFF as shown below to prevent the effects of chattering. If

the measurement interval is set a value greater than four times the chattering period,

measurement is possible by avoiding chattering effects.

* Measurement interval of 5 s or less: Use the wider of the ON/OFF width of the
detection period (approximately 75% to 90% of the measurement interval)

Measurement Measurement Measurement

Detection interval =
Measurement interval x 75% to 90%

. interval . interval  interval )
' Detection | Detection : Detection l

, .
i :
[ . [ ]
 interval , ' interval | ! interval !
| |
i :
: ,

&

Chattering

* Measurement interval of 5 s or more: Use the wider of the ON/OFF width of
approximately 4.5 s

IM MW100-01E

1-51

suojjoung jo uoijeue|dxgy H



1.11 Functions of the 8-CH, Medium-Speed Analog

Output Module

The module has eight outputs for voltage or current.
An external power source (24 V) is required for current output.
For voltage output only, an external power source is not required.

Terminal cover

Input terminal (clamp terminal)

Output Types
Output Type Notation
No output SKIP
Analog output AO
Output Method
Output Method Notation Actions
Transmission output Trans Outputs a voltage or current according to the
measured or computed data of the input channel
specified on the same unit. You can also produce
pattern output using the broken line input function.
Arbitrary output Comm.Input  Outputs specified values based on values sent from
the PC.
Output Range
Output Range Notation Output range
Voltage 10V —10.000 V to 10.000 V
Current 20 mA 0.000 mA to 20.000 mA

Output Update Interval

The output is updated at 100-ms (minimum) intervals. It is not synchronized to the

measurement interval.

Operation upon Startup and Errors

See section 1.13, “Operation of the Eight-Channel Medium-Speed Analog Output Module
and the Eight-Channel Medium Speed PWM Output Module.”

Output Operation during Calibration

Calibration Condition

Output Operation

Channels being calibrated

Arbitrary output (output of calibration value)

Non-calibrated channels

Holds the output value (holds the value last output during steady
operation (see section 1.13))
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1.12 Functions of the 8-CH, Medium-Speed PWM
Output Module

This module has eight outputs for pulse wave duty. A certain duty pulse waveform is output
according to the specified pulse interval. A pulse interval can be set for each channel.

Terminal cover

Input terminal (clamp terminal)

Output Types
Output Type Notation
No output SKIP
PWM Output PWM
Output Method
Output Method Notation  Actions
Transmit TRANS Outputs a duty pulse waveform according to the measured or
computed data of the input channel specified on the same unit.
You can also produce pattern output using the broken line
input function.
Arbitrary output COM Outputs specified data based on the values sent from the PC.

Output Range and Output Waveform
Output range: 0.000 to 100.000%
Output width

External .
power supply Duty= Outputwidth 5 (%]
voltage Pulse interval

Pulse interval

Pulse Interval
1 ms to 300 s (can be set channel by channel)

Range Notation Setting Range
1 ms interval setting range 1ms 1 ms to 30.000 s (can be set in units of 1 ms)
10 ms interval setting range 10 ms 10 ms to 300.00 s (can be set in units of 10 ms)

* The pulse interval can be set by determining the pulse interval coefficient.
The pulse interval coefficient is set from 1 to 30000.
Pulse interval = range x pulse interval coefficient

Output Update Interval
The output is updated at 100-ms (minimum) intervals. It is not synchronized to the
measurement interval.

Operation upon Startup and Error Occurrence
See section 1.13, “Operation of the 8-CH Medium-Speed Analog Output Module and the
8-CH Medium Speed PWM Output Module.”

IM MW100-01E 1-53

suojjoung jo uoijeue|dxgy H



1.13 Operation of the 8-CH Medium-Speed Analog
Output Module and the 8-CH Medium Speed
PWM Output Module

The following describes the output operation of the analog and PWM output modules.

Output upon Startup, Error Occurrence, and Stopping’

Output Format

* Firmware version R3.03 or later

Output Selection Notation Actions
Hold previous value Last Holds the last value output.
Output preset value Preset Outputs an arbitrarily specified output value.

In the output format below, current (analog output module) or pulse wave duty (PWM

output module) is output.

» Transmission output: Outputs analog or PWM according to the measured or
computed data from the measurement channel specified on the
same unit. All input modules can be specified (but not output
modules).

» Arbitrary output: When commands are received from the PC, the instrument
outputs analog or PWM signals accordingly.

Once the power is turned ON and the unit is able to perform communication, arbitrary

output becomes possible. For transmission output within a unit, after measurement or

computation starts, the output values are updated upon transmission output.

Output on Disabled Channels

Type of Disabled Channel Output

Channels changed from enabled to Holds the last output value when channel was
disabled through setting changes active

Channels invalid upon startup Output according to settings upon startup

The timing at which changes applied to the output module take effect is according to the
events below.

(Ex. When changing settings from transmission output within a unit to arbitrary output, the
last value of transmission output within a unit is held until the arbitrary output request is
generated.)

Output Operation per Settings and Setting Changes

Condition upon Power ON and Output Operation

Condition When Power Is Turned ON Output Operation

When Output Settings are Disabled Operation when power is turned ON
With transmission output within a unit, Before meas. start Operation when power is turned ON
and reference channels disabled Start measurement Output upon error occurrences
Transmission output within a unit Before meas start  Operation when power is turned ON

Start measurement Transmission output

Arbitrary output No output request  Operation when power is turned ON
Output requested  Arbitrary output
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1.13 Operation of the 8-CH Medium-Speed Analog Output Module and the 8-CH Medium Speed PWM Output

Module

Output Operation through Setting Changes (Common)

Setting Changes (Contents)

Output Operation

Setting changes for operation™ Prev. value held — preset value

Outputs the preset value the on
startup next time the power is
turned ON

Preset value — hold prev. value

The last output value from the
previous operation is held for the
next time the power is turned ON
(outputs the output value active
when the power was last turned
OFF during the previous session)

Setting changes for operation™ Prev. value held — preset value

Outputs the preset value the
upon error occurrence next time
an error occurs

Preset value — hold prev. value

Holds the last output value active
before the error occurs for the
next time an error occurs.

Preset value setting changes™

No changes (as above)

Change setting of output ch from Enabled — Disabled

Holds the output value (last
output value)

*1 After changing settings, the changes take effect when measurement starts.
*2 Changes are also applied to inactive channels.

Output Operation through Setting Changes (Individually by Output Setting)

Output Setting

Setting Changes (Contents)

Output Operation

Transmission
output Within
units

Output value held

(until the next output event)

Range setting  AO: V & mA
changes PWM: 1 ms <10 ms or interval
Operation Transmission within units —

setting changes arbitrary output

Span setting changes

Arbitrary
output

Range setting

changes

AO:V < mA

Output value held

PWM: 1 ms <10 ms or interval

(until the next output event)

Operation

Arbitrary output —

setting changes transmission within a unit

When the range settings of a PWM output module are changed, the output value is not held.
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1.13 Operation of the 8-CH Medium-Speed Analog Output Module and the 8-CH Medium Speed PWM Output
Module

Steady Output Operation

Output Operation When Connected for Communication

Communication Connection Status Output Operation

Normal connection (initial connection after power ON) Operation when power is turned ON

Communications opened successfully Holds the output value (last output value)
(when communications were cut and restored for the 2nd or more time)
Communication disconnected successfully Holds the output value (last output value)

Output Operation during Measurement and When Performing Transmission
Output

“Transmission output execution ON” in the table is when the transmission output control
is ON. “Transmission output execution OFF” in the table is when the transmission output
control is OFF.

The status of transmission output execution below is for transmission output on
measurement channels. For transmission on MATH channels, substitute “measurement

start” with “computation start,

” o«

“measuring” with “computing.”

measurement stop” with “computation stop,” and

Output Setup

Status

Output Operation

Transmission
output within unit

Meas. stop —
Measurement starts

Transmission output start or output value hold (depending
on the transmission output execution on/off status

on: transmission output starts

off: output value held)

Measuring —
Measurement stops

Depending on the output operation upon stop setting
Last: Holds the output value (last output value)
Preset: Outputs the preset value”

Measuring

Transmission output
execution off — on

Transmission start

Transmission output
execution on — off

Holds output value (last output value)

Arbitrary output

Meas. stop —
Measurement start

No effect

Measuring —
Measurement stop

No effect

Measuring

Transmission output
execution off — on

No effect

Transmission output
execution on — off

No effect

* Firmware version R3.03 or later
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1.13 Operation of the 8-CH Medium-Speed Analog Output Module and the 8-CH Medium Speed PWM Output

Module

Output Operation during an Abnormality and after Recovery from the Abnormality
Output Operation during an Abnormality (by Module)

Abnormal Module

Display Status

Output Operation

Operation when power is turned ON

Operation when power is turned ON or
when output value uncertain

Internal communication error occurred,
resulting in an error recovery event. If
the error recovery time is 10 s or more,
output is performed per the operation for
error occurrence, and then output is
executed per the operation for power ON.

Operation when power is turned ON or
when output value uncertain

Main module b System errors
bF Dip switches
FO ROM error
F1 SRAM error
F2 EEPROM error
F3 Battery error
F4 Ethernet error
Output modules uo Range information error
U1 Calibration value error
u2 Error during calibration
U3 Error in writing the
calibration value.
U4 Unusable modules
Input modules uo Range information error
U1 Calibration value error
U4 Unusable modules

Operation when errors occur (transmission
between units output only, since the
transmission source input channel is
illegal™)

*1 The number corresponding to the error is shown in the [].
*2 lllegal occurs when a module is removed, when a module recognition fails, or when a module

malfunctions.
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1.13 Operation of the 8-CH Medium-Speed Analog Output Module and the 8-CH Medium Speed PWM Output
Module

Output Operation during an Abnormality (by Output Setting)
Output Setting Abnormal Status Output Operation

Transmission Referenced input channels are +Over Outputs a value +5% of the specified
output within units span of the output channel™

Referenced input channels are —Over Outputs a value —-5% of the specified
span of the output channel™

Referenced input channel is illegal Operation upon errors
(input module removed)

Referenced input channel is set to Skip

Referenced input channel is Invalid
(math error in Differential computation)

Internal communication error Output value held (occurs immediately
after an internal communication error,
but there is a recovery action™?)

CPU abnormality Operation upon errors

Arbitrary output Internal communication error Output value held (occurs upon an
internal communication error, but there
is a recovery action?)

CPU abnormality Operation upon errors

*1 PWM output may not always reach +5% (+Over)/—5%(—Over).
*2 See “Output Operation after Recovery from an Abnormality.”

Output Operation after Recovery from an Abnormality (by Output Setting)

Output Setting Abnormality Recovery Output Operation

Transmission Referenced input module recovers Operation upon errors — transmission
output within units (removed input modules are inserted) output

Referenced input channel changed
from Skip to Measurement range

Referenced input channel is restored
from Invalid (math error in Differential
computation) to normal

Recover after internal communication If the error recovery time is 10 s or

error more; operation upon error —
operation upon power ON—
Transmission output

If the error recovery time is within 10 s;
operation upon startup — transmission

output
CPU abnormality (does not recover)  Operation upon errors
Arbitrary output Recover after internal communication If the error recovery time is 10 s or
error more; operation upon error —
operation upon power ON— arbitrary
output®

If the error recovery time is within 10
s; operation upon startup — arbitrary
output*®

CPU abnormality (does not recover)  Operation upon errors

*

Executed by arbitrary output from the PC after recovering from the error.
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1.14 Functions of the 10-CH, Medium-Speed Digital

Output Module

This module has ten contact signal outputs that are based on alarm output settings and
output settings from the PC.

S
SEAR
S

Terminal cover

LOutput terminal (clamp terminal)

Output Types

The following types (output factors) are available.
Type Notation Description
Alarm Alarm Measurement and MATH channels

Manual Comm.Input  Manual DO operation(Relay turns ON/OFF depending on the value
sent from the PC)

Media Media When determined that no space remains within the specified “remaining
space time”

Fail Fail When an abnormality occurs on the CPU of the MW100 main module

Error Error When an error is detected on the MW100

(abnormal or missing module, etc.)
* Firmware version R3.03 or later

Output Update Interval

The output is updated at 100-ms intervals. It is not synchronized to the measurement
interval.

Relay Excitation State / Hold Operation

You can select whether or not to energize the output relays upon output. The excitation
status selection differs depending on the output type.

Excitation Notation Description Available Output Types
Status
Energize Energize Energize when relay output is ON Alarm/Comm.Input/Error/Media

De-energize De-energize Not energize when relay output is ON  Alarm/Comm.Input/Fail
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1.14 Functions of the 10-CH, Medium-Speed Digital Output Module

Relay Operation

Reflash Function

Also, when a condition in which alarm output must be cleared arises, you can select
whether to turn output relays OFF (Non-hold), or leave them ON until an output clear
command (alarm ACK) appears (Hold).

Hold operation Notation Description

Hold On Maintains relay output even after relay output is cancelled.

Non-Hold Off Does not maintain relay output when relay output is cancelled
(normal operation).

* When set to non-hold * When set to hold

Alarm ACK Alarm ACK
v v_v
Output cause Output cause : : :
occurrence  —! — occurrence L. ' L

ON ON
Relay output Relay output l
OFF— — OFF

.

—| =
100ms
The following types of relay operation are available.
Operation Description
And Output ON when all alarms assigned to each alarm output relay activate.
Or Output ON when one or more alarms assigned to each alarm output relay activate.

The relay operates after the first alarm. If a second alarm activates, the relay restarts

after briefly stopping operation.

» The non-operation period is 200 ms.

» Even if a new alarm occurs during the non-operation, the non-operation time is not
extended.

+ The number of output relays that can be specified for the reflash function is unlimited.

*  When selecting relay output other than alarm output relays, the reflash function
specification is disabled.

* You can specify the reflash function when OR is selected for the AND/OR function and
Non-Hold is selected for the Hold/Non-Hold function.

Alarm1 status
Alarm2 status
Alarm3 status ;

Reflash function

relay status J |—| |—| I—
- |— - |—
200ms 200ms
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1.14 Functions of the 10-CH, Medium-Speed Digital Output Module

Preset Output upon Error (Firmware version R3.03 or later)

The following types are available.

Output Notation Description

Off Off No forced transition to Open/Close upon error.
Open Open Relay output Open (De-energize) upon error.
Close Close Relay output Close (Energize) upon error.

» The following conditions are required when the DO preset setting is enabled.
» The DO output type must be “Alarm DO”
* The Hold setting must be “Off”
* The Action must be “OR”

» The Energize/De-energize setting is enabled as in the standard specifications.

» Even if the preset setting is enabled for Alarm DO, DO preset output does not occur if
no alarm DO assignment from measurement or MATH channels is assigned.

» The computation error definition is for when the computed value is +OVER.

 If multiple measurement or MATH channels are set for alarm DO output, the preset
output upon error is carried out if an error occurs on any one of the channels.

* Preset output upon error is cleared when errors are cleared on all measurement or
MATH channels set as alarm DO.

Preset Output upon Stop (Firmware version R3.03 or later)

The following types are available.

Output Notation Description

Off Off Holds previous value

Open Open Relay output Open (De-energize) upon error.
Close Close Relay output Close (Energize) upon error.

The stop detection/clear condition varies depending on the combination of channels set
for alarm DO.

Alarm DO setting Stop detected Stop cleared
Measurement channels only Measurement stop Measurement start
MATH channels only Computation stop Computation start
Measurement + MATH channels  Computation stop Computation start

If a stop is detected during preset output upon error, the preset output upon stop is
carried out.
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1.15 MATH Function (/M1 Option)

Overview of the MATH Function

Results are computed by expressions using constants, operators, and functions.
Computed data from computed results can be displayed or recorded (saved). MATH
allows you to determine the average/maximum/minimum of a specified channel on a
specified date/time, or output events (start/stop record, reset time, etc.) under specified
conditions.

Number of MATH Channels

MATH Types

Computation can be performed on sixty channels, and 240 channels can be used
for communication input. The maximum number of characters that can be used in an
expression is 120 for MATH channels and 10" for communication input channels. Four
arithmetic operations and calculation constants can be written to communication input
channels in addition to the communication input channel number.

*  Or “8” on models with firmware version R3.02 or earlier.

The following types of computations can be performed.
» Basic math
* Logical operations
+ Bit output™
» Relational operations
 Arithmetic functions
+ TLOG functions™
* CLOG functions
» Conditional expressions
*1 Firmware version R3.03 or later
*2 Even if the MATH function (/M1 option) is not included, if the 10-CH Pulse Input Module is
installed, only integration (TLOG.PSUM) is available.

Basic Math

Type Operator Example Explanation

Addition + 001+002 Finds the sum of measured values on channels 001 and 002

Subtraction - 002-001 Finds the difference in the measured values of channels 001
and 002.

Multiplication  * 003*K01 Multiplies the measured data on channel 003 by constant KO1

Division / 004/K02 Divides the measured data on channel 004 by constant K02

Exponentiation ** 005**006 Raises the measured data of channel 005 to the power of the

measured data of channel 006.
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1.15 MATH Function (/M1 Option)

Logical Operations

Explanation

When channel 001 = 0 and channel 002 =0, 0
When channel 001 # 0 and channel 002 =0, 0
When channel 001 = 0 and channel 002 # 0, 0

When channels 001 and 002 # 0, 1

When channel 001 = 0 and channel 002 =0, 0
When channel 001 # 0 and channel 002 =0, 1
When channel 001 = 0 and channel 002 # 0, 1

When channels 001 and 002 # 0, 1

When channel 001 = 0 and channel 002 =0, 0
When channel 001 # 0 and channel 002 =0, 1
When channel 001 = 0 and channel 002 # 0, 1

When channels 001 and 002 # 0, 0

Type Operator Example
Logical product ~ AND 001ANDO002
Logical sum OR 0010R002
Exclusive OR XOR 001XOR002
Logical negation NOT NOTO001

When channel 001 =0, 1
When channel 001 #0, 0

Bit Output (Firmware version R3.03 or later)

Type Operator

Example

Explanation

Bit output”  BIT

C001 is 0, the computed result is 0.

C001BITB02 When bit 2 (LSB = 0) of communication input channel
C001 is 1, the computed result is 1. When bit 2 of

* If data is O or negative, the output value is 0.

Relational Operations

Type Operators Example Explanation

Equal EQ. 001.EQ.002  When channel 001 = channel 002, 1
When channel 001 # channel 002, 0

Not equal .NE. 002.NE.001 When channel 001 # channel 002, 1
When channel 001 = channel 002, 0

Greater than .GT. 003.GT.K01 When channel 003 > constant KO1, 1
When channel 003 < constant KO1, 0

Less than LT. 004.LT.K10 When channel 004 < constant K10, 1
When channel 004 = constant K10, 0

Greater than .GE. 003.GE.KO1  When channel 003 = constant K01, 1

or equal to When channel 003 < constant K01, 0

Less than LE. 004.LE.K10  When channel 004 < constant K10, 1

or equal to When channel 004 > constant K10, 0

Arithmetic Functions

Type Operators Example Explanation

Absolute value ABS() ABS(001) Finds abs val of measured values on ch 001.

Square root SQR() SQR(002) Finds sqr rt of measured values on ch 002.

Common logarithm LOG() LOG(003) Finds common log of measured data on ch 003.

Exponent EXP() EXP(005) Finds e* where x is the measured data on ch 005.
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1.15 MATH Function (/M1 Option)

TLOG Functions™
The TLOG computation computes the maximum, minimum, maximum-minimum, integral,
average, and pulse integral of the specified channel. One function can be used per

expression.

Type Operators Example Explanation

Maximum value TLOG.MAX() TLOG.MAX(001) Finds max value of measured values on ch 001.
Minimum value TLOG.MIN() TLOG.MIN(002) Finds min value of measured values on ch 002.
Maximum value TLOG.P-P() TLOG.P-P(003) Finds P-P of the measured data on ch 003.

to minimum value

Integral value TLOG.SUM() TLOG.SUM(004) Finds integral val of measured values on ch 004.
Mean value TLOG.AVE() TLOG.AVE(005) Finds the avg value of measured values on ch

005.

Pulse Integration™ TLOG.PSUM() TLOG.PSUM(011) Finds the pulse integral of measured values on
ch 011. (integrated number of rising edges)

*1 The channels that can be specified in TLOG functions are the measurement and MATH channels
excluding TLOG.PSUM.

*2 The channels that can be specified for a TLOG.PSUM computation are measurement channels
of the 10-CH Pulse Input Module (/M1 option not required) or DI channels on modules that
accept digital input.

CLOG Functions*
The CLOG computation computes the maximum, minimum, maximum-minimum, integral,
and average values of the specified channel group. One function can be used per

expression.

Type Operators Example Explanation

Maximum value CLOG.MAX() CLOG.MAX(001-010) Finds max of measured data on ch 001
to 010.

Minimum value CLOG.MIN() CLOG.MIN(001.003) Finds min of measured data on ch 001
and 003.

Maximum value CLOG.P-P() CLOG.P-P(002-009) Finds P-P of the measured data on ch

to minimum value 002 to 009.

Mean. value CLOG.AVE() CLOG.AVE(011-020) Finds avg of measured data on ch 011 to
020.

* The channels that can be specified in CLOG functions are the measurement and MATH
channels. (The number of channels which can be specified is to ten channels.)

Conditional Expressions

Type Operators Explanation

Conditional expressions [EXPR1?EXPR2:EXPR3] Execute expression 2 when expression 1 is
true, or expression 3 when it is false

Other
Type Operator Explanation
Parentheses () Specifies the order of operations
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1.15 MATH Function (/M1 Option)

Order of Operations in Expressions

Expressions are hierarchical according to the table below. The operations are listed in
the table from top to bottom in order of precedence. These precedences must be taken
into account when writing expressions.

Type Operators
(High precedence)
Arithmetic, TLOG, CLOG functions, ABS(), SQR(), LOG(), EXP(), TLOG.MAX(), TLOG.MIN(),

and Bit output TLOG.P-P(), TLOG.SUM(), TLOG.AVE(), TLOG.PSUM(),
CLOG.MAX(), CLOG.MIN(), CLOG.P-P(), CLOG.AVE(), BIT

Conditional expressions [EXPR1?EXPR2:EXPR3]

Exponentiation **

Logical negation NOT

Multiplication and division *

Addition and subtraction +, —

Relational operation .GT,, .LT,, .GE., .LE.

Equivalence .EQ., .NE.

Logical product AND

Logical sum, exclusive OR OR, XOR

(Low precedence)

Reference channel

The following channels can be referenced for data used in computations.

Type Channel number Description
Measurement Channel 001 to 060 Data from measurement channels
Computation channels A001 to A300 Data from MATH channels

(Channels A061 to A300 are used for
communication input only.)

Communication input channels C001 to C300 Numerical values in expressions substituted
with communication input

Flag input channels FO1 to F60 Set in expressions as the constant 1 or 0

Calculation constant K01 to K60 Represented as a fixed constant in expressions

Program channels P01 to P03 Inputs broken line data into expressions

Flag Input Channels
Can be set in expressions as the constant 1 or 0. Normally 0, but turns to 1 upon
occurrence of certain events of the Event/Action function.
For example, given the expression:
NOTFO01 * TLOG.SUM(001)
if the Event action’s Edge action is set to FLAG:F01, when the event
occurs, FO1 becomes 1 and NOTF01 becomes 0, therefore the total of channel 001 is 0.
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1.15 MATH Function (/M1 Option)

Program Channels

Up to thirty-two inputs of broken line data can be included in expressions.

Multiple points can be set for the time from the start point and the output value at that
point. Specified points are linked with a straight line, the value of Y at the elapsed time X
is output. There is Single, in which one cycle is executed, and Repeat in which execution
repeats. By specifying a MATH channel to which broken line input is assigned to the
reference channel of an analog output channel, you can output arbitrary patterns.

* Example

Y : Output

(30.800) (40.800)

(10.500)
(20.500)

(0.0) (50.0)
X : Elapsed time (s)

» Entry Example
Input of broken line data in the example is as follows.
(0.0), (10.500), (20.500), (30.800), (40.800), (50.0), (-1.0)
If there are fewer than thirty-two setting points, a (-1.0) is required to show the end of
the points.
» Operation of program channels for the computation operation
Computation Operation Program channel operation

Computation start Starts broken line computation from the held elapsed time

Computation stop Holds the broken line computed value

Computation clear Resets the elapsed time to 0 and start the broken line computation
from the beginning

Computation reset During self-computation, 0-clear the elapsed time and start the

broken line computation

» Operation after Elapsed Time

Mode Notation Program channel operation
Single Single Holds the broken line computed value of the last point
Repeat Repeat Returns to the start point then repeats broken line

Computation Operation

Starting and Stopping Computation
Execution of computation starts and stops according to user commands (Start/Stop key,
Event/Action function, or monitor screen settings).

Clearing Computations
Clears all MATH channel data (including MATH alarms) per the Event/Action function,
communication commands, or requests from the monitor setting screen.

Resetting Computation

Clears all MATH channel data (including MATH alarms) per the Event/Action function,
communication commands, or requests from the monitor setting screen. If this request
occurs during a computation, it is executed on the next computation interval and
computation starts. Also, if the request occurs while the computation operation is
stopped, it is cleared when computation starts.
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1.15 MATH Function (/M1 Option)

Math Interval

Group Reset

Clears all MATH channel data (including MATH alarms) per the Event/Action function or
requests from communication commands. If this request occurs during a computation, it
is executed on the next computation interval and computation starts. Also, if the request
occurs while computation is stopped, it is cleared when computation starts.

Math Groups
Specifies multiple channels from among Math channels 1 through 60. Up to seven
groups can be set. Math groups are used with group reset.

Select one from among the measurement group numbers, and specify a MATH interval.
For the MATH interval, select a group having a measurement interval of 100 ms or
higher. Computation is performed every MATH interval using the values of the reference
channels.

Rolling Average

Determines the rolling average of the computed results on the measurement channel and
uses it as the computed result of that channel. The number of samples and the sampling
interval can be specified for each computation channel.
The setting ranges are as follows:

Sampling interval: 1 s to 1 hour (23 levels)

Number of samples: 1 to 1500
+ Example

If the MATH interval is 2 s, the sampling interval is 10 s, and the number of samples is

3, the computed data on which rolling average is calculated is as follows:

Moving average source
MATH interval
Sampling interval
Time (s)
Set the sampling interval to an integer multiple of the MATH interval. If the sampling
interval is shorter than the MATH interval, the sampling interval is matched to the MATH
interval.
P> For details on setting the sampling interval, see “MATH Function Specifications (/M1
Option)” in section 5.2.
Math Span
The upper and lower limits for the display of the monitor screen and other items. The
MATH span setting range is as shown below depending on the decimal place. If the
computed results fall outside of the MATH span setting range, they are displayed on
screen as plus over or minus over data.
Decimal Place MATH span setting range
0 —-9999999 to 99999999
1 —999999.9 to 9999999.9
2 —99999.99 to 999999.99
3 —9999.999 to 99999.999
4 —999.9999 to 9999.9999
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1.15 MATH Function (/M1 Option)

Handling Units in Computations
In computations, computed values (measured and computed data) are handled as
numbers without units. Also, they are unrelated to the math channel units.
Example:
Expression = 001 + 002 + K01
001 (measurement ch 1) = 20 mV, 002 (measurement ch 2) = 30 V, K01 (math constant)
=10
Given the above, the computed result is 60.

Alarm Level
You can implement alarm actions based on the computed data. Four levels can be set
per channel. The alarm types are upper limit, lower limit, delay upper limit, and delay
lower limit. There is no hysteresis function. There is no hysteresis function.

Pulse Integration (TLOG.PSUM)

The input number of pulses is integrated for the measurement channels of the 10-CH
Pulse Input Module, or the DI channels of modules that accept digital input.
* Pulse Integration with the 10-CH Pulse Input Module
The number of pulses per measurement interval is integrated on the module. The
integration continues with the TLOG.PSUM computation on the main module.
0 to 10000 pulses/s
* Pulse Integration with DI Channels
The ON/OFF statuses are measured on the module, and the number of changes from
OFF to ON are retained.
The integration continues with the TLOG.PSUM computation on the main module.
Integration is performed at an interval of 100 ms or more, but pulse integration is
performed at the measurement interval of modules that accept digital input (DI).
* 0 to 40 pulses/s (measurement interval: 10 ms, duty: 50%)
* 0 to 4 pulses/s (measurement interval: 100 ms, duty: 50%)
* 01to 0.8 pulses/s (measurement interval: 500 ms, duty: 50%)
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1.15 MATH Function (/M1 Option)

Processing Computed Results with Abnormal Input Values or Overflow Values
You can select the computed result when an error occurs on the reference channel
(measurement or MATH channel) of a MATH channel.
P> For processing of computed results, see “MATH Operation Settings” in section 3.4.

MATH Operation
You can select the computed data when the computed result is an error.

Choice for the Computed Result Notation
Plus over +Over
Minus over —Qver

Computation Operation of TLOG.PSUM
You can select the computed data when the computed result of the TLOG.PSUM
computation exceeds the MATH span setting range.

Notation Minimum value” Maximum value™ Description

Over —-9999999 99999999 When the result is less than the minimum
value, computation stops as an overflow
Computed result: -OVER
When the maximum value is exceeded,
computation stops as an overflow
Computed result: +OVER

Rotate 0 99999999 When the minimum value is not reached,
computation continues with the next count
being the maximum value.
When the maximum value is exceeded,
computation continues with the next count
being the minimum value.

*1 The minimum and maximum values vary depending on the decimal place.

P> For the MATH span setting range, see “MATH Span” in this section

Special Processing of the Computed Result
If a reference channel is a measurement channel or MATH channel, the processing of
the computed data differs depending on the selection.
* Reference channel status
The following demonstrates cases in which an abnormal input value or overflow value
occurs on the reference channel.
Reference Channel Status Description
Measurement channel Abnormal input value The module of the target channel is
disconnected, or some other abnormality
The target channel becomes Skip
Overflow value Input value exceeds the measurement range
Computation channel ~ Abnormal input value  When the computed result on a MATH
channel in an expression is an error
Overflow value When the computed result on a MATH

channel in a TLOG or CLOG expression
exceeds the MATH span setting range
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1.15 MATH Function (/M1 Option)

Special computation processing (excluding TLOG and CLOG computation) for

measurement channels

Reference Channel Status

Notation Process Description

Abnormal input value

Error Computed result is an error

Skip

Continue computation using previous value of

channel on which abnormal value was input

Overflow value

Over Compute using overflow value

Skip Continue computation using previous value of
channel on which overflow value resulted

Limit™ The overflow value is replaced with the upper or

lower limit, and computation continues

*1 The lower/upper limit value replaced on the measurement channel differs depending on the

computation type.

Measurement channel: Measurement range upper and lower limit
Scaled measurement channel: Upper and lower limit of scaling

Special processing for reference channels of TLOG and CLOG computations

TLOG Computation

Reference

Channel Status Notation

MAX MIN

P-P

AVE Sum PSUM

Abnormal input Error

Computed result is an error™

value Skip Current TLOG computation is skipped
Overflow value Error Computed with the |Computed|Computed result is an error™
Skip overflow value as-is |resultis a |Current TLOG computation is
+OVER™ |skipped
Limit The overflow value is replaced
with the upper or lower limit,
and computation continues™
CLOG Computation
Firmware version R3.04
Refaerence .
Channel Status Notation MAX MIN P-P AVE

Abnormal input | Error

Computed result is an error

value Skip

abnormality occurred

Computation is carried out without the channel on which the

Overflow value Error

Computation
occurs with the
overflow value as-

Computed
is +Over™?

IS

Computed result is
an error

result

Skip

overflow occurred

Computation is carried out without the channel on which the

Limit

The overflow value is replaced with the upper or lower limit,
and computation continues™

Firmware version R3.03 or earlier

Reference

Channel Status Notation

MAX | MIN | P-P

AVE

Abnormal input  |Error

Computed result is an

error

value Skip

Computation is carried out without the channel on which the

abnormality occurred

Overflow value Error

Computed result is an

error

Skip

Limit

Computed with the
overflow value as-is

Computation is carried out without the

channel on

which the overflow occurred

The overflo

upper or lower limit, and computation

continues™

w value is replaced with the

*2 If the data is plus over only or minus over only, the computed result is an error
*3 Once an error occurs, computed results continue to be errors until computation is cleared
*4 The lower/upper limit value replaced on the reference channel differs depending on the input

type.
Measurement channel

Computation channel:

Measurement range upper and lower limit
Scaled measurement channel: Upper and lower limit of scaling
Span upper limit and lower limit
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1.15 MATH Function (/M1 Option)

TLOG Time Scale
You can select the sum scale for the TLOG.SUM computation.

Integration Units Notation Explanation

No time scale off 3 (data)™

Every second /sec > (data)/(Number of times of computing per second.)
Every minute /min 2 (data)/(Number of times of computing per minute.)
Every hour /hour > (data)/(Number of times of computing per hour.)
Every day™ /day 3 (data)/(Number of times of computing per day.)

*1 Integration of data every MATH interval
*2 Firmware version R3.03 or later
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1.16 Report Function (/M3 Option)

The maximum, minimum, average, integral, and instantaneous values of the specified
measurement or MATH channels (up to 60 ch) can be written to the following report files.

Created File Report Type Description

Daily Hourly + Daily Report data including 24 hours of hourly data from a specified
time + 1 day of report data

Weekly Daily + Weekly Report data including 7 days of daily data from a specified
time* on a specified day + 1 week of report data

Monthly Daily + Monthly ~ Report data including 1 month of daily data from a specified

time* on a specified day + 1 month of report data

* The specified time for weekly and monthly reports is the same as the creation time for the daily
report files.

Starting and Stopplng the Report Function
When recording is started, acquisition of report data starts.
» The timing of report file creation, report data writing, and report data writing stop is
shown in the figure below.
 If recording is stopped, report data from the last writing of report data to the time
recording was stopped is written, and acquisition of report data stops.

* Daily report file ® = Write hourly data

O = Write hourly and daily data

Specified time for creation Specified time for creation
Record start of daily reports of daily reports Record stop

f—e—eo—e—e—o)
t 24 hours ‘ 1

[ E—
11 hour

Report file created Report file created Report file created

Report file Report file Report file
writing stops writing stops writing stops

* Weekly report file ® = Write daily report data

O = Write daily and weekly report data

Specified day for creation Specified day for creation
Record start of weekly reports of weekly reports Record stop

[ S—
11 day f 1 week T
Report file created Report file created Report file created
Report file Report file Report file
writing stops writing stops writing stops

* Monthly report file @ = Write daily report data

O = Write daily and monthly report data

Specified date for creation Specified date for creation
Record start of monthly reports of monthly reports Record stop
[ S—
11 day f 1 month
Report file created Report file created Report file created
Report file Report file Report file
writing stops writing stops writing stops

Resetting the Average, Maximum, Minimum, and Integral Values

The values are reset when report file writing stops. When recording starts, you can select
to reset or not reset the values held in report data.

1-72 IM MW100-01E



1.16 Report Function (/M3 Option)

Report Measurement Interval
The shortest acquisition interval for report data is 100 ms. Even if a channel is specified
with a measurement interval shorter than 100 ms, acquisition occurs at 100 ms intervals.

Sum Scale of the Integral Value

You can select the unit time (formula) for the integral value. Unit time and units can be
specified for each channel.

Sum Scale Notation Description

No time scale  Off The integral value of the data from each measurement or MATH
interval

Every second  /sec The integral value of data from each measurement or MATH interval
+ computations per second

Every minute /min The integral value of data from each measurement or MATH interval
+ computations per minute

Every hour /hour The integral value of data from each measurement or MATH interval
+ computations per hour

Daily /day The integral value of data from each measurement or MATH interval

+ computations per day

Operation during Power Failure
When a power failure occurs, data used to create report data will be lacking. The
following operation occurs upon recovery from a power failure.

Power failure-A Power failure-B

U U

— 00— 0—0—0— 00— 00— 00— 00— 00— 00—

©® = Write report data

* When a power failure occurred during the report writing time (power failure-A)
The report data is written after the power failure recovers. A mark (Pw) indicating the
occurrence of the power failure is added to the report data.

* When a power failure occurred other than during the report writing time (power
failure-B)
The acquisition of the report data is restarted after the power failure recovers, and
report data is written at the specified time. A mark (Pw) indicating the occurrence of
the power failure is added to the report data.

Displaying Report Files
Values and graphs can be displayed in the browser’s data view. Also, you can display
values with the MW100 Viewer Software.
P> For information on the browser’s data view screen, see the data view under “Explanation of
Display Items” in section 3.16.
P> For information on the MW100 Viewer Software, see the MW100 Viewer Software User’s
Manual (IM MW180-01E)
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1.16 Report Function (/M3 Option)

Processing Reports with Abnormal Input Values or Overflow Values
You can select how reports are processed when an error occurs on the channel
(measurement or MATH channel) for which a report is created.

Special Processing of Report Results

P> For report processing during abnormalities, see “Report Operation Settings 1” in section 3.12.

Status of channel for which the report is created
The following demonstrates cases in which an abnormal input value or overflow value
occurs on the channel for which the report is created.

Channel Type Status

Description

Measurement channel

value

Abnormal input

The module of the target channel is
disconnected, or some other abnormality

Overflow value

Input value exceeds the measurement range

Computation channel

Overflow value

When the computed result on a MATH channel
exceeds the MATH span setting range™

Processing during abnormal input™

Report Data Type Notation Process Description
Maximum/minimum/ Error The report data is an error
integral/average value Skip Uses the previous value of the channel on

which the abnormal input value occurred

Processing during an overflow"™

Report Data Type Notation Process Description
Integral/average value Error The report data is an error
Skip Uses the previous value on the channel on
which the overflow value occurred
Limit™ The overflow value is replaced with the upper

or lower limit

*1
*2

*3

*4

For the MATH span setting range, see “MATH Span” in section 1.15.
The instantaneous value during abnormal input is 99999999 (decimal place depends on the

setting)

The maximum, minimum, and instantaneous values during an overflow are handled as

follows.

* +Over: Measurement channel
MATH channel

* —Over: Measurement channel
MATH channel

99999 (decimal place depends on the setting)
99999999 (decimal place depends on the setting)
—99999 (decimal place depends on the setting)
—9999999 (decimal place depends on the setting)

The lower/upper limit value replaced differs depending on the channel’s setting condition.
Measurement channel: Measurement range upper and lower limit
Scaled measurement channel: Upper and lower limit of scaling
Computation channel: Span upper limit and lower limit

1-74

IM MW100-01E



Chapter 2

Installation and Wiring

2.1

Handling Precautions

This section describes the precautions to be taken when using the MW100. Please read
before using this product.

» If you are using this instrument for the first time, make sure to thoroughly read the
safety precautions given on pages iii and iv.

» Do not remove the case.

For internal inspection or adjustment, contact your nearest YOKOGAWA dealer.

» Do not place objects on top of the instrument.

Never place other instruments or objects containing water on top of the instrument.
Doing so can lead to malfunction.

» Take proper care when carrying the instrument.

First, turn off the DUT and the MW100 and remove all cables including measurement
wires and communication cables. Then, remove the power cord from the outlet.

» To prevent internal overheating, do not obstruct the vent holes of the modules.

+ This instrument uses many plastic parts. When cleaning, wipe using a dry soft cloth.
Do not use volatile chemicals since this might cause discoloring and deformation.
Doing so can cause discoloring or deformation.

» Do not bring charged objects near the signal terminals. Doing so can lead to
malfunction.

» Do not pour volatile agents on the MW100 or leave it in contact with rubber or PVC
products for an extended time. Doing so can lead to malfunction.

» Do not apply shock to the instrument.

* When not in use, make sure to turn OFF the power.

 If there are any symptoms of trouble such as smoke, strange orders, or strange
sounds coming from the instrument, immediately turn OFF the power and shut off the
power supply. Contact your dealer immediately.

» Handle the power cord correctly.

Nothing should be placed on top of the power cord. The power cord should also be
kept away from any heat sources. When unplugging the power cord from the outlet,
never pull by the cord itself. Always hold and pull by the plug. If the cord is damaged,
contact your dealer for replacement. When ordering, see the MW100 Data Acquisition
Unit Operation Guide (IM MW100-02E) for the power cord part number.

IM MW100-01E
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2.2 Installation

Installation Location
Install the instrument indoors in the following locations.

In temperatures of —20 to 60°C

If the ambient temperature is —20 to 40°C, place the instrument in a location where the
humidity is 20 to 80% RH. For 40 to 50°C, the humidity should be 10 to 50%. For 50 to
60°C, the humidity should be 5 to 30%. However, no condensation should be present.
Also note that the temperature range of certain modules is —20 to 50°C.

Nofte
Condensation may occur if the instrument is moved to another place where the ambient
temperature is higher, or if the temperature changes rapidly. Measurement errors can occur
when using thermocouple input. In this case, let the instrument adjust to the new environment
for at least one hour before using the instrument.

Locations where the operating altitude is 2000 m or less

Well-ventilated locations
Install the instrument in a well-ventilated location to prevent the temperature inside the
instrument from rising.

Location where mechanical vibration is small
Select a location with small mechanical vibration for installation.

Horizontal location
Install the instrument on a flat, even surface.

Do not install the instrument in the following places.

Dangerous locations where flammable liquids, vapors, or dust is present

In direct sunlight or near heat appliances

Select a location with the smallest fluctuation from room temperature (23°C) as
possible. Placing the instrument in direct sunlight or near heat appliances can cause
adverse effects.

Where an excessive amount of soot, steam, humidity, dust, or corrosive

gas is present

Soot, steam, humidity, dust, and corrosive gas can cause adverse effects on the
instrument. Avoid installing the instrument in an environment with a high level of such
substances.

Near magnetic field sources

Install the instrument in a location where the magnetic field is 400 A/m or less. Avoid
bringing instruments that produce magnetic fields or magnets near this instrument.
Using the instrument near a strong magnetic field source can cause measurement
errors.

Installation Procedures

CAUTION

When attaching the instrument to DIN rails, use metal plates at least 2 mm thick
in three places to secure the unit and prevent it from falling.

The MW100 Data Acquisition Unit can be used on the desktop, placed on a floor, rack
mounted, or panel mounted. In all cases, be sure to install the instrument in a vertical
position.
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2.2 Installation

Placing on a Desktop or on the Floor

Since each module has feet you can attach the necessary modules to the base plate
allowing the unit to be placed vertically. For the procedure for attaching the modules, see
the next page.

Functional ground
terminal screw

Attaching to DIN Rails
By attaching DIN rail mounting brackets to the base plate as in the figure below, you can
rack-mount or panel-mount the MW100 Data Acquisition Unit.

» Attachment of the DIN rail mount bracket to ¢ Attachment of the base plate to the DIN rail
the base plate

Latch lever
(press to release
from the DIN rail)

screws (M3) DIN rail mount

bracket

DIN rail mount

bracket
DIN rail mount

bracket

* To prevent slacks in the DIN rail,
fix at least three locations of the DIN rail.
* Dimensions when mounted on a DIN rail

Unit: mm DIN rail
455 (1 main module, for connecting six input/output modules) 158.6

105

131

l ‘
JUL@JULJUMULJUL&JULJUU&JULJUL@JULJUL&JUMUUMUUUUL
151.1

455 397 339 281 223 165 163

58 pitches in between

=
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2.3 Attaching the Modules

A [ WARNING

To prevent electric shock and instrument breakdown, do not connect the power
supply to the main module when attaching modules.

Preparing the Base Plate
The accessory brackets are attached in order to attach the MW100 main module to the
base plate.

Remove the base block bracket Attach the bracket that came with the MW100

Attachment Procedure

1. Check that the power supply is not connected to the main module.

2. Align the connector on the rear panel of the module to the connector at the desired
position of the base plate and insert the connector. Attach the main module to the
right-most position on the base plate.

When the connectors are correctly connected, the guide pin on the rear panel of the
module is inserted into the guide hole on the base plate. In addition, the module is
secured to the base plate with the latch lever locking in place at the bottom section of
the base plate.

3. Fasten screw(s) (M3) at the top of the input/output modules.

To remove the module, loosen the attachment screw, pull down on the
latch lever on the rear panel of the module, and pull the module straight
from the base plate.

cover* Base plate
(accessory sold
separately) Module connector

Guide holes
* Can be attached

by hooking the
top section of
the cover to the
top edge of the
base plate and
pressing down
on the lower
section of the
cover.

Main module
Module attachment
screw

Latch lever
(pull up to remove the module
from the base plate) Base plate

Input/Output module
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2.3 Attaching the Modules

Attachment Positions and Channel Numbers

Channel numbers are recognized as follows:
» Browser monitor and commands
Channel numbers within units. Example: CH001
+ MW100 Viewer software
Unit number + Channel number within units. Example: CH01001

Representation of channel numbers: (][] [][][]
~ [ Channel numbers in a unit (001-060)
Unit number (00-89)

5 4 3 2 1 0 <=——Slot number

1| O || Ll O (1o |l O
T | = TN | | ey |
041-050 021-030 001-010

. Lk
051-060 031-040 011-020 <+—— Channel number in the unit

* The last one digit on a 4-channel
module is 1 to 4.
The last one digit on a 6-channel
module is 1 to 6.
The last one digit on a 8-channel
module is 1 to 8.

P> For setting the unit number, see “Other Settings” in section 3.3.

CAUTION

The 30-CH Medium Speed DCV/TC/DI Input Module takes up three modules
worth of space when attaching to the base plate. If attached incorrectly, damage
or malfunction can result.

IM MW100-01E
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2.4 Connecting Signal Wires

Terminal Arrangement Markings on the Terminal Cover
Characters indicating the terminal function and a terminal symbol indicating the type of
signal to be input/output to each terminal are written on the back of the terminal cover
of each I/O module. For information on wiring of corresponding terminal signals, see the
wiring procedures in this section. The 4-CH Medium-Speed Strain Module (-NDI) does
not have a terminal cover.

4-CH, High-Speed 10-CH, Medium-Speed 30-CH, Medium Speed
Universal Input Module Universal Input Module DCV/TC/DI Input Module

Terminal ——e o—— Label for
cover s LT B, || clam
Ga0va WAX T  CATH GV WAX TO+  CATII y terminals
Channel number — R ;cns ;cm
within module
2. CHT E: CH2
. 5 5
Terminal —— EE_ Eﬁ_
symbol | | H] TR
B2 CH3 B2 CHl B8 cH B8 CH
[ I P [ TR T
10 [+-R0

B B
W2 12

B B
B2 OH4 B2 o2
3 13

m @En
B4 CHIO 114 CHS
[ ]

30-CH, Medium Speed  6-CH, Medium-Speed  4-CH, Medium-Speed
DCV/TC/DI Input Module 4-wire RTD Resistance Strain Input Module
(/H3) Input Module (-B12, -B35)

Label for —e
Screw BB o ATELER Lo
terminals - T oy B = ]
B2 EH2 B2 B2 - 2 oh
o @ & oM B3 ol
=ACH7 =‘CNZ <13 <K e 5
[ - O] 6
.:CHB 2 o meom ;”“2
A8 CHS EAs CH2
I [+ AV
o o [ZL . o
8 Mo Ho = CH3
B9 gy B9 g By o o
n
Bo B 13 CHG 413 CH3 :i
o En |L] ||0] s O
M5 W 15
10-CH, High-Speed 10-CH, High-Speed
10-CH, Pulse Digital Input Module Digital Input Module
Input Module (-D05) (-D24)
10Vpk MAX + TO— 10Vpk MAX 4 TO — 50Vpk MAX + TO =
250V== MAX TO%  CATIl 250V= MAX TO % CATII 250VaMAXTO 4 CATI
[+ [+

8-CH, Medium-Speed  8-CH, Medium-Speed 10-CH, Medium-Speed
Analog Output Module PWM Output Module Digital Output Module

2o MAX TOE CATH 25002 MAX TO%_ CATH

15 15 I I s s
N A Comeon v W W5

o rly one et of Vext erminals,
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2.4 Connecting Signal Wires

Attaching and Removing the Terminal Block

The 1/O terminals of the modules in the figure below can be removed. The terminals
of the 30-CH, Medium-Speed DCV/TC/DI Input Module (MX110-VTD-L30) cannot be
removed.

The terminal cover can be removed by pressing backward with the cover lifted up.

4-CH, High-Speed Universal 4-CH, Medium-Speed Strain
Input Module

Input Module (-B12, -B35)
N

Pull-out

The terminal block can
be attached and
detached.

The terminal plate can be
attached and detached.
Attachment screw

(Loosen before removing the terminal plate.)

10-CH, Medium-Speed Universal Input Module/ 8-CH, Medium-Speed Analog
6-CH, Medium-Speed 4-wire RTD Resistance Output Module/

Input Module/ 8-CH, PWM Output Module/
10-CH, Pulse Input Module/ 10-CH, Medium-Speed Digital
10-CH, High-Speed Digital Input Module Output Module

(-D05, -D24)

Pull-out
handle ¢

The terminal plate can be The terminal block can be
attached and detached. attached and detached.
Attachment screw Attachment screw

(Loosen before removing the terminal plate.) (Loosen before removing the terminal block)

IM MW100-01E 2-7
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2.4 Connecting Signal Wires

Attaching the Plate with Screw Terminal and Plate with Clamp Terminals for Current

A screw terminal plate (model 772080, sold separately) can be attached to the 10-CH
Medium Speed Universal Input Module, the 10-CH Pulse Input Module, and the 10-CH,
High Speed Digital Input Module. In addition, the dedicated plate with clamp terminals for
current (model 772081/772082/772083, sold separately) can be attached to the 10-CH
Medium Speed Universal Input Module.

The plate with screw terminal is attached and removed in the same manner as the screw
terminal block. Note that the terminal arrangement is different than that of the clamp
terminal plate. The proper arrangement is shown on the back of the terminal covers, so
be sure to replace the cover along with the terminal plate.

P> For the handling of the plate with screw terminal, see “Handling the MX100/MW100 10-CH
Plate with Screw Terminal” in IM MX100-77E.

P> For the handling of the plate with clamp terminals for current, see the MX7100/MW100
Setting Up the Plate with Clamp Terminals for Current (772081/772082/772083) (IM MX100-
78E.)

Plate with screw terminal Plate with clamp terminals for current

Attachment
screw

Attachment
screw

NNessssooooooooooll ¢

Screw Terminal Block

Connection cable
between the input module
and screw terminal block
(772062-0XXX*)

* Length: 050 or 100 cm.

The 10-CH Medium-Speed Universal Input Module, 10-CH Pulse Input Module, and
10-CH High-Speed Digital Input Module allow you to remove the terminal plate and
connect a 10-channel screw terminal block (accessory sold separately, M4 screws) that
can be attached to a DIN rail (see the figure below).

10-CH screw terminal block (772061)

-

> 2
G [ ~Attachment screw
for connector cover
e e —— Connector cover
K 3
U ®

b
Terminal cover -/B

Loosen the attachment screw for the connector

cover and open the connector cover.

10-CH, Medium-Speed Universal Input Module/
10-CH, Pulse Input Module/

10-CH, High-Speed Digital Input Module

10-CH screw terminal
block (772061)

AN

QN
&
Q
O

Latch lever

Attachment screw (Pull down to detach.)

2-8
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2.4 Connecting Signal Wires

General Precautions When Wiring the Input/Output Signal Wires

A

To prevent the possibility of electric shock when wiring, confirm that the power
supply source and signal source are turned OFF. After making the connections,
secure the terminal cover and do not touch the terminals with your hands.

For signal wires on which voltage exceeding 30 VAC / 60 VDC is applied relative
to the ground potential or between signals, use reinforced (double) insulation
wires. For all other signal wires, use basic insulation wires. For the withstand
voltage of insulation wires, see the table below.

Applied Voltage (Vrms or VDC) Basic Insulation Double (reinforced) insulation

30 (60 VDC) to 100 620 Vrms 1000 Vrms
101 to 150 840 Vrms 1400 Vrms
151 to 300 1390 Vrms 2300 Vrms
301 to 600 2210 Vrms 3700 Vrms

To avoid electric shock when removing the terminal plate or block and wiring the
terminals, attach the terminal block or plate to the input output module before
inputting or outputting signals. Electric shock or fire can result if signals are
applied to the terminals if the terminal block is removed from the input/output
modules.

When wiring to screw terminals, use round, insulation coated crimp-on lugs on
the terminals (4 mm screws on the screw terminal block, and 3 mm screws on
the screw terminals and screw terminal plate) that do not come out when loose.
To prevent fire, use signal wires of the following temperature ratings.

Module Type Temp. Rating
Screw terminal block 75°C
Universal input module, DCV/TC/DI input module, 4-wire RTD 80°C

resistance input module, Strain input module, Pulse input module,
Digital input module, Digital output module

Analog output module, PWM output module 85°C

IM MW100-01E
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2.4 Connecting Signal Wires

A

CAUTION

If a large pulling force is applied to the input/output signal wires connected to the
MW100, the terminal or signal wire may break. To prevent this from happening,
secure all the wiring cables to the installation panel.
Do not apply a voltage exceeding the value indicated below to the input
terminals of the universal input modules. Doing so can damage the modules.
* Maximum input voltage

Voltage range of 1 VDC or less, TC, RTD, and DI (contact): £ 10 VDC

Voltage range of 2 VDC or more, and DI (LEVEL): + 120 VDC
* Maximum common mode voltage

Between channels: 250 VACrms (50/60 Hz) (-H04)

120 VACrms (50/60 Hz) (-M10)

Input to ground: 600 VACrms (50/60 Hz)
Do not apply a voltage exceeding the values indicated below to the input
terminals of the DCV/TC/DI input module. Doing so can damage the module.
* Maximum input voltage

Voltage range of 1 VDC or less, TC, and DI (contact): + 10 VDC

Voltage range of 2 VDC or more, and DI (LEVEL): + 120 VDC
* Maximum common mode voltage

Between channels: 120 VACrms (50/60 Hz)

Input to ground: 600 VACrms (50/60 Hz)
Do not apply a voltage exceeding the value indicated below to the input
terminals of the 4-Wire RTD resistance input module. Doing so can damage the
module.
* Maximum input voltage

Voltage range of 1 VDC or less, RTD, resistance, and DI (contact): £ 10 VDC

Voltage range of 2 VDC or more, and DI (LEVEL): + 120 VDC
* Maximum common mode voltage

Between channels: 120 VACrms (50/60 Hz)

Input to ground: 600 VACrms (50/60 Hz)
Wiring of the Strain Input Module (-NDI)
When connecting a bridge head, in order that the empty weight of the cable
does not exceed 5 kg, ensure that the cable does not hang down more than 1.5
m (the distance to the floor). If the cable hangs longer than 1.5 m, secure the
cable to the installation panel or some other location.
Do not apply a voltage exceeding the value indicated below to the input
terminals of the strain input modules. Doing so can damage the modules.
* Maximum input voltage: + 10 VDC
* Maximum common mode voltage

Between channels: 30 VACrms (50/60 Hz)

Input to ground: 250 VACrms (-B12, -B35), 30 VACrms (-NDI) (50/60 Hz)
Do not apply a voltage exceeding the value indicated below to the input
terminals of the pulse input module. Doing so can damage the module.
* Maximum input voltage: + 10 VDC
* Maximum common mode voltage

Input to ground: 250 VACrms (50/60 Hz)
When using the pulse input module with contact input, the measured signal
becomes easily affected by wiring impedance at high speed. The cable should
be approximately 25 m or less when the pulse width is 0.05 ms, or 500 m or less
at 0.5 ms. The wiring impedance varies depending on the such things as the
cable length, type, and wiring conditions.

210
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2.4 Connecting Signal Wires

» Do not apply a voltage exceeding the value indicated below to the input
terminals of the 10-CH, High-Speed Digital Input Module and the output
terminals of the 10-CH, Medium-Speed Digital Output Module. Doing so can
damage the modules.

* Maximum input voltage
10-CH, High-Speed Digital Input Module: + 10 VDC (-D05), + 50 VDC (-D24)
10-CH, Medium-Speed Digital Output Module: £ 250 VAC or 250 VDC

* Maximum common mode voltage
Input/output terminal to ground: 250 VACrms (50/60 Hz)

+ Do not apply a voltage exceeding the value indicated below to the input
terminals of the analog output modules or the PWM output modules. Doing so
can damage the modules.

* Maximum common mode voltage
Output terminal to ground: 250 VACrms (50/60 Hz)

» This is a measurement category Il (IEC61010-1) and overvoltage category Il

(CSA1N.61010-1) instrument.

Consider the points indicated below to prevent noise from entering the
measurement circuit. For information about measures against noise, see

section 2.9, “Measures against Noise on the MW100 Data Acquisition Unit.”
» Keep the measurement circuit away from the power supply cable (power supply

circuit) and ground circuit.

+ ltis desirable that the object under measurement is not a noise source. However, if
this is not avoidable, insulate the object under measurement and the measurement
circuit. In addition, ground the object under measurement.

» Shielded wires are effective against noise caused by electrostatic induction. As
necessary, connect the shield to the ground terminal of the MW100 (make sure this
does not lead to grounding at two points).

» Twisting the measurement circuit wires at short intervals is relatively effective against
noise caused by electromagnetic induction.

» The protective earth ground must be connected to low ground resistance (100 Q or less).

When using the reference junction compensation of the MW100 through
thermocouple input, take measures to stabilize the temperature at the

terminal section.
» Always close and secure the terminal cover.

» Do not use thick wires with high heat radiation effect (cross-sectional area of 0.5 mm?
or smaller recommended).

» Keep the ambient temperature consistent. Large temperature fluctuation occurs such
as when a fan nearby is turned ON/OFF.

Connecting the input wires in parallel with other instruments may mutually

affect the measured values. If you need to make a parallel connection:
¢ Turn OFF burnout.

» Ground each instrument at a single common point.

* Do not turn ON/OFF the instrument while measurement is in progress. It may cause
adverse affects on the other instrument.

Note that RTDs and resistors cannot be connected in parallel.

IM MW100-01E
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2.4 Connecting Signal Wires

Wiring Procedures
1. Turn OFF the power to the instrument.
2. Loosen the terminal cover attachment screw and lift up the terminal cover.
3. Connect the signal wires to the terminals.
4. Return the terminal cover to the original position and secure it with the screw. The
appropriate screw tightening torque is 0.6 N-m.

4-CH, High-Speed Universal Input Module

Attachment screw for terminal cover

Terminal cover

|

~— Input terminal (clamp terminal)

Wiring the Universal Input Module and DCV/TC/DI Input Module

* Thermocouple input * RTD input
A 0— Yao
78 o0—— & A

A0 Compensation

O
lead b
Lead wire resistance per wire of
10 Q or less*. Make the resistance
of the three wires equal.
* In the case of Pt100Q. 5 Q max
for Pt50Q. 1 Q max. for Cu10Q.
* DC voltage input/DI input (contact) * DC current input
V79 o———+ —o Yo +
or DC current input
%o T 4ol :
DC voltage  Contact Shunt resistor
/b © input /b © Example: For 4 to 20 mA input,
shut resistance values should
be 250 Q * 0.1%.
Terminal type: Clamp, or screw (in the case of M3: -L30/H3)

Applicable wire size: For -HO04, 0.2 to2.5 mm? (AWG24 t012)
For -M10 and -L30 (clamp), 0.14 to 1.5 mm? (AWG26 to 16).
Nofte
*  With the 10-CH Medium-Speed Universal Input module, the A and B RTD input terminals
are insulated on each channel, but terminal b is shorted internally on all channels.
* Measurement using RTD cannot be performed with the 30-CH Medium Speed DCV/TC/DI
Input Module.
*  When the plate with screw terminal (model 772080) is connected to the 10-CH Medium-
Speed Universal Input Module, the terminal arrangement differs from that of clamp
terminals, so wire according to the markings on the terminal cover.
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2.4 Connecting Signal Wires

Wiring the 4-Wire RTD Resistance Input Module

* DC voltage input/DI (contact) input * RTD input, resistance input

A0 Voltage A Resistance, RTD
% + —=O -'/A
Ko T %
DC voltage Contact
cO Input (o3
Nothing connected to
the | or C terminal Resistance per lead wire of 10 Q or less
* DC current input
A o
% O +
DC current input
o i
coO Shunt resistor
Example: For 4 to 20 mA input, shut resistance values
should be 250 Q #0.1%.
Terminal type: Clamp

Applicable wire size: 0.14 to 1.5 mm? (AWG26 to 16)

Wiring the Strain Input Module
Note

When using a sensor without a remote sensing wire, use the DV450-001 (conversion cable).

¢ 1 Gauge Method

fixed resistance
resistance value of lead
wire

: resistance value of strain
gauge
output voltage from bridge
voltage applied to bridge

-B12, -B35 -NDI Bridge head
. (701955 or 701956)
Setting switch

! andiin (Re — o [

B ~ 2

No.1 ey |0 = b2
No.2 B(L) HI @ — 0

No.3 — 4

No.4 cew (1] 10) ] g 5

No.5 L] 6

o ([ |0) il

OFF ON Setting | 0] 8

No.1| No.2| No.3|No.4| No.5 switch ——

ON | ON | ON | OFF | OFF ON DDDDD
OFF

SW 12345

SW1|SW2 | SW3 | SW4 | SW5
ON | ON | ON | ON [OFF

IM MW100-01E 2-13
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2.4 Connecting Signal Wires

¢ 1 Gauge 3 Wire Method

E
R: fixed resistance
r: resistance value of lead wire -NDI Bridge head
Rg: resistance value of strain gauge (701955 or 701956)

e: output voltage from bridge

E: voltage applied to bridge E{i g ;
-B12, -B35 = g :
Setting switch — 0l 5
| A(+V) 1[ @ = 0 6
No.1 = o 7
No.2 [Re L] [Bw|) Setting — ol s
o. -
No.4 c(v) Dl svteh o0
No5 00
D( H) :II @ OFF
OFF ON SW 12345
No.1| No.2| No.3| No.4| No.5 SW1|SW2 |SW3 |SW4 | SW5
ON | ON | OFF| ON | OFF OFF | ON | ON | ON | OFF

¢ Adjacent 2 Gauge Method

fixed resistance
resistance value of lead
wire

: resistance value of strain
gauge
output voltage from bridge
voltage applied to bridge

-NDI Bridge head
-B12, -B35 (701955 or 701956)

Setting switch =1 ol 1
| a7 ) [Rei T 2
No.1 [Ret 1] SEE
No.2 /E{B(L)@ [ Rg2 | 1 0 4
No.3 [Rg2 | = 0 5
No.4 cwvN| ) = bl e
No.5 N
p(H) || ][] . N
OFF  ON 0 Setting L os
switch ——
No.1| No.2| No.3| No.4| No.5 ON
ON | ON | OFF| OFF | ON OFF DDDDD

SW 12345

SW1 [SW2 |SW3 |SW4 | SW5
OFF [ ON | ON | ON | OFF
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2.4 Connecting Signal Wires

¢ Opposing 2 Gauge Method

-B12, -B35
Setting switch
! AY) | TS
No.1
No.2 B(L) SU:
No.3
No.4 e[|
No.5
o[
OFF ON
No.1| No.2| No.3| No.4| No.5
ON | OFF | ON [OFF| ON

¢ Opposing 2 Gauge 3 Wire Method

gauge

fixed resistance
resistance value of lead wire
: resistance value of strain

-NDI Bridge head
(701955 or 701956)

SEASEISEIS

-B12, -B35

Cannot be connected. Use -NDI.

-NDI Bridge head
(701955 or 701956)

Setting

switch ——
ON

IR LRI

O ~NOOOAWN-=

OFF

iy

Sw

12345

Swi1

Sw2

Sw3

Sw4

SW5

OFF

OFF

OFF

ON

OFF

Setting

EINIEILTEIEIE

SISISISESISISES)
O NOGOhAWN-=

output voltage from bridge
voltage applied to bridge

switch ——
ON

OFF

ainnt

Sw

12345

SW1 |Sw2

Sw3

Sw4

SW5

ON | OFF

ON

ON

OFF

Rg1

) =2

Rg2

R: fixed resistance

r: resistance value of lead wire

S —

Rg: resistance value of strain gauge
e: output voltage from bridge
E: voltage applied to bridge

IM MW100-01E
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2.4 Connecting Signal Wires

¢ 4 Gauge Method

Rg4 . .
R: fixed resistance

r: resistance value of lead wire
Rg: resistance value of strain gauge
e: output voltage from bridge

E: voltage applied to bridge

Rg1

Rg1,Rg2 Rg3, Rg4

-B12, -B35

Setting switch
|

No.1
No.2
No.3
No.4
No.5

N
SOSSSS

OFF

No.1| No.2| No.3|No.4| No.5
OFF | OFF | OFF| OFF | ON

-NDI Bridge head
(701955 or 701956)

O ~NOOOAWN =

[T YT 1TV 17

|—— Setting switch

| el e

SW 12345

SW1[SW2 [SW3 | SW4|SW5
OFF | OFF | OFF | ON | OFF
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2.4 Connecting Signal Wires

Wiring the Pulse Input Module and Digital Input Module
Nofte

*  With the pulse input module and digital input module, the (-) terminal and unassigned

terminals on all channels are shorted internally.

*  When the screw terminal plate (model 772080) is connected to the pulse input module and
digital input module, the terminal arrangement differs from that of clamp terminals, therefore
wire according to the markings on the terminal cover.

Wiring the Pulse Input and Digital Input (-D05)

* Contact input  Transistor input * 5-V logic input

tg:’/ tF Fﬁ

Main Input Specifications (for Pulse Input and Digital Input (-D05))

Input type: DI (non-voltage contact, open collector, and 5-V logic)
Input format: Pull up at approx. 5 V/approx. 5 kQ, common potential between
channels

Minimum detection pulse width:
Pulse input: 40 ps
Digital input (-D05): Twice the measurement interval or more
Input threshold level:
+ Pulse input
Non-voltage contact or open collector:
Count upon change from contact open (100 kQ or
more) to contact close (100 Q or less)
5-V logic: Count upon change from 1V or less to 3 V or more
+ Digital input (-D05)
Non-voltage contact or open collector:
100 Q or less: ON, 100 kQ or more: OFF
5-V logic: OFF at 1 V or less and ON at 3 V or more
Contact/Transistor rating:
Contact with a rating of 15 VDC or greater and 30 mA or greater
Transistor with a rating of Vce > 15 VDC and Ic > 30 mA
Terminal type: Clamp
Applicable wire size:  0.14 to 1.5 mm? (AWG26 to 16)

Wiring Digital Input (-D24)

* 24V logic input
24V
+

Main Input Specifications (for Digital Input (-D24))

Input type: DI (24-V logic)

Input format: Common potential between channels

Min. detection pulse width: Twice the sampling interval or more

Input threshold level: 24-V logic: OFF at 6 V or less and ON at 16 V or greater
Terminal type: Clamp

Applicable wire size:  0.14 to 1.5 mm? (AWG26 to 16)

IM MW100-01E 2-17
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2.4 Connecting Signal Wires

Wiring with the Analog Output Module

External power supply Voltage Current
+ -
Vext ¥ *2av Y
- o—T - power supply Load Load| Direction of
current
(when using current output) - I+
CAUTION

Two power supply terminals are connected internally. Therefore, do not connect
a separate external power supply to them. Fire can result.

Main Output Specifications
Terminal type: Clamp, attached and removed in units of 4 channels
Load impedance: Voltage 5 kQ or more
Current 600 Q or less.
Applicable wire size: 0.08 to 2.5 mm? (AWG28 to 12)

Wiring with the PWM Output Module

External power supply Pulse width output
+Oo————+ V+
4to28V
- OJ_ power supply Load
CAUTION

Two power supply terminals are connected internally. Therefore, do not connect
a separate external power supply to them. Fire can result.

Main Output Specifications
Output capacity: 1A/ch max, however, 4 A or less total for all modules "
Terminal type: Clamp, attached and removed in units of 4 channels
Applicable wire size: 0.08 to 2.5 mm? (AWG28 to 12)
*1 A 1A current limit circuit is built in to the output circuit. Once the current limit circuit is ON,
the circuit continues to operate unless the external power supply is turned OFF.
*2 This module has a built-in fuse. The built-in fuse protects against fires or abnormal
emissions of heat due to load short-circuiting or other abnormalities.

2
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2.4 Connecting Signal Wires

Wiring with the Digital Output Module

NO
oO——O0—>
250 VDC/0.1 A, 250 VAC/2 A, or

~— - c E 30 VDC/2 A (resistance load)

O

Main Output Specifications

Contact mode: A contact (SPST)
Contact capacity: 250 VDC/0.1 A, 250 VAC/2 A, or 30 VDC/2 A (resistance load)
Terminal type: Clamp, attached and removed in units of 5 channels

Applicable wire size: 0.08 to 2.5 mm? (AWG28 to 12)

Note

Do not connect anything to the unassigned terminals of the digital output module.

IM MW100-01E
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2.5 Connecting the Power Supply and Turning the
Power Switch ON and OFF

Connections with the Power Cord (Power Supply and Power Cord Suffix Code -1c*)
*isD,F, R, Q, or H.

A | WARNING

» To prevent the possibility of electric shock when wiring, confirm that the power
supply source is turned OFF.

» To prevent shock or fires, only use the power cord supplied by Yokogawa
together with the MW100 Data Acquisition Unit.

» Make sure to perform protective earth grounding to prevent electric shock.
Connect the MW100 Data Acquisition Unit power cord into a three-prong
electrical outlet with a protective grounding terminal. The AC outlet must be of a
three-prong type with a protective earth ground terminal.

Also, do not use the functional ground terminal (see 2.2, “Installation” as a
protective ground terminal.

» Do not use an extension cord without protective earth ground. Otherwise, the
protection function will be compromised.

Use a power supply that meets the conditions indicated below.

Item Specifications
Rated supply voltage 100 to 240 VACrms
Supply voltage range used AC power supply, 90 to 250 VACrms

Rated supply voltage frequency 50/60 Hz
Allowable line frequency range  50/60 Hz 2%
Maximum power consumption Up to approximately 70 VA maximum when six modules are used

Nofte
Do not use a supply voltage in the range 132 to 180 VAC, as this may have adverse effects on
the measurement accuracy.

Check that the power switch of the main module is OFF.

2. Connect the accessory power cord plug to the power connector of the MW100
Data Acquisition Unit.

3. (Use the power cord that came with the package.) Connect the plug on the other
end of the power cord to the outlet that meets the conditions above. The AC outlet
must be of a three-prong type with a protective earth ground terminal.

Power connector

Power switch

Power cord
(included in the package)

en the basic suffix code is -1D
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2.5 Connecting the Power Supply and Turning the Power Switch ON and OFF

Wiring the Power Supply Terminal (Power Supply and Power Cord Suffix Code -1W)

A | WARNING

» To prevent the possibility of electric shock when wiring, confirm that the power
supply source is turned OFF.

» Furnish a switch (double-pole type) to separate the unit from the main power
supply in the power supply line. Also, include an ON/OFF indicator with the
switch as well as a display that acts as a power supply shut down for the
instrument.

Switch specifications
Steady state current rating: 3 A or more
Inrush current rating: 100 A or more
Conforms with IEC60947-1 and -3
» Connect a fuse of 2 Ato 15 A to the power supply line.
» Do not insert a switch or fuse on the ground line.

Use a power supply that meets the conditions indicated in “Connections with the Power
Cord (Power Supply and Power Cord Suffix Code -1¢*)” on the previous page.

1. Check that the power supply and the power switch of the main module is OFF.

2. Loosen the screw fixing the power supply terminal cover of the main module in
place and open the power supply terminal cover.

3. Connect the power cord and the protective ground cord to the power supply
terminals according to the figure below.
Use round crimp-on lugs with isolation sleeves (for 4 mm screws) for the power
cord and protective ground cord terminals.

4. Close the power supply terminal cover and secure it with the screw.

= == 1d|

nMwi1o0
'DATA ACQUISITION UNIT|
YOKOGAWA ¢

L]
I
|

L1

)
o
|

)
0 - 240V AC~

=L -
[SYSTST=T=T=) ||
OO0 ‘&UTHFAHW

ﬂnﬁw%ﬂfwwi@
Q0Q

Power supply
Power cord || terminal cover

Protective

Power cord grounding cord

Protective grounding cord
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2.5 Connecting the Power Supply and Turning the Power Switch ON and OFF

Wiring the Power Supply Terminal (When the Suffix Code of the Power Supply/Cord Is
2 or -3W)

*isD,F, R, Q, or H.
When using an AC adapter for the power supply

A e

» To prevent the possibility of electric shock when wiring, confirm that the power
supply source is turned OFF.

» Use the power cord supplied by Yokogawa with the instrument.

» Check that the supply voltage matches the rated voltage of the AC adapter
before connecting the power cord.

» During periods of extended non-use, remove the AC adapter’s power cord from
the AC outlet.

* Do not use an AC adapter (model:772075) other than the one supplied by
YOKOGAWA.

» Nothing should be placed on top of the AC adapter power cord. The power cord
should also be kept away from any heat sources.

*  When unplugging the power cord from the outlet, never pull by the cord itself.
Always hold and pull by the plug. If the power cord is damaged, contact your

dealer for replacement.
. _________________________________________________________________________________________________________________|

Use a power supply that meets the conditions indicated below.

Item Specifications
Rated supply voltage 100 to 240 VACrms
Supply voltage range used AC power supply, 90 to 250 VACrms

Rated supply voltage frequency 50/60 Hz
Allowable line frequency range  50/60 Hz +2%
Maximum power consumption Up to approximately 70 VA maximum when six modules are used

1. Check that the power supply and the power switch of the main module is OFF.

2. Loosen the screw fixing the power supply terminal cover of the main module in
place and open the power supply terminal cover.

3. Connect the plus (red) and minus (blue) wires from the AC adapter and the
protective ground wire to the power supply terminal as in the figure below.

4. Close the power supply terminal cover and secure it with the screw.

Plus wiring
Power supply

. . terminal cover
Protective ~ Minus wiring
grounding line Protective

grounding line

Plus wiring

Minus wiring
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2.5 Connecting the Power Supply and Turning the Power Switch ON and OFF

When Using a DC Power Supply

A | WARNING

» To prevent the possibility of electric shock when wiring, confirm that the power
supply source is turned OFF.

» To avoid electric shock or fire, use electric wires having a cross sectional area of
0.3 mm2 (AWG 22) or more.

1. Check that the power supply and the power switch of the main module is OFF.

2. Loosen the screw fixing the power supply terminal cover of the main module in
place and open the power supply terminal cover.

3. Following the wiring diagram (see “When Using an AC Adapter” in this section),
wire the plus/minus wires from the DC power supply and the protective grounding
wire to the power supply terminal.

4. Close the power supply terminal cover and secure it with the screw.

Use a power supply that meets the conditions indicated below.

Item Specifications
Rated supply voltage 121028 VDC
Supply voltage range used DC power supply: 10 to 32 VDC

Maximum power consumption  Up to approximately 35 VA maximum when six modules are
used

Turning the Power Switch ON and OFF

Pressing the “I” side of the power switch turns the instrument ON. Pressing the “O” side
turns the instrument OFF.

When turned ON, the 7-segment LED (see section 1.3, “Functions of the Main Module”
illuminates. When the self check and other processes are complete, the unit number is

displayed.

Note

» Before turning the power ON, check that the modules are attached correctly and that the
power cord is connected correctly.
» If the 7-segment LED does not illuminate even if the power switch is turned ON, turn OFF

the power switch, then check the items below. If the condition does not change when turning
ON the power even after checking those items, it is probably a malfunction. Contact your
nearest YOKOGAWA dealer for repairs.
* That the power cord is plugged in properly.
» That the power supply voltage is within the allowable voltage range specified in this
section

» If the 7-segment LED displays something other than a unit number when the power switch
is turned ON, see section 4.1, “Error Display on the 7-Segment LED and Corrective Actions”
and carry out the specified corrective action. If the displayed information does not change
even when you carry out the corrective action, it is probably a malfunction. Contact your
nearest YOKOGAWA dealer for repairs.

IM MW100-01E 2-23
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2.6 Connecting the Ethernet Cable

Connection Procedure

Connector
Connect the Ethernet cable to the Ethernet port on the main module.

Connection to the PC

Make the connection via a hub. For a one-to-one connection with a PC, make the
connection as shown in the figure below. In the same manner, you can connect multiple
MW100 Data Acquisition Units to a single PC.

PC

fepooo
Hub

> LAN cable

MW100)

B =H—Ethernet port
=

o Uo o o Ho o Je5E
H"L H"L M"L H"L M"‘LJ"“—"“““"L_‘

MW100 Data Acquisition Unit

o o o o o o

Checking the Communication Status

You can check the status on the two LEDs at the upper-right and lower-right of the
Ethernet port.
P> For the LED indications, see “Part Names and Functions” in section 1.3.

Changing the Data Rate
The MW100 can be connected to a 10BASE-T/100BASE-TX hub. The data rate can be
fixed to 10 Mbps half duplex by setting the dip switch.
To fix the data rate to 10 Mbps half duplex, turn switch 6 of dip switch 1 OFF. To activate
the settings, carry out the same procedure as described in “Initializing Settings.”
P> For a description of the dip switch, see “Switches and Keys” in section 1.3.
Initializing Settings
Use dip switch 1 on the main module to initialize settings including the IP address
assigned to the MW100.
1. Turn OFF the power to the MW100.
2. Check that the switch 5 of dip switch 1 on the main module is OFF.

3. Turn OFF the power to the MW100.
After the 7-segment LED indicates the power ON self check, “bF” is displayed.

4. Check the status of step 3, then turn the power OFF.
5. Turn switch 5 of dip switch 1 back ON.

Check that the settings have been initialized using the IP setting software.
P> For a description of the dip switch, see “Switches and Keys” in section 1.3.
P> For a description of the indications of the power ON self check, see “Displays” in section 1.3.
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2.7

Connecting the RS-422A/485 Interface (/C3

Option)

Terminal Wiring and Signal Names

OO OO
FG SG SDB SDA RDB RDA

I I

SERIAL COMM

FG (Frame Ground)

Case grounding for the main unit.

SG (Signal Ground)

The signal ground.

SDB (Send Data B)

Send data B(+).

SDA (Send Data A)

Send data A(-).

RDB (Received Data B)

Received data B(+).

RDA (Received Data A)

Received data A(-).

Connection Procedure

Cables Used

There are two types of cable, a 4-wire and 2-wire cable. Choose a cable depending on

the following conditions.

Cable Used Twisted pair shielded cable
3 x 24 AWG or more (4-wire), 2 x 24 AWG or more (2-wire)
Characteristic impedance 100 Q
Capacitance 50 pF/m
Cable length Max 1.2 km*

*

the total cable length (shielded, twisted pair).

The transmission distance of the RS-422A/485 interface is not the direct distance, but rather

A

making connections.

To prevent electric shock, confirm that the power supply is turned OFF before

Connections with Upstream Devices
The following figure shows a connection with an upstream device. If the upstream

devices use an RS-232 port,

Host computer
or connected
upstream instrument

[ ] Ro22ma5 Yarfjalapangarhs

connect through a converter.

Connected Main unit
upstream RS-422_A/485
instrument terminals
- —r— _

Host computer

Converter

|‘:| RS-232 |:| RS-422A/485

Connected upstream instrument :

-

Main unit
RS-422A/485
terminals

o

tog
Om [

o

A
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2.7 Connecting the RS-422A/485 Interface (/C3 Option)

Example of a Connection with an Upstream Device

You can connect the MW100 to an upstream device with an RS-232, RS-422A, or RS485
connection port.

For RS-232, use a converter. Refer to the following table for connections to most
converter terminals. For details, see the manual that came with the converter.

RS-422A/485 Port Converter
SDA(-) TD(-)
SDB(+) TD(+)
RDA(-) RD(-)
RDB(+) RD(+)

SG SHIELD
FG EARTH

4-Wire

In general, a 4-wire connection is used with upstream devices. For a 4-wire connection,
the send and receive wires must be crossed.

— Termination resistance (externally attached) 120 Q 1/2 W or more Termination resistance —

Upstream
instrument

SDA(-)O

SDB(+)O

RDA(-)O

RDB( +)O
SG

N

Main unit
RS-422A/485
terminals

(built-in: with switch)

"""" s
/ (QE
--(SDB)--

-(RD A)--

o)

2-Wire
On the RS-422A/485 terminal block, connect signals of the same polarity for sending and
receiving, and connect only two wires externally.

Termination resistance (externally attached) 120 Q 1/2 W or more

le

3.

(%]
o
w|>»> W >

x
0% 0%

»
@

e

#n
(#n32)

Do not connect termination resistance from #1 to #n-1.

Termination resistance
(built-in: with switch)

Main unit
Upstream RS-422A/485
instrument terminals
SDA(<)0 /\ N \ SD A /N @ \ SD A SD A
oos(e) NETR o \' | sos) [ o \ | soB) sD B
RD A RD A RD A
RDA(-)
RDB(+)9 et et "o
SG SG SG
SG O: (SG) / \ (SG) /
FG FG o
1
ATV 4P IAYAN AR Tl
1 T T T
= Mo #22 7 e #n

(#n31)

Do not connect termination resistance from #1 to #n-1.
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2.7 Connecting the RS-422A/485 Interface (/C3 Option)

A

Note

* The noise rejection method differs depending on the conditions of use. In the connection

example, the cable shielding is only connected to the ground of the main unit (one-sided
grounding). This method is effective for noise rejection during long distance communications
and other processes when there is a difference of potential between the grounding of the
computer and that of the main unit. If there is no difference in potential between the PC
ground and the main unit ground, it may also be effective to connect to the PC ground
as well (two-sided ground). There are also cases where it is effective to use two sided
grounding with a capacitor connected in series on one side. Consider the above options
when taking measures against noise.

« With the 2-wire configuration (Modbus protocol), after the last data is output from the
upstream PC, the 485 driver must be set to high impedance before 3.5 characters.

Serial Interface Converter
The following are recommended models of converters.
Sysmex RA CORP./MODEL RC-770X, LINE EYE/SI-30FA, YOKOGAWA/ML2

CAUTION

Some converters not recommended here have non-insulated FG and SG
terminals. When using such converters, do not connect them as shown on the
previous page (do not connect anything to the converter’s FG ad SG terminals).
Especially for long-distance situations, potential differences can arise causing
damage to instruments or communication abnormalities. Also, if the converter
has no SG terminal, use the converter as-is without connecting signal ground.
For details, see the user’s manual for the converter.
. _________________________________________________________________________________________________________________|
Some converters not recommended here have reversed signal polarity (A/B or +/—
markings). When using such converters, be sure to reverse the connections.

When Using Instruments That Only Support RS-422A

For 4-wire configurations, up to thirty-two MW100s can be connected to a single
upstream device. However, if at least one of the devices in the system only supports RS-
422A, it may not be possible to connect up to thirty-two units.

When Using Recorders That Only Support Yokogawa RS-422A

The maximum number of units that can be connected in this case is sixteen. Drivers for
some conventional Yokogawa recorders (the HR2400, uR series, and other recorders)
only support RS-422A. When such recorders are used, only a maximum of sixteen units
can be connected.

Note

In the RS-422A standard, up to ten units can be connected to a single port (in 4-wire configurations).

Termination Resistance

This module has built-in termination resistance. When using multi-drop connections
(including point-to-point connections), for the outermost unit, turn terminator switch ON.
Turn it OFF for units in the middle. Also, turn ON termination resistance for the connected
upstream device (see the manual of the upstream device). When using a converter, turn
ON its termination resistance. The recommended converters have built-in termination
resistance.

IM MW100-01E
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2.8

Connector Pin Assignments and Signal Names
Connector Pin Assignments

Handshaking

1 2
\

3 45
[/

@oo

o O O
o O O

1T
6 7 8 9

©

Signal Names Corresponding to Connector Pins
The following table shows signal names for the RS-232, JIS, and ITU-T standards.

Connecting the RS-232 Interface (/C2 Option)

Signal Name

Pin IS TUT  RS=232 Notation Meaning

2 RD 104 BB (RXD) Receive data Input signal to the instrument

3 SD 103 BA (TXD) Transmitted data Output signal from the instrument

5 SG 102 AB (GND) Signal ground The signal ground.

7 RS 105 CA (RTS) Requesttosend The handshaking signal when receiving
data from the computer, and output signal
from the instrument.

8 CS 106 CB (CTS) Clear to send The handshaking signal when receiving

data from the computer, and input signal
to the instrument.

* Pins 1, 4, 6, and 9 are not used.

One of the following four methods in the table below can be selected for the instrument.

Table of Handshaking Methods (O indicates that it is supported)

Data Transmission Control
(Control used to send data to a PC)

Data Reception Control
(Control used to receive data from a PC)

Software Hardware Software Hardware
handshaking handshaking handshaking handshaking
Stops Stops transmission Send X-OFF Set CA (RTS) to
transmission |when CB (CTS) h N:: ki when the False when the h Nz ki
Handshaking method | when X-OFF |is false. andshaking | ocejved data | received data buffer|"andshaking
is received. Resume when buffer is 3/4th | is 3/4th filled. Set to
Resume it is true. filled. Send True when the
when X-ON X-ON when the | received data buffer
is received. received data | becomes 1/4th filled
buffer becomes
1/4th filled.
OFF-OFF O O
XON-XON O O
XON-RS O O
CS-RS O O
OFF-OFF
» Send Data Control

Handshaking is not performed between the instrument and the computer. “X-OFF” and
“X-ON” from the computer are treated as data, and CS is ignored.

Receive Data Control

Handshaking is not performed between the instrument and the computer. When the
receive buffer of the instrument becomes full, data thereafter is discarded.
RS = True (fixed)
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2.8 Connecting the RS-232 Interface (/C2 Option)

XON-XON

Send Data Control

Software handshaking is not performed between the instrument and the computer.
If X-OFF is received from the computer while the instrument is sending data, data
sending stops, and restarts when the next X-ON code is received. CS from the
computer is ignored.

Receive Data Control

Software handshaking is not performed between the instrument and the computer.
When the used capacity of the instrument’s receive buffer reaches 1537 bytes, an
X-OFF code is sent to the computer, and when the buffer reaches 511 byte, the X-ON
code is sent.

RS = True (fixed)

XON-RS

Send Data Control

Software handshaking is not performed between the instrument and the computer. If
X-OFF is received from the personal computer while the instrument is sending data,
data sending stops, and restarts when the next X-ON code is received. CS from the
computer is ignored.

Receive Data Control

Hardware handshaking is not performed between the instrument and the computer.
When the used capacity of the instrument’s receive buffer reaches 1537 bytes, RS is
set to False, and when the buffer reaches 511 byte, RS is set to True.

CS-RS

Send Data Control

Hardware handshaking is not performed between the instrument and the computer.
If CS becomes False while the instrument is sending data, transmission stops and
restarts when CS becomes True. X-OFF and X-ON from the computer are treated as
data.

Receive Data Control

Hardware handshaking is not performed between the instrument and the computer.
When the used capacity of the instrument’s receive buffer reaches 1537 bytes, RS is
set to False, and when the buffer reaches 511 byte, RS is set to True.

Connection Examples

* OFF-OFF/XON-XON * CS-RS(CTS-RTS)
PC MW PC MW
SD 3 SD sD 3 sD
RD——— 2 RD RD— 12 RD
RS 7 RS RS 7 RS
cs [l s cs cs—— s cs
SG 5 SG SG 5 SG

* XON-RS(XON-RTS)

The RS on the PC side and the CS
PC MW . .
3 SD on the instrument side do not need
2 rp tobe connected for control.
7 RS However, we recommend that they
| 8 CS  pe connected so that the cable
5 SG  can be connected in either direction.

Note

« A computer program must be created such that the receive buffers of the instrument and
computer do not become FULL.
*  When selecting XON-XON, output data in ASCII format.

IM MW100-01E
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2.9 Measures Against Noise on the MW100 Data
Acquisition Unit
The technical Information described below is available as reference material on
measures against noise. For information on obtaining a copy, contact your nearest
YOKOGAWA dealer.
* Noise Interference on Recorder (Tl 4D5B1-80E)
Describes the fundamentals concerning noise and its countermeasures in two parts:
basic edition and application edition.
» MX100 Performance Specifications (T1 04M08B01-00E)
This describes in detail the noise rejection characteristics and functions that are
unique to the MW100 Data Acquisition Unit.
This section briefly describes the integrating A/D converter and the first-order lag filter
that the MW100 Data Acquisition Unit employs as measures against noise.

Integrating A/D Converter
MW100 input modules employ integrating A/D converters for converting the measured
analog signals into digital signals. The integrating A/D converter integrates the measured
values at the specified time width. If the specified time width matches the period of the
signal you wish to reject, the signal is rejected.

Cancelled out

Input voltage
/ (instantaneous value)

l* - - -\ - DC voltage (average value)

Integration time

For example, if the integration time is 20 ms, signals having frequencies of 50 Hz and
integer multiples of 50 Hz can be rejected. Likewise, if the integration time is 16.67 ms,
signals having frequencies of 60 Hz and integer multiples of 60 Hz can be rejected. If
the integration time is 100 ms, signals having 10 Hz and integer multiples of 10 Hz can
be rejected. The commercial power supply is one of the noise sources. By setting these
integration times, commercial power noise of 50 Hz or 60 Hz can be eliminated.

On the MW100, the integration time is set as shown below.

4-CH, High-Speed Universal Input Module

Mef:t:r:':lent I"t?rsi’r'ﬁé'on Rejected Frequencies and Notes
10 ms 1.67 ms | 600 Hz and its integer multiples
16.67 ms | 60 Hz and its integer multiples
50 ms 20 ms 50 Hz and its integer multiples
Auto Automatically detects the power supply frequency and set 16.67 or 20 ms
100 ms . .
200 ms 36.67 ms | 50 Hz and 60 Hz and their integer multiples
500 ms 100 ms 10 Hz and its integer multiples
1s

200ms | Low-pass filter with Fc = 5 Hz

2, 5,10, 20, 30,60 s

* Because the power supply frequency noise is not rejected, measured values may fluctuate particularly in temperature
measurements. If this happens, make the measurement interval longer.
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2.9 Measures Against Noise on the MW100 Data Acquisition Unit

6-CH, Medium-Speed 4-wire RTD Resistance Input Module/
10-CH, Middle-Speed Universal Input Module

Me?:tt;(‘elr;}ent Intgrgi;rr'?(telon Rejected Frequencies and Notes
100 ms 1.67 ms | 600 Hz and its integer multiples®
200 ms
16.67 ms | 60 Hz and its integer multiples
500 ms 20 ms 50 Hz and its integer multiples
Auto Automatically detects the power supply frequency and set 16.6 or 20 ms 5
1s 36.67 ms | 50 Hz and 60 Hz and their integer multiples [}
2s 100 ms | 10 Hz and its integer multiples %
5,10, 20, 30,60 s 200 ms Low-pass filter with Fc = 5 Hz g:
* Because the power supply frequency noise is not rejected, measured values may fluctuate particularly for temperature g
measurements using thermocouples or 20 Q measurements. If this happens, make the measurement interval longer, or use
the 4-CH High-Speed Universal Input Module. g
[-%
30-CH, Medium-Speed DCV/TC/DI Input Module g
Measurement Integratlon Rejected Frequencies and Notes 8
Interval Time
500 ms 1.67 ms 600 Hz and its integer multiples®
16.67 ms |60 Hz and its integer multiples
1s 20 ms 50 Hz and its integer multiples
Auto Automatically detects the power supply frequency and set 16.67 or 20 ms
2s 36.67 ms |50 Hz and 60 Hz and their integer multiples
5,10, 20, 30,60s |100 ms 10 Hz and its integer multiples

* Because the power supply frequency noise is not rejected, measured values may fluctuate particularly
for temperature measurements using thermocouples. If this happens, make the measurement interval
longer, or use the 4-CH High-Speed Universal Input Module or the 10-CH Medium-Speed Universal
Input Module.

4-CH, Medium-Speed Strain Input Module

Measurement Integ_;ratlon Rejected Frequencies and Notes
Interval Time
100 ms 1.67 ms 600 Hz and its integer multiples*
16.67 ms |60 Hz and its integer multiples
200ms 20 ms 50 Hz and its integer multiples
Auto Automatically detects the power supply frequency and set 16.67 or 20 ms
500 ms 36.67 ms |50 Hz and 60 Hz and their integer multiples
1s 100 ms 10 Hz and its integer multiples
2131 620 30805 200 ms | Low-pass fiter with Fo = 5 Hz

* When the measurement interval is 100 ms, measured values may fluctuate since power supply frequency
noise is not rejected.
In such cases, set the measurement interval to 200 ms or more.

However, when using the SNTP time synchronization function, the integral times below
are used.

6-CH, Medium-Speed 4-wire RTD Resistance Input Module/
10-CH, Middle-Speed Universal Input Module

Measurement Integration|

Rejected Frequencies and Notes

Interval Time
100 ms 1.67ms | 600 Hz and its integer multiples*
200 ms ' 9 P
16.67 ms | 60 Hz and its integer multiples
500 ms 20 ms 50 Hz and its integer multiples
Auto Automatically detects the power supply frequency and set 16.6 or 20 ms
; z 36.67 ms | 50 Hz and 60 Hz and their integer multiples
5s 100 ms 10 Hz and its integer multiples
10, 20, 30,60 s 200 ms Low-pass filter with Fc = 5 Hz

* Because the power supply frequency noise is not rejected, measured values may fluctuate particularly
for temperature measurements using thermocouples. If this happens, make the measurement interval
longer, or use the 4-CH High-Speed Universal Input Module.
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2.9 Measures Against Noise on the MW100 Data Acquisition Unit

30-CH Medium Speed DCV/TC/DI Input Module

Measurement Integratlon Rejected Frequencies and Notes
Interval Time
500 ms 1.67 ms 600 Hz and its integer multiples*
16.67 ms |60 Hz and its integer multiples
1,2s 20 ms 50 Hz and its integer multiples
Auto Automatically detects the power supply frequency and set 16.67 or 20 ms
5s 36.67 ms |50 Hz and 60 Hz and their integer multiples
10, 20, 30,60 s 100ms 10 Hz and its integer multiples

* Because the power supply frequency noise is not rejected, measured values may fluctuate particularly for
temperature measurements using thermocouples. If this happens, make the measurement interval longer, or use

the 4-CH High-Speed Universal Input Module or the 10-CH Medium-Speed Universal Input Module

4-CH, Medium-Speed Strain Input Module

Measurement Integ.ratlon Rejected Frequencies and Notes
Interval Time
100 ms 1.67 ms |600 Hz and its integer multiples®
16.67 ms |60 Hz and its integer multiples
200 ms 20 ms 50 Hz and its integer multiples
Auto Automatically detects the power supply frequency and set 16.6 or 20 ms
500 ms 36.67 ms |50 Hz and 60 Hz and their integer multiples
; z 100 ms 10 Hz and its integer multiples
5,10, 20, 30,60 s 200 ms Low-pass filter with Fc =5 Hz

* When the measurement interval is 100 ms, measured values may fluctuate since power supply frequency
noise is not rejected.
In such cases, set the measurement interval to 200 ms or more.

First-Order Lag Filter
For noise sources other than power supply noise, the MW100 Data Acquisition Unit is
equipped with a first-order lag filter having output characteristics indicated in the figure
below against step input.
For the filter setting, the time constant is determined by selecting filter coefficient N for
the measurement interval.

Step input

0%

Output characteristics

- S 63.2% of the output value

;<—>: Time constant

Filter coefficient = measurement interval x filter coefficient N

Measurement Interval (s)

Selectable Time Constants (s)

N=5 N=10 N=20 N=25 N=40 N=50 N=100

0.01 0.05 0.1 0.2 0.25 0.4 0.5 1

0.05 0.25 0.5 1 1.25 2 25 5

0.1 0.5 1 2 2.5 4 5 10

0.2 1 2 4 5 8 10 20

0.5 2.5 5 10 12.5 20 25 50

1 5 10 20 25 40 50 100

2 10 20 40 50 80 100 200

5 25 50 100 125 200 250 500

10 50 100 200 250 400 500 1000

20 100 200 400 500 800 1000 2000

30 150 300 600 750 1200 1500 3000

60 300 600 1200 1500 2400 3000 6000
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2.9 Measures Against Noise on the MW100 Data Acquisition Unit

If the first-order lag filter is applied to the input signal, low-pass filter frequency

characteri

Attenuation

stics shown in the figure below are attained.

Cutoff frequency
Pass band | Cutoff band

0dB
-3dB

If the time

Frequency

constant of the first-order lag filter is set long, the cutoff frequency is lowered,

and frequency bandwidth that can be rejected is widened. Set an appropriate time
constant according to the frequency of the noise you wish to reject.

IM MW100-01E
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2.10 Handling of the CF Card

Handling Precautions of the CF Card

Note the following points when using the CF card. For the general handling precautions

of the CF card, see the user’s manual that came with the CF card.

» The CF card is a precision electronic device. Do not use or store the CF card in an
environment with strong static electricity or an environment where electric noise tends
to appear.

» Do not remove the CF card from the card slot while data is being written. Doing so can
damage or erase the data.

Inserting the CF Card
When inserting the CF card into the card slot, first touch the antistatic metal, then open
the slot cover, and finally insert the card with the back side facing left as in the figure
below.

Antistatic metal

Card slot

Eject lever Reverse side of the CF card

Slot cover

Ejecting the CF Card
Be sure to check that the CF card is not being accessed before ejecting the card from
the slot.
To eject the CF card, first open the slot cover while touching the antistatic metal, then
push the eject lever. Then, press the eject lever that came out once again, and remove
the CF card from the slot.

Nofte
« If the eject lever is difficult to push with your finger, use the tip of a pen or other pointed
object.
» Do not close the slot cover by force when the eject lever is out. Doing so can damage the
CF card slot. When not using the eject lever, push the lever in so that the slot cover can be
closed.

P> For CF card replacement while recording is in progress, see “Saving Data to the CF Card” in
section 1.3.
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Chapter 3  Setting and Data acquisition

3.1 Connection Environment

This section explains the environment in which the MW100 is connected, including
requirements for the PC system, browser and plug-in software, and setting screens.
This chapter focuses on settings entered with the browser. For information about
communication commands, see the Communication Command Manual (IM MW100-17E).

w

PC System Requirements
* OS (Operating System)
Run the system under any of the following operating systems.
*  Windows 2000
* Windows XP (excluding the 64-bit edition)
* Windows Vista (excluding the 64-bit edition)

e PC
A PC that runs one of the OS above, and that meets the following CPU and memory
requirements.
* When Using Windows 2000 or Windows XP
CPU: Pentium Il, 400 MHz or faster (Pentium Ill, 1 GHz or faster recommended)
Memory: 256 MB or more (512 MB or more recommended)
* When Using Windows Vista
CPU: 32-bit (x86) processor of 1 GHz or more
Memory: 1 GB or more

uonisinboe ejeq pue Buipyeg

e Hard Disk
Free disk space: 50 MB or more (1 GB or more recommended)
RPM: 7200 rpm or more recommended

* Input Devices (Mouse, Keyboard, Etc.)
A device supported by the OS

e Monitor
* When Using Windows 2000 or Windows XP
A display supported by the OS with 1024 x 768 dot resolution or better and capable
of displaying 65535 colors or more.
* When Using Windows Vista
A video card recommended for the OS, and a display supported by the OS with
1024 x 768 dot resolution or better and capable of displaying 65535 colors or more.

* Ethernet Port
An Ethernet port compatible with the OS (requires 10BASE-T or 100BASE-TX).

Browser

One of the following browser is required for entry of settings on the MW100.
* Internet Explorer 5.0, 5.5, 6.0, 7.0

IM MW100-01E 341



3.1 Connection Environment

Installing Java

Java is required for entering settings on the MW100 using a browser.
* When Using Windows 2000 or Windows XP

Java Runtime version 1.4 recommended
* When Using Windows Vista

Java Runtime version 6.0 recommended

Java might not be installed on the following operating systems.
*  Windows 2000 SP4 or later

* Windows XP SP2 or later

* Windows Vista

If Java is not installed, you can install it from the MW100 User's Manual CD.
e For Windows 2000, and Windows XP: Java Runtime version 1.4
* For Windows Vista: Java Runtime version 6.0

MW100 Operation Screens

The operation screens of the MW100 main module consist of Monitor screens enabling
operations in Measurement mode, Setting screens that are mainly used in Setting mode,
and Status screens for mode changes.

When entering settings, the pages for all setting items can be displayed, but there may
be settings or items that cannot be entered depending on the installed modules and
options.

Top Screen
¢ Monitor
Single Screen, Dual Screen, Data View and Lite Monitor
*  Firmware version R3.03 or later
¢ Setting
Channel Setting, System Setting, Display Setting, Communication Setting, and Setting
List
*  Firmware version R3.03 or later
e Status

Measurement, MATH, and Recording status changes

3 Top - [10.0.23.44] - Microsoft Internet Explorer =[]
Fle Edt View Favorkes Tods Help | &
Q= - @ - [#] [@ (| Pseweh Jorenis @ (2- 23R [ B
Adcress 2] hetpi/]10.0.23. #4webfindex stm B> E “Lim »

- E|
-1 MASTE: YOKOGAWA
= R 0ATA ACQUISITION UNIT
Top
Single Screen Channel Setting
Dual Soreen Systern Setting
Data View Display Setting
Lite Monitor Communication Setting
Setting List
Measurement |[Stop -
MATH Stop |
[Recording Stop =
Apply
-]
[&]pone [T [ ’3ecalneranet 4
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3.1 Connection Environment

Single Screen and Dual Screen
Monitor-displays the data from the MW100.
P> For details on the operation, see section 3.16, “Measured Data Monitor Display/Settings.”

Data View
Displays alarm summaries, manual sample, and reports (digital values, graphs).
P> For details on the operation, see section 3.16, “Measured Data Monitor Display/Settings.”

Lite Monitor (Firmware version R3.03 or later)
For simplified display of data from the MW100.

IM MW100-01E
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3.1 Connection Environment

Channel Setting

You can set the measurement range, expressions, and other items.

Top > Channel Setting,

ATDT Channel Setting
ACP W Charmel Setting

MATH Channel Setting
MATH Constant Sething
MATH Group Setting

Recording Channel Se

Delay Alarm Setting

Filter, Burncut, RTC Setting.
Strain Input Setting

DO Channel Setting
Program Channel Setting
Comm. Input Channel Setting
Folling Average Setting.

Transmission Output Centrol

System Setting

You can set the measurement interval, measurement groups, and other items.

System Information
Module Information

Status Information
Log Infermation

Measurement Setting
MATH Sething
Eecor, e

inning Fecording Sethy

ACTP WM Preset Setting

Timer Setting
Match Time Setting

Eventtdction Setting

Eeport Setting 1
Eeport Setting 2

SavelLoad Setup Data
Save Option Setting

Save Folder Setting

Date and Time Setting
Daylight Saving Time Setti

Other Sethings

Display Setting

You can set tags, display groups, and other items.

Top > Display Setting

Channe] Tag Setting
Channel Color Setting

Graph Scale Setting
Trip Line Sething

Message Setting

Display Group Setting

Other Sethings

Communication Setting
You can perform user registration and enter FTP/e-mail settings, and other items.

Top > Communication Setting

User Setting
Serial Communication Setting
IP Address Setting

Server Setting

Modbus Master Setting 1
Modbus Master Setting 2

Modbus Chent Setting 1
Modbus Chent Setting 2
Wodbus Client Setting 3

DIYE Chent Setting
FTP Client Setting
Tufail Client Sething 1
Maid Chent Setting 2
SITE Client Setting

IM MW100-01E



3.1 Connection Environment

Host Name Display

Switching Modes

Setting Mode

The host name or IP address is shown in brackets on the title bar of the window.

23 Top {[192.168.1.100]} Microsoft Internet Explorer

File Edit view | Favortes Tools  Help

= o - Host name, or IP address
Qe - D - [x] @] (] Dseoen Jlpraenes ¢ The IP address is displayed if a host
Address [{€] hitp:/192.168.1,100jweb/index.shtm name has not been specified.

| — AR AVA FAFIE™

The MW100 has a Measurement mode and a Setting mode, and the mode must be
changed depending on the operation to be performed.

IMeasurement

hATH Sto
( o
||FRemrdmg Stop

Switch between Measurement
and Setting modes.

P> For the operating procedure, see section 3.3, “System Settings.”
P> For a description of the mode transition, see section 3.13, “Starting and Stopping
Measurement, Computation, and Recording.”

To Single Screen or Dual Screens for the monitor, switch to Measurement mode. Meas.
Mode (Measurement Mode) is indicated for items that require you to switch Measurement
Mode in the procedural explanation of chapter 3.

To modify channel settings, system settings, display settings, or communication settings,
switch to Setting mode. Setting Mode is indicated for items that require you to switch to
Setting Mode in the procedural explanation of chapter 3.

IM MW100-01E
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3.2 Communication Settings

Connection to the MW100 can be made using Ethernet or serial communications
(optional). Also, when performing communication using the Modbus protocol, Modbus
settings are required. When the login function is enabled, connection is made after
entering a user name and password.

Nofte
For details on the network such as the IP address and DNS, check with your network
administrator.

If you are performing communications using the Modbus protocol, you must also specify
Modbus settings.

Setting Mode

Ethernet Connection

Setting Up Ethernet for the First Time, IP Address Unclear
Ethernet connections are not possible under the factory default settings. You must enter
an IP address.

1.

After opening an Ethernet connection between the MW100 and PC, run the
MW100 Viewer Software CD-ROM or the MW100 IP address setting software
installed on the PC.

You can select to enter a fixed IP address, or have the address automatically
obtained by DHCP. If you select a fixed IP address, enter the IP address, subnet
mask, default gateway, and DNS.

Skip to the procedures under Connecting to an MW100 with a Specified IP
Address (Including DHCP).

P> For setting procedures on the MW100 Viewer Software, see the MW100 Viewer Software

User’s Manual (IM MW180-01E)

You can also power up using a fixed IP address and connect to the network.

When Connecting to an MW100 with a Specified IP Address (Including DHCP).

1.

Open an Ethernet connection between the MW100 and PC, then start the
browser.

Enter the host name or IP address of the MW100 in the browser’'s URL/Address
box. The MW100 top page appears. If the login function is set, step 3 is required.

Ex. 1) IP address is 192.168.1.100
http://192.168.1.100/

Ex. 2) Host name is mw100user (requires DNS client settings)
http://mw100user/

Before the top page appears, the network password entry screen is displayed.
Enter a user name and password and click the OK button.

3-6
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3.2 Communication Settings

Changing the IP Address and Connecting

This is used when an IP address has already been set, and the IP address will be
changed by browser or DHCP before connecting. To change the IP address, follow steps
1-6 and 10-11. For changes by DHCP, follow steps 1-3 and 7-11.

1.

9.

From the Top screen, click Communication Setting > IP Address Setting.

Top > Communication Setting > IP Address Setting

Host Mame |mw1 O0user

Domain Matme Idaqmaster com

IP Address 192.168.1.100

Subnet Mask [255.255.254.0

Default Gateway 19216811
S - -

DNS Information ¥ Get from DHCP Server

Host Marne [ Register to DMS Server

Arply

Enter a host name in the Host Name box under DNS Information. Enter the host
name as necessary when you change the IP address.

Enter a domain name in the Domain Name box under DNS Information. Enter the
domain name as necessary when you change the IP address.

Enter a fixed IP address in the IP Address box under IP Address Information.
Enter a subnet address in the Subnet Mask box under IP Address Information.

Enter a default gateway address in the Default Gateway box under IP Address
Information.

To enable the DHCP client function, select the DHCP Client Function check box.

To obtain DNS information from the server, select the DNS Information check
box.

To register a host name on the server, select the Host Name check box.

10. Click the Apply button.
11. Power cycle the MW100. The setting changes are applied.

IM MW100-01E
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3.2 Communication Settings

Connecting with Serial Communication (Optional)
You can enter settings using a browser, or with communication commands. The following
explains setting entry using a browser.

P> For information about communication commands, see the Communication Command

Manual (IM MW100-17E).

From the Top screen, click Communication Setting > Serial Communication
Setting.

Top > Comumication Setting > Serial Communication Setting

Function Mormal -

Address 31

Baud Rate 9600 7| bpe

Parity Bit Even x

Stop Bit 1 >l bit

Data Length 8 x| bit

Handshale OFF :OFF =
Anply

Receiver Settings

2,

In the Function list, select Normal for the MW100-specific protocol, Modbus
Master for the Modbus protocol master, or Modbus Slave for the Modbus
protocol slave.

Enter an address number in the Address box. Select the address in the range of
1 to 32 for the MW100-specific protocol and 1 to 247 for the Modbus slave.

Data Transfer Settings

4,

5.
6.
7

9.

Select a baud rate in the Baud Rate list.
Select a parity check method in the Parity Bit list.
Select a number of bits from the Stop Bit list.

Select a communication data length from the Data Length list. Be sure to select 8
bits if you are outputting the data in binary format.

Select a handshaking method in the Handshake list. This setting is valid only for
the RS-232 interface.

P> For a description of the setup parameters of data transmission, see “Communication” in

section 5.2.

Click the Apply button. The setting changes take effect.
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3.2 Communication Settings

Modbus/RTU Settings

Set the items below to use the Modbus/RTU function.
» For Modbus master, set “Modbus Master Setting 1 and 2.”
» For Modbus slave, set “Modbus master settings 1 and 2,” and “Receiver settings.”

P> For a description of setting the receiver, see “Connecting with Serial Communication

(Optional)” in this section.

Modbus Master Setting 1
This is for settings regarding the communication condition when using the Modbus
Master function.

1.

From the Top screen, click Communication Setting > Modbus Master Setting 1.

Top > Communication Setting > Modbus Master Setting 1
[

Cycle 1s -

Communication Timeout 100ms ¥

Gap between Messages Off =

Eetransmission 1 =

Wait Tirme 0 g
Apply

Select the Enable check box under Master Function.
Select a communication interval from the Cycle list under Communication.

Select a timeout time from the Communication Timeout list under
Communication.

In the Gap between Messages list under Communication, select a gap time from
receiving of the response until the sending of the next command.

Select a number of times in the Retransmission list under Recovery Action.
Enter a recovery wait time in the Wait Time box under Recover Action.

Click the Apply button. The setting changes take effect.

P> For setting items of the Modbus Master function, see “Modbus Master Function (M1 Option)”

under “Modbus Protocol Specifications” in section 5.2

P> For a description of the communication timeout, see the Communication Command Manual

(IM MW100-17E).

IM MW100-01E
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3.2 Communication Settings

Modbus Master Setting 2

1. From the Top screen, click Communication Setting > Modbus Master Setting 2.

Top > Comrmunication Setting > Modbus Master Setting 2

oo [Reac =i [oom |[im 16 - Icum |G
00z |[Wie = Iw A00m 32 Big__<]|[n0z 00z

| |
o B
_ B
006 =
007 =
o |
s B
010 3"
Anply
2. Select the command number group to be set from the Command List list.
3. Select READ/WRITE in the Function box.
4. Enter the address of the slave device in the Slave box.
5. Enter the numbers of the used registers in the Register box. When specifying
multiple registers, enter the first register number.
6. Select a data type in the Data Type list.

Enter the channel numbers used in the Channel boxes.
Click the Apply button. The setting changes take effect.

P> For details on the registers and data types, see “Modbus Master Function” in “Modbus
Protocol Specifications” in section 5.2.
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3.2 Communication Settings

Modbus/TCP Settings

Set the items below to use the Modbus/TCP function. An explanation on the settings is
given in the appendix.
» For Modbus client, set Modbus Client Setting 1 to 3.
» For Modbus server, set the Modbus server to On in the Server Setting.
P> For a description of the server settings, see “Server Settings” in section 3.14.

Modbus Client Setting 1
This is for settings regarding the communication condition when using the Modbus Client
function.

1. From the Top screen, click Communication Setting > Modbus Client Setting 1.

Top > Communication Setting > Modbus Client Setting 1
R - .

Cycle 1s hd
N - o

Connection Timeout 0 3

Wait Time 10 5

Apply

2. Select the Enable check box under Client Function. After clicking the Apply
button, the settings are enabled and communication begins.

Clear the Enable check box and click the Apply button to stop communications.
3. Select a communication interval from the Cycle list under Communication.

4. |If you select the Close check box and there is no response from the server,
communication is closed after the time entered in Connection Timeout elapses.

5. Enter the time until communication is closed in the Connection Timeout to box
under Connection.

6. Enter the time until communications are recovered in the Wait Time box under
Recovery Action.

7. Click the Apply button. The setting changes take effect.

P> For a description of the connection wait time and communication recovery wait time, see
“Modbus Client Function” under “Modbus Protocol Specifications” in section 5.2.

IM MW100-01E 3-11
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3.2 Communication Settings

Modbus Client Setting 2
Register the server to which commands are sent. Use the number of the registered
server for Modbus client setting 3.

1. From the Top screen, click Communication Setting > Modbus Client Setting 2.
The server list is displayed.

Top > Communication Setting > Madbus Client Setting 2

[Somwerlin ]

No.  Seer P
T T i
02 192 166.1.101 502
03 502
04 502
05 502
06 502
07 502
08 502
09 502
10 502
Ay |

2. Enter the server name in the Server box.
3. Enter the server port number in the Port box.

4. Click the Apply button. The setting changes take effect.

Modbus Client Setting 3

1. From the Top screen, click Communication Setting > Modbus Client Setting 3.

Top > Communication Setting > Modbus Client Setting 3

001 Int 16 2 ICUEH

002 Write zuw 255 40001 Int 32 - Little zuuuz 002
003 off ﬂl ﬂl
004 off ﬂl
00s off ﬂl
008 off ﬂl
007 off ﬂl
008 off ﬂl
009 off ﬂl ﬂl
010 off 3|| 3“
Apply

2. Enter settings in the same manner as for Modbus Master Setting 2. Enter the
server number of the server list in the Server box.

3. Enter the server unit number in the Unit box.

P> For details on the registers and data types, see “Modbus Client Function” under “Modbus
Protocol Specifications” in section 5.2.
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3.2 Communication Settings

Login Function and User Settings
Using this function, you can restrict access to previously registered users.

1.

From the Top screen, click Communication Setting > User Setting.

Top > Communication Setting = User Setting

I - o

(el

--

B User Jluseﬂ |n...u
03 User Jluseﬁf |n...u
04 of = | m]

5 of = | m]

5 of = | m]

07 of = | m]

08 of = | m]

I of = | m]
sl (=
Apply

Login Function

2,

Select the Enable check box. This enables the login function.

User Settings

3. Select Admin or User in the Level list under User List. Only Admin can be
selected for list number 01.

4. Enter the user name to set in the User Name box under User List.

5. After selecting the Password check box under User List, enter the password to
be assigned to the user in the Password box. If you do not select the check box,
you cannot enter the password.

6. Click the Apply button. The setting changes take effect.

Nofte

If you forget the password for the user set to the Admin level, there is no way to recover except
initializing the MW100 using dip switch 1. Be sure not to forget the password.

P> For the initialization procedure using the dip switch, see section 4.6, “System Initialization.”
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3.3 System Settings

System Reconstruction

When connecting the MW100 for the first time, or when changing the position of an
installed input/output module on the connected MW100, system reconfiguration is

performed (to match up with the actual modules). Before reconfiguration, connect to the
MW100 to be reconfigured.

Nofte

Always turn the power to the MW100 OFF before attaching or removing input/output modules.

Setting Module Information
1. From the top page, click System Setting > Module Information.

2. If the Configured Module and Attached Module boxes are different, click the
Reconstruct button to reconfigure the system.

Top > System Setting > Module Information

[Modle Tformation |

Mo  Cofigured Moduls  AttahedModuls  Stams
1 b1 1 0-UNY-HO4 X171 0-UNY-HO4

2 A1 25-MKCMT0 X1 25-MKCM10

K hx112-B35-M04 hx112-B35-M04

el A1 20-PWhA-M08 X1 2 0-Pyiha-h08

5

Setting the Date and Time
Sets the date and time on the MW100.

1. From the top page, click System Setting > Date and Time.

Top > System Setting > Date and Time Setting

[EE e T om0 e
[EE e E G E
[ P P

Apply

2. Enter the year, month, and date in the Date box. Use the last two digits of the
Western calendar for the year.

3. Enter the hour, minute, and second in the Time box. Time is specified in 24-hour
format.

4. Enter the hour and minutes in the Time Zone box.

5. Click the Apply button. The setting changes take effect.
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3.3 System Settings

Viewing and Initializing the System Information

You can view the model name, serial number, installed options, firmware version, and
Web software version in the corresponding display boxes.
Also, you can initialize system settings.

System Information
From the top screen, click System Setting > System Information.

Top > System Setting > System Information

System Information
Model [Mwion |
Serial Mo W
Opticn IMATH REPORT DEG_F RS-422 DST
Wersion ,R‘EXEIT—
Web Version ,REXEIT—
Tnitializing Level |
Iedia Information
Capacity |494352/ 500176 K nde free
Format ™ Ezecute
Initialize:

Viewing System Information
Various items are displayed in the system information display area.

Initializing System Information
1. Select the initialization level from the Initialization Level list.

2. Click the Initialize button to initialize the system settings.

P> For details, see section 4.6, “System Initialization.”

Formatting the CF Card and Checking the Free Space

You can format the CF card and check the amount of available space on the card.

Media Information
From the top screen, click System Setting > System Information.

Top > System Setting > System Information

System Information
Model [Mwion |
Serial Mo W
Opticn IMATH REPORT DEG_F RS-422 DST
Wersion ,R‘EXEIT—
Web Version ,REXEIT—
Tnitializing Level |
Iedia Information
Capacity |494352/ 500176 K nde free
Format ™ Ezecute
Initialize:

Checking the Free Disk Space
The amount of used and total space is displayed in the Capacity box under Media
Information.

Formatting
1. Select the Format check box under Media Information.

2. Click the Initialize button to initialize the CF card.

IM MW100-01E
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3.3 System Settings

Daylight Saving Time Setting

Other Settings

1. From the top screen, click System Setting > Daylight Saving Time Setting.

Top > System Setting > Daylight Saving Time Setting
Dyt Seving T | ¥ aable

Start Time Apr v week:[1st 7| |Sun =| hour: |0
End Time Oct x| week:|1st x| [Sun | hour:|0
Apply

2. Select the Daylight Saving Time check box. The Summer time and Winter time
function is enabled.

3. Select a starting month, week, and day of the week for the start of Summer time
in the Start Time box. Enter a start time in the box.

4. Select an ending month, week, and day of the week for the end of Summer time
in the End Time box. Enter an end time in the box.

5. Click the Apply button. The Summer time and Winter time start times are enabled.

This is for entering the MW100 unit number, units of temperature, alarm hold, rate-of-
change interval, and strain initial balance settings.

From the top screen, click System Setting > Other Settings.

N
S - -
Rate-ofchange Alarm

Increase Interval ,B—

Decrease Interval ,E—
Stean T Balancing | |

Apply

Unit Number
1. Enter a number from 0 to 89 for identifying the MW100 unit in the Unit No. box.
2. Click the Apply button. This enables the setting changes.

Temperature Unit
1. Select Celsius deg C or Fahrenheit deg F in the Temperature Unit list.
2. Click the Apply button. This enables the setting changes.

Alarm Status Hold
1. If the Hold check box is selected, alarms are held.

2. Click the Apply button. This enables the setting changes.

P> For a description of the alarm hold/non-hold, see “Alarms” in section 1.3.

Rate-of-Change Interval
1. Enter the measurement count that determines the interval in the Increase
Interval box under Rate-of-Change Alarm.
2. Enter the measurement count that determines the interval in the Decrease
Interval box under Rate-of-Change Alarm.

3. Click the Apply button. The settings for each item are applied.

P> For a description of the rate-of-change interval, see “Alarms” in section 1.3.
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3.3 System Settings

Executing Strain Initial Balancing
1. Select the initial balance execution method from the Strain Initial Balancing list.
2. Click the Apply button. Initial balancing is executed on the channel selected in the
strain input settings in the channel settings.

P> For channel settings when executing strain input initial balance, see “Setting Up and
Executing Strain Input Initial Balancing” in section 3.5.

Status Information and Processing/Operation
You can change the MW100 operation mode, operate the main unit keys, and check
alarm statuses. The operation described here can also be carried out in measurement
mode.

Changing Status Information (Mode)
From the top screen, click System Setting > Status Information. You can perform the
same procedure in the Status table in the top screen.

Top > System Setting > Status Information

MATH [5to — =
Recording [Stop |! ~
Alarm |-
[ziting Al ACK [ ]
Stams Contol

Key Operation ,ﬂ

KeyLock [T Enable

Alarm Acknowledge M Execute

Error Display O Clear

Manual Sample ﬁ

File Diwision ,ﬁ

Transmission Cutput ,ﬁ

Communication Test ,ﬁ

Apply

* Switching between Measurement Mode and Setting Mode
1 Inthe Operation box under Measurement, you can select Start to switch to
Measurement mode, or Stop to switch to Setting mode.
2. Click the Apply button. The changed status is displayed in the Status display
box.

* Computation Start/Stop
1 Inthe Operation box under the MATH item, you can select Start to start
computation, or Stop to stop computation.
2. Click the Apply button. The changed status is displayed in the Status display
box. You can also start and stop computation from the Monitor screen.

* Recording Start/Stop
1 Inthe Operation box under the Recording item, you can select Start to start
recording, or Stop to stop recording.
2. Click the Apply button. The changed status is displayed in the Status display
box. You can also start and stop recording from the Monitor screen.

Checking Status Information
When an alarm occurs, Waiting Alarm ACK is displayed in each display box.
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3.3 System Settings

Processing and Operation

Operating Main Unit Keys
1. Select the main unit key you wish to operate from the Key Operation list.

2. Click the Apply button. The same operation takes place as if you had pressed the
main unit key.

Main Unit Key Lock
1. Select the Main unit Key Lock check box.

2. Click the Apply button.
The key operation is disabled, and “.” is displayed in the lower right of the 7-segment LED
on the main unit.

Checking the Alarm Status
1. Select the Alarm Acknowledge check box.
2. Click the Apply button. Alarm ACK executes.

P> For information on alarm ACK, see “Alarms” in section 1.3 and “Relay Excitation State / Hold
Operation” in section 1.14.

Clearing the Error Display
1. Select the Error Display check box.
2. Click the Apply button. Clears the error number displayed in the 7-segment LED.

Performing a Manual Sample / Dividing Manual Sample Files

1. Inthe Manual Sample list, select Sample to perform a manual sample, or Divide
to divide the manual sample file.

2. Click the Apply button. The selected action executes.

P> For details on manual sample: see “Manual Sample Function” in section 1.3.
P> For saving manual sample data, see “Saving Data to the CF Card” in section 1.3.

Dividing Measured, Computed, and Thinned Data Files

1. In the File Division list, select Memory Save to divide measured or computed
data files, or Memory Save (T) to divide thinned data files.

2. Click the Apply button. File division executes.

P> For information on data file division, see “File Division” under “Saving Data to the CF Card”
in section 1.3.

Turning Transmission Output ON and OFF
1. Inthe Transmission Output list, select ON to perform transmission output.

2. Click the Apply button. Transmission output executes.

Execute Communication Test
1. Select the item you wish to test from the Communication Test list.

2. Click the Apply button. The communication test executes.

P> For a description of the execution of the communication test, see “Communication Test”
under “Communication” in section 5.2.
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3.4 Setting Acquisition Conditions for Measured/
Computed Data

This is an explanation of measurement settings, MATH settings, recording settings, and
thinning settings.

Measurement Operation Settings

1. From the top screen, click System Setting > Measurement Setting.

Top > System Setting > Measurement Setting
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Apply

Measurement Group Settings

2. Select the measurement interval from the Interval list. Set a measurement
interval for each group number.

Measurement Module Settings
Sets the integral time and measurement group assignments for each module.
3. Select the group you wish to assign in the Interval Group list.
4. Select an integral time of AUTO, 50 Hz, or 60 Hz in the A/D Integration Time list.
This setting is enabled from the measurement interval.

5. Click the Apply button. The setting changes take effect.

P> For a description of the measurement interval and integration time that can be specified, see
section 2.9, “Measures Against Noise on the MW100 Data Acquisition Unit.”

Nofte
* The measurement interval that is assigned to the measurement group number is,
(interval is short) meas. group1 < meas. group2 < meas. group 3 (interval is long)
* The equivalent of three modules worth of settings are entered for the 30-CH Medium Speed
DCV/TC/DI Input Module.
* Select the same measurement group for the three measurement groups.
» Select the same integral time for the three A/D integral times.
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3.4 Setting Acquisition Conditions for Measured/Computed Data

Computation Operation Settings
From the top screen, click System Setting > MATH Setting.

Top > System Setting > MATH Setting
Interval Group 1 =
Error Data + Qver [x

Sum Scale of x
PSUM Overflowed Data Qwer =

Abnormal Input Data Errar =

Owerflowed Data Ower =

Abnormal Input Data Errar =

Owerflowed Data Error @
Apply

MATH Interval Settings

1. Inthe Interval Group list, select the interval group number. The measurement
interval is set to the interval assigned to the selected group number.

Nofte
If multiple interval groups are specifying the same measurement interval, specify the largest
number for the interval group number that you select.

MATH Operation Settings
2. Select +Over or —Over in the Error Data list.

TLOG and CLOG Computation Operation Settings
3. Select units of integration in the Sum Scale list.

4. Select Over (computation stop) or Rotate in the PSUM Overflowed Data list.

Measurement Input Settings
5. Select Error (MATH error) or Skip in the Abnormal Input Data list.

6. Select Over (handle as an overflow value), Skip, or Limit in the Overflowed Data
list.

TLOG and CLOG Input Settings
7. Select Error (MATH error) or Skip in the Abnormal Input Data list.
8. Select Error (MATH error), Skip, or Limit in the Overflowed Data list.

9. Click the Apply button. This enables the settings changes.

P> For processing upon MATH errors, see “Processing Computed Results with Abnormal Input
Values or Overflow Values” in section 1.15.
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3.4 Setting Acquisition Conditions for Measured/Computed Data

Measurement/Computation Recording Operation Settings

1. From the top screen, click System Setting > Recording Setting.

Top > System Setting > Recording Setting

e
e e e s

DIRECT Data Length 30 min x

Limit for Media Alarm 1h=

IDAQMASTEP W00 Data File Message
Apply

Set the recording operation for each measurement group.

2. Select the recording start action in the Mode list under Interval Group.
If you select Direct, steps 3 and 4 are required. If you select Trigger, steps 3 to 6 are
required.

3. Select the recording stop action in the Action list under Interval Group.

4. Select the recording interval in the Recording Interval list under Interval Group.
The recording interval is set to an integer multiple of the measurement interval. In addition,
the selectable recording interval varies depending on the measurement interval assigned to
the selected interval group.

5. Select a recording data length from the Data Length list under Interval Group.

6. Select a pretrigger length (%) from the Pre-trigger list under Interval Group.

P> For the selectable recording intervals, see “Recording of Measured/Computed Values”
under “Recorder Structure” in section 5.2.
Recording Operation Settings

7. Select a recording data length from the DIRECT Data Length list. Measurement
groups for which the recording start timing is Direct are all set to this.

8. Select the remaining space time in the Limit for Media Alarm list. When the
specified remaining amount is reached, you can have output such as relay output
occur.

P> For a description of the recording start action, see “Saving Data to the CF Card” in section 1.3.

File Message Settings

9. Enter the message to be saved to the measured/computed data file in the File
Message box.

10. Click the Apply button. The setting changes take effect.
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3.4 Setting Acquisition Conditions for Measured/Computed Data

Thinning Operation Settings

1. From the top screen, click System Setting > Thinning Recording Setting.

Top > System Setting > Thinning Recording Setting
[T 7 Bt
Eecording Interval ds -

Recording Action Single |

Data Length 30 min =

IDAQMASTER WW100 Thinning Recording Data File Megsage,
Apply

Thinning Settings

2. Select the Enable check box. Thinning recording is enabled, and you can enter
thinning recording settings.

P> For a description of the recording start action, see “Saving Data to the CF Card” in section 1.3.

Setting the Thinning Interval, Recording Operation, and Recording Data
Length

3. Select the thinning time in the Recording Interval list. A time shorter than the
measurement interval specified for the measurement group cannot be set.

4. Select a recording stop action in the Recording Action list.

5. Select a recording data length from the Data Length list.

Thinning File Message Settings

6. Enter the message to be saved to the thinning data file in the Thinning File
Message box.

7. Click the Apply button. The setting changes take effect.
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3.4 Setting Acquisition Conditions for Measured/Computed Data

Recording Channel Settings

You can set the channels to which data is recorded or thinning recorded, and the
channels set to manual sample.

1. From the top screen, click Channel Setting > Recording Channel Setting.

Top > Channel Setting > Recording Channel Setting

o2 On =l[on o
o On =l[on o
m On =l[on o
[ocs On =l[on o
o6 On =l[on o
o7 On =l[on o
[oce On =l[on o
[oos On =l[on o
pio o Sf[on [t

Apply

2. Select the channel group you wish to set from the Channel List list.

{1 R

Recording, Thinning Recording, and Manual Sample Settings
3. Turn On recording in the Recording list when recording data.
4. Turn On data thinning in the Thinning Recording list when thinning data.

5. Turn On manual sample in the Manual Sample list when recording manual
sample data.

6. Click the Apply button. The setting changes take effect.

Data Save Folder Settings

Specify the method for creating the folder in which measured/computed and thinned data
are saved.

1. From the top screen, click System Setting > Save Folder Setting.

Top > System Setting > Save Folder Setting

Meode Partial x

Folder Name ABC

Start Mumber 0000
Apply

2. Select how to create the folder from the Mode list. If you select Partial, carry out
steps 3 and 4. If you select Free, carry out step 3.

3. Enter the folder name in the Folder Name box. An error occurs if you set Mode to
Partial and Free and you do not enter the folder name.

4. Enter the start number in the Start Number box to specify the start number.
The number displayed when moving to the data save folder setting screen is the number
created next time. (If you move to the setting screen while the recording is in progress, the
number that is being created is displayed.)

5. Click the Apply button. The setting changes take effect.

P> For a description of folder mode, see “Saving Data to the CF Card” in section 1.3.
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3.5 Setting Measurement Conditions
(Measurement Channel Settings)

Setting Mode

Measurement Channel Settings
You can set the input type, range, span, and computation (linear scaling and differential
computation between channels).
The selectable input type, range, and other settings can differ depending on the module.
For details, see the explanation of the functions of individual modules in chapter 1,
“Explanation of Functions,” or chapter 5, “Specifications.”

Setting the Input Range
1. From the top screen, click Channel Setting > Al/DI Channel Setting.

= Channel Setting > AI/DI Channel Setting

WOLT = 2.0000

1760.0
RTD 1|IPHEIEI1 j‘l 2000
004 ol EILEVEL i.ll]
n0s RRJCEIR _jlll] ]
006 WOLT z“ 2y - -IfZ oono
007 WOLT EI’E oon B.000
008 WOLT ﬂl*i oono 2.0000
009 WOLT ﬂl*i oono 2.0000
010 WOLT zuﬂ-li oono

E00.0

1760.0

2.0000 1000.0 L]

30000 ke

Apply
2. Select the channel group you wish to set from the Channel List list.

Setting the Input Mode
3. Select the input type from the Mode list.

Setting the Measurement Range
4. Select the measurement range from the Range list.
Setting the Measurement Span
Determines the actual measurement range from the measurable range.
5. Enter the lower and upper limit of Span in the Lower or Upper boxes under Span.
Remote RJC (RRJC) Reference Channel Setting
This is required when RRJC is selected for the input type.

6. Enter the remote RJC reference channel number in the Ref. Ch. box.

7. Click the Apply button. The setting changes take effect.
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3.5 Setting Measurement Conditions (Measurement Channel Settings)

Computation Settings
Specify computation settings to perform linear scaling or differential computation between
channels.

1. From the top screen, click System Setting > Al/DI Channel Setting.

2. Inthe Calc list, select Scale for linear scaling or Delta for differential computation
between channels.

¢ Linear Scaling Settings

Set this item when linearly scaling the measured values.
3. Enter the lower or upper limit of scale in the Lower or Upper box under Scale.
4. Select the decimal place from the D.P. list under Scale.
5. Enter the scale conversion value in the Unit box.

» Settings of Differential Computation between Channels
6. Enter the reference channel number in the Reference box.

7. Click the Apply button. The setting changes take effect.
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3.5 Setting Measurement Conditions (Measurement Channel Settings)

Global Channel Settings

If the setting items of channels are the same, the settings of the first channel can be

applied collectively to the specified range. The setting range of channels is 001 to 060.

Be sure to meet the following conditions for the specified range.

» The first channel number is a channel number of an input module.

» The last channel number is greater than the first channel number.

» At least one of the channel numbers from an input module is included.

» The channels between the first and the last channel numbers are input modules that
have been recognized by the system.

If the modules below are connected, you can set 001 to 016 but not 001-028, because
they contain output modules. However, if the input range is set to TC in 001-016, setting
is not possible, because Four-Wire RTD Resistance Input Module channels cannot be
set.

001-004 4-CH, High-Speed Universal Input Module

011-016  6-CH, Medium-Speed Four-Wire RTD Resistance Input Module

021-028 8-CH, Medium-Speed PWM Output Module

Procedure

1. Enter the first and last channel numbers of the modules you want to set
collectively. (The figure below is an example in which channels 001 to 004 are set
collectively.)

T e S B 5o s s O
—e | —

Lower  Uppsr
[vorgferSffomm [z [or 5] I——

2. The first number is set to the default value. Change the setting.

3. Click the Apply button. The settings are applied to the specified range of
channels.
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3.5 Setting Measurement Conditions (Measurement Channel Settings)

Scale Input Methods
After selecting the number of digits after the decimal point for the upper or lower limit
value from the list, enter

the number you wish to set in the input box. If the number of digits after the decimal
place set in the input box is

larger than the specified number of digits, it will be rounded. (For example, if the decimal
place is set to 2 and
you enter a value of 95.006, it will be rounded to 95.00.)

Desired Scale

Decimal Point Position

Number Input

0.00 to 100.00 2

Lower limit: O
Upper limit: 10000

10.0 to 500.0 1

Lower limit: 100
Upper limit: 5000

—6.000t0 4.500 3

Lower limit: —6000
Upper limit: 4500

Example of a filled in screen.

Filter, Thermocouple, and Chattering Filter Settings
You can set filters, burnout, reference junction compensation, and chattering filters for
measurement channels.
» Burnout and reference junction compensation are valid when the input type is set to
thermocouple (TC).
Depending on the input module, settings can be entered even when the input type is
not thermocouple (TC), but this has no effect on measurement because the burnout
and reference junction compensation do not function.
» The chattering filter can be set on channels included on the 10-CH Pulse Input Module.

« Afilter coefficient cannot be set with the 10-CH, High-Speed Digital Input Module.

From the top screen, click Channel Setting > Filter, Burnout, RJC Setting under the

Top item.

Example of thermocouple input

Example of pulse input

Top > Channel Setting > Filter, Burnout, RJC Setting
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|

Top > Channel Setting > Filter, Burnout, RJC Setting
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Apply

Setting the Filter Coefficient
1. Select a coefficient in the Filter list.

2. Click the Apply button. The setting changes take effect.

P> For information on filter coefficients, see “First-Order Lag Filter” in section 2.9.

Apply
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3.5 Setting Measurement Conditions (Measurement Channel Settings)

Setting the Burnout

1. Select the direction in which the measured value is set off the range when a
burnout detection occurs from the Burnout list.

2. Click the Apply button. The setting changes take effect.

P Fora description of the burnout detection behavior, see “Burnout” in section 1.3.

Reference Junction Compensation

1. Select the type of reference junction compensation in the Type box under RJC.
2. Enter a reference junction compensation voltage in the Voltage[uV] box. Set
when reference junction compensation is set to External.

3. Click the Apply button. The setting changes take effect.

P> For the setting range of the RJC, see “RJC” in section 5.2.

Chattering Filter Settings

1. In the Chattering Filter list, turn ON the channels on which to apply the chattering
filter.

2. Click the Apply button. This enables the settings changes.

P> For information on the chattering filter, see “Filter” in section 1.9.

Setting Up and Executing Strain Input Initial Balancing

If the measurement channel is strain input, you can enter settings for executing initial
balancing. This setting is allowed even if the measurement channel is something other
than strain input, but has no effect in that case.

1. From the top screen, click Channel Settings > Strain Input Setting.

Top > Channel Setting > Strain Input Setting
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Apply

Select the channel group you wish to set from the Channel List list.

Turn On the channel on which you wish to perform initial balancing in the Initial
Balancing list.

4. Click the Apply button to finalize.
5. Execute the Initial Balancing item under Other Settings in the system settings.

Lol

P> For execution of initial balancing, see processing and operation under “Other Settings” in
section 3.3.

P> For a description of initial balancing, see “Initial Balancing (Unbalance Adjustment)” in
section 1.8.
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3.6 MATH Settings (MATH Channel Settings and

the /M1 Option)

Setting Mode

You can set the MATH operation, expressions, MATH span, MATH coefficients,
and MATH groups. This section also explains settings for program channels and
communication input data.

Even if the MATH function (/M1 option) is not included, channels included on the 10-CH

Pulse Input Module are only available for integration (TLOG.PSUM).

Entering Expressions

1. From the top screen, click Channel Setting > MATH Channel Setting.

Top > Channel Setting > MATH Channel Setting

for_[oncomeie  [esjpm [ I
A0z [ =] [oo+-0n3 2 =] om0 100.00
A0 [ = [anuiyAne 1 =] [ons 1000
o[ =] | |

pns_ [ = | |

pne_ [0 =] | |

| | |

e[ =] | |

s [ =] | |

ot [ = | |

_beely |

2. Select the channel group you wish to set from the Channel List list.

Setting the MATH Operation
3. Turn ON the MATH channels to be used in the Action list.

Entering Expressions

4. Enter an expression in the Formula box.

P> For information about expressions, see section 1.15, “MATH Functions (/M1 Option).”

Setting the MATH Span

The method to enter the span value is the same as the method to enter the scale of a

measurement channel.

5. Enter the lower or upper limit of the MATH span in the Lower or Upper box under

Span.

6. Select the decimal place from the D.P. list under Span.

7. Enter the scale conversion value in the Unit box.

P> For the procedure to enter the scale, see “Setting the Scale” in section 3.5.

8. Click the Apply button. The setting changes take effect.
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3.6 MATH Settings (MATH Channel Settings and the /M1 Option)

Global Expression Setting
If the expression to be assigned to the MATH channels is the same, you can collectively
apply the settings of the first channels to the specified range of channels. The range
for specifying the expression is AO01 to A300. Set the last number greater than the first
number.
The operating procedure is the same as the global setting the measurement channels.

P> For a description of the global setting of channels, see “Global Channel Settings” in section

3.5.

Setting MATH Constants

1.

2,
3.
4,

From the top screen, click Channel Setting > MATH Constant Setting.

Top > Channel Setting > MATH Constant Setting

K01 1

K02 200

K03 35

K04 1.2346E-5

[ 1

0B

K07

K09

1
1

os |1
1

ko |1
Apply

Select the constant group you wish to set from the Constant List list.

Enter a constant in the Constant List list.

Click the Apply button. The setting changes take effect.

P> For a description of the MATH constants, see section 1.15, “MATH Function (/M1 Option)”

Setting MATH Groups

1.

and “MATH Function Specifications (/M1 Option)” in section 5.2.

From the top screen, click Channel Setting > MATH Group Settings.

Top = Channel Setting > MATH Group Setting

WI

ADOT-A010

ADT1.ADT3ADTEANT

ADO1

ADO1

ADO1

ADO1

=== ==

ADO1

Apply

Enter the channel numbers to be grouped in the Channel Set box.

Specify channel numbers by delimiting them with dots as in A001.A003.A006, or
specify a range as in AO04-A008.

Click the Apply button. The setting changes take effect.
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3.6 MATH Settings (MATH Channel Settings and the /M1 Option)

Program Channel Settings

1. From the top screen, click Channel Setting > Program Channel Setting.

Top > Channel Setting > Program Charmel Setting

Mo  Action Pomfs
Fo1 Single ~|||(0.0),(10.500),(20.500),(30.800),(40.800),(50.0), {-1.0)

Pz [Repeat =]|[i0.0) (10 2025 0)450 011 0)
Pos Jor |

Apply

2. Select Single or Repeat in the Action box for the program channel number you
wish to use.

3. Enter the elapsed time and setting value in the Point Set box.

4. Click the Apply button. The setting changes take effect.

P> For a description of the syntax of broken line data, see “Reference Channels” in section 1.15.
P> For a description of the broken line data, see appendix 7, “Using the Broken Line Data.”

Rolling Average Settings

1. From the top screen, click Channel Settings > Rolling Average Setting under
the Top item.

Top > Channel Setting > Rolling Average Setting

IS [ 7o

Mo Action Dervll  Mumberofsamplss
lA001 E 2z A IW—I
002 On z'l 125 z'IS

JA003 off z'l Z'I

|00 off z'l Z'I

JA005 off z'l Z'I

LA00E off z'l Z'I

L0007 off z'l Z'I

L4005 off z'l Z'I

JA009 off z'l Z'I

2010 or = Z|_|I

_ Ay |

Select the channel group you wish to set from the Channel List list.

3. Inthe Action list, select On to enable the long term moving average, or Off to
disable it.

4. Select the sampling interval from the Interval list.
Set a multiple of the MATH interval.

5. Enter the number of samples for the moving average in the Number of samples
box.

6. Click the Apply button. This enables the settings changes.

P> For information on rolling averages see “Rolling Average” in section 1.15.
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3.6 MATH Settings (MATH Channel Settings and the /M1 Option)

Setting Mode

Communication Input Data Settings

1. From the top screen, click Channel Settings > COM Input Channel Setting.

Top > Channel Setting > COM Input Channel Setting

conz 1.2345E-5

=]

=1

=1

=
=1=1=1=1===

Apply

2. Select the channel group you wish to set from the Channel List list.

3. Enter the communication input data value in the Input Value box. For the range
of available communication input values, see chapter 5, “Specifications.”

4. Click the Apply button. The setting changes take effect.

P> For the range of communication input data values, see “MATH Function Specifications (/M1
Option)” in section 5.2.
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3.7 Setting Alarms

You can set the alarm type, alarm value, hysteresis, and output operation. Only the alarm
value can be changed while the recording is in progress.

P> For a description of alarm types, see “Alarms” in section 1.3.

Setting Mode

Meas. Mode

Alarm Setting (Al/DI)

You can set measurement channel alarms.

1. From the top screen, click Channel Setting > Alarm Setting (Al/DI).

Top > Channel Setting > Alarm Setting (AL/DI)

II1 Ejllw 0000 02000 ﬂjlluzw
[ [or=l |
[ [or=l |
[z =] [aonio o =
|2 IS | T o =
[ [or=l |
[ [or=l |
foos [ [on =] |
[ [or=l |
[ [or=l |
[ [or=l |
o4 [ [or =] |
[ [or=l |
[ [or=l |
[ [or=l |
s |[1 ot = | =]
[ [or=l |
[ [or=l |
F—Jon =] |
Apply

2. Select the channel group you wish to set from the Channel List list.

Alarm Settings

3. Select the alarm type from the Level list.
To use the upper (rH) or lower (rL) limit on rate-of-change alarm, you must set the rate-of-
change interval.
To use the delay upper (tH) or lower (tL) limit alarm, you must set the delay alarm.

4. Enter an alarm value in the Value box.

5. Enter a hysteresis value in the Hysteresis box.

P> For the procedure to set the rate-of-change interval, see “Other Settings” in section 3.3.
P> For the procedure to set the delay alarm, see “Delay Alarm Setting” in this section.

Output Settings
6. Turn output On/Off in the Action box.
7. Enter an alarm output channel in the Relay box.

8. Click the Apply button. The setting changes take effect.
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3.7 Setting Alarms

Alarm Setting (MATH)

You can set MATH channel alarms.

Delay Alarm Setting

1.

From the top screen, click Channel Setting > Alarm Setting (MATH).

Top > Channel Setting > Alarm Setting (MATH)

Oupwt
Type Vabe  Acion Rely
on =] [or
L =f[oon of =
ot = |

x|
H_=l[iz00

Below, enter settings in the same manner as with measurement alarms. With
MATH alarms, there is no hysteresis setting.

Set the delay time for using the delay alarm.

From the top screen, click Channel Setting > Delay Alarm Setting.

Top > Channel Setting > Delay Alarm Setting

Mo  Tmels]
T

jon2 B0
o0z
o0
jo0s
jO0E
joo7
jo0s
jo0g
010

Apply

In the Channel List list, select the channels you want to set.

1
1
1
1
1
1
1
1

Enter the delay time in the range of 1 to 3600 (s) in the Time box of the channel
number you want to set. Set the time so that it is an integer multiple of the
measurement or MATH interval.

Click the Apply button. The setting changes take effect.
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3.8 Digital Output Settings

Setting Mode

Relay Settings

You can set the operation type, excitation status, hold, operation, reflash, error preset*,
and stop preset*.
*  Firmware version R3.03 or later

1. From the top screen, click Channel Setting > DO Channel Setting.

Top > Channel Setting > DO Channel Setting

Mo  Kid  Energee

——ae A A g g a
I T | ] — |
T | o [ s |
| 1 o o s |

Apply

2. Select the channel group you wish to set from the Channel List list.

Relay Output Factor Settings

3. Select Relay output factor from the Type box.
If you select Alarm, you must set Energize/De-energize, hold, operation, and re-alarm. If you
select Comm.Input (Manual DO), you must set Energize/De-energize.

Energize Setting

4. Select Energize or De-energize in the Energize list.

P> For a description of energize and de-energize, see “Relay Excitation State/Hold Operation”
in section 1.14.

Hold, Action, and Reflash Settings
5. To set the relay status to Hold in the Hold list, select On.
6. Select a relay operation condition in the Action list.

7. Select Off in the Reflash list to perform the reflash function.

P Fora description of the reflash alarm, see “Reflash Function” in section 1.14.

Preset Output upon Error (Firmware version R3.03 or later)

8. Inthe Error Preset box, select Off, Open, or Close. The preset value is output
to the DO channel if an error occurs on a measurement or MATH channel set for
alarm DO. If set to Off, operation occurs per the standard specification.

Preset Output upon Stop (Firmware version R3.03 or later)

9. In the Stop Preset box, select Off, Open, or Close. The preset value is output if
measurement stop or computation stop is executed on a DO channel.

10. Click the Apply button. The setting changes take effect.
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3.9 Analog/PWM Output Settings

Output Range Settings (Analog Output)

You can set the output type, action, range, span, preset value, and reference channel.
1. From the top screen, click Channel Setting > AO/PWM Channel Setting.

Top > Channel Setting > AQ/PWM Channel Setting

Lower
AD =] [Trans =[[1o0v_=[Fraoon

e [an =f[Tans =f[rov <] om0 10000 1.000 02
s [a0 =f[Tens =f[rov <] oo 10000 1.000 003
4 [a0 =f[Tens =f[rov <] oo 10000 1.000 04

b5 [a0 =f[Trans =] [e0ma ][00 20000 1.000 005

b4 [a0 =][Trans =] [e0ma ][00

a7 [an =] [Gomm npur =] [T0v =] [-iaao0

i4a_[An =] [Somm npur =] [T0v =] [-iaao0
o 0 H

Apply

2. Select the channel group you wish to set from the Channel List list.

Output Types
3. Inthe Mode box, select AO to output or SKIP to not output.

Output Action Setting

4. Select Trans (transmission output) or Comm.Input (arbitrary output) in the Action
box.

Output Range Settings
5. Select 10 V (voltage output) or 20 mA (current output) in the Range box.

Span Setting
Select the actual output range from the allowed output range.

6. Enter the lower limit of span in the Lower box under Span. Also, enter the upper
limit value in the Upper box.
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3.9 Analog/PWM Output Settings

Preset Value

7. Inthe Preset Value box, enter a preset value for the output operation when
turning on the power or when an error occurs. When a preset value is selected in
the output operation settings, the specified value is output.

P> For the procedure to set the output operation, see “Output Operation Settings” in this
section.

P> For a description of preset values, see “Output upon Startup and Error Occurrence” in
section 1.13.

Reference Channel Settings
This is set if TRANS is selected for the output action.

8. Enter an input channel or MATH channel for transmission output in the Reference
Channel box.

9. Click the Apply button. The setting changes take effect.

Output Range Settings (PWM Output)

You can set the output type, action, range, span, pulse interval, preset value, and
reference channel.

1. From the top screen, click Channel Setting > AO/PWM Channel Setting.

Top > Channel Setting > AQ/PWNM Channel Setting

Lower  Upper |
Pk =] [Trans =] [1ms =] [200 30000
143 Pkt =] [Trans =] 10 ms =] [1i.000 100000 10 10.000 103
144 Pkt =] [Trans =] [0 ms =] [20.000 100000 20 0000 04
045 Pkt =] [Trans =] 10 ms =] [1i.000 100000 10 10.000 105
145 Pkt =] [Trans =] 10 ms =] [1i.000 100000 10 0000 106
47 P =] [ Carnm nput =] 16 me =] [o 000
48 P =] [ Carnm nput =] 16 me =] [o 000 100,000 i 0000
o |
=] HHI

100.000 1 0.000

Apply

r_osressedbn fom [ bw

Apply

2. Inthe Channel List list, select the channels you want to set.

Output Type
In the Mode box, select PWM to output or SKIP to not output.

Output Action Settings
Select Trans (transmission output) or Comm.Input (arbitrary output) in the Action box.
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3.9 Analog/PWM Output Settings

Setting the Pulse Resolution

5. Select the pulse resolution in the Range box.

Span Setting
Select the actual output range from the allowed output range.

6. Enter the lower limit of span in the Lower box under Span. Also, enter the upper
limit value in the Upper box.

Pulse Interval

7. Inthe Pulse Interval box, enter a coefficient that determines the pulse interval.

P> For a description of the pulse interval coefficient, see “Pulse Interval” in section 1.12.

Preset Value

8. Inthe Preset Value box, enter a preset value for the output operation when
turning on the power or when an error occurs. When a preset value is selected in
the output operation settings, the specified value is output.

P> For the procedure to set the output operation, see “Output Operation Settings” in this
section.

P> For a description of preset values, see “Output upon Startup and Error Occurrence” in
section 1.13.

Reference Channel Settings
This is set if Trans is selected for the output method.

9. Enter an input channel or MATH channel for transmission output in the Ref.
Channel box.

10. Click the Apply button. The setting changes take effect.

Global Channel Settings
If the setting items of channels are the same, the settings of the first channel can be
applied collectively to the specified range. The setting range of channels is 001 to 060.
The specified range of channels must be analog output modules only or PWM output
modules only.

P> For a description of the global setting of channels, see “Global Channel Settings” in section
3.5.
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3.9 Analog/PWM Output Settings

Output Operation Settings

You can set the operation upon power ON, or when an error or a stop occurs.

P> For a description of the behavior at power-on, error occurrence, and stopping, see “Output
upon Startup, Error Occurrence, and Stopping” in section 1.13.

1. From the top screen, click System Setting > AO/PWM Preset Setting.

Top > System Setting > AO/PWM Preset Setting

Last

= Lot =]
fea st =]
045 Preset ﬂ

I —

Apply

2. Select the channel group you wish to set from the Channel List list.

Setting the Power ON Operation

3. Select Last or Preset in the Power ON list under Preset Value.
When Preset is selected, the specified value is output in the output range setting screen.

Setting the Operation upon Error Occurrence

4. Select Last or Preset in the Error list under Preset Value.
When Preset is selected, the specified value is output in the output range setting screen.

Setting the Operation upon Stop (Firmware version R3.03 or later)

5. Inthe Stop box, select Last (previous value) or Preset (preset value). When a
Stop occurs, the value per the selected operation is output.

6. Click the Apply button. The setting changes take effect.
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3.9 Analog/PWM Output Settings

Transmission Output Control

Turning Transmission Output On and Off for Analog Output/PWM Output
This is set if Trans is selected for the output action in the output range settings.

1. From the top screen, click Channel Setting > Transmission Output Control.

Top > Channel Setting > Transmission Output Contral

Wo  Oupn
041 On x

=]
=
N
=]
E

=]
=
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E

=]
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=
=]
E
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=
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=]
E

=]
=
=
=]
E

=]
=
@
=]
E

[ /RS [ [E ] WA /R[N [[E

Apply

Select the channel group you wish to set from the Channel List list.
3. Select On or Off in the Output list of the channel number you wish to set.

4. Click the Apply button. Starts transmission output on channels set to On.
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3.10 Event/Action Settings

By linking the Event function and Action function, you can control the operations of the
MW100.

P> For setting examples of event action, see appendix 3, “Using the Event Action.”

Setting Mode

1. From the top screen, click System Setting > Event/Action Setting.

Top > System Setting > Event/Action Setting

Mo  Fwemi  Chamel  Deleofon Acion  Flg |
e o e
o — o = | e
e =
|[os Alamn Channel =] [i01 Zl[Edee =l[Faa  =[JF0l
e = | s
e =
L =
o o s
I of = = = | ]

Apply

2. Select the number group of the Event / Action you wish to set from the list.

Selecting the Event Type

3. Select the event (event function) type in the Event list of the number you wish to
set. Depending on this setting, the Channel box may become enabled, meaning
that the settings in steps 2 and 3 are required.

4. In the Channel box, enter the number (channel number, relay number, etc.) for
the event selected in the event type selection in step 1.

5. If the event type is Alarm Channel, select the alarm level number for the event in
the Channel box.

Selecting the Event Detection Method

6. Select the event detection method from the Detection list. The action (action
function) that can be selected varies depending on the item selected for the
detection method.

P> For the event types, see “Event Action Function” in section 1.3.

Selecting the Action Type

7. Select the action (Action function) type from the Action list. If Flag is selected for
the action, the Flag box is enabled, meaning that the setting in step 8 is required.

8. Enter a flag number in the Flag box.

P> For the action types, see “Event Action Function” in section 1.3.

9. Click the Apply button. The setting changes take effect.
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3.11 Timer and Match Time Settings

The time up action function can be controlled through the specified time interval and time.

P> For a description of the timer and match time, see “Timer” or “Match Time” in section 1.3.

Setting Mode

Timer Settings

From the top screen, click System Setting > Timer Setting.

Top > System Setting > Timer Setting

Absolute JII 11
- -
- -
- -
- -

Apply
Relative Time Timer
1. Select Relative in the Mode list.

2. Enter the desired time interval in the Relative Time boxes. The day, hour, and
minute are arranged in order from the left.

3. Click the Apply button. The setting changes take effect.

Absolute Time Timer
1. Select Absolute in the Mode list.

2. Enter the desired reference time in the Ref. Time boxes under Absolute Time.
The hour and minute are in order from the left in the box.

3. Select the time interval you wish to set in the Interval list under Absolute Time. M
and H indicate the minute and hour respectively.

4. Click the Apply button. The setting changes take effect.
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3.11 Timer and Match Time Settings

Setting the Match Time

From the top screen, click System Setting > Match Time Setting.

Top > System Setting > Match Time Setting

Mo  Mode MackTae
1

[ern ][ JF_Jre B
g week [sw =[] e Wfs |
o - -
Apply
Monthly Timeup
1. Select Month in the Mode list.

2. Enter the desired date and time in the Time list. The day, hour, and minute are
arranged in order from the left.

3. Click the Apply button. The setting changes take effect.

Weekly Timeup
1. Select Week in the Mode list.

2. Select a day of the week from the Time list, and enter the desired time in the
Time box. Enter the hour and minute in the second and third box from the left,
respectively.

3. Click the Apply button. The setting changes take effect.

Weekly Timeup
1. Select Day in the Mode list.

2. Enter the desired time in the Time box. Enter the hour and minute in the second
and third box from the left, respectively.

3. Click the Apply button. The setting changes take effect.
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3.12 Report Settings (/M3 Option)

You can enter settings for creating report files.
P> For details on the report function, see section 1.16, “Report Function (/M3 Option).”

Setting Mode

Report Operation Settings 1
1. From the top screen, click System Setting > Report Setting 1 under the Top

item.

Report Function [ Enable
Record Start ¥ Reset

Creation Date and Time
Dadly Report P mw
Weeldy Report m
Monthly Report |1_

Report Data
Abnormal Input Data lm
Overflowed Data m

Apply

Enabling and Disabling the Report Function

2. Select the Report Function check box. The report function is enabled, and you
can enter settings for the report function.

Resetting When Recording Starts

3. Select the Record Start check box. When recording starts, the Maximum,
Minimum, Average, and Integral values are reset.

Report File Creation Time Setting

4. Enter the time to update the daily file in the Daily Report box.
Time is specified in 24-hour format. The creation time for weekly and monthly report files is
the same as the creation time for the daily report files.

5. Select the day of the week to create the weekly report file in the Weekly Report
list.

6. Enter the date on which to create the monthly report file in the Monthly Report
box.
The date is specified in the range from 1 to 28 days.
Abnormal Input Processing Setting
7. Select Error or Skip in the Abnormal Input Data list for Report Data.

Overflow Processing Setting
8. Select Error, Skip, or Limit in the Overflow Data list for Report Data.
9. Click the Apply button. This enables the settings changes.

P> For processing upon abnormal input or overflows, see “Processing Reports with Abnormal
Input Values or Overflow Values” in section 1.16.
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3.12 Report Settings (/M3 Option)

Report Operation Settings 2

1. From the top screen, click System Setting > Report Setting 2 under the Top
item.

Top > System Setting > Report Setting 2

Ne.  Acton  Chamel  SmSede Umt
o1 fon Elpor Peec Elkes |
2 an =] [+001 thour =] 3

& or | =]

s or | =]

s or | =]

o6 or | =]

o7 or | =]

e or | =]

& or | =]

0 or | =]

Apply

2. Select the number of the group for which you wish to set the Report from the list.

Setting Channels for Creating Reports
3. Select ON in the Action list of the number you wish to set.

4. Enter the channel numbers used to create reports in the Channel boxes.

Setting the Sum Scale and Display Units

5. Select the unit time from the Sum Scale list.
P> For the unit time, see “Sum Scale of the Integral Value” in section 1.16.

6. Enter the units for displaying the integral value in the Unit box.

7. Click the Apply button. This enables the settings changes.
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3.13 Starting and Stopping Measurement,
Computation, and Recording

This is an explanation of the procedure for starting and stopping measurement,
computation, and recording. These operations can be performed by pressing keys on the
MW100 main module, or from a browser.

The state transition diagram of the MW100 is given below.

Setting .
Setting Mode

A
STOP START
Y

Measurement |

A

Y

Computation*

+ Measurement Mode

STOP START i

Hold down Hold down STOP TART

Hold d Hold d (sToP) (START)
v Hold down Hold down

for2s for2s

Recording | g

* On models with the /M1 option
or when the 10-CH Pulse Input Module is installed

Starting and Stopping Measurement

Using Main Module Keys

¢ Starting Measurement
While measurement is stopped, briefly press the START key. Measurement starts
and the unit switches to Measurement mode.

¢ Stopping Measurement
While recording and computation are stopped, briefly press the STOP key.
Measurement stops and the unit switches to Setting mode.

Using a Browser
e Starting Measurement
In the Status table in the top screen, select Start from the Operation list under the
Measurement item. Measurement starts and the unit switches to Measurement mode.
* Stopping Measurement
In the Status table in the top screen, select Stop from the Operation list under the
Measurement item. Measurement stops and the unit switches to Setting mode.
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3.13 Starting and Stopping Measurement, Computation, and Recording

Starting and Stopping Computation

This operation is available when the MATH function (/M1 option) is included, or when the
10-CH Pulse Input Module is installed. You can use the function when MATH channels
are set.

Neither the computation start nor the computation stop operation can be done while
recording MW100. It is possible to operate it from the Event/Action function and a
browser. However, even if computation start/computation stop is set by the Event/Action
function, it is disregarded while MW100 is not recording.

Using Main Module Keys

¢ Computation Start
While recording is stopped, and during measurement, briefly press the START key.
Computation starts.

e Computation Stop
During computation, and while recording is stopped, briefly press the STOP key.
Computation stops.

Using a Browser (in the Setting Screen)

The main module can be switched to Measurement mode. This is done while recording is

stopped.

» Starting Computation
In the Status table in the top screen, select Start from the Operation list of the MATH
item. Computation starts.

» Stopping Computation
In the Status table in the top screen, select Stop from the Operation list of the MATH
item. Computation stops.

You can also start or stop the computation from the Monitor screen.

P> For the procedure to start or stop the computation in the Monitor screen, see section 3.16,
“Measured Data Monitor Display/Settings.”

Starting and Stopping Recording

Using Main Module Keys

e Starting Recording
During measurement, hold down the START key for two or more seconds. Recording
starts.

¢ Stopping Recording
During recording, hold down the STOP key for two or more seconds. Recording stops.

Using a Browser (in the Setting Screen)

The main module can be switched to Measurement mode.

» Starting Recording
In the Status table in the top screen, select Start from the Operation list of the
Recording item. Recording starts.

¢ Stopping Recording
In the Status table in the top screen, select Stop from the Operation list of the
Recording item. Recording stops.

You can also start or stop the recording from the Monitor screen.

P> For the procedure to start or stop the recording in the Monitor screen, see section 3.16,
“Measured Data Monitor Display/Settings.”
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3.13 Starting and Stopping Measurement, Computation, and Recording

Checking the Operating Status of the MW100 Using the Status Indicators

You can confirm the operational status of the MW100 by viewing the status indicators on
the front panel.

MEASURE

Behavior Color Indication

Off - Setting mode

On Green Measurement mode

RECORD

Behavior Color Indication

Turning Off -- Recording stopped

On Green Recording

Blinking Green Transitioning from recording to recording stop
ALARM

Behavior Color Indication

Turning Off - No alarm

On Red Alarm active or alarm hold

MATH

Behavior Color Indication

Turning Off -- Computation stopped

On Green Computing

Blinking Green Transitioning from computing to computing
stopped
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3.14 Network Utility Settings

Setting Mode

DNS Client Settings

FTP Client Settings

© N o o

9.

From the top screen, click Communication Setting > DNS Client Setting.

Top > Communication Setting > DNS Client Setting

DS Server

Priuay [EA A RT—
Secondary W
Domain Suffiz
Primary |daqma5ter.cum
Secondary |
Apply

In the Primary and Secondary boxes under DNS Server, enter the IP addresses
of the respective DNS servers.

In the Primary and Secondary boxes under Domain Suffix, enter the domain
name.

Click the Apply button. The setting changes take effect.

From the top screen, click Communication Setting > FTP Client Setting.

Top > Commumication Setting > FTP Client Setting

FTP Client Function ¥ Enable
Time Shift T wi
FTP Server m
Server |ﬂp.daqmaster.cum
Port ,21—
Tser W
Password = W
Directery Ifdata
PASV Mode I~ Enable
Apply

Select the Client function check box to enable the function.

Enter the delay (in minutes) from file creation to file transmission start in the Time
Shift box.
Set the delay time shorter than the recording data length.

Select the number of the destination to be set in the Destination list.
You can set up to two destinations. Number 1 is primary and number 2 is secondary.

Enter the FTP server name in the Server Name box.
Enter the FTP server port number in the Port Number box.
Enter the user name of the FTP server in the User Name box.

Select the Password check box, and then enter the user password in the
Password box.
If you do not select the check box, you cannot enter the password.

Enter the folder to be accessed when opening a connection in the Directory box.

10. You can select the PASV Mode check box to use FTP passive (PASV) mode.
11. Click the Apply button. The setting changes take effect.
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3.14 Network Utility Settings

Mail Client Settings

These settings configure the e-mail function. The setting screen contains mail client
setting 1 and mail client setting 2.

Mail Client Setting 1

1.

No o kowDd

From the top screen, click Communication Setting > Mail Client Setting 1.

Top > Commumication Setting > Mail Client Setting 1

Server |sm|p dagmagter.com

Port 25

Server |pup3 dagmaster.com

Fort 110

Tser mw100user

Password [ |enensnenes
Anply

Select the SMTP Client Function check box. This enables e-mail transmission.
Enter the name of the SMTP server in the Server Name box under SMTP Server.
Enter the SMTP server port number in the Port box under SMTP Server.

Enter the name of the POP3 server in the Server box under POP3 Server.

Enter the POP3 server port number in the Port box under POP3 Server.

To require authorization (POP before SMTP) when sending e-mail, select POP3 in
the Authorization list, or if SMTP Authentication’ is required, select AUTH. This
enables entry of the Authorization items.

* Firmware version R3.02 or later

Enter the name for logging into the POP3 server in the User box under
Authorization.

Select the Password check box under Authorization, and then enter the
password for accessing the server in the Password box.
If you do not select the check box, you cannot enter the password.

10. Click the Apply button. The setting changes take effect.
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Mail Client Setting 2

1.

10.

1.

12,

13.

14.

From the top screen, click Communication Setting > Mail Client Setting 2.

Top > Communication Setting > Mail Client Setting 2

Mallleader
Subject [wr100 ALARM
Sender |mWTDDusar@daqmaslercnm
Recipient 1 [rw100user2@dagmaster.com
Recipient 2 [rw100userd@dagmaster.com
P !
Alarm Channel Set [o01-003.008
Instantancous Data W Attach
Type T Howly W Daily [T Weekly [ Monthly
Content M Max ¥ Min M Ave ¥ 3um [ Inst
| Fle Creation Wotiication [ 1
Meda Alam Notcaion  [2 <]
[Power Falure Mosiication | [T -]
(SR T2
[ [ o2
Interval 24 7|h
Ref Time lIJ— - ,EI—
Instantaneous Data I Attach
Apply

Enter the subject of the e-mail in the Subject box under Mail Header. Up to thirty-
two alphanumeric characters can be input.

Enter the sender mail address in the Sender box.

Enter the recipient address in the Recipient 1 box. Enter the address for
Recipient 2 in the same manner. You can specify multiple addresses for each
recipient. Separate each address with a space. You do not have to set both
recipients. Use up to 150 alphanumeric characters.

To set up alarm notification, select an address for alarm notification in the Alarm
Notification list. 1 and 2 sends notification to both recipient 1 and 2.

Enter an alarm notification channel in the Alarm Channel Set box under Alarm
Notification. To add instantaneous values, select the Instantaneous Data check
box. Specify channel numbers by delimiting them with dots as in 001.003.005, or
specify a range as in 004-008.

To attach instantaneous values, select the Instantaneous Data check box.

For notification of reports, select a destination address for notification in the
Report Notification list.
1 and 2 sends notification to both recipient 1 and 2.

Select the check boxes corresponding to the Type of reports for which to send
notification under Report Notification.

Select the Content check box corresponding to the type of data with which to
send notification under Report Notification.

To set up notification of data file creation, select a notification address in the File
Creation Notification list.

In the same manner as in step 7, set Media Alarm Notification , Power Failure
Notification , and System Error Notification.

To set up Periodic Report notification, select an address for notification in the
Periodic Report list.

Select transmission interval time from the Interval box under Periodic Report.
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3.14 Network Utility Settings

15. Enter a reference time for the send interval in the Time box under Periodic
Report.

16. To attach instantaneous values to Periodic Report, select the Instantaneous
Data check box.

17. Click the Apply button. The setting changes take effect.

Time Synchronization Client Settings
Enter these settings to automatically synchronize the time.

1. From the top screen, click Communication Setting > SNTP Client Setting.

Top > Communication Setting > SNTP Client Setting

Server |5n|p.daqma5ter.|:um
Port 123
Ref Time i 00
Interval 12h >

Apply

Select the SNTP Client Function check box to enable the function.
Enter the name of the NTP/SNTP server in the Server box under SNTP Server.
Enter the NTP/SNTP server port number in the Port box.

Enter a reference time to be queried Ref.Time box under Query Action. Next,
select a query time interval in the Interval list.

o e

6. Click the Apply button. The setting changes take effect.
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Server Settings

These settings enable the various server functions.

1. From the top screen, click Communication Setting > Server Setting.

Top > Communication Setting > Server Setting

Timeout IW— min.
[Serverbrocess
Modbus Delay Response Off hd
Sewerlst
Sewer  Adon Pet
MODBUS HIEDE—I
TP on <[
HTTP On EIED
SNTP On EIW 23
GENE On Elﬁdm 8
DIAG On 3’“3431 7

Apply

Keep Alive Function
2. Select the TCP Keep Alive check box to to enable the keepalive function.

P> For a description of the keepalive function, see “Communication” in section 5.2.

Communication Timeout Function

2. Select the Application Timeout check box to enable the application timeout
function when connecting to the MW100-specific communication (GENE) server.

3. Enter the timeout value for the connection to the GENE server in the Timeout
box.

Server Process

2. Select a delay time in the Modbus Delay Response list.

Server List Settings

4. To use a server, turn it On in the Action box of the corresponding server name.
The HTTP server is always turned On.

5. Enter the port number used by the server in the Port box. Normally, you can use
the default setting.

P> For a description of each server, see “Communication” in section 5.2.

6. Click the Apply button. The setting changes take effect.
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3.15 Saving and Loading Setup Data

You can save and load MW100 main unit settings. The setup file is stored in the CONFIG
folder of the CF card.

P> For the settings that are saved and loaded, see “Saving Data to the CF Card” in section 1.3.

Saving and Loading Setup Data

From the top screen, click System Setting > Save/Load Setup Data.

Top > System Setting > Save/Load Setup Data

Setup File

Operation - =

File List 06/01/01 23:39 mwsetl]
06/01/01 2339 mwsetd2
06/01/01 2340 mwsetld
06/01/01 2340 mwsetld
DB/01/01 2340 mwsetls

File Mame

Save/Load

Saving Settings
1. Select Save in the Operation list.

2. Enter a file name in the File Name box, then click the Save/Load button.The
extension cannot be input (it is fixed at PNL). If you enter an existing file name,
the existing file is overwritten.

Loading Settings
1. Select Load in the Operation list.

2. Enter a file name in the File box, then click the Save/Load button.

Setup Data Save Conditions
1. From the top screen, click System Setting > Save Option Setting.

Top > System Setting > Save Option Setting

Save Option

Channel Settings @ Save

Eecording Settings ¥ Save

Communication Settings ¥ Save

Other Settings ¥ Save
Arply

2. Select the settings you wish to save by selecting the Channel Settings,
Recording Settings, Communication Settings, and Other Settings check
boxes.

3. Click the Apply button. The setting changes take effect.
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3.16 Measured Data Monitor Display/Settings

You can monitor-display data measured on the MW100.
The available screen formats are Single Screen, Dual Screen, Lite Monitor*, and Data
View.
Single Screen and Dual Screen: You can select trend display, numerical display, meter
display, bar graph display, or overview display.
Lite Monitor : Use this for digital display.
Data View: You can select alarm summary, manual sample, or report display.
* Firmware version R3.03 or later

Monitor-Display of Measured Data

The measured data is displayed in single screen or dual screen. The next the display
is shown, the display is shown in the previous condition (you must enable the browser
cookies).

Single Screen
Use this when the monitor contains a single screen. You can display one group.
From the top screen, click Single Screen.

Top > Monitor - Single Screen
»> [ ] [ ] ] k) Cutput Ghannel r P W ALARM
Fiec Stop Pause  Alarm Ack 0o i o REC
Math Reset Math Glear @ m MATH

[Group] - [Grouptt = [Free =][Message = B [ BB i
100 msee SIEINrRAEEE

A 00 <27E1237568- - RE.0M @ 2@ 3@ @ RE
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3.16 Measured Data Monitor Display/Settings

Dual Screen
Use this when the monitor contains two screens. You can display two groups.
From the top screen, click Dual Screen.

Top > Monitor - Dual Screen

» [ ] [ ) ] “3 Output Ghanne! 4 Room-3 > mALARM
Rec Stop Pause  Alarm Ack A0 NN 4 250V v R
Math Reset Math Glear @  MATH
[Free =][message Ei I

[Group] : [Groupti =] [ee]z]m] [ Cronp] [Grouplz =
100 mses @l & & |1 [l 'n |H = S| 100 mse:

5 dh:an -
500 msec @ QLm0 H=o

MA00 <27E123758= - R0
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3.16 Measured Data Monitor Display/Settings

Explanation of Display Iltems
This is an explanation of the icons and measured data display items used in the monitor
screen.

Switching the Operation Icons

Switch to small
Top > Monitor - Dual Screen @ operation icons
» [ | ® 9 Output Charnel Roor-01 » malsRM  You can switch from
Rec Stop Pause  Alarm Ack a0 WEEEENNEN <[ 0000V [» g Rec large to small
Math Reset Math Clear (@) B MATH operation icons 3
‘ Switch to large
Top > Monitor - Dual Screen operation icons
e - M EE e @ B I 7@ W ALARM 0 REC W WATH You can switch from
Foom-01 v NN 4 00wy small to large

operation icons

Record Start/Stop, Computation Start/Stop

Used to start and stop data acquisition.

The icons of all functions are shown in the figure for the sake of explanation, but normally
buttons are dimmed when disabled.

uolnjisinbae ejeq pue buieg

¢ Operation Icons

— Computation start/stop button
Starts and stops computation (with the /M1 option or when
the 10-CH Pulse Input Module is installed)
— Recording Start/Stop button
Starts and stops data acquisition.

— Output channel operation icons
(When output modules installed)
Area for displaying manual DO and

Pause button operation icons for arbitrary output.
Pauses monitor display updating. Displays one channel’s worth.
Data acquisition does not stop.

Alarm ACK button Operational status

llluminates during alarms,

If set to hold alarms, alarms ) -
recording, and computation.

are cleared upon alarm clear
wait. (Includes relay action)

» [} 9 %3 Output Charnel Room-01 || aLarm
Rec Stop Pause  J {Alarm Ack 0 NS 250V M| @ keo
[ W MATH

Math Resst Math Clear ][O Timer Reset ][b Transmit Start ]

. Transmission output start/stop button
Timer reset button  (When output modules installed)

Resets the timer. Collectively starts or stops output on output channels
Computation reset/clear button set for transmission output. If both ON and OFF are
Resets/clears computation. mixed in the transmission output control settings,
(with the /M1 option or when the the transmission output stop display is invoked.

10-CH Pulse Input Module is installed)

¢ Output Channel Operation Icons

Manual DO channel:
Channel number switching

Click to switch the channel number
Output Channel Room-22

® =l Channel number/tag name display

Relay ON/OFF button
Click to turn relays ON and OFF

Arbitrary output channel:
Channel number switching

Click to switch the channel number
Cutput Channel Rnnm*DS—l—
1 10

® Channel number/tag name display
Changes output value

Click to change the output value.

Output value display

Analog output: V or mA display

PWM Output: % display

Output value display bar
Displays output values in a bar graph. Also, you can click to change the output values.
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3.16 Measured Data Monitor Display/Settings

Monitor Display Switching and Group Selection

Select the Display Group * Bar graph
Select the display group you * Digital
wish to display. * Trend

(o) B

Select message

Select

1 to 5 messages can be set in advance.

Free message box
Text can be entered when Free is selected
in the message selection list.

Message button

Writes

Manual sample button
Performs a manual sample.

Writes

Data View button
Displays alarm summaries, manual samples, or reports

in a se

Select a Background Color

Switch

Select a Monitor Display
display type.

Select a monitor
* Overview
» Meter

|Free j|Me55aElE @ @

a message to write.

the selected message.

data to the manual sample file from the CF card.

parate window.

background color between white and gray.

Contents of the Status Bar

WA 00 <TTETT

T - R30I

- MW100 serial number

MW100 firmware version

Measurement group recording operation (1 to 3)/
thinning recording operation status (T)/

report recording operation
Recording: Yellow

Trigger wait state: Green

Stop state: Gray

'l @@ TERE =

Memory capacity of the CF card
Used space (%) displayed with a green bar.
When the CF card is not installed,

the Ejected display appears.

status (R)

— 1

MATH processing performance —
(with the /M1 option or when a pulse input

module is installed)

When computation processing reaches 100%, data loss occurs.
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3.16 Measured Data Monitor Display/Settings

Monitor Display Screen
e Trend Display

Select the waveform display zone
« Auto zone
« Slide zone
« Full zone

» User zone

Zoom in or out of the time axis Switch i
Measurement . witch waveform
|_interval Alarm display ON/OFF rthickness
100 mset ElEREY N TNITEN = o

Select Y-axis
display

Alarm indication
ON/OFF

Channel ON/OFF

— Channel number
display/tag name
display

1— Zone display
section ON/OFF

Time axis zoom factor

Selecting the Display Zone of Waveforms

User Zone

Displays each waveform at the position of the Zone specified in the Display Scale.
The Y-axis displays active channels.

Full Zone

Each waveform is displayed in the full zone of the waveform display area. The Y-axis
displays active channels.

Slide Zone

Each waveform is displayed slightly staggered across the waveform display area. The
Y-axis displays active channels.

Auto Zone

The waveform display area is divided up according to the number of displayed
waveforms.

« User zone * Full zone « Slide zone * Auto zone

Trip line
You can display a trip line in the Trend display.

P> For the procedure to set the trip line, see “Trip Line Setting” in “Display Settings” in this
section.

500 msec @ ®RE|RMmm H=o
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3.16 Measured Data Monitor Display/Settings

* Digital Display
Displays measured data as numerical values. When alarms are set, the alarm status
is displayed to the left of the numerical value. You can set the graph display reference
position to Normal or Center for the bar graph section.

P> For a description of the graph display reference position, see “Bar Graph Display” in “Monitor
Display Screen” in this section.

CH 005 Channel number
display/tag name
display

(- Alarm status
@ Alarm not D llluminated: No alarm occurring @ llluminated: Alarm occurring
set up Blinking: Alarm hold clear wait (symbol in circle is alarm type: H/L/rH/rL/dH/dL/tH/tL)
after alarm factor cleared Blinking: Alarm hold clear wait after alarm
factor occurrence

e Bar Graph
Displays measured values in a bar graph. When alarms are set, the alarm status is
displayed to the left of the bar graph. For information on alarm statuses, see Digital
Display in this section. You can set the graph display reference position to Normal or
Center for the bar graph section.

P> For a description of the alarm status, see “Digital Display” in “Monitor Display Screen” in this
section.

Channel number display/
tag name display

L Graph display reference position
* Normal
 Center
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3.16 Measured Data Monitor Display/Settings

* Meters
Displays measured values in a meter. When alarms are set, the alarm status is
displayed to the left of the meter. For information on alarm statuses, see Digital
Display in this section.

P> For a description of the alarm status, see “Digital Display” in “Monitor Display Screen” in this
section.

w

uonisinboe ejeq pue bunjes

e Overview Display
Displays alarms and measured values using digital values in the Monitor display.
Channels set to Skip are not displayed.
Channel No./Tag Name
When set to Tag Name display,
the tag name is displayed.

Meas. value/MATH value

Unit

Alarm Status
The alarm status is indicated by color.
* No alarm: Green
« Alarm occurrence: Red
Or, when set to alarm hold, the alarm hold clear
wait display is as follows.
« Alarm hold clear wait
after alarm cause cleared: Green, text blinking
« Alarm hold clear wait
after alarm cause occurs: Red, text blinking

Reducing the size of the window causes only
the channel numbers and alarm types to be
displayed.

Alarm Type

Displays the alarm type (H/L/rH/rL/dH/dL/tH/L).

If two or more alarms occur at once, the alarm level
numbers are displayed in order starting from the smallest
number.
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3.16 Measured Data Monitor Display/Settings

Computation start/stop/reset/clear buttons

¢ Lite Monitor screen (Firmware version R3.03 or later)

Displays measured data in a simplified format.

Top > Lite Monior-

o0 o ) i e
1.6421 ’ 0.0023
| m— " — .
0.0206 , -0.0189 ,
-0.0016 , 0.0217 ,
" — e
-0.0158 -0.0044
v v
0.0235 -0.0125
v v

Parts of the Display
This is a description of the icons and areas for displaying measured data in the Lite
Monitor screen.

Changing the display update interval
Enter the display update interval.

Record start/stop buttons Allowable setting range is 1 to 3600.
Changing the font size

Pause button Select the text size for the digital display.

Update

Select the display Status of each action Change settings button

Select the text size for the digital display.

-0.0252

Alarm Statuses
Turn red when alarms occur.
Not displayed if alarms do not occur, or are not set.

Note
» Depending on the operating environment, approximately 4 KB of PC memory can be
consumed for a single screen update. If the PC runs out of memory, close then reopen the
Web screen.
»  When accessing the screen with general user privileges, the computation start/stop/reset/
clear and recording start/stop buttons are not available.
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3.16 Measured Data Monitor Display/Settings

Data View
From the Display Data list, select Alarm Summary, Manual Sample, Report - Digital, or
Report - Graph.

¢ Alarm Summary
Select a number of events from 30, 60, 100, 150. Also, the screen automatically
updates once per minute. You can also click the Update button to refresh the screen
manually.

Number of displayed alarms
Sets the number of alarms to display.

Alarm time
Click to sort in ascending or Select displayed data
descending order. Select Alarm Summary.

Alarm Summary

Update
) (o) s

uolnjisinbae ejeq pue buieg

@ 07/10/25 17.52:23.000 001 1H On

@ 07/10/25 17.52:17.000 001 1H Off

@ 07110125 17:52:16.000 001 1-H On

@ 07/10/25 17:52:15.000 001 1-H Off

@ 07/10/25 17:52:14.500 001 1-H On

@ 0710/25 17.52:14.000 001 1-H Off

@ 07/10/25 17.52:12.500 001 1H On

@ 0710/25 17.52:12.000 001 1H Off

@ 07/10/25 17.52:11.500 001 1H On
Channels Type
Shows the channel on which the alarm occurred. Shows the alarm level and type.
All Channels is displayed when an alarm ACK 1-H
operation is performed. EAlarm type (H/L/rH/rL/dH/dL/tH/L)

Click to sort in ascending or descending order.
When using the tag name display, sorting occurs
in alphabetical order.

Alarm level (1-to 4)

¢ Manual Sample
Displays manual sample file data saved on the CF card. Click the Update button to
update* the data. Displays the latest manual sample file.
* If you click the Update button while writing of data to a file is in progress, the data might not
be displayed. After writing of the data, click the Update button again.

File name display
Displays the name of the Select displayed data
manual sample file. Select Manual Sample.

Display Data - |Manual Sample =
Wanual Sample (2550001 Update

CHOO01 CHO02 CHOO03 CHOD4
W W i v
2007/10/25 20:24:35.000 | 1.0833 0.9707 0.8595 07435 Banelp
2007/10/25 20:24:45.000 | 0.9629 0.8628 0.7640 06653
2007/10/25 20:25:16.000 | -0.1451 -0.1300 -0.1151 -0.1003
2007/10/25 20:25:31.000 ) -0.5734 -0.5138 -0.4550 -0.3062
Eagelinw

f
Manual sample execution time Scroll

Displays the time at which the manual sample Scrolls vertically or horizontally,
was performed. and changes the display range.
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* Report - Digital
Select a report file to display of Daily, Weekly, or Monthly and a date from the report
file selection list then click the Update button.
In the example below, the hourly report from 16:00 to 17:00 in the daily report file is
displayed.

Type, Date/Time, Status

« Displays the report type.

« Displays the date and time of writing.

« Displays error (Er), over (Ov), or power failure (Pw).

Measurement/MATH channel and units Report file selection

The tag name can also be displayed. Select displayed data
The sum scale is displayed in brackets [ ]. Select Report— Digital.

Tt |

Display Data
Report -[Digital L ([oaiy_=J[o7m7ne o =) Updte |
A CHO02 CHO03 CHO04
mV [m¥h] mV [m3h] mV [mih]  mV [mih]
ourly Pagelp
2007/07/19 15:00:00
Status
[Eve 1] ] 1] 1]
Ihlax 0.08 0.11 013 0.14
Ity -0.07 -0.11 -0.12 -0.14
Sum. 2.565278E-3 2.798611E-3 0 7.200667E-3
st -0.03 0.07 -0.02 0
PageDown
C 1 >
|
I
Report data Scroll
Displays the average, maximum, minimum, integral, Scrolls vertically or horizontally,
and instantaneous values for each channel. and changes the display range.

¢ Report - Graph

r Type, autoscale
Select a display type.
* Sum graph button:
Displays the integral value for each channel in a bar graph.
If the integral values are 0 or less, the bar graph will have

a height of 0.
« Maximum (Max), minimum (Min), and average (Ave)  File/channel select button
graph buttons: * File button:
Displays the data for each channel in a broken line graph. Opens the file selection screen.
 Auto Scale button: ¢ Ch button:
Click to automatically adjust the scale. Opens the channel selection screen.
Display channel tag name Select displayed data
Shows the displayed channel and tag name. Select Report— Graph.
I
Display Dara
Report - Graph
= Room—{1 = Room—12 = Room—{03 Foom—-04 Foom—-5 [I
Room—08 Room—07 Room—08 Room—-19 Room—10
L{ Sum || hax | [ Min | Ave | [Auto Scale || File Ch
nuuuuuuuUNIT A40E7
450000001 30E7

20000000 207

150000001 1.0E7

=

aol

00
12 3 4 5 6 7 8 9 101112 13 1415 16 17 18 18 20 21 22 23 0
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Setting Mode

Display Settings

File selection screen
Selects the report file to be displayed in the graph.
Click the OK button to return to the Report - Graph screen.

07/07/30 DAILY - 0 07/07/19 DALY - 0 |

07/07/10 DALY - 0 07/07/08 WEEKLY - 1 |

07/07/05 DAILY - 0 07/07/05 WEEKLY - 0 |
07/07/06 MONTHLY - 0

Channel selection screen

Selects the channels and tag names displayed in the graph.

Up to 10 channels can be selected. You can clear all selections with Clear All button
(Firmware version R3.02 or later).

Click the OK button to return to the Report - Graph screen.

‘ Room-01 I Room-02 I Room-03 I Room-04 I Room-05 Room-08
\ Raoom-07 | Room-08 ‘ Room-09 | Room-10 ‘

Tag Settings
Enter Tag names to assign to measurement and MATH channels. If the tag name display
is enabled, the tag names specified here are displayed.

P> For the procedure to switch to the tag name display, see “Other Settings” in this section.
1. From the top screen, click Display Setting > Channel Tag Setting.

Top > Display Setting > Channel Tag Setting

o B

001 INFUTO1

00z INFUTDZ

003 INFUTD3

004 INFUTD4

n0s INFUTDS

006 OUTPUTOT

007 OUTPUTOZ

008 OUTPUTO3

009 OUTPUTD4

010 OUTPUTDS
Apply

2. Select the tag number group you wish to set from the Channel List list.

3. Enter a tag name in the Tag box of each tag number.
You can use 15 alphanumeric characters. If you do not enter the tag names, the channel
numbers are displayed even if the tag name display is enabled.

4. Click the Apply button. The setting changes take effect.
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3.16 Measured Data Monitor Display/Settings

Message Settings
You can specify a message to be written along with data saving during recording.

1. From the top screen, click Display Setting > Message Setting.

Top > Display Setting > Message Setting

No Mg

Messagell

MessagelZ

Messageld

1
Z
3 Messageld
Gl
5

Messagels

Apply

2. Enter the message in the Message box in the Message List. You can use fifteen
alphanumeric characters.

3. Click the Apply button. The setting changes take effect.
Nofte

Enter the free message in the free message box in the monitor screen.

P> For information on free messages, see “Explanation of Display Items” in this section.

Setting Display Colors
1. From the top screen, click Display Setting > Channel Color Setting.

Top > Display Setting > Channel Color Setting

001 &l -

J

002 *v.Green

003 ellow

004 Chocolate x

005 ellow

006 Qlive

007 *v.Green

008 Lime

009 Green

[ {1 /EN /R |/EN/EN R J[EN /BN

0o Cyan

IBlack IREd IBrown Chocolate Orange
Tellow I Olive T Green Lime IG'rEEn
Cyan [ Light Blue Blue IDak Blue

IB Violet Violet IMagEnta Purple IMarcon

Apply

Select the channel group you wish to set from the Channel List list.

3. Select the color you wish to assign in the Color list of each channel. Color
samples are shown towards the bottom of the screen.

4. Click the Apply button. The setting changes take effect.
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3.16 Measured Data Monitor Display/Settings

Graph Scale Settings
1. From the top screen, click Display Setting > Graph Scale Setting.

Top > Display Setting > Graph Scale Setting

Llnear = -INDrma\ = ID
l:
003

| e |
[LUinear =] [Auto =] [Mormel <] [30 100
e T
[LUinear =] [Auto =] [Mormel_<] [0 100
| e |
| e e
e e
e e |
s e |

Anply

2. Select the channel group you wish to set from the Channel List list.

[
o
m
[
o

3. Select Linear or Log in the Scale list.

4. Select the number of divisions in the Div list. It can only be selected when
set to Linear display. If you select Auto, the number of divisions is determined
automatically from the scale or span of the specified channel.

5. Select a display position of Normal or Center in the Bar Graph Type list. The
digital or bar graph display is updated accordingly.

6. Specify a percentage from the top or bottom in the Zone boxes. Enter a Lower
value of 0 to 95 (%), and an upper value from 5 to 100 (%).

7. Click the Apply button. The setting changes take effect.
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3.16 Measured Data Monitor Display/Settings

Display Groups Settings
You can display the measured data for each specified group in the Monitor display.

1.

From the top screen, click Display Setting > Display Group Setting.

Top > Display Setting > Display Group Setting

No.  GrowMams  Chamel$e:

01 Group01 001-010

02 Group02 011.013.015.4001-A005

03 Group03 012.016-020.A006

04 Group04 001-020

05 Group0s 021-040

06 Group06 041-060

07 Group0? 001-020

03 Group08 021-040

09 Groupd 041-060
Apply

Select the group you wish to set from the Display Group list.

Enter the group name in the Group Name box (using up to 15 characters).

Enter the channel numbers you wish to assign to the group in the Channel Set
box. Specify channel numbers by delimiting them with dots as in 001.003.005, or
specify a range as in 004-008. Up to 20 channels (using up to 100 characters)
can be specified. If more than 20 channels is specified, the first 20 channels are
displayed.

Click the Apply button. The setting changes take effect.

Trip Line Setting
You can display a trip line in the Trend display.

1.

From the top screen, click Display Setting > Trip Line Setting.

Top > Display Setting > Trip Line Setting

Display Color  TopPomi
On = IRed 2 I
an ] [vellow [ 25
o [[Bue ~[r5
| I
Celr
IBla:k. IREd IBrown Chocolate Orange
Tellow I Olive T Green Lime IG'reen

Cyan ITeal Light Blu Blue JDark Blue
IB Violet Violet IMagsnta Purple IMaroon

Apply

===

Select the group number you wish to set from the Display Group list.
Turn On the line you wish to display in the Display list.

Select the color you wish to display in the Color list. Color samples are shown
toward the bottom of the screen.

Specify a percentage for the position of the trip line in the Trip Point box. 100% is
the scale maximum in the trend display, and 0% is the minimum.

Click the Apply button. The setting changes take effect.
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3.16 Measured Data Monitor Display/Settings

Setting Mode

Log Information

Other Settings (Selecting Channel Number Display or Tag Name Display)

1.

From the top screen, click Display Setting > Other Settings.

Top > Display Setting > Other Settings
Channel Mo /Tag Display Channel Mo, *

Apply

Select whether to display channel numbers or tag names in the Channel No./Tag
Display list.

Click the Apply button. The setting changes take effect.

You can display information from the recording log, alarm summaries, and other sources.
For information about display contents, see the MW700 Communication Command
Manual (IM MW100-17E).

Log Information

1.

From the top screen, click System Setting > Log Information.

Top > System Setting > Log Information

Display range

|Retnrding Log

0740725 10:05:23

07/10/24 07:09:23 28CHs 400KB
07/10/24 07:09:23 Create 10410002
07/10/24 07:09:33 Record stop 1
07/10/24 07:09:34 Create ALARMLG
07/10/24 07:09:35 Create RECORDLG
07/10/24 16:37:01 Power  off
07/10/24 20:48:49 Power  on
07/10/25 00:23:04 Pawer  off
07/10/25 00:23:12 Power on
07/10/25 00:46:34 Power  off
07/10/25 00:47:05 Pover  on
07/10/25 08:23:31 Power  off
07/10/25 08:24:00 Fower  on
07/10/25 08:24:50 Power  off
07/10/25 08:25:01 Pawer on
07/10/25 08:25:17 Card in
07/10/25 08:37:31 Power  off
07/10/25 08:37:52 Pover  on
07/10/25 08:41:35 Power  off
07/10/25 08:42:00 Fower  on

Update

Select the type of log you wish to display in the Log Information list.

Log Information

Time Stamp

Maximum no. of
output displayed

Log output request time

Enter the number of logs to display or the display range in the box to the right of
the list. The box that you enter varies depending on the type of log you wish to
display.

Click the Update button. The updated time is displayed in the display box aligned
with the Log Information list, and the updated time current log information is
displayed in the log display area.

IM MW100-01E
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3.16 Measured Data Monitor Display/Settings

Setting List (Firmware version R3.03 or later)

1.

Note

From the top screen, click Setting List.
7 Setting List - [10.0.23.44] - Microsoft Internet Explorer (=] 3
File Edt View Favortes Tooks  Help ‘ o
GB&EK S \ﬂ \E‘ (ol ‘ /,)Sear[h .. Favorites {4}‘ - i _J ‘3
address [{€] http:/f10.0.23. 44/ webimon_Jst shim R \Lm »
LW 100 Top.
¥ Channel Setting ¥ System Setting 7 Display Setting ¥ Communication Setting _D15PI8Y | THT format
MW100 Seiting List
2002710417 10:00:54
Basic Information
Serial Ho FE1Z3801
Option MATHREPORT DEG F R3-232
Unit Ho o0
Module Information
Mo. | ConfigueedModule | IntervalGrovp | Intervel Amlg‘;“?a“m
i ME115-D24HI0 1 S0ms Auto
1 MX110-UNV-HO4 2 100 ms Auto
2 MEI0-THV-M10 3 200 ms Auto
3 | MXLZ-MECMIO
4| WIKI0VAC-MOE
5 X1 20-PWI-MO2
MATH
[ ntervalGrowp | 2 |
| MaTHIsterval | 100 ms |
~
Chamel Setting "
ATDI Channel
[ Span | Ref. | Scale | [ Recarding |
|N° Wogh | B e v Bkl e e Ttiomer 1 U9 T 7 Tl =
& [ [ [ [ [ tocal intranet P

Select the check boxes of the settings you wish to display (Channel Setting,
System Setting, Display Setting, Communication Setting), then click the Display

button.

You can click the TXT Format link to display the list in text format.

To save text-formatted screens, click File > Save As from the browser’s menu.

Set the format to text (.txt), then save the file.

To convert the file to CSV format, change the file’s extension to .csv.
Saved CSV files cannot be reloaded onto the MW100.
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Chapter 4

Troubleshooting and Maintenance

4.1

Error Display on the 7-Segment LED and
Corrective Actions

The main module has a two-digit 7-segment LED. The 7-segment LED displays the
system status. This section describes the displays on the 7-segment LED when errors
occur on the system and their corrective actions. For information about normal displays
other than for errors, see section 1.3, “Functions of the Main Module.”

If servicing is necessary, or if the instrument is not operating correctly after performing
the corrective actions below, contact your nearest YOKOGAWA dealer.

Errors upon Startup

The left and right digits of the 7-segment LED display “b” and an error code, respectively.
The LED illuminates.

Display Probable Cause Corrective Action Ref. section
b* (where * The dip switch settings Turn OFF the power, remove the CF card, turn ON all dip 1.3

is any character are not correct. switches, and power up again. If the situation does not change

other than F). servicing is required.

bF The dip switch settings  Powering up in setup reset mode. Turn OFF the power, turn ON 1.3

are not correct. all dip switches, and power up again. Since all settings such as
the IP address are initialized, reconfiguration is necessary.

System Errors

The left and right digits of the 7-segment LED display “F” and an error code, respectively.
The LED illuminates.

Display  Possible Problem Corrective Action Ref. section
FO System ROM error. Servicing required. -
F1 SRAM error Servicing required. -
F2 EEPROM error Servicing required. -
F3 Error in the internal battery Servicing required. -
of the main module. However, this error is also displayed immediately after the
battery is replaced. If this happens, power-cycle the MW100.
F4 Ethernet controller error Servicing required. -
F6 Web file load error Servicing required. -
FF Error in writing unit information Servicing required. -

Module Errors

The left and right digits of the 7-segment LED display are U and an error code,
respectively. The LED illuminates.

In the case of module errors, the error number and the corresponding module number
are displayed alternately as shown in the figure below.

Error number Module number
et

oot g il t'
Display  Possible Problem Corrective Action Ref. section
uo Range information error. Servicing required. -
U1 Calibration value error. Check the module’s installation status, then recalibrate the -
module. If the error occurs even after recalibrating, servicing
is required.
u2 Calibration reference voltage = Check whether the correct calibration reference voltage is -
value is not correct. being applied or whether the channel to which the voltage is
(during calibration) applied is correct.
U3 Error in writing the calibration ~ Servicing required. -
value.
U4 The installed module cannot ~ Replace the module with one that can be used. -
be used.
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4.1 Error Display on the 7-Segment LED and Corrective Actions

Communication Errors
The left and right digits of the 7-segment LED display “C” and an error code, respectively.

The LED blinks.
Display  Possible Problem Corrective Action Ref. section
co DHCP address Check network connections. Use a Fixed IP address 26,32*
acquisition error Check with your network administrator whether your environment
supports acquisition of addresses by DHCP.
C1 DNS name error Check network connections. Check with your network manager 26~

to determine whether your environment supports host name

registration.

* See the MW100 Viewer Software User’s Manual (IM MW180-01E).

Settings Errors

The code is divided into two parts which are displayed alternately on the 7-segment LED;
in the first part, the letter E appears in the left digit with the hundreds digit of the error
code to the right, and the second part consists of the last two digits of the error code.

Display  Possible Problem Corrective Action

E001 Invalid function parameter. Enter the correct parameter.

E002 Value exceeds the setting range. Set a value within the allowable range.

EO003 Incorrect real number format. Use the correct real number format.

E004 Real number value exceeds the setting range. Set a real number within the allowable range.

E005 Incorrect character string. Set an allowable character string.

E006 Character string too long. Set a character string within the allowable length.

E007 Incorrect display color format. Specify a display color using the correct format.

E008 Incorrect date format. Enter the date using the correct format.

E009 Data value exceeds the setting range. Set a date within the allowable range.

EO010 Incorrect time format. Enter the time using the correct format.

EO11 Time value exceeds the setting range. Set a time within the allowable range.

EO012 Incorrect time zone format. Specify a time zone using the correct format.

EO013 Time zone value exceeds the setting range. Set a time zone within the allowable range.

EO014 Incorrect IP address format. Enter an IP address using the correct format.

E020 Invalid channel number. Enter the correct channel number.

E021 Invalid sequence of first and last channel. Set a value for the last channel that is greater or equal to than
the first channel.

E022 Invalid alarm number. Enter the correct alarm number.

E023 Invalid relay number. Enter a correct relay number.

E024 Invalid sequence of first and last relay. Set a value for the last relay that is greater or equal to than the
first relay.

E025 Invalid MATH group number. Enter a correct MATH group number.

E026 Invalid box number. Enter the correct box number.

E027 Invalid timer number. Enter the correct timer number.

E028 Invalid match time number. Enter the correct match time number.

E029 Invalid measurement group number. Enter a correct measurement group number.

E030 Invalid module number. Enter a correct module number.

E031 Invalid start and end time of DST. Enter a correct start and end time.

E032 Invalid display group number. Enter a correct display group number.

E033 Invalid tripline number. Enter a correct tripline number.

E034 Invalid message number. Enter a correct message number.

E035 Invalid user number. Enter a correct user number.

E036 Invalid server type. Enter a correct destination type.

E037 Invalid e-mail contents. Enter a correct send destination.

E038 Invalid server number. Enter a correct server number.

E039 Invalid command number. Enter a correct command number.
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4.1 Error Display on the 7-Segment LED and Corrective Actions

Display  Possible Problem Corrective Action
E040 Invalid client type. Enter a correct client type.
E041 Invalid server type. Enter a correct server type.
E050 Invalid input type. Enter an input type that can be selected for the module
specified by the channel number.
E051 Module of an invalid input type found in the Enter an input type that can be selected for all modules
range of specified channels. specified by the channel range.
E052 Invalid measuring range. Enter a measurement range that can be selected for the module
specified by the channel number.
E053 Module of an invalid measuring range found in Enter a measurement range that can be selected for all
the range of specified channels. modules specified by the channel range.
E054 Upper and lower limits of span cannot be equal. Set a different value for the upper and lower limits of span.
E055 Upper and lower limits of scale cannot be equal. Set a different value for the upper and lower limits of scale.
E056 Invalid reference channel number. Set channels other than the input module’s own channel.
E060 Cannot set an alarm for a skipped channel. Set a type for the channel number setting other than SKIP.
E061 Cannot set an alarm for a channel on which Set the ON/OFF setting for expressions on the channel number
MATH function is turned OFF. to ON.
E062 Invalid alarm type. Enter an allowed alarm type.
E063 Invalid alarm relay number. Set a relay number for alarm output relays.
E065 Cannot set hysteresis for a channel on which Set the channel number alarm type to something other than
alarm are turned OFF. OFF.
EQ70 Nonexistent channel specified in MATH Check whether a channel number outside of the allowable
expression. range was specified in the expression.
EO071 Nonexistent constant specified in MATH Check whether a MATH constant outside of the allowable
expression. range was specified in the expression.
EQ72 Invalid syntax found in MATH expression. Check whether the syntax of the expression is correct.
EQ73 Too many operators for MATH expression. Reduce the number of operators.
EO074 Invalid order of operators. Check whether the relationship between the operators used in
the expression satisfies proper syntax.
EQ75 Upper and lower limits of MATH span cannot be Set a different value for the upper and lower limits of the MATH
equal. span.
E080 Incorrect MATH group format. Check whether the MATH group format is correct.
E081 Incorrect channels for MATH group. Check whether there are any channels outside the allowable
range specified in the MATH group.
E082 Too many channels for MATH group. Reduce the number of channels specified in the MATH group.
E090 Incorrect break point format. Use the correct break point format.
E091 Time value of break point exceeds the setting Set a time within the allowable range.
range.
E092 Output value of break point exceeds the setting Set an output value within the allowable range.
range.
E093 No break point found. Set one or more break points.
E094 Invalid time value of first break point. Set the time of break point 1 to zero.
EQ095 Invalid time sequence found in break points. Set the times of break points in ascending order.
E100 Invalid output type. Enter an output type that can be selected for the module
specified by the channel number.
E101 Module of an invalid output type found in the Enter an output type that can be selected for all modules
range of specified channels. specified by the channel range.
E102 Invalid output range. Enter an output range that can be selected for the module
specified by the channel number.
E103 Module of an invalid output range found in the Enter an output range that can be selected for all modules
range of specified channels. specified by the channel range.
E104 Upper and lower limits of output span cannot Set a different value for the upper and lower limits of output
be equal. span.
E105 Invalid transmission reference channel. Set the input module or MATH channel number.
E110 Invalid channel number for contact input event. Enter the channel number for DI input.
E111 Invalid channel number for alarm event. Set an input module or MATH channel number.
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4.1 Error Display on the 7-Segment LED and Corrective Actions

Display  Possible Problem Corrective Action

E112 Invalid relay number for relay event. Set the channel number for the DO module.

E113 Invalid action type. Enter a correct action type.

E114 Invalid combination of edge and level detection Set the edge and level detection types to something different.

actions.

E115 Invalid combination of level detection actions. Set events of different types to different actions in level
detection.

E116 Invalid flag number. Enter a correct flag number.

E120 Invalid measurement group number. Set the measurement interval so that meas. gr 1 < meas. gr 2
< meas. gr 3. The maximum allowable ch for 10 ms
measurement is 10, and for 50 ms, 30.

E121 Invalid measurement group number for MATH Set MATH interval to a measurement group of 100 ms or

interval. longer.

E130 Size of data file for measurement group 1 Set the number of saved channels, recording interval, and

exceeds the upper limit. recording data length so that the data file of measurement
group 1 does not exceed 10 MB.

E131 Size of data file for measurement group 2 Set the number of saved channels, recording interval, and

exceeds the upper limit. recording data length so that the data file of measurement
group 2 does not exceed 10 MB.

E132 Size of data file for measurement group 3 Set the number of saved channels, recording interval, and

exceeds the upper limit. recording data length so that the data file of measurement
group 3 does not exceed 10 MB.

E133 Size of MATH data file exceeds the upper limit. Set the number of saved channels, recording interval, and
recording data length so that the MATH data file does not
exceed 10 MB.

E134 Size of thinned data file exceeds the upper limit. Set the number of saved channels, recording interval, and
recording data length so that the thinned data file does not
exceed 10 MB.

E135 Cannot set smaller value for thinning recording Set a value for the thinning recording interval higher than

interval than measuring or MATH interval. the measurement and MATH interval.

E136 Invalid combination of thinning recording, Set a value for the thinning recording interval that is a common

measuring and MATH interval. multiple of the measurement and MATH intervals.

E137 Combination of thinning recording interval and Set the thinning recording data length to an integer multiple

thinning recording data length incorrect. of the thinning recording interval.

E138 Cannot set recording operation for measurement  Set the measurement interval of the measurement group

group with no measuring interval. number to something other than OFF.

E139 Invalid recording interval. Set a recording interval which can be set to the measurement
interval of the measurement group.

E140 Upper and lower limits of the display zone cannot  Set the upper and lower limits of display zone to a different

be equal. value.

E141 Cannot set smaller value than lower limit of Set a larger value for the upper limit than that of the lower limit.

display zone for upper limit.

E142 Width of display zone must be 5% of that of the Set the upper and lower limits so that the difference between

entire display or more. them is 5% or more.
E145 Incorrect display group format. Enter a display group of the correct format.
E150 IP address must belong to class A, B, or C. Set an IP address belonging to class A, B, or C.
E151 Net or host part of IP address is all 0’s or 1’s. Set a valid combination of IP address and subnet mask.
E152 Invalid subnet mask. Enter a setting according to your network.
E153 Invalid gateway address. Make sure that the network part of the IP address and default
gateway match.
E160 Incorrect alarm e-mail channel format. Specify a channel using the correct format.
E165 Invalid channel number for Modbus command. Enter a correct channel.
E166 Invalid combination of start and end channel for Set the first and last channel to the same type.
Modbus command.

E167 Invalid sequence of start and end channel for Set the last channel equal or greater than the first channel.
Modbus command.

E168 Too many channels for command number. Set a valid number of channels for the data type.

E170 Invalid channel number for report. Set the channel included on the input module.
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4.1 Error Display on the 7-Segment LED and Corrective Actions

Execution Errors

The code is divided into two parts which are displayed alternately on the 7-segment LED;
in the first part, the letter E appears in the left digit with the hundreds digit of the error
code to the right, and the second part consists of the last two digits of the error code.

Display  Possible Problem Corrective Action

E201 Cannot execute due to different operation mode.  Confirm the operation mode.

E202 Cannot execute when in setting mode. Change the mode before execution.

E203 Cannot execute when in measurement mode. Change the mode before execution.

E204 Cannot change or execute during memory sampling. Stop the save operation before executing.

E205 Cannot execute during MATH operation. Stop the MATH operation before executing.

E206 Cannot change or execute during MATH operation. Stop the MATH operation before executing.

E207 Cannot change or execute while saving/loading Execute after the settings are saved or loaded.

settings.

E209 Cannot execute while memory sample is stopped. Change the mode before execution.

E211 No relays for communication input found. Check installation of relays and the relay output types.

E212 Initial balance failed. Check the settings and wiring.

E213 No channels for initial balance found. Check the target channels.

E214 No channels for transmission output found. Specify channels for transmission output.

E215 No channels for arbitrary output found. Specify channels for arbitrary output.

E221 No measurement channels found. Check the measurement module, measurement group number,
measurement interval, and other settings.

E222 Invalid measurement interval. Set the measurement interval so that: Meas. gr 1 < meas. gr 2
<meas. gr3

E223 Too many measurement channels. The number of measurable channels during 10 ms
measurement is 10, and for 50 ms measurement, 30.

E224 No MATH channels found. Check the MATH channel settings.

E225 Invalid MATH interval. Set the MATH interval to measurement groups of 100 ms or
more. When measuring with measurement modules, set the
measurement group numbers on which to perform
measurement.

E226 Cannot start/stop MATH operation. Cannot execute because MATH start is set for the level
detection action.

E227 Cannot start/stop recording. Cannot execute because recording start is set for the level
detection action.
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4.1 Error Display on the 7-Segment LED and Corrective Actions

Execution Errors

The code is divided into two parts which are displayed alternately on the 7-segment LED;
in the first part, the letter E appears in the left digit with the hundreds digit of the error
code to the right, and the second part consists of the last two digits of the error code.

Display  Possible Problem Corrective Action
E301 CF card error detected. Do not eject or otherwise disturb the card while being accessed.
E302 No enough free space on CF card. Delete unneeded files to free up space. Replace the CF card.
E303 CF card is write-protected. Check write permissions.
E311 CF card not inserted. Insert the CF card correctly.
E312 CF card format damaged. Check the CF card. Please format the CF card.
E313 CF card damaged or not formatted. The file may be damaged. Format or replace the CF card.
E314 File is write-protected. Check write permissions.
E315 No such file or directory. Check the files and folders.*
E316 Number of files exceeds the upper limit. Delete unneeded files to reduce the number of files.
E317 Invalid file or directory name. Check the files and folders.*
E318 Unknown file type. Check the files.
E319 Same name of file or directory already exists. Check the files and folders.*
E320 Invalid file or directory operation. Check the files and folders.*
E321 File is in use. Wait until access is finished.
E331 Setting file not found. Check the name of the setting file.
E332 Setting file is broken. Could not load setting file because it is corrupted.
E341 FIFO buffer overflow. You must reduce the time required to store files.
Delete unneeded files to free up space.
E342 Data to be saved to file not found. Check the settings.
E343 Power failed while opening file. Files may have been damaged.
Take appropriate action for power failure.

E344 Some or all data prior to power outage could not Do not change the CF card during a power failure.

be recovered.
E345 Could not restart recording after recovery from Perform the record start operation.

power outage.
E346 Recording could not be started due to power Perform the re-recording start operation.

outage.

Take appropriate action for power failure.

* May occur in the MW100 internal processing (during an abnormality)

Communication Command Errors
The code is divided into two parts which are displayed alternately on the 7-segment LED;
in the first part, the letter E appears in the left digit with the hundreds digit of the error
code to the right, and the second part consists of the last two digits of the error code.

Display  Possible Problem Corrective Action
E401 Command string too long. Keep the command within 2047 Bytes from first character to
terminator.
E402 Too many commands enumerated. Set the number of enumerated commands within 99.
E403 Invalid type of commands enumerated. Send the commands without enumerating them.
E404 Invalid command. Confirm the command name.
E405 Not allowed to execute this command. Login at a level that allows execution of this command.
E406 Cannot execute due to different operation mode.  Switch to a mode that allows execution of this command.
E407 Invalid number of parameters. Check the number of parameters.
E408 Parameter string too long. Keep the length of individual parameters within 512 Bytes.
E411 Daylight saving time function not available. Check the daylight saving time settings.
Not available with the current model.
E412 Temperature unit selection not available. Not available with the current model.
E413 MATH option not available. Not available with the current model.
E414 Serial communication interface option not available. Not available with the current model.
E415 Report option not available. Not available with the current model.
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4.1 Error Display on the 7-Segment LED and Corrective Actions

Communication Errors
The code is divided into two parts which are displayed alternately on the 7-segment LED;
in the first part, the letter E appears in the left digit with the hundreds digit of the error
code to the right, and the second part consists of the last two digits of the error code.

Display = Possible Problem Corrective Action

E501 Login first. First, finish logging in.

E502 Login failed, try again. Enter the correct user name and password.

E503 Connection count exceeded the upper limit. Close unneeded connections and reconnect.

E504 Connection has been lost. Try to make a new connection.

E505 Connection has time out. Try to make a new connection.

E520 FTP function not available. Enable the function.

E521 FTP control connection failed. Check the FTP server address and the main unit address
setting. Also check the Ethernet cable connection.

E530 SMTP function not available. Enable the function.

E531 SMTP connection failed. Check the SMTP server address and the main unit address
setting. Also check the Ethernet cable connection.

E532 POP3 connection failed. Check the POP3 server address and the main unit address
setting. Also check the Ethernet cable connection.

E550 SNTP function not available. Enable the function.

E551 SNTP command/response failed. Check the SNTP server address and the main unit address

setting. Also check the Ethernet cable connection.

System Errors

The code is divided into two parts which are displayed alternately on the 7-segment LED;
in the first part, the letter E appears in the left digit with the hundreds digit of the error
code to the right, and the second part consists of the last two digits of the error code.

Display  Possible Problem Corrective Action
E999 System error. Servicing required.
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4.2
Corrective Actions

Error Display in the Monitor Screen and

Error Message

Corrective Action

Could not connect to the instrument.
Check cables and other connections.

Check Ethernet cable connections and the IP addresses of devices.

Communication error occurred.
Check cables and other connections.

Check Ethernet cable connections and the IP addresses of devices.

The actually installed modules differ from the modules
recognized by the system.

Reconstruct the module configuration.

The size of the data files exceeds the allowable upper limit.

Set the number of save channels, recording interval, and recording
data length so that the data files of measurement groups 1, 2, and 3,
and the computed and thinned data files are all within 10 MB.

Value smaller than measuring interval or MATH interval
cannot be set for the thinning recording interval.

Set a value higher than the measurement and MATH interval.

Combination of thinning recording interval, measurement
interval, MATH interval incorrect.

Set the thinning recording interval so that it is a common multiple of
the measurement and MATH intervals.

The recording data length cannot be set equal to or less
than the recording interval.

Set a recording data length larger than the recording interval.

Insufficient space on the CF card.

Delete unneeded files on the CF card to free up some space.
Replace the CF card.

The CF card is not inserted.

Insert the CF card.

The CF card is damaged or not formatted.

Reinsert the CF card or format it.

No data found in file.

Check the recording settings.

Remove MATH start/stop action from the Event/Action
settings.

Remove MATH start/stop action from the Event/Action settings.

Remove recording start/stop action from the Event/Action
settings.

Remove recording start/stop action from the Event/Action settings.
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4.3 Troubleshooting

If servicing is necessary, or if the instrument is not operating correctly after performing
the corrective actions below, contact your nearest YOKOGAWA dealer.

The 7-segment LED does not illuminate.

Possible Problem Corrective Action Ref. section
The power switch is not ON. Turn ON the power switch. 2.5
The supply voltage is too low. Check whether the voltage is within the supply voltage 2.5
rating range.
The fuse is blown. Servicing required. -
The power supply is broken. Servicing required. -

The 7-segment LED blinks repeatedly.

Possible Problem Corrective Action Ref. section
The power supply is shorted inside the Remove the input/output module one by one and 2.3
input/output module. determine the broken module (servicing required).

The power supply is shorted inside the main Replace the main module. (Servicing required.) 2.3

module.

The MW100 cannot be detected from the PC or cannot be detected with the Search button.

Possible Problem Corrective Action Ref. section
The LINK LED does not turn ON. Replace the Ethernet cable. 1.3
The cable is broken.
The LINK LED does not turn ON. Check the hub’s power supply. If it still does not work, 1.3
There is a problem with the hub. replace the hub and check the hub’s operation.
The LINK LED does not turn ON. Check whether the PC can connect to the network. 1.3
There is a problem with the PC. Replace the PC’s NIC.
The ACT LED does not turn ON. Check the hub’s power supply. If it still does not work, 1.3

There is a problem in the connection between Replace the hub and check the hub’s operation.
the hub and the MW100.

The ACT LED does not turn ON. Check whether the PC can connect to the network. 1.3
There is a problem with the PC. Replace the PC’s NIC.
There is a problem in the network configuration. Check that the IP address, subnet mask, and default *
The settings are not correct. gateway settings on the MW100 are correct.
There is a problem in the network configuration. Turn OFF the power to the PC and the MW100, and *
The setting changes have not taken effect. carry out reconnection.
The PC and the MW100 are not in the same Connect the PC and the MW100 in the same network *
segment. segment. When connected as shown in the following

figure, the Search button cannot be used to detect the
MW100, but you can make the connection by manually
specifying the IP address of the MW100.

Network A

When using Windows XP or Windows Vista, check the *
firewall function.

* See the MW100 Viewer Software User’s Manual (IM MW180-01E).

IM MW100-01E
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4.3 Troubleshooting

The MW100 can be detected using the Search button, but browser connection fails.

Possible Problem Corrective Action Ref. section
The IP address is set to the default value. Set the correct IP address. *

The default value cannot be used to make the

connection.

There is a problem in the network configuration. Check that the IP address, subnet mask, and default
gateway settings of the PC and the MW100 settings are

correct.
The PC software, main module style number, and Check the PC software release number and main module Page i
release number rule is not upheld. style number before upgrading the version.

[PC software release no.] = [main module style no.]

*  See the MW100 Viewer Software User’s Manual (IM MW180-01E).

MW100 Calibration Software not connected.

Possible Problem Corrective Action Ref. section
Attempting to make multiple connections. Another  Exit all other software programs. 4.3,*
software program is already connected.

The main module and input/output module style Check the release number of the PC software and the Page i
number rule is not upheld. main module style number, then upgrade the version.

[PC software release no.] = [main module style no.] = [input/
output module style no.]
*  See the MW100 Viewer Software User’s Manual (IM MW180-01E).

The connected input/output module is not detected.

Possible Problem Corrective Action Ref. section
Module connection or module startup error. Turn OFF the power. Detach the input/output module once 2.5
Attached the module while the power was ON. and attach it again.
The PC software, main module, and input/output Check the PC software release number and main module  Page i
module style and release number rule is not style number before upgrading the version.
upheld. [PC software release no.] 2 [main module style no.] =

[input/output module style no.]
Carried out an incorrect calibration. Recalibrate. 4.3,*

*  See the MW100 Viewer Software User’s Manual (IM MW180-01E).
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4.3 Troubleshooting

The measured value is not correct

Possible Problem Corrective Action Ref. section

The input wiring is not correct. Check the input wiring. 24

The measured value is at +Over or —Over. Change to an appropriate setting. 3.5
The measurement range setting and input
range do not match.

The temperature error is large or is unstable. Change to the correct setting. 3.5
The TC type setting and the type actually
connected are different.

The temperature error is large or is unstable. Change to the correct setting. 3.5
The RJC setting is not correct.

The temperature error is large or is unstable. Block the wind from hitting the terminals. -
The wind is hitting the terminals.

The temperature error is large or is unstable. Suppress changes in the ambient temperature such as -
The ambient temperature change is drastic. by inserting it into a box.

The temperature error is large or is unstable. Match the thickness and length of the three 2.4
There is an error in the wiring resistance measurement cables.
(in the case of a 3-wire RTD).

The measurement error is large or is unstable. Take measures against noise. 2.9
Noise effects.

The measurement error is large or is unstable. Reduce the signal source resistance such as by -
Effects from the signal source resistance. inserting a converter.

The temperature error is large or is unstable. Stop parallel connections. -
Effects from parallel connections. Do not use the burnout setting.

Measured value from strain gauge type sensor When using a sensor without a remote sensing wire, -

not correct. use the DV450-001 (conversion cable).

On the strain module (-B12, -B35), the gauge Enter the correct settings. 2.4

method and dip switch settings are not correct.

On the strain module (-B12, -B35), the gauge Use a module that supports the resistance value of the 2.4

resistance and internal bridge resistance values strain gauge (120 Q, -B12; for 350 Q, -B35).

are different

On the strain module, scaling corresponding to Displayed with 1 gauge method conversion. 1.8

the gauge method is not set (for 2 gauge and Set scaling appropriately depending on the gauge

4 gauge methods, the amount of strain is doubled method.

or quadrupled.)

On the strain module (-NDI), a strain gauge type =~ When using a sensor without a remote sensing wire, 2.4

sensor without a remote sensing wire is being use the DV450-001 (conversion cable).

used.

Alarms are not output.

Possible Problem Corrective Action Ref. section

There is a problem in the alarm setting. Both the alarm and output relay must be set 3.7,3.8

appropriately.
Make the alarm and output relay settings appropriate.

The CF card is not detected.

Possible Problem Corrective Action Ref. section

There is a problem with the CF card. Replace the CF card. 2.10

Eject and format the CF card, then insert it again.

IM MW100-01E
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4.4 Calibration

To maintain measuring accuracy, we recommend calibration once per year. Calibration
of the instrument requires a calibration instrument of the necessary accuracy and
resolution. Please consult with the dealer from whom you purchased the instrument.

Range Calibration for DC Voltage, RTD, Resistance, Strain, and Analog Output

Required Instruments
» DC Voltage/Current Standard
Must meet the following specifications (M/9100 by FLUKE or equivalent)
Output range: 20 mV to 100 V
Output accuracy of output range: £(0.01%+1 pV) or less
* Resistance standard
Must meet the following specifications (ADR3204 by Alpha Electronics or equivalent)
Resistance setting range (resolution): 0.2 to 1999 Q (0.001 Q), 0.2 to 19999 Q (0.01 Q)
Resistance accuracy of the resistance setting range: * (0.01% of rdg + 2 mQ ) or less
» Bridge head (Yokogawa Electric model 701955 and 701956)
» Digital multimeter
Must meet the following specifications (7562 by Yokogawa or equivalent)
Accuracy: +0.01% or less

Calibration Procedure

1.
2,

6.

Wire the standard and instrument to be calibrated as shown in the figure below.
Turn ON the power while holding down user function key 1 on the MW100. The
unit enters Calibration mode.

Allow a sufficient warm-up time for the MW100 Data Acquisition Unit (thirty
minutes or more).

Confirm that the ambient temperature and humidity meet the standard operating
conditions.

After setting up communications between the PC and the MW100, start the
MW100 Calibration software and perform calibration.

For instructions on the MW100 calibration software, see the MW100 Viewer Software User's
Manual (IM MW180-01E).

To exit Calibration mode, turn the power OFF.

Wiring Diagram
»  When calibrating the DC voltage range of the 4-CH, High-Speed Universal Input
module

When calibrating 0 V When calibrating a range other than 0 V

Input terminal

+
3 Short

* Carry out calibration for each input terminal.

 —

Input terminal
+ Hi

J oo a;

il

- Lo

'[’]cm:)o:il‘

OO0 O

DC voltage/current standard

4-12
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4.4 Calibration

*  When calibrating the RTD range of the 4-CH, High-Speed Universal Input module

When calibrating 0 Q

@ B
B2 o B o
[Py

Input terminal

QE Short
b

When calibrating a range other than 0 Q

Bl Bioe terminal
B om *

Input terminal

* Carry out calibration for each input

Make the resistance of
three lead wires equal.

Q T\
Hliis g=)
40 o S = =

H
B Mg
G

Resistance standard

* When calibrating the DC voltage range of the 10-CH, Medium-Speed Universal Input

module

+

Short the input terminal of CH1 (apply 0 V)

Input terminal of CH2

= [—

=R o
il =
Lo(|6 & =

= coooo

* When calibrating the RTD range of the 10-CH, Medium-Speed Universal Input module

1~
~—]

- ‘{When calibrating the RTD (1 mA) 600 mV range,
1 connect 300 Q to the input terminal of CH5.*

* When calibrating the RTD (1 mA) 60 mV range, connect 60 Qto |%.°(—___] E ]

the input terminal of CH6.

When calibrating the RTD (1 mA) 200 mV range, connect 200 Q E ¥ :‘

to the input terminal of CH4.

ﬂ

G

Resistance standard

IM MW100-01E
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4.4 Calibration

* When calibrating the DC voltage range of the 30-CH, Medium-Speed DCV/TC/DI
Input module

MX110-VTD-L30

([ —

96 o
hillg g =
Lo||0 ® =

A [=r=X=X=X=]

DC voltage/current standard
Input terminal of CH2

-

 —
= @ ooooecb
; 1 0000

* Hi 22 8880 %
— = o 000 8

Lo o |[©00 ooolU e

o

| [=l=l=X=X=) I o— ©*

DC voltage/current standard
Input terminal of CH2

* When calibrating the DC voltage range of the 6-CH, Medium-Speed Four-Wire RTD
Input module

Short the input terminal of CH1 (apply 0 V)

+ -

 —

=
Q@ @
[oaLongo]

il

Lo

0

OO0

DC voltage/current standard

Input terminal of CH2 *
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4.4 Calibration

Resistance standard

When calibrating the RTD or resistance range of the 6-CH, Medium-Speed Four-Wire
RTD Resistance Input module

Short the input terminal
of CH3 (connect 0 Q)

0> |—

i /

When calibrating the RTD (1 mA)
20 mV range, connect 20 Q to the
input terminal of CH4.*

* When calibrating the RTD (1 mA) 60 mV range, connect 60 Q to the input terminal of CH5.
When calibrating the RTD (1 mA) 200 mV range, connect 200 Q to the input terminal of CH6.
When calibrating the RTD (1 mA) 600 mV range, connect 300 Q to the input terminal of CH4.
When calibrating the RTD (0.25 mA) 600 mV range, connect 2400 Q to the input terminal of CH5.
When calibrating the RTD (0.25 mA) 1 V range, connect 3000 Q to the input terminal of CH6.

When calibrating the range of the 4-CH, Medium-Speed Strain Module (-B12, -B35,
and -NDI)

The clamp terminals (-B12, -B35) and NDIS terminal (-NDI) are connected using the
4-gauge method (see below or next page). Use a resistance of 120 Q for resistors R1
through R3, and connect a resistance to R4 equivalent to the Zero or Full value.

To correctly calibrate the range, do so in the order Zero, then Full.

Measurement Range Registors R1, Registor R4 Resistance value

to Be Calibrated R2, and R3 ZERO FULL accuracy

ZERO 120.000 Q 120.000 Q  120.000 Q  +0.005%, +0.3 ppm/°C
2000 pSTR (strain) 120.000 Q 120.000Q 117.154 Q  +0.005%, +0.3 ppm/°C
20000 PSTR (strain) 120.000 Q 120.000Q 113.010Q  +0.005%, +0.3 ppm/°C
200000 pSTR (strain)  120.000 Q 120.000Q 80,000 Q  +0.005%, +0.3 ppm/°C

*

The Full calibration value of the 2000 pStrain range is equivalent to 12000 pStrain.
The Full calibration value of the 20000 pStrain range is equivalent to 30000 pStrain.
The Full calibration value of the 200000 pStrain range is equivalent to 200000 pStrain.

For -B12, -B35

1@

12 @

Setting slwitch (CH1 to CH4) HIERY)

T 4
~:II—© Connect CH2
No.1 PE S 0 oty

No.2 T 6 )

o2 517 0

No.5 Gt 8 [0

e @

OFF ON 100

No.1[ No.2][ No.3[No.4] No.5 11110

OFF | OFF | OFF| OFF | ON 12 (0

{1310

T]1410)

150

11610

IM MW100-01E
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4.4 Calibration

For -NDI Bridge head
(701955 or 701956)
=1 10 1
EagslE
> 0 3
R [CRa [ e
=1 bl 5 Connect CH2 only
(R 1 [ oy 6
S
| [0] 8

|—— Setting switch

| e

SW 12345

SW1]SW2 [SW3[SW4[SW5
OFF | OFF | OFF | ON | OFF

» When calibrating the output range of the 8-CH, Medium-Speed Analog Output module
All eight channels are calibrated at Zero (0 V) and Full (10 V).

it 1 (@)

| 2 0

L Dg H :[I:i@

‘L Joen e
%\_Z_% HE= :[[5 @

E Digital multimeter %%%

E 1] 8 @
19 10
i 101
to1] :[[11@
|:2==1] II: @
T e
T}14

11510

Calibration of Temperature Measurements using Thermocouples

Required Instruments

» DC Voltage/Current Standard
Must meet the following specifications (5520A by FLUKE or equivalent):
Output accuracy: +(0.005%+1 pV) or less

* 0 °C reference temperature device
Must meet the following specifications (ZC-114/ZA-10 by Coper Electronics or
equivalent)
Standard temperature stability accuracy: £0.05°C or less
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4.4 Calibration

Reference Junction Compensation of Thermocouple Input

Normally, the input terminal of the input module is nearly at room temperature,
therefore the actual thermocouple output differs from the value in the table for the
thermoelectromotive force with the 0°C standard. Modules able to measure temperature
with thermocouples can be compensated by measuring the temperature of the input
terminal and adding the corresponding thermoelectromotive force to the actual
thermocouple output. Therefore with the measurement terminal shorted (equivalent to
an edge detection of 0°C), the measured value indicates the temperature of the input
terminal.

When calibrating modules capable of temperature measurements using thermocouples,
it is necessary to apply input from a DC standard voltage current generator with this
compensation voltage subtracted (the electromotive force of the 0°C standard that is
equivalent to the temperature of the input terminal). As in the figure, when performing
reference junction compensation at 0°C using a 0°C standard temperature device, you
can perform the calibration by inputting the 0°C standard electromotive force from DC
standard voltage/current generator.

Wiring Diagram

Thermocouple wires or
Copper wires TC extension wires 4-CH, High-Speed Universal

J-; ()() ( Input Module*

Input terminal

o

000
o ©

566 LI & [S7
0 oo

+

DC voltage standard wires wires

+© i
5 -6—] )
Copper

—=
L

- Thermocouple

Cold junction

* Connect the 10-CH, Medium Speed
0°C standard temperature Universal Input Module and the
device 30-CH, Medium Speed DCV/TC/DI
Input Module in the same manner
as well.

Nofte

» Calibration of temperature measurements of the MW100 Data Acquisition Unit using
thermocouples differs from calibration of DC voltage and RTD ranges in that the input
cannot be adjusted. If the temperature measurement calibration using thermocouples does
not meet the accuracy specifications, check thoroughly for input error and other problems,
then contact your Yokogawa dealer or representative.

» If errors exist in the thermocouple wires and TC extension wires, correct calibration is not
possible. Be sure to use a calibrated thermocouple.

IM MW100-01E
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4.5

Parts and Maintenance

This instrument does not have parts that need periodic replacement.

However the main module (model: MW100) has wearable parts listed below. Also, the
aluminum electrolytic capacitors below are included with each input/output module.
There is no replacement service for the parts listed.

If you are to use the MW100 for an extended time, repair or replace the main module
according to the service life of the parts and taking into consideration the actual usage

conditions.

Part Name Lifespan Remarks

Lithium battery Approx. 10 years When used under standard operating conditions.
One battery is used.

Aluminum electrolytic Approx. 10 years When used under standard operating conditions.

capacitor

The main module and PWM output module have fuses. These fuses cannot be replaced
by the user. If the fuse blows, contact your nearest YOKOGAWA dealer for repairs.

Installed Module Rating

Main module AC power supply Maximum rated voltage: 250 V; maximum rated current: 3.15 A
Type: Timelag (T)

Main module DC power supply Maximum rated voltage: 250 V; maximum rated current: 6.3 A
Type: Timelag (T)

PWM module Maximum rated voltage: 250 V; maximum rated current: 3.15 A
Type: Timelag (T)

4-18
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4.6 System Initialization

Initialization Type

Initialization Procedure

Perform this procedure to initialize the settings on the MW100. The following types of
initialization are available.

Type Level Items Initialized

Initialization using dip switches ---- All settings

Initialization using All Setting other than configurated module
communication commands information

All except Comm. Settings excluding the following items
(IP address, host name, subnet mask, default
gateway, DHCP parameters, DNS parameters,
communication timeout parameters, login
parameters, baud rate, parity bit, stop bit, data
length, handshaking, and module recognition
information)

Using Dip Switches

1.
2,

Turn OFF the power to the MW100.
Check that the switch 5 of dip switch 1 on the main module is OFF.

~BoEEAEEE

Turn OFF the power to the MW100.
After the 7-segment LED indicates the power ON self check, bF is displayed.

Check the status of step 3, then turn the power OFF.
Turn switch 5 of dip switch 1 ON.

Initialization using communication commands

Using a Browser

For information about initialization using communication command, see the MW100
Communication Command Manual (IM MW100-17E).

1.

3.

From the top screen, click System Settings > Module Information under the
Top item.

Select the initialization level from the Initialization Level box under System
information.

Click the Initialize button. Initialization is performed.

P> For a description of the operation screen for initialization, see section 3.3, “System Settings.”

IM MW100-01E

4-19

aaueuajulely pue Bugooysajgnoay H



4.7 Updating the System

You can upgrade the MW100 main unit firmware to the latest version. When you upgrade
the version, you can use the upgraded firmware on the MW100.

Note that to add new functions by upgrading the style, you need to purchase the style
upgrade Kit.

CAUTION

» If you update the firmware, all settings such as the IP address and range
settings are reset to factory default values. Saving the current settings to the CF
card before updating the firmware makes it easy to reconfigure the MW100 after
updating the firmware.

* The IP address, subnet mask, default gateway, host name, domain name, date,
and time are not saved to the setup file. Take a note of the IP address, subnet
mask, default gateway, host name, and domain name.

» Be sure to update both the firmware and Web software. Otherwise, the operation
may become unstable.

» Depending on the firmware style (release number), it may also be necessary to
upgrade the MW100 Viewer software. For details, visit our Web site or contact
your nearest Yokogawa dealer.

Update Preparation

Checking the Current Version
Check the current version of the MW100.

P> For the procedure to check the version, see “Viewing and Initializing the System Information”
in section 3.3.

Firmware and Web Software Preparation

1. Afile for upgrading the version can be downloaded from our Web site.
You must complete user registration at the URL given in the MW100 Data Acquisition Unit
Operation Guide (IM MW100-02E) before downloading the version upgrade file.

2. Double-click the EXE file that you downloaded to decompress the file.

3. Save the two extracted files to the root directory on the CF card.
The version upgrade files for style 3 are mw103m.Izh and web3_en.tar.
Confirm that no other files having the same extension are saved on the CF card.

Updating Operation
Check that the MW100 is in Setting Mode before starting the operation.
P> For a description of Setting Mode, see “Status Information and Processing” in section 3.3.

Updating the Firmware
1. Turn OFF the MW100.
2. Insert the CF card containing the firmware in the MW100 CF card slot.
3. Turn OFF switch 4 of the MW100 dip switch 1.

~ HERBAEE

2 34561738
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4.7 Updating the System

4. Turn ON the MW100. The MW100 starts loading the firmware.
If the 7-segment LED displays “90,” the loading operation is complete. If the LED
does not display “90,” redo the procedure from “Firmware and Web Software
Preparation.”

5. Turn OFF the MW100.

6. Turn ON switch 4 of the MW100 dip switch 1.
To proceed with the updating of the Web software, skip step 7, and carry out the
procedure from step 2 in “Updating the Web Software.”

7. Turn ON the MW100. The firmware is updated.

Updating the Web Software

1. Turn OFF the MW100.

2. Insert the CF card containing the Web software in the MW100 CF card slot.

3. Turn OFF switch 3 of the MW100 dip switch 1.

ON
386036

4. Turn ON the MW100. The MW100 starts loading the Web software.
If the 7-segment LED displays “bc,” the loading operation is complete. If the LED
does not display “bc,” redo the procedure from “Firmware and Web Software
Preparation.”

5. Turn OFF the MW100.

6. Turn ON switch 3 of the MW100 dip switch 1.

7. Turn ON the MW100. The Web software is updated.

Update Confirmation

The MW100 settings are initialized after the update operation. If the latest firmware and
Web software versions are displayed after specifying the network settings, the update
operation is complete.

P> For the procedure to check the version, see “Viewing and Initializing the System Information”

Restoring the Settings

in section 3.3.

To restore the settings before the update operation, set the network, set the date/time,
reconstruct the system, and load the setup file.
P> For a description of the network settings, see section 3.2, “Communication Settings.”
P> For a description of the date/time settings, see “Setting the Date and Time” in section 3.3.
P> For a description of the system reconstruction, see “System Reconstruction” in section 3.3.
P> For a description of the loading of the setup file, see “Saving and Loading Setup Data” in

section 3.15.

Deleting Temporary Internet Files

When you update the MW100, the time information is initialized. In rare cases, the
Setting or Monitor display of the browser may not display correctly. If this happens, delete
the temporary internet files (cache) of the browser.

If Java Runtime by Sun Microsystems Is Used
When you update the MW100, the Setting or Monitor display of the browser will not
display correctly. If you are using Java Runtime, clear the cache.

IM MW100-01E
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Chapter 5  Specification

5.1 Common Specifications

Normal Operating Conditions

Rated power supply voltage: AC power supply (with or without AC adapter): 100 to 240 VAC
DC power supply: 12 to 28 VDC

Supply voltage range used: AC power supply (with or without AC adapter): 100 to 250
VAC
DC power supply: 10 to 32 VDC

Power supply frequency: 50 Hz 2%, 60 Hz +2%

Power consumption: AC power, or DC power with AC adapter: Approx. 70 VA
max.
DC power supply: Approx. 35 VA max.
*When any six /0O modules are installed

Vibration: 10 to 60 Hz 0.2m/s® or less

Shock: Not allowed

Magnetic field: 400 A/m or less (50/60 Hz)

Position: Position horizontally with feet down
Structure: Not explosion-proof

Usage location: Indoors

Operating altitude: 2,000 m or less

Overvoltage category: Il (per IEC61010-1 CSA22.2 No. 61010-1)
Measurement category: Il (per IEC61010-1 CSA22.2 No. 61010-1)
Pollution degree: 2 (per IEC61010-1 CSA22.2 No. 61010-1)

Transport and Storage Conditions

Environmental conditions during transport and storage:

Ambient storage temperature : —25 to 70°C

Ambient storage humidity: 5% to 95% RH (no condensation)
Vibration: 10 to 60 Hz 4.9m/s? or less

Shock: 392 m/s® or less (packaged condition)

Mechanical Specifications (Excluding AC Adapter)

External dimensions: Approx. 455 x 131 x 159 mm (when six slots are attached)

Weight: Approx. 4.3 kg (maximum total weight)
Installation method:  Desktop or floor, panel mount, or attached to a DIN rail
Material: Steel plate, aluminum die-cast, molded plastic resin

Standards Compliance

CSA: CSA22.2 No 61010-1, overvoltage category Il, measurement
category I, pollution degree 2
UL: Conforms to UL61010B-1 (CSA NRTL/C)
CE: EMC directive; EN61326 Class A
EN61000-3-2
EN61000-3-3

Low voltage directive; EN61010-1; overvoltage category I,
measurement category I,
pollution degree 2
C-Tick: Conforms with AS/NZS CISPR11 Class A Group1
Overvoltage category Il:  An index for defining transient overvoltages (includes the
rated impulse withstand voltage, and applies to electrical
equipment supplied with power from fixed installations such as
a distribution board).
Pollution degree 2: The degree of adherence by a solid, liquid, or vapor that
reduces the withstand voltage or surface resistance factor
(applies only to normal indoor atmospheres (with non-
conductive pollution).
Measurement category Il: For measurements performed on circuits directly connected
to the electrical distribution system such as provided by a wall
outlet.

uonesyloadg ﬂ
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5.2 Main Module (MW100-E) Specifications

Measurement

Style number: S3

Measurement range and accuracy:
See the measurement range and accuracy given in the
specifications of each input module.

Maximum number of inputs:
60 inputs (however, only up to six modules can be controlled)

Measurement interval: Select from 10, 50, 100, 200, 500 ms, 1, 2, 5, 10, 20, 30, or 60 s.
Up to three intervals defined for the input modules can be set
(multi-interval)
Also, the following limitations apply to the measurement interval
and number of measurement channels.

Measurement Interval Number of measurable channels
10 ms 10
10 ms and 50 ms mixed. 10
50 ms 30

Synchronization between modules:
Synchronized within the same sampling interval (in the same unit)

Synchronization between channels:
On the 4-CH, High-Speed Universal Input Module, the 10-CH,
Pulse Input Module, and the 10-CH, High-Speed Digital Input
Module: synchronized between channels.
On the 10-CH, Medium-Speed Universal Input Module, 30-CH,
Medium Speed DCV/TC/DI Input Module, Six-Channel Medium-
Speed Four-Wire RTD Resistance Input Module, and 4-CH,
Medium-Speed Strain Input Module: not synchronized between
channels due to the scanner type.

Filter function: First-Order Lag Filter
Applicable measurement types: For each channel of DC voltage,
thermocouple, RTD, strain, pulse, and resistance you can select
a time constant (time until 63.2% of the output value is reached)
corresponding to the sampling interval indicated in the table below.
Time constant = measurement interval x N (where N =5, 10, 20,
25, 40, 50, or 100)

Measurement Interval (s) Selectable Time Constants (s)

N=5 N=10 N=20 N=25 N=40 N=50 N=100
0.01 0.05 0.1 0.2 0.25 0.4 0.5 1
0.05 0.25 0.5 1 1.25 2 2.5 5
0.1 0.5 1 2 2.5 4 5 10
0.2 1 2 4 5 8 10 20
0.5 2.5 5 10 12.5 20 25 50
1 5 10 20 25 40 50 100
2 10 20 40 50 80 100 200
5 25 50 100 125 200 250 500
10 50 100 200 250 400 500 1000
20 100 200 400 500 800 1000 2000
30 150 300 600 750 1200 1500 3000
60 300 600 1200 1500 2400 3000 6000
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Measurement groups: Measurement channels can be divided into up to 3 groups by
module. The measurement interval must be the same for all
channels in the group.

Note that the equivalent of three modules worth of measurement
group settings are entered for the 30-CH Medium Speed DCV/
TC/DI Input Module. You cannot assign to different measurement
groups or change the measurement interval. You must assign all
three slots to the same measurement group.

MATH

Differential computation between channels:
Differential computation between arbitrary channels (DCV, TC,
RTD, DI, strain, resistance, pulse)
Linear scaling: Scalable ranges: DCV, TC, RTD, DI, strain, resistance, pulse
Scaling range: —30000 to 30000
Scaling display range: —32000 to 32000
Decimal point position: Arbitrary
Units: Can be arbitrarily set using up to six characters
Linear scaling accuracy:
Linear scaling accuracy (digits)
= Measurement accuracy (digits) x expansion rate + 2 digits
(rounded up to the decimal place)
Note that the expansion rate = scaling span (digits) /
measurement span (digits)
(Ex.) Measuring range: 6 VDC (integral time of 16.67 ms or
more)
Measurement span: 1.000 to 5.000 V,
Scaling span: For a setting of 0.000 to 2.000
The measuring accuracy for 5.000 V input is as follows
according to the expression above.
+ {(0.05% % 5.000 V + 2 digits) x (2000 / 4000) + 2 digits}
=+ {(0.0025 V + 2 digits) x 0.5 + 2 digits}
=+425
~ 5 digits (rounded up to the decimal place)
Thus the measuring accuracy when scaling = £ 5 digits

MATH Function Specifications (/M1 Option)

The following MATH functions can be added with options.

Number of MATH channels: 60 (can also be used for communication input)

Number of channels for communication input: 240

Computation start/stop: Execution of computation starts and stops according to
user commands (Start/Stop key, Event/Action function, or
communication commands).

Note that computed data includes the data when
computation started and stopped.

MATH interval: Specify one from among the measurement group numbers,
and perform computation. However, measurement intervals
of 10 ms or 50 ms cannot be specified.

Computation reset/clear:  You can reset or clear the computed data via the Event/
Action function, communication commands, or requests from
operations in the monitor screen.

Group reset: Only the MATH channels set by group, up to seven groups,
are reset by the Event/Action function. Can be executed
using the Event/Action function.
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Calculations: Basic math (+, —, %, +, exponentiation)
Relational operators (>, 2, =, <, <, #)
Logical operators (AND, OR, XOR, NOT)
Arithmetic operators (SQR, ABS, LOG, EXP)
TLOG computations (max, min, max-min, average,
integration, pulse integration)
CLOG computations (max, min, max-min, average)
Conditional expressions ([EXPR1?EXPR2:EXPR3])
Order of precedence in expressions:
The order of precedence of operators is given below.
Type Operator

(High order of precedence)

Arithmetic, TLOG, and CLOG functions ABS(), SQR(), LOG(), EXP(), TLOG.MAX(), TLOG.MIN(),
TLOG.P-P(), TLOG.SUM(), TLOG.AVE(), TLOG.PSUM(),
CLOG.MAX(), CLOG.MIN(), CLOG.P-P(), CLOG.AVE()

Conditional operation [expression 1?expression 2:expression 3]
Power >

Logical negation NOT

Multiplication and division !

Addition and subtraction +, -

Relational computation .GT,, .LT,, .GE., .LE.

Equal and not equal .EQ., .NE.

Logical product AND

Logical sum and exclusive logical sum OR, XOR

(Low order of precedence)

Calculation order: Performs calculation in ascending order by channel number.
Characters used in expressions:
Up to 120 per channel
For communication input channels only, a maximum of
10 characters can be used per channel. Four arithmetic
operations and calculation constants can be written in
addition to the communication input channel number.
* Or “8 characters” on models with firmware version R3.02 or earlier.
Number of stacks: 35 or fewer per expression
Conditional expression: Other expressions can be nested in conditional expressions.
Conditional expressions can be nested together.
Operators cannot be used to combine conditional
expressions.
MATH span: When displaying waveforms on the Web, set the upper and
lower limit values.
The setting range is —9,999,999 to 99,999,999.

Decimal place setting: Oto4

Computation range: A given result during computation must be within £ 1.7 x
10>,

Math output value: Data output by the computation (for binary output)

Data Type Description

—-9,999,999 to 99,999,999 Normal output range

2,147,450,879 (TFFF7FFFh) Plus over

-2,147,385,343 (80018001h) Minus over

-2,147,319,806 (80028002h) Skip

* If the computation fails, the previous value is output.

MATH constants: 60

Precision: Mantissa, 5 digits; exponent, 2 digits
Range: —9.9999E+29 to —1.0000E-30,0,1.0000E-30 to
9.9999E+29
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Reference channel:

Measurement channel

MATH channels*

Communication input channels

Flag input channels

MATH constant

Program channels

* If an expression refers to its own channel or a channel of a
larger number than its own channel, the data from the previous
MATH interval is used.

Communication input channels: 300

Flag input channels:

Program channels:

Rolling average:

Numerical values in expressions can be substituted using

communication input.

Precision: Mantissa, 5 digits; exponent, 2 digits

Range: —-9.9999E+29 to —1.0000E-30,0,1.0000E-30 to

9.9999E+29

60

Flag value can be substituted in computational expressions.

Range: 0, 1

Varies according to the operation of the Event/Action function.

3

Broken line data can be input into expressions.

You can set time since the start point (set in units of seconds) and

the output values during that time using up to 32 points. Straight

lines link those specified points, and values corresponding to the

elapsed times are output.

No. of set points: 32

Elapsed time from start point: 0 to 86400 sec.

Start point time: Fixed at 0

Limitation on specification of elapsed time: Only 1 output value

per specified time allowed

Output values: —30000 to 30000

Sampling interval:
1 to 6/10/12/15/20/30 s, 1 to 6/10/12/15/ 20/30 min, and 1 hour
Set the sampling interval to an integer multiple of the MATH
interval. If it is not, the sampling interval is increased to an
integer multiple of the MATH interval. If the sampling interval is
shorter than the MATH interval, the sampling interval is set to
the MATH interval.

Number of samples: 1 to 1500

When the number of samples is not reached:
Calculates the average using the available data.

When upper/lower limit is exceeded:
If the MATH data exceeds the upper or lower limit, the data is
clipped at the upper or lower limit, and the rolling average is
computed. The upper and lower limits are £100000000. The
decimal place is the same as that of the MATH span.

Resetting the rolling average:
The rolling average is reset when you execute the following
operations. Clear the computed value, reset the computed
value, reset the computed value of the MATH group, change
the MATH channel, or change the channel setting of the rolling
average.

Processing when dropouts occur in the computed data:
If a dropout occurs in the computed data while sampling, the
rolling average is calculated using the next computed data.
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RJC

MATH alarm function: Four levels per channel
Type: Upper limit, lower limit, delay upper limit, and delay lower
limit. No hysteresis function available.

Loss of computed data:
In the monitor screen, when the MATH performance meter
exceeds 100%, some computations at each MATH interval cannot
be completed, and loss of computed data occurs. When this
happens, the previous computed value is held. If computation
loss occurs frequently, lengthen the MATH interval to reduce the
load. To stop computation promptly, press the Stop key on the
main module.

When the volume of computations is high:
Display updating on the monitor screen, response to computation
stop operations, and other behavior may be slow. To stop
computation promptly, press the Stop key on the main module.

Operation after power failure:
If a power failure occurs during a computation, the value
computed just before the power failure is recalled after recovery,
and computation starts using that value.

Type Value after power failure recovery
MATH channel data Holds previous value

Communication input channel data Holds previous value

Flag input channel data Holds previous value

Program channel data Holds elapsed time and previous value

With temperature measurement using thermocouples, the input terminal section is
nearly at room temperature, therefore the actual thermocouple output differs from the
value in the table for the thermoelectromotive force with the 0°C standard. Modules able
to measure temperature with thermocouples can be compensated by measuring the
temperature of the terminal and adding the corresponding thermoelectromotive force to
the actual thermocouple output. For the compensation accuracy, see specifications of
individual modules.
Internal RJC: Uses the reference junction compensation function of a module capable
of measuring temperature with thermocouples.
External RJC: Uses an external reference junction compensation function. Set the RJC
voltage to be added to the input.
Junction compensation setting range: —20000 to 20000 (pV)
Remote RJC: See “Remote RJC” in this section.

Remote RJC (RRJC)

When the item to be measured is located at a great distance, you can setup relay
terminals near the item, measure between the relay terminal and the input terminal of
the input module (reference channel) using thermocouples, and use the resultant value
as the reference junction compensation of the temperature measurement. However, the
same thermocouple type is used for reference channels and measured channels.
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Alarms

Alarm types: Upper limit, lower limit, differential upper limit, differential lower
limit, upper limit on rate-of-change, lower limit on rate-of-change,
delay upper limit, delay lower limit

Number of settings:  Four levels per channel
ON/OFF can be set for each channel and level

Alarm setting range:  DC voltage, TC, RTD, DI, strain, pulse, resistance, linear scaling,
differential between channels, remote RJC

Hysteresis: Alarm OFF value arbitrarily set

Rate-of-change calculation interval of rate-of-change alarms:

Upper limit on rate-of-change alarm: 1 to 32 times the
measurement interval
Lower limit on rate-of-change alarm: 1 to 32 times the
measurement interval
Number of alarm outputs:
10 to 60 outputs (10 points per DO module)

Output mode: Energize/De-energize, AND/OR, Hold/Non-hold

Alarm ACK: If set to hold using the alarm status or relay output Hold/Non-hold,
the hold status is cleared.

Alarm output update interval:

100 ms (not synchronized with the measurement interval)
Delay alarm: Delay time:
1 to 3600 s, common setting for delay upper and lower limits.
Set the delay time to an integer multiple of the measurement
or MATH interval. If it is not, the delay time is increased to an
integer multiple of the measurement or MATH interval. If the
delay time is shorter than the measurement or MATH interval,
the delay time is set to the measurement or MATH interval.
Operation at power failure:
After the power supply recovers, the alarm detection behavior
is reset, and new alarm detection is started.
Math start action:
The alarm detection behavior on the MATH channel is reset,
and new alarm detection is started.

Reflash alarm: If multiple alarms are assigned to an output relay and the
second alarm occurs while the first relay is activated, the relay is
deactivated once and activated again.

IM MW100-01E

uonesyloadg ﬂ



5.2 Main Module (MW100-E) Specifications

Report Function Specifications (/M3 Option)

Report operations:

Report types:
Report data channels:

Report data types:

Starts/stops creation of report data at the same time that
measurement starts/stops. If recording is in progress at the report
creation time, report data is saved to the CF card.

Report creation can be turned ON/OFF

Hourly, daily, weekly, or monthly

60 max

Measurement and MATH channels can be selected. If a target
channel is set to SKIP or OFF, report data is not created.

Reports can be created using all maximum, minimum, average,
integral, and instantaneous values from the specified channels.

Report data acquisition interval:

Report data values:

100 ms (shortest)

Numerical range: —9999999 to 99999999 (excluding the decimal
place)

Decimal place: Same as decimal place of the reference channel
Integratable range: 0.0001 to 1.000000E+16

Processing of special data:

You can select how to handle abnormal values maximum,

minimum, integral, and average values.

You can select how to handle overflows for integral and average

values.

* For details, see “Processing Reports with Abnormal Input Values
or Overflow Values” in section 1.16.

Report file creation date/time:

E-mail transmission:

You can set the date, day, or time of creation. The specified date/
time will be the date/time at which report files are divided. The
creation date/time for each report file is shown in the table.
Report  Creation Creation Creatjon Description

File Date Day Time™
Daily file — = 0to 23 Saves 1 day’s worth of
hourly and daily reports.
Weekly — Sun to 0to 23 Saves 1 week’s worth of
file Sat daily and weekly reports.
Monthly 1to282 - 0to 23 Saves 1 month’s worth of
file daily and monthly reports.
*1 “~”indicates that the item is invalid.

*2 The creation date cannot be set to 29, 30, or 31.

*3 The creation time for weekly and monthly reports is the same as the
creation time for the daily reports.

When an hourly, daily, weekly, or monthly report is created,
creates a report and sends by e-mail.

You can set whether or not to send the e-mail

An e-mail can be sent when a report file is completed

FTP transfer (FTP client):

Files can be transferred using the FTP client function when report
files are completed
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Recorder Structure

Measured data, computed data, thinned data, manual sample data, report data, setting
values, recording logs, and alarm summaries can be saved to the CF card.

Folder Structure

Folders for each file type are created on the CF card, and files are saved in them.

Folder types: » Folder for storing data folders
» Data folder
» Folder for storing manual sample files
+ Folder for storing report files
 Folder for storing settings files

Folder for storing data folders: DATA
Stores data folders.

Folder for storing manual sample files: MANUAL
Folder and file names cannot be specified

Folder for storing report files: REPORT
Folder and file names cannot be specified

Folder for storing settings files: CONFIG
Folder names cannot be specified

Data folder: Depends on the data folder name setting
If the data folder creation method is Auto, the folder number
management file MWFOLDER.INF is created in the DATA folder.
The file contains the latest folder numbers (nnnn), and should
not be deleted. When a DATA folder is deleted, a new folder is
created starting with 0000.

Folder for storing measured data, computed data, thinned data,
recording logs, and alarm summary files.

Data folder names: Names are created with one of four methods: Auto (automatic),
Partial (partially specified), Free (arbitrary string), or Date (date/
time).

Auto:  DATA + nnnn
DATA is fixed
nnnn is automatically generated from 0000 to 9999
Partial: Any 4 alphanumeric characters + nnnn, where nnnn =
0000 to 9999
You can specify a start number. The number is
automatically incremented.
If 1 to 3 characters are used, all spaces are filled in to the
left. If 5 characters or more are specified, they are not
reflected in the folder name.
If the folder name already exists, the existing folder is
used.
Free: Any 8 alphanumeric characters
If the folder name already exists, the existing folder is
used.
Date: Date/time + n, wheren=0t09,Ato Z
The date/time portion is in the format mddhhmm
The date/time is the local time when the folder is created.
m: month 1to 9, X (October), Y (November),
Z (December)
dd: day 1 to 31
hh: hour 00to 23
mm: minute 00 to 59
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Capacity of the CF card
Capacity needed for storage:
The recording starts only if sufficient free space for saving the
data is available on the CF card. The required free space is a total
of the following sizes.
» Space for storing the measured, computed, and thinned data.
One file size for Single and FullStop
Twice the one file size for Rotate
 Capacity of recording logs, alarm summaries, manual sample
files, reports, and other files
Approximately 5 MB

Recording of Measured/Computed Values
Measured and computed data can be saved by measurement group to the CF card.
Supported external media:
CF card Type | x 1 slot (Type | can be used)
Max. card size: 2 GB
Supported file systems: FAT12 and FAT16
Record start/stop: Starts and stops recording to CF card per the START and STOP
keys, Event/Action function, communication commands, or
monitor screen operation.
Recording action: Separate files created for each measurement group, and
measured and computed data are recorded on the CF card.
For each measurement group, you can select whether or not to
perform the save operation.
Recording stop action: Single, Full Stop, Rotate
Single: Creates a single file of a specified size on the CF card
and stops the recording.
Fullstop:  Creates files of a specified size until the CF card is full
and stops the recording.

Rotate: Creates files of a specified size until the CF card is full
and continues the recording by deleting the oldest file
in the folder.

The recording stop action can be specified for each interval

group.

If free space cannot be secured or when securing of free space

takes extended time, an error is indicated on the 7-segment LED.

For details, see chapter 4.1, “Media Related Errors.”

Trigger (recording start action):

OFF, Direct, and Trigger

Direct: Starts recording when recording start is executed.

Trigger:  Enters the trigger wait mode when recording start is
executed. Recording starts when an event occurs.

The recording start action can be specified for each interval

group.
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Pretrigger function:

Recording channels:

Recording interval:

File name:

Data length:

The pretrigger when the recording start action is set to Trigger can
be set for each interval group from 0 to 100% in 10% intervals.
Pretrigger length:  When there are fewer than ten data, the
pretrigger length is rounded up.
When there are ten or more data, the
pretrigger length is rounded down.
Ex.) Recording interval 600 second, data length 1 hour,
pritrigger 30 %
Number of data in a file: 1 hour /600 s =6
Pritrigger length =6 x 30/ 100 = 1.8 about 2 files
Posttriger length=6-2=4
You can select to record or not record for each channel. However,
the number of recording channels is limited as follows:
No. of recording channels per unit of time:
1500 ch/s (when not using the report or manual sample function)
1200 ch/s (when using the report or manual sample function)
Ex.) Measurement group 1 Recording interval 10 ms, 10 ch
Measurement group 2 Recording interval 100 ms, 50 ch
(1s/0.01s)x10ch+(1s/0.1s) x50 ch=1500 ch/s.
Set the recording interval for each measurement group as a
multiple of the measurement interval.
For a measurement interval of 50 ms, 500 ms, or 5 s, set a
multiple of 1, 2, 4, or 10.
For other measurement intervals, set a multiple of 1, 2, 5, or 10.
Otherwise, set a multiple of 1, 2, 5, or 10.
Automatically generated using the date and serial number
mddinnnn.MXD
m: Month file created (local time), 1 to 9, X (October),
Y (November), Z (December)
dd: Date when file created (local time), 1 to 31
i Files for measurement groups 1to 3 are 1to 3
Computed data files are M
Thinned data files are T
nnnn: Serial number (0000 to 9999)
MXD: File extension (uppercase)
Measurement groups for which TRIGGER was selected can be
set individually.
For the measurement groups on which Direct mode was selected,
all groups have the same length.

Trigger Type Selectable data length Target
Direct 30 min. All groups
1,2,3,4,6, 8, or 12 hours

1,2,3,5,7,10, 14, or 31 days

Trigger 10, 20, or 30 min. Individual groups
1,2,3,4,6,8,0r 12 hours
1,2,3,5,7,0r 10 days
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File size:
File size calculation:

Within approximately 10 Mbyte per file

File size (bytes) = header size” + data size™

*1 Header size (bytes) = Fixed length of 1448 + no. of recording
channels x 232

*2  Measurement data size (bytes) = no. of recording measurement
channels x 4 x no. of samples
Math data size (bytes) = no. of recording math channels x 6 x no. of
samples
No. of samples = Data length (s)/recording interval (s)

Ex.) Recording interval: 100 ms; no. of measurement channels, 24; data
length, 10 min.:
Header size = 1448 (bytes) + 24 x 232 (bytes) = 7016 (bytes)
Data size = 24 x 4 (bytes) x (600 (s)/0.1 (s)) = 576,000 (bytes)
File size = 7016 + 576000 = 583016 (byte)

= 569 (KB)

Guideline of the sample time for the different CF card sizes (when one type of recording

File division:

File message:

Write message:

interval is used):

Number of Recording Capacity of the CF card
Saved CHs Interval 128 MB 512MB 1GB
10 ms 8.8 hours 35.3 hours 2.8 days
100 ms 3.7 days 14.8 days 28.9 days
10 CHs 500 ms 18.5 days 74 days 144 days
1s 37 days 148 days 289 days
2s 74 days 296 days 578 days
100 ms 36.8 hours 6.1 days 12.0 days
500 ms 7.7 days 30 days 60 days
24 CHs 1s 15.3 days 61 days 119 days
2s 30 days 122 days 239 days
100 ms 14.8 hours 2.4 days 4.8 days
500 ms 3.0 days 12.3 days 24.1 days
60 CHs 1s 6.1 days 24.6 days 48 days
2s 12.3 days 49 days 96 days
5s 31 days 123 days 241 days

You can use the Event/Action function, status screen operations,
or communication commands to divide files at an arbitrary timing.
Valid when the recording start action is Direct and recording stop
action is Fullstop or Rotate.

The maximum number of characters that can be specified is 120.
The file message can be viewed when the file information is
displayed on the MW100 Viewer Software.

During execution of the recording action, a message that
corresponds to the recorded data can be included in the file.

No. of characters in message: Up to 15

Messages: 6 (messages 1 to 5, and Free)

No. of write operations: Up to 30 per file

Operation upon failure recovery:

If a power failure occurs during recording, the data up to the
failure is restored upon recovery from the failure. The data after
recovery is recorded continuously to newly created files.

Operation when synchronizing time:

If time synchronization to SNTP is carried out during recording,
the time is saved to the recording log file.
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Thinning Recording Function
Apart from the measured and computed data file, a set of thinned data from the

measured and computed values are saved to CF card.

Record start/stop:

Recording stop action:

Thinning time:

Recording channels:

File name:

Data length:

File size:
File size calculation:
File division:

File message:

Writing message:

Operation upon failure

Executed simultaneously with the start/stop of the recording

of measured and computed values. No trigger functions are
available. User can select Thinning record or Do not record
Select a record stop action of Single, Full stop, or Rotate.

See recording stop action in “Recording of Measured/Computed
Values”

Data saving is set for 1 per thinning time.

Set a thinning time of: 4, 5, 10, 20, or 30 sec; 1, 2, 3, 4, 5, 10, 20,
or 30 min.; or 1 hour. However, the thinning time cannot be set
shorter than the measurement interval.

Can be specified for each channel (settings for recording of
measured and computed values is set separately)

Generated automatically in sequence using the date and serial
number (cannot be specified by the user).

See the file names in “Recording Measured/Computed Values."
Select 30 minutes, or 1, 2, 3, 4, 6, 8, or 12 hours, or 1, 2, 3, 5,
7,10, 14, or 31 days. However, it cannot be set so that the file
size could exceed 10 Mbyte. Also, the data length cannot be set
shorter than the thinning time.

Within approximately 10 Mbyte per file

Same as that for the computed data files.

You can use the Event/Action function, status screen operations,
or communication commands to divide files at an arbitrary timing.
Valid when the recording stop action is Fullstop or Rotate.

The maximum number of characters that can be specified is 120.
The file message can be viewed when the file information is
displayed on the MW100 Viewer Software.

During execution of the recording action, a message that
corresponds to the recorded data can be included in the file. Six
messages of up to 15 characters each are available for including
in a single file, up to 30 messages per file.

recovery:

If a power failure occurs during recording, the data up to the failure
is restored after appended during recovery from the failure. The
data after recovery is recorded continuously to newly created
files.
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Manual Sample Recording Function
Manual sample operation:

Special data values:

Number of samples:

Sample channels:
Data format:
File name:

Maximum file size:

* When Manual Sample is executed using an Event/Action,
communication command, or status screen operation, the latest
measured or computed values are saved to the CF card. If a
manual sample operation is executed while writing to a manual
sample file is in progress, the operation is ignored. Also, the
manual sample file is divided when Manual Divide is executed.

» After manual sample data is recorded in backup memory
(SRAM), it is saved to the manual sample file. If the CF card
runs out of free space, data is recorded in the SRAM until
space becomes available on the card, at which point it is saved
to the file. The number of times samples can be saved to
SRAM = 2048 + (no. of channels + 3). If that number of times is
exceeded, samples are overwritten (and deleted).

* The free space required on the CF card to save the manual
sample file = total file size of measured/computed/thinned files
(times 2 when Rotate is set) + 512 KB.

* When the recording action is Rotate and old files are deleted to
create new files, (when there is no free space on the CF card),
the manual sample file cannot be saved.

When measured or computed data is special data, the manual

sample data is as shown below in the table.

Measured/

Computed Data Manual Sample Data Notes

Measured data: 99999

+
OVER Computed data: 99999999 Decimal place
_OVER Measured data: —99999 depends on the setting
Computed data: —9999999
INVALID,
ILLEGAL Blank Measured values only

100 samplesf/file

Can be specified for each channel

Tab delimited text

Automatically generated using the date and serial number (the

date is the file create date)

mddSnnnn.DAM

m: Month file created (local time), 1 to 9, X (October),
Y (November), Z (December)

dd:  Date when file created (local time), 01 to 31

S: Fixed character

nnnn: Serial number (0000 to 9999)

DAM: Manual sample file extension (uppercase)

Approximately 360 KB/file (max)
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Report Recording Function (/M3 Option)
Record start/stop operation: Executed simultaneously upon recording start/stop of
measured and computed values. No trigger function available.
Report data: Creates daily, weekly, and monthly data. The creation time for
daily, weekly, and monthly reports is the same as the daily report
file creation time.
Report recording channels:
Can be specified for each channel (up to 60 channels).
Data format: Tab delimited text
File name: Automatically generated using the date and serial number (the
date is the file create date)
jyymmddn.DAR
i D (daily), W (weekly), M (monthly)
yy:  Year when file created (local time), last 2 digits of Western
calendar
mm: Month when file created (local time), 01 to 12
dd: Date when file created (local time), 01 to 31
n: Serial number (0 to 9, Ato Z)
DAR: Report file extension (uppercase)
Maximum file size: Approximately 135 KB/file (max)

Saving Settings
Saves settings to CF card.
Saving/loading: Set by user function key on the main unit, browser, or by
communication command. From the user function key, only the
SETTING.PNL file can be saved and loaded.
Settings that can be saved:
All settings are saved
Saved items: Channel: Input range, output range, expression, calculation
constant, MATH group, alarm, delay alarm, rolling
average, filter and TC, strain input, relay, program
channels, measurement operation, computation
operation, output operation, and tag settings.
Recording: Recording channel, recording operation, thinning
recording operation, save option, file message, and
data save folder settings
Communication: User, serial communication, IP address*, server,
Modbus client 1 to 3, Modbus master 1 and 2,
DNS client, FTP client, mail client 1 to 3, and
time synchronization client settings.
* The DNS and IP address information can be saved,
but the information is not loaded.
Others: Event action, timer, match time, report, other (system),
Daylight Savings Time, color, graph scale, trip line,
message, display group, and other (display) settings.
File creation location: CONFIG folder on the CF card
Created file name: From the user function keys, SETTING.PNL.
An arbitrary file name can be set with the PNL extension from
communication commands or the browser. The maximum number
of characters for the file name is 8 excluding the extension.

IM MW100-01E
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Display

Internal Backup Memory

Function overview:

Using the main unit’s internal backup memory (SRAM) even upon
a power failure, data before the failure is saved to CF card without
loss.

Backup memory capacity: For measured and computed data 1.25 Mbyte
For thinned data 256 Kbyte
For manual sample data 8 Kbyte
For report data 48 Kbyte
Status LED llluminated: Indicates measuring, recording, alarm occurrence,

computing, and receiving data by serial communications
Blinking: Processing recording stop, processing MATH stop

Two-digit 7-segment LED:

Ethernet port LED:

MW100 Data Acquisition Unit status display

Unit number, error occurrence time, power ON self-check in
progress, key lock ON, processing.

Ethernet communication status (LINK, ACT)

Measured data monitor display (display on a web browser):

Trend display*, digital display*, bar graph*, meters*, overview
display, alarm summary, manual sample, and report
* Displayed in groups. 18 groups at maximum, 20 channels/group

5-16
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Communication
Ethernet Port
Interface: Ethernet 10BASE-T/100BASE-TX
The data rate can be fixed to 10 Mbps half duplex by turning
switch 6 of dip switch 1 OFF.
Connector type: RJ-45
Main protocols: FTP, SMTP, SNTP, DHCP, DNS, HTTP, Modbus/TCP, and MW100
dedicated protocol.
Communication services:  Send/receive measured and computed values, send/receive
setting values, maintenance/diagnostic services, and others.
Login function: Use when accessing a setting/measurement server, maintenance/
diagnostic server, FTP server, or HTTP server. Up to 10 can be
registered.
List of services: The port number of each server is the default number.
Server Type Application Port Number Number of Simultaneous
Connections
Modbus server For the Modbus protocol 502 4
FTP server File transfer service 21 4
HTTP server Web service 80 Infinity
SNTP server Adjust the time 123 Infinity
GENE server For MW100-specific 34318 4
communication commands
DIAG server For MW100 maintenance 34317 1
EtherNet/IP server EtherNet/IP 44818 10
* Firmware version R3.02 or later
Keep alive function: If no response is made to periodically sent test packets on the TCP level,
the connection is forcibly closed.
The connection is checked every 30 s. If there is no response, the
connection is checked four times at 5-s intervals. If no response is
received, the connection is disconnected.
Timeout function: Connection to server from which no communication is made over
a specified period is forcibly dropped.
Server Type Timeout Value
Modbus server 30s
FTP server 10 minutes
HTTP server 2 minutes
GENE server | 1 to 120 minutes. Set in unit of 1 minute.
DIAG server 10 minutes
EtherNet/IP server ° 10 minutes
*1 You can select whether to use the timeout function for the GENE server.
*2 Firmware version R3.02 or later
DHCP function: The IP address is automatically obtained from the DHCP server
IM MW100-01E 5-17
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SNTP function:

E-Mail function:

FTP function:

Client function:
Acquires time information from the specified SNTP server
when the power is turned on, upon start of measurement, when
the SNTP client is turned ON, at a user-specified time, and at a
specified time interval.
When time information is acquired upon startup, measurement
start, and when the SNTP client is turned ON, the time is
not applied if the difference between the time of the MW100
and the server is 1 hour or more. When the time is acquired
at specified time intervals, the MW100 time is corrected by
1 second at 10 second intervals. This is effective when the
shortest measurement interval within a unit is two seconds or
more. However, if the time between the server and MW100 is
different by 10 minutes or more, the time is not applied.
Server function:
Provides time information to the MW100 connected to the
network.
Sends e-mail according to timing of: alarm activation/release,
specified time intervals, file creation time, time at which free
memory space drops below specified amount, time power turned
ON, when specified errors occur, when reports are created, and
other events.
Recipients: Two mail recipient locations can be set
Number of characters: Multiple addresses using up to 150
characters
User Authentication: POP before SMTP(PLAIN, APOP), SMTP
Authentication (PLAIN, CRAM-MDS5,
Firmware version R3.02 or later)
Client function:
Measured data, computed data, thinned data, manual sample
data, report data files, recording logs, and alarm summaries
that are saved to CF card can be sent.

Recipient: Primary and secondary
Number of characters: Up to 64 characters
Transmission time: When the file is created

Transmission time shift: ~ You can delay the transmission
timing by a specified time.
» Specified as 0 to 120 minutes, in
1-minute increments
» The duration of the transmission
time shift cannot be set shorter
than the recording data length.
The maximum number of files
on which the transmission
time shift function can be used
simultaneously is 24.
The files are sent to the primary recipient first, and if
transmission fails, they are sent to the secondary recipient.
If transmission to the secondary recipient also fails, the file is
held in memory (up to 24 files that failed to be sent are held)
and transmission is retried after the next file is created or when
the power is turned on (assuming there are files in the CF
card). File retransmission is cancelled if the FTP client function
is turned OFF.
Server function:
Transfer or delete files according to commands from a PC.

IM MW100-01E
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HTTP function: Enables entry of settings on the MW100, starting and stopping
of measurement, computation, and recording, and real time
monitoring of measured and computed values using a Web
browser, as well as acquisition of CF card files using WebDAV.

RS-232 Interface (/C2 Option)
Connection method:  Point-to-point

Communications: Full-duplex

Synchronization: Start-stop synchronization

Baud rate: 1200, 2400, 4800, 9600, 19200, 38400, 57600, or 115200 bits
Start bit: 1 bit, fixed

Data length: Select either 7 or 8 bits

Parity: Select even, odd, or none.

Stop bit: Select either 1 or 2 bits

Hardware handshaking: RS-CS can be used

Software handshaking: X-ON, X-OFF can be used

Receive buffer length: ~ 2047Byte

Protocol: Dedicated protocol and Modbus/RTU

Communication services:  Send/receive setting values, send/receive measured and
computed values.

RS-422A/485 Interface (/C3 Option)
Connection method:  Multi-drop: 4-wire 1: 32, 2-wire 1: 31

Communications: Half-duplex

Synchronization: Start-stop synchronization

Baud rate: Select 1200, 2400, 4800, 9600, 19200, 38400, 57600, or 115200 bps
Start bit: 1 bit, fixed

Data length: Select either 7 or 8 bits

Parity: Select even, odd, or none.

Stop bit: Select either 1 or 2 bits

Receive buffer length: 2047Byte

Protocol: Dedicated protocol and Modbus/RTU

Communication services:  Send/receive setting values, send/receive measured and
computed values.

Communication Input Function
All settings on the main unit other than dip switch operation can be performed with

communication commands. For information about communication commands, see the
MW100 Communication Command Manual (IM MW100-17E).
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Communication Output Function

The following information about the main unit can be output using communication
commands. For information about communication commands, see the MW7100
Communication Command Manual (IM MW100-17E).

Item

Description

Measured value

Outputs most recent measured value

Computed value

Outputs most recent computed value

Output value

Outputs most recent output value

Units, decimal place

Outputs the units and decimal place for measured and
computed values

Measured and computed value
FIFO data

Qutputs the measured and computed values from the FIFO
buffer

Thinned values FIFO data

Outputs the thinned values from the FIFO buffer

Alarm summary

Outputs the alarm summary

Message summary

Outputs the message summary

Recording log

Outputs the recording log

Computation status

Outputs the MATH status

Recording status

Outputs the recording status

Operation log

Outputs the key operation log

Communication log

Outputs the communication log

FTP log Outputs the FTP operation log
SMTP client log Outputs the mail transmission log
DHCP log Outputs the DHCP log

HTTP log Outputs the HTTP log

Modbus client log

Outputs the Modbus client log

Modbus client command

Outputs the Modbus client status

Modbus client connection status

Outputs the Modbus client connection status

Modbus master log

Outputs the Modbus master log

Modbus master command

Outputs the Modbus client status

Modbus master connection status

Outputs the Modbus master connection status

CIP server Iog'

Outputs CIP server information

PCCC slave Iog'

Qutputs PCCC slave information

Status

Status byte information

User information

User settings

Relay information

Relay action information

System information

Outputs the module recognition status

Analog output information

Outputs the analog output value information

Initial balancing information

Outputs initial balance information for the strain input module

* Firmware version R3.02 or later

Communication Test

This function checks whether the FTP and mail transmission settings are entered

correctly.

Notation Description

FTP1 Transfers a test file to recipient 1.
FTP2 Transfers a test file to recipient 2.
SMTP1 Transfers a test mail to recipient 1.
SMTP2 Transfers a test mail to recipient 2.
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Modbus Protocol Specifications

Common to Modbus Master Function and Modbus Slave Function
Communication possible in RTU mode of the Modbus protocol

Communication media:
Control method:
Baud rate:

Start bit:

Data length:

Parity:

Stop bit:
Transmission mode:
Slave address:

RS-232, RS-422A/485

No flow control (None only)

Select 1200, 2400, 4800, 9600, 19200, 38400, 57600, or 115200
bps

1 bit, fixed

8 bit, fixed

Select Odd, Even, or None

Select either 1 or 2 bits

RTU (remote terminal unit) mode only

1 to 247 (slave address only)

Modbus Master Function (/M1 option)

Communication interval:

Timeout time:

The interval for reading and writing data to and from other
instruments is selected from the following.

100, 200, 250, 500 ms, or 1, 2, 5, 10, 20, 30, 40, 50, 60, 90,
120 s

Depending on the performance of the main unit, if data reading
and writing is not possible at the set communication interval,
data loss results. If this occurs, the previous value is held for
the communication input channel data. In this case, you must
lengthen the communication interval, or reduce the load on the
main unit.

From the following, select a timeout time for no response from
the specified slave after sending commands from the main unit.
100, 200, 250, 500 ms, or 1 s

Number of retries: The number of transmissions attempted if no response to
commands from the main unit are received from the slaves.
Select from the following: OFF, 1,2, 3,4, 0r5
Communication recovery time: You can select from the following the send interval for the
command sent after the point at which there is no
response from the slaves after sending commands the
specified number of retry times.

1t0120s

Wait between commands: Select a time to wait between receiving of the response to
a command until the next command is sent.
Off, 0, 10, 20, 50, 100 ms

Supported functions: The functions that the MW100 supports are as follows.

Function Code Function

Action

1 Read statuses of coils (0xxxx) Reads statuses of a series of coils.
2 Read statuses of input relays (1xxxx)  Reads statuses of a series of input
relays.

3 Read values of hold registers (4xxxx,  Reads values of a series of hold
4XXXXX) registers.

4 Read values of Input registers (3xxxx, Reads values of a series of input
3XXXXX) registers.

5 Turn status of a single coil (Oxxxx) Turns off/on a single coil.

6 Write a value to a single hold register ~ Writes a value to a hold register.
(4XXXX, 4XXXXX)

15 Turn statuses of coils (0xxxx) Turns off/on a series of coils.

16 Write values to hold registers Writes values to a series of hold

(4XxXXX ,4XXXXX)

registers.

* Firmware version R3.04 or later

IM MW100-01E
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Command settings: Up to 100 commands can be set.
Command items: Loading channels: C001 toC300
Writing channels: 001 to 060, A001 to A300, C001 to C300

Address: 1to 247

Input registers: 30001 to 39999, 300001 to 365535
Hold registers: 40001 to 49999, 400001 to 465535
Type:

Type Description

Int 16 Signed 16-bit integer

Uint 16 Unsigned 16-bit integer

Int 32 - Big Signed 32-bit integer (from upper to lower. )

Int 32 - Little  Signed 32-bit integer (from lower to upper. )

Uint 32 - Big Unsigned 32-bit integer (from upper to lower. )

Uint 32 - Little Unsigned 32-bit integer (from lower to upper)

Float - Big 32-bit floating decimal (from upper to lower. )

Float - Little ~ 32-bit floating decimal (from lower to upper)

If the type is Int 16 or Uint 16, the maximum number of channels that can
be specified for read/write channels is 127. For other types, the maximum is
63.

Bit data values output by Modbus client/master when the command type is set to “Write”

in the Modbus client/master settings, see the followings:

» Values per Modbus Registers (Measurement channel data and MATH channel
data)(page 5-25)

» Values per Modbus Registers (Communication input channel data)(page 5-26)

Modbus Slave Function
Supported function:  The functions that the MW100 supports are as follows.

Function Code Function Operation

1 Read statuses of coils (0xxxx) Reads statuses of a series of coils.

2 Read statuses of input relays (1xxxx) Reads statuses of a series of input
relays.

3 Read values of hold registers (4xxxx) Reads values of a series of hold
registers.

4 Read values of Input registers (3xxxx)  Reads values of a series of input
registers.

5 Turn status of a single coil (0xxxx) Turns status of a single coil.

6 Write a value to a single hold register ~ Writes a value to a hold register.

(4xxxx)

8 Loop back test Returns the same message as the
command message.

15 Turn statuses of coils (0xxxx) Turns statuses of a series of coils.

16 Write values to hold registers (4xxxx)  Writes values to a series of hold
registers.

* Firmware version R3.03 or later
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Register Assign (Modbus Server Functions and Sharing)

Coil Data Data type
00001 Data on communication input channel C001 Bit

00002 Data on communication input channel C002 Bit

I I I

00300 Data on communication input channel C300 Bit

Communication input channel coils are 0 (Off) when data is zero, infinite (+Inf, —Inf), or
NaN, and 1 (On) when data is one or non-infinite.

* Firmware version R3.03 or later

Input Relay* Data Data type
10001 Data on measurement channel 001 Bit

10002 Data on measurement channel 002 Bit

I | [

10060 Data on measurement channel 060 Bit

Input relays of measurement channels are 0 (Off) when data is zero, infinite or of a special
value (+Over, —Over, Skip, No Channel, Error, Invalid, or Lack), and 1 (On) when data is
one or non-infinite.

13001 Data on MATH channel A001 Bit
13002 Data on MATH channel A002 Bit
I | [

13300 Data on MATH channel A300 Bit

Input relays of MATH channels are 0 (Off) when data is zero, infinite or of a special value
(+Over, —Over, Skip, No Channel, Error, Invalid, or Lack), and 1 (On) when data is one or

non-infinite.
18001 Measuring Bit
18002 Computing Bit
18003 Recording Bit
18004 Alarm occurring Bit
18005 Waiting to confirm alarm status Bit

Input relays indicating mode information are 1 (On) during operation in the relevant mode,
and 0 (Off) when stopped.

* Firmware version R3.03 or later

Input Registers Data Data Type
30001 Lower byte of measured data of measurement channel 001 Int 32
30002 Upper byte of measured data of measurement channel 001
I I
30119 Lower byte of measured data from measurement channel 060
30120 Upper byte of measured data from measurement channel 060
» No decimal place information
31001 Lower byte of measured data from measurement channel 001 Float
31002 Upper byte of measured data from measurement channel 001
I I
31119 Lower byte of measured data from measurement channel 060
31120 Upper byte of measured data from measurement channel 060
* Includes decimal place information.
32001 Alarm status of measured data of measurement channel 001 Bit string
I I
32060 Alarm status of measured data of measurement channel 060
» Register structure and alarm status values
Alarm 2 1 4 3
| abits | 4bits | abits | 4bits |
0: No alarms 1: Upper limit alarm occurs
2: Lower limit alarm occurs 3: Differential upper limit alarm occurs
4: Differential lower limit alarm occurs 5: Upper limit on rate-of-change alarm occurs
6: Lower limit on rate-of-change alarm occurs ~ 7: Delay upper limit alarm occurs
8: Delay lower limit alarm occurs

IM MW100-01E
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Input Registers Data Data Type
33001 Lower byte of computed data of computation channel AO01 Int 32
33002h Upper byte of computed data of computation channel AO01
I |
33599 Lower byte of computed data of computation channel A300
33600 Upper byte of computed data of computation channel A300
.» No decimal place information
34001 Lower byte of computed data of computation channel AO01 Float
34002 Upper byte of computed data of computation channel AO01
I
34599 Lower byte of computed data of computation channel A300
34600 Upper byte of computed data of computation channel A300
* Includes decimal place information.
35001 Alarm status of computed data of computation channel A001 Bit string
I I
35300 Alarm status of computed data of computation channel A300
« Register structure and alarm status value: Same as alarm status of measured data.
36001 Data from measurement channel 001 Int 16
36002 Data from measurement channel 002
I I
36060 Data from measurement channel 060
* No decimal place information
« Firmware version R3.04or later
37001 Data from MATH channel A001 Int 16
37002 Data from MATH channel A002
I I
37300 Data from MATH channel AO03
» No decimal place information.
* Firmware version R3.04 or later
38001 Measuring Int 16
38002 Computing Int 16
38003 Recording Int 16
38004 Alarm occurring Int 16
38005 Waiting to confirm alarm status Int 16
* Input registers indicating mode information are 1 (On) during operation in the relevant
mode, and 0 (Off) when stopped.
» Firmware version R3.03 or later
39001 Year Int 16
39002 Month
39004 Hours
39005 Minute
39006 Second
39007 Milliseconds
39008 DST(0, 1)
Hold Registers Data Data Type
40001 Lower byte of communication input channel C001 Float
40002 Upper byte of communication input channel C001
I I
40599 Lower byte of communication input channel C300
40600 Upper byte of communication input channel C300
41001 Lower byte of communication input channel C001 Int 32
41002 Upper byte of communication input channel C002
I |
41599 Lower byte of communication input channel C300
41600 Upper byte of communication input channel C300
» Firmware version R3.04 or later
42001 Communication input channel C001 Int 16
42002 Communication input channel C002
I |
42300 Communication input channel C300
* Firmware version R3.04 or later
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Values per Modbus Registers (Measurement channel data and MATH channel data)
The main module handles data on measurement channels as type Int16, and data on
MATH channels as type Int32. The Modbus register values of these data are shown in

the table below.

Value type Name/description of value Value per Modbus register
Int 32 Int 16 Float Bit "

+Over +Qver 2,147,450,879 32,767 +Inf(0x7f80 0000) O
Data value greater than the upper limit  (Ox7fff 7fff) (0x7fff)

—Qver —Over -2,147,385,343 32,767 —Inf(0xff80 0000) 0
Data value smaller than the lower limit ~ (0x80001 8001)  (0x8001)

Skip Skip -2,147,319,806  —32,766 —NaN(0xff80 0
Channel disabled (0x8002 8002) (0x8002) 0002)

No Channel No channels —2,147,254,269 -32,765 —NaN(0xff80 0
No channels exist (0x8003 8003) (0x8003) 0003)

Error Error —2,147,188,732 -32,764 —NaN(0xff80 0
Error in computation of data value (0x8004 8004) (0x8004) 0004)

Invalid Undefined -2,147,123,195  -32,763 —NaN(0xff80 0
Data value is undefined (0x8005 8005) (0x8005) 0005)

Lack Computation omitted -2,147,057,658 -32,762 —NaN(0xff80 0
Computation not processed (0x8006 8006) (0x8006) 0006)

Valid Data is valid Mantissa * Mantissa * ° Physical qty. 0,1°

*1 The value of the bit alone is insufficient to determine whether it is a special value. Mode (18000’s, 38000’s) and other

information must also be used to determine whether it is a special value or other value.

*2 If the data to be computed or the computed result is NaN, an error occurs. Furthermore, data resulting in an error is

replaced with +Over or —Over according to the “Operation upon Computation Error” setting.

*3 After turning the power to the MW100 ON, data values are undefined (Invalid) until initial measurement and computation are
finished (until the first data of measurement and MATH channels is created).

*4 Only the mantissa of values can be acquired from Int 32 format data of measurement and MATH channels. Decimal place
information of some form must be acquired separately from the MW100 in order to convert to physical values.

*5 When the expressible range in the Int 16 type is exceeded, the value takes on the upper or lower limit for the data range.
Take care when you use Int 16 registers to handle MATH channel data. Let x and y denote the original data and the
corresponding values per Modbus registers respectively,
y=min (when x < min)
y=x (when min < x < max)
y=max (when max < x)

where min=-32,768 (0x8000), max=32767 (0x7fff)

*6 The value is 0 (Off) when the corresponding measurement channel data or MATH channel data is zero, and 1 (On) when
data is not zero.

Nofte

This is an example of acquiring decimal place information.

» For measurement channels
» In the Web browser’s Input Range Setting screen, check the values in the Decimal
columns under Scale (when scaling is not used, the decimal place of the value in the

Span column).

» Acquire channel information using an SR command query of the MW100-specific
communication service.

* Output measurement channels using the FD command of the MW100-specific
communication service, then check the “Exponent” value.

e For MATH channels
» In the Web browser’s “Expression Settings” screen, check the value in the Decimal
column under Span.

* Acquire channel information using an SO command query of the MW100-specific
communication service.

»  Output MATH channels using the FD command of the MW100-specific communication
service, then check the “Exponent” value.

IM MW100-01E
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Values per Modbus Registers (Communication input channel data)
The main module handles data from the communication input channels as type Float.
The Modbus register values of these data are shown in the table below.

Comm. Input

Value (y) per Modbus Register

Channel Data Float Int 32 Int 16 Bit '
(Float)(x) min = —2,147,483,648 min = -32,768

max = 2,147,483,647 max = 32,767
+Inf +Inf max max 0
—Inf —Inf min min 0
NaN NaN max max 0
Valid Data (physical gty.) Data (integer)*2 Data (integer)'2 0,1°

y = integral portion of x (min £ x £ max)

y=min (x < min)
y = max (X > max)

y = integral portion of x (min £ x £ max)
y=min (x < min)
y = max (X > max)

*1  The value of the bit alone is insufficient to determine whether it is a special value. Mode (18000’s, 38000’s) and other
information must also be used to determine whether it is a special value or other value.

*2 The value is read in with the values after the decimal place removed. For example, if the value stored in a communication
input channel is 56.78, the value read in under the Word type is 56. If the value stored in a communication input channel is
—12.34, the value read in under the Word type is —12.

*3 The value is 0 (Off) when the corresponding communication input data is zero, and 1 (On) when the data is not zero.

Modbus error response:

The main unit returns the following error codes to the master

instrument.
Code Function Operation
1 Function code invalid Requested non-supported function
2 Invalid register number Attempted to read/write registers for which no
corresponding channels could be found.
3 Invalid number of registers The specified number of registers was zero.
7 Could not be executed Attempted to read MATH registers from an

instrument without the MATH function option.

However, there is no response in the following cases.

* CRC Error

« Errors other than in above table.
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Modbus Client Function (/M1 option)

Communication possible with Modbus/TCP protocol

Communication media: Ethernet 10BASE-T/100BASE-TX

Communication interval: You can select the following:
100, 200, 250, or 500 ms, or1,2,5,0r 10 s
Depending on the performance of the main unit, data
reading and writing may not be able to be performed at
the set communication interval resulting in data loss. If this
occurs, the communication input channel holds the previous
value. In this case, you must lengthen the communication
interval, or reduce the load on the main unit.

Connection wait time: The connection can be dropped if there is no response from
the server after sending commands.
You can select the connection wait time from the following.
Forever (do not drop connection), 0 to 10 s

Communication recovery wait: The time after which commands are sent following
disconnection after the connection wait time. Selected from
the following: Soon (communication interval), 1-60 s

Connection destination (server):  Up to 10 can be set.

Supported function: Same as Modbus master function
Command settings: Up to 100 commands can be set.
Command items: Loading channels: C001 to C300

Writing channels: 001 to 060, A001 to A300, C001 to C300
Server (specified by registered number): 1 to 10

Input registers: Same as Modbus master function

Hold registers: Same as Modbus master function

Type: Same as Modbus master function

If the type is Int 16 or Uint 16, the maximum number of
channels that can be specified for read/write channels is
127. For other types, the maximum is 63.

Modbus Delay Response: You can specify a wait time of 0, 10 ms, 20 ms, or 50 ms
before the Modbus server responds to commands, so that
the MW100 processing capacity will not diminish even when
connected in continuous communication mode.

Modbus Server Function

Communication possible with Modbus/TCP protocol

Communication media: Ethernet 10BASE-T/100BASE-TX

Port: 502/tcp

Maximum no. of simultaneous connections: 4

Receive timeout: Drops communication connection if packets not received for
30 s (fixed) or more

Supported function: Same as Modbus slave function. However, there is no
function code 8 (loopback test).

Register assignments: Same as Modbus slave function

Modbus error response: Same as Modbus slave function
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EtherNet/IP Server Function (Firmware version R3.02 or later)

The server function enables you to read measured data from MW100 measurement channels, and
computed data from MW100 math channels, and read/write data on communication input channels.

Specifications Descriotion

Implementation Level 2 (Message Server + /O Server)
Connection Max. 20 connections (10 sessions)
Protocol EIP / PCCC, EIP / native

Messaging Explicit (UCMM, Class 3) + I/0O (Class 1)
Object

Assembly, PCCC, Data Table, Identity, Message Router, Connection
Manager, Ethernet Link, TCP/IP Interface
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Event Action

By linking the Event function and Action function, you can control the operations of the

main unit.
Number of settings:
Event function:

Action function:

Event detection:

Execution sequence:

Timer and Match Time

Internal Timer
No. of timers:
Types of timers:
Relative time timer:

Absolute time timer:

Match Time
No. of match times:
Match time function:

30
Digital input information, alarm occurrence, relay action, internal
timer time up, match time, user function key, and recording start.
A relay action caused by the reflash alarm also operates as an
event.
Recording start/stop, activate trigger, computation start/stop/
reset/clear/group reset, reset timer, alarm ACK, flag input, write
message, divide file (measurement/computation/thinning daia
file, read/write settings, perform manual sample, divide manual
sample file
Read/write setting value file can be performed with user function
key.
Edge: Execute an operation once according to changes in events
Level: Continue operation as long as the condition continues.
MATH operation start, recording operation start, flag input
enabled.
The same start function cannot be set to edge start or
multiple settings simultaneously.
When setting the start operation to time up on the timer,
match time, or user function key, then computation
start/stop, recording start/stop, and flag input 0/1 repeat
alternately.
Execute from Event/Action setting number 1.
The action that is performed is of the last event that is executed.

6

Two; Relative timer and Absolute timer

Repeats time up every specified time interval.

Time interval can be set in 1-minute intervals.

Setting range is 00 days 00 hours 01 min. to 31 days 23 hours
59 minutes. If the setting of the relative timer is changed or in the
event of a power failure, the timer is reset to 0 and starts again. If
the clock is changed, the timer time is not adjusted.

Using the specified reference time as a standard, repeats the time
up every specified time interval.

Reference time set in one-minute intervals in the range of 00
hours 00 min. to 23 hours 59 minutes.

Time intervals: 1, 2, 3, 4, 5, 6, 10, 12, 15, 20, 30 min, 1, 2, 3, 4, 6,
8, 12, 24 h. When the power fails or the clock is changed and the
timeup time is exceeded, the time up is not acknowledged.

3

Time up occurs: every month on the specified day, every week on
the specified time; or every day at the specified time.

The setting is set in 1-minute intervals. When the power fails or
the clock is changed and the timeup time is exceeded, the time
up is not acknowledged.

IM MW100-01E
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5.2 Main Module (MW100-E) Specifications

User Interface

Other Functions

Number of keys:

Key action:

User function keys:

Key lock function:
Dip switch 1:

Time
Time function:

Internal time accuracy:
Daylight saving time:

Tag Strings
During recording:

During displaying:

Tag string settings:
No. of characters:

4: Start key (START) and Stop key (STOP),
User function key 1 (USER1),
User function key 2 (USER?2),

START: Measurement, computation, and recording start

STOP: Measurement, computation, and recording stop, and
saving of data acquisition logs and alarm summaries

USER1: Write setting values file (default)

USER2: Load setting file (default)

Keys can be assigned arbitrarily by the user with the Event/Action

function.

All keys can be enabled or disabled at once.

Operation upon power ON determined by dip switch settings.

All switches ON: Normal operation

Switch 5 (only) OFF: All settings initialized

Switch 6 (only) OFF: Fixed to 10-Mbps half-duplex Ethernet
communication

Switch 8 (only) OFF: Fixed IP address (192.168.0.10)

Switch 4 (only) OFF: Load the firmware

Switch 3 (only) OFF: Load the Web software

Time settings consist of date, time, and time zone.
Backup function included.
Year designation:  Last two digits of Western calendar
80 to 99 (1980-1999), 00 to 35(2000-2035)
+100ppm
The time on the internal clock is updated on the specified month,
week, weekday, and time.

Summer:  On the month, week, weekday, and hour set as
Summer time, the time on the internal clock is moved
one hour ahead.

Winter: On the month, week, weekday, and hour set as

Winter time, the time on the internal clock is moved
one hour behind.

Unlike the internal clock, which is changed on the main unit, the
dates of the measured and computed values are not adjusted.

Tags can be stored for measured and computed values that are
recorded and saved.

You can select whether to display tags or channel numbers on all
channels.

Can be set channel by channel.

Upto 15
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5.2 Main Module (MW100-E) Specifications

Log Information

Recording logs
When recording is stopped, data acquisition logs saved on the main unit are all saved
to the CF card.
Maximum no. of saved logs:
250 (if this number exceeded, old files are overwritten by new

ones)

* “1021” on models with firmware version R3.02 or earlier
File name: RECORDLG.TXT
Save location: During recording, in the DATAnnnn folder on the CF card

When recording stopped, on the root folder of the CF card
Alarm summaries
When recording is stopped, alarm summaries saved on the main unit are all saved to
the CF card.
Maximum no. of saved summaries:

256 (if this number exceeded, old files are overwritten by new

ones)
File name: ALARMLG.TXT
Save location: During recording, in the DATAnnnn folder on the CF card

Communication related log information can be saved in the main unit.

Communication log, FTP client operation log, e-mail operation log, DHCP operation

log. Information logs can be referenced via output from communication commands

and on the browser, and when the power is cut, they are initialized and not backed up.

Maximum no. saved: Shown in the table below. If the number is exceeded, old logs
are overwritten

Item Maximum no. saved
Operation log 256
Error log 50
Message summary 50
Communication log 200
FTP client log 50
SNTP client log 50
SNTP client log 50
DHCP client log 50
FTP server log 50
HTTP server log 50
Modbus master log 50
Modbus client log 50
Modbus slave log 50
Modbus server log 50
Computation status 1
Recording status 1

Maximum no. displayed

Item Maximum no. displayed
Modbus client connection command 100

Modbus client connection status 10

Modbus master command 100

Modbus master connection status 247

Strain initial balance result 60

IM MW100-01E
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5.2 Main Module (MW100-E) Specifications

Initializing Settings

Two types of settings initialization are available.

Initialization of all settings:
Initializes all setting values and measured values on the main
unit. You can perform initialization through communication
commands, from the browser, or by resetting the dip switch
positions and turning ON the unit. However, when initialized using
communication commands or the browser, module recognition
information is not initialized.

Initialization of all settings excluding communication parameters:
All settings and measured values except for communication
parameters and module recognition information are initialized.
Communication commands are executed from the browser.

Initialization of the CF Card
Formats the CF card.

Format type: Supports FAT12/FAT16, logical format only
CF card size: 2 GB maximum
File name format: 8.3 format

General Specifications

Operating temperature: —20 to 60°C

Operating humidity: 20 to 80% RH for —20 to 40°C
10 to 50% RH for 40 to 50°C
5 to 30% RH for 50 to 60°C

Power consumption: Approx. 8 W

Insulation resistance: Between power supply terminal and earth terminal: 20 MQ or
more (500 VDC)

Withstand Voltage AC power Between AC power supply terminal and earth

terminal: 1500 VAC (50/60 Hz) for one minute
DC power Between DC power supply terminal and earth
terminal: 1000 VAC (50/60 Hz) for one minute

External dimensions: Approx. 105 (W) x 131 (H) x 137 (D) mm

Weight: Approx. 1 kg.
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5.2 Main Module (MW100-E) Specifications

External Dimensions
Units: mm
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If not specified, the tolerance is +3%. However, in cases of less than 10 mm, the
tolerance is £0.3 mm.

IM MW100-01E 5-33

uonjesyloadg ﬂ



5.3 Base Plate (MX150) Specifications

Number of main modules that can be attached:
1 (always attached)

Number of input/output modules that can be attached:
1 to 6* (specified by the suffix code)

* One 30-CH Medium Speed DCV/TC/DI Input Module uses three modules worth.

External dimensions: Approx. 118 to 408 (W) x 75 (H) x 35 (D) mm
Weight: Approx. 0.37 kg (1 main module, for connecting six input/output

modules)

External Dimensions

Units: mm

MXx150-1, -2, -3, -4, -5, -6

407.5 (1 main module, for connecting six input/output modules)
58 pitches in between
117.5 (1 main module, for connecting one input/output module)

OTOO o o O [ O O ) O O o O O o OOI-_=10 [e)
@ @ @ @
o% o% e e o% o% B
i i i m
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If not specified, the tolerance is £3%. However, in cases of less than 10 mm, the

tolerance is £0.3 mm.

Attaching the MW100 Main Module

The accessory bracket must be attached in order to attach the MW100 main module
to the base plate. For information about attaching the bracket, see the Installation and

Connection Guide (IM MW100-72E).
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5.4 4-CH, High-Speed Universal Input Module
(MX110-UNV-H04) Specifications

Style number: S1

Type of measurement: DC voltage, thermocouple, 3-wire RTD, DI (contact, LEVEL)
Number of inputs: 4

Input method: Floating unbalanced input, insulation between channels
A/D resolution: 16 bits (£20000/£6000/0 to 60000)

Measurement range and accuracy:
The accuracy applies to standard operating conditions:
Ambient temp: 23 +2°C, ambient humidity: 55 £+10% RH, supply
voltage: 90 to 250 VAC, power frequency: 50/60 Hz £1%, warm-
up time: at least 30 minutes, without adverse conditions such as

vibrations.
Measurement Rated Measurement Accuracy Highest
Input Range Measurement Integration Time: 16.67 ms Measuroment Aceuracy | Resolution
Type Range or More ntegration Time: 1.67 ms (1 Digit)
20 mV —20.000 to 20.000 mV |+(0.05% of rdg + 5 digits) +(0.1% of rdg + 25digits) 1V %)
60 mV —60.00 to 60.00 mV +(0.05% of rdg + 2 digits) 10 pv T
200 mV —200.00 to 200.00 mV_|[+(0.05% of rdg + 2 digits) 10 pv 8
DC voltage | 2V —2.0000 to 2.0000 V__[+(0.05% of rdg + 5 digits) +(0.1% of rdg + 10digits) 100 pV S
6V —6.000 to 6.000 V +(0.05% of rdg + 2 digits) 1mV 8
20V —20.000 to 20.000 V. |+(0.05% of rdg + 2 digits) 1mV [=+
100 V —100.00 to 100.00 V__ |#(0.05% of rdg + 2 digits) 10 mV g
60 mV (high res.) [0.000 to 60.000 mV__ |+(0.05% of rdg + 20 digits) +(0.1% of rdg + 100 digits) 1V
6 V (high res.) 0.0000 to 6.0000 V +(0.05% of rdg + 20 digits) +(0.1% of rdg + 100 digits) 100 pVv
1V —1.0000 to 1.0000 V. [+(0.05% of rdg + 2 digits) +(0.1% of rdg + 10 digits) 100 pVv
R 0.0 to 1760.0°C +(0.05% of rdg + 1°C) +(0.1% of rdg + 4°C)
s Except 0 to 100°C: 3.7°C, 100 to | Except 0 to 100°C: 10°C, 100 to
300°C: 1.5°C forRand S; 300°C: 5°C for Rand S;
B 0.0 to 1820.0°C 400 to 600°C: 2°C, less than 400 to 600°C: 7°C, less than
400°C: not guaranteed for B 400°C: not guaranteed for B
+(0.05% of rdg + 0.7°C) 4(0.1% of rdg + 3.5°C)
K —200.0 to 1370.0°C Except —200°C to —100°C: Except —200°C to —100°C: .
+(0.05% of rdg + 1°C) +(0.1% of rdg + 6°C) 0.1°C
- E™ —200.0 to 800.0°C
3 J1 —200.0 to 1100.0°C __|#(0.05% of rdg + 0.5°C) +(0.1% of rdg +2.5°C)
£ T —200.0 to 400.0°C Except —200°C to —100°C: Except —200°C to —100°C:
2 12 —200.0 to 900.0°C +(0.05% of rdg + 0.7°C) for J and L| #(0.1% of rdg + 5°C) for J and L
2 9] —200.0 to 400.0°C
E N3 0.0 to 1300.0°C +(0.05% of rdg + 0.7°C) +(0.1% of rdg + 3.5°C)
> W 0.0 to 2315.0°C +(0.05% of rdg + 1°C) +(0.1% of rdg + 7°C)
g KPvsAu7Fe 0.0 to 300.0K £(0.05% of rdg + 0.7K) +(0.1% of rdg + 3.5K) 0.1K
g +(0.05% of rdg + 2.5°C) +(0.1% of rdg + 12°C)
@ PR40-20 0.0 to 1900.0°C Except 300 to 700°C: 6°C, Except 300 to 700°C: 25°C, 0.1°C
%_(—',) less than 300°C: not guaranteed | less than 300°C: not guaranteed
3 % NiNiMo 0.0 to 1310.0°C +(0.05% of rdg + 0.7°C) +(0.1% of rdg + 2.7°C)
898 ™ +(0.05% of rdg + 2°C) $(0.1% of rdg + 7°C)
£3 L | WRe3-25 0.0 to 2400.0°C Except 0 to 200°C: 2.5°C, Except 0 to 200°C: 12°C,
£ ;, » more than 2000°C: more than 2000°C:
- +(0.05% of rdg + 4°C) +(0.1% of rdg + 11°C)
+(0.05% of rdg + 2°C) +(0.1% of rdg + 8.5°C)
W/WRe26 0.0 to 2400.0°C Except 100 to 300°C: 4°C, Except 100 to 300°C: 12°C,
less than 100°C: not guaranteed | less than 100°C: not guaranteed
N (AWG14) 0.0 to 1300.0°C +(0.05% of rdg + 0.7°C) +(0.1% of rdg + 3.5°C)
+(0.05% of rdg + 0.5°C) +(0.1% of rdg + 2.5°C)
XK GOST —200.0 to 600.0°C Except —200 to 0°C: Except —200 to 0°C:
+(0.2% of rdg + 0.7°C) +(1% of rdg + 2.5°C)

*1 R, S,B, K, E, J, T: ANSI, IEC 584, DIN IEC 584, JIS C 1602-1995
*2 L: Fe-CuNi, DIN43710/U: Cu-CuNi, DIN 43710

*3 N: Nicrosil-Nisil, IEC 584, DIN IEC 584

*4 W: W-5% Re/W-26%Re (Hoskins Mfg Co)
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5.4 4-CH, High-Speed Universal Input Module (MX110-UNV-H04) Specifications

Measurement Rated Measurement Accuracy Highest
Input Range Measurement Integration Time: 16.67 ms | Measurement Accuracy | peggjytion
Type Range or More Integration Time: 1.67 ms (1 digit)
3‘31?8;, . ‘ggg-g :g ggg-g:g +(0.05% of rdg + 0.3°C) £(0.1% of rdg + 1.5°C) 0.1°C
Pt100 (high res.) -140.00 t0 150.00°C |,/ 950 4030 0 . 0.01°C
RTD JPL100 (high res.) | ~140.00t0 150.00°C | "0 of 1dg +0.3°C) *(0.1% of rdg +1.5°C) :
(Measurement [Ni100 SAMA™2 —200.0 to 250.0°C R o
current: 1 mA) [Ni100 DIN"2 —60.0 to 180.0°C +(0.05% of rdg + 0.3°C) +(0.1% of rdg + 1.5°C) 0.1°C
Ni120°3 —70.0 to 200.0°C
Pt100 (high noise resistance) —200.0 to 600.0°C o o o £(0.1% of rdg + 2.5°C 0.1°C
JPL100 (ngh noise esistance] —200.0 to 550.0°C | (0-05% of rdg + 0.3°C) #(0.1% of rdg +2.5°C) :
Pt100 GOST —200.0 to 600.0°C +(0.05% of rdg + 0.3°C) +(0.05% of rdg + 0.3°C) 0.1°C
5;1?8(;,1 ~2000106002°C —1+(0.05% of rdg +0.3°C) £(0.1% of rdg + 1.5°C) 0.1°C
PH100 (high res.) =140.00to 150.00°C__1,(0,05% of rdg + 0.3°C) £(0.1% of rdg + 1.5°C) 0.01°C
JPt100 (high res.) —140.00 to 150.00°C
Pt50"1 —200.0 to 550.0°C +(0.05% of rdg + 0.3°C) +(0.1% of rdg + 1.5°C)
Cu10 GE™* —200.0 to 300.0°C
Cu10 L&N™ —200.0 to 300.0°C +(0.1% of rdg + 0.7°C) +(0.2% of rdg + 2.5°C) 0.1°C
Cu10 WEED* —200.0 to 300.0°C
Cu10 BAILEY* —200.0 to 300.0°C
J263B 0.0 to 300.0K +(0.05% of rdg + 0.3K) +(0.1% of rdg + 1.5K) 0.1K
Cu10at 20°C -200.0 to 300.0°C
alpha=0.00392 £(0.1% of rdg + 0.7°C) +(0.2% of rdg + 2.5°C) 0.1°C
Cul0at20°C -200.0 to 300.0°C
alpha=0.00393
;l;ﬁgfé A —200.0t0 300.0°C  |#(0.1% of rdg + 0.5°C) £(0.2% of rdg + 2°C) 0.1°C
RTD =
(Measurement Cu53_at0 c -50.0 to 150.0°C
current 2 mA) [21PNa=0.00426035 £(0.05% of rdg + 0.3°C) £(0.1% of rdg + 1.5°C) 0.1°C
Cu100 at 0°C -50.0 to 150.0°C
alpha=0.00425
Pt25(JPt100/4) —200.0 t0 550.0°C +(0.1% of rdg + 0.5°C) +(0.2% of rdg + 2°C) 0.1°C
Cu10 GE .
(high resolution) —200.0 to 300.0°C
10 L&N
(Chll‘ t?reioluﬁon) -200.0 to 300.0°C . .
c %o WEED +(0.1% of rdg + 0.7°C) +(0.2% of rdg + 2.5°C) 0.1°C
u ! —200.0 to 300.0°C
(high resolution)
Cut0 BAILEY —200.0 to 300.0°C
(high resolution)
Pt100 (high noise resistance)| —200.0 to 250.0°C +(0.05% of rdg + 0.3°C R R
JPH100 (high noise resistance)| —200.0 to 250.0°C (0.05% of rdg ) (0.1% of rdg +1.5°C) o.1r°c
Cu100 GOST —200.0 to 200.0°C +(0.05% of rdg + 0.3°C) +(0.1% of rdg + 1.5°C) 0.1°C
Cu50 GOST —200.0 to 200.0°C +(0.05% of rdg + 0.3°C) £(0.1% of rdg + 1.5°C) 0.1°C
Cu10 GOST —200.0 to 200.0°C +(0.1% of rdg + 0.7°C) +(0.2% of rdg + 0.5°C) 0.1°C
Level Vth=24V Threshold level accuracy: 0.1 V

DI

Contact input

ON for 100 Q or less, OFF for 10 kQ or more™

*1 Pt50: JIS C 1604-1989, JIS C 1606-1989/Pt100: JIS C 1604-1997, IEC 751, DIN IEC 751/JPt100: JIS C 1604-1989, JIS C 1606-1989
*2 SAMA/DIN

*3 McGRAW EDISON COMPANY
*4 Guaranteed accuracy range Cu10 GE: —84.4 to 170.0°C/Cu10 L&N: -75.0 to 150.0°C/Cu10 WEED: —20.0 to 250.0°C/
Cu10 BAILEY: -20.0 to 250.0°C
*5 Measured using a measurement current of approximately 10pA at 200 mV range. Threshold level is approximately 0.1 V.

Measurement interval, integration time, and filter:

Measurement Integration . . .
Interval Time Filter Rejected Noise and Notes

10 ms 1.67 ms™! 600 Hz and its integer multiples

16.67 ms Rectangular 60 Hz and !ts !nteger mult!ples
50 ms 20 ms 50 Hz and its integer multiples

Auto™? Automatically detects the power supply frequency and set 16.67 or 20 ms
;gg :: 36.67 ms |Trapezoidal |50 Hz or 60 Hz and their integer multiples
500 ms 100 ms Rectangular |10 Hz and its integer multiples
1s )

Fc = 5-Hz low- filt

2.5.10, 20,30, 60 s 200 ms Cos ¢ = 5-Hz low-pass filter

*1 When the measurement interval is 10 ms, measured values may fluctuate since power supply frequency

noise is not rejected. In such cases, set the measurement interval to 50 ms or more.
*2 For DC power, set to 20 ms.

Reference junction compensation:
Switch external/internal by channel, includes remote RJC

function
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5.4 4-CH, High-Speed

Universal Input Module (MX110-UNV-H04) Specifications

Reference junction compensation accuracy:

Maximum input voltage:

Normal mode voltage:

Normal mode rejection ratio:

Common-mode voltage:
Common mode rejection rati

When measuring temperature greater than or equal to 0°C

and when the temperature of the input terminal is balanced

Type R, S, W: £1°C

Type K, J,E, T, N, L, U, XK GOST: £0.5°C

Type N(AWG14), PLATINEL, NiNiMo, WRe3-25,

W/WRe26: +1°C

Note: The internal reference junction compensation is fixed
to 0°C for type B and PR40-20

DC voltage at 1-V range or less, TC, RTC, and DI (contact):

+10 VDC (continuous)

Other measurement ranges: +120 VDC (continuous)

DC voltage, TC, DI (LEVEL): 1.2 times the range rating or

less (50/60 Hz, peak value including the signal component)

RTD 100 Q: 50 mVpeak

RTD 10 Q, 25 Q, 50 Q: 10 mVpeak

For integration time of 16.67 ms or more: 40 dB or more

(50/60 Hz £ 0.1%)

For integration time of 1.67 ms: 50/60 Hz is not rejected

The RTD and resistance ranges indicates the voltage

conversion value when current flows.

600 VACrms (50/60 Hz), reinforced (double) insulation

0 (50/60 Hz £0.1%, 500 Q unbalanced between minus

measurement terminal and ground)

The RTD and resistance ranges indicates the voltage

conversion value when current flows.

When the integration time is 16.67 ms or more: 120 dB or more

When the integration time is 1.67 ms or more: 80 dB or more

Common-mode voltage between channels:

Noise rejection:

Input resistance:

Insulation resistance:
Input bias current:
Withstand voltage:

Input signal source resistance:

Thermocouple burnout:

Parallel capacity during RTD:

Power consumption:
External dimensions:

Weight:
Terminal type:
Applicable wire size:

250 VACrms (50/60 Hz), reinforced (double) insulation
Rejection by the integrating A/D converter and the use of low
pass filters
For DC voltage 1 V range or less and thermocouple range:
10 MQ or less
For DC voltage 2 V range or higher: Approx. 1 MQ
While measurement stopped: Approx. 1 MQ
Between input terminal and earth terminal: 20 MQ or more
(500 VDC)
10 nA or less (except for burnout setting)
2300 VAC (50/60 Hz) for one minute between input terminals
3700 VAC (50/60 Hz) for one minute between the input
terminal and earth terminal
DC voltage, thermocouple: 2 kQ or less
RTD 50 Q, 100 Q types: 10 Q per line or less
RTD10 Q, 25 Q types: 1 Q per line or less
Superposed electric current system, detection within the
thermocouple range (detection ON/OFF possible)
Up/Down setting is possible, current approximately 100 nA
2 kQ or less normal, 10 MQ or more disconnected
Effect on measurement accuracy: £15 pV or less (not
including effect of signal source resistance)

0.01 yF or less
Approx. 3 W
Approx. 57 (W) x 131 (H) x 151 (D) mm (including the
terminal cover)
Approx. 0.5 kg.
Clamp, detachable per channel
0.2 to 2.5 mm? (AWG24 to 12)

IM MW100-01E
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5.4 4-CH, High-Speed Universal Input Module (MX110-UNV-H04) Specifications

Effects of Operating Conditions
The specifications below apply when the integration time is 16.67 ms or more.
Warm-up time: At least 30 minutes after power-up
Effects of ambient temperature:
The effect received by changes in 10°C increments of the ambient
temperature is
+(0.05% of rdg. + 0.05% of range) or less
However, for Cu10 Q: £(0.2% of range + 1 digit)
Effects of power fluctuation:
Meets the accuracy specifications for AC power supply in the
range 90 to 132 V and 180 to 250 V
Effects of magnetic field: The fluctuation in external magnetic fields for AC (50/60 Hz)
400 A/m is
+(0.1% of rdg. + 10 digits) or less
Effects from the signal source resistance:
Effect from fluctuation in DC voltage and thermocouple signal
source resistance of 1 kQ
DC voltage: 1V range or less +10 pV or less
2 V range or higher +0.15% of rdg. or less
Thermocouple: +10 pV or less
However, when burnout is set, £150 uV or less
RTD: Fluctuation per 10 Q change per line (3 lines all
same resistance) for 100 Q types: +0.1°C or less;
other than 100 Q types: +1.0°C or less; fluctuation
resulting from difference in resistance between
lead wires of 40 mQ (max. difference among
three wires): approximately 0.1°C (for Pt100)
Effect of position: Horizontal with the feet at the bottom is the rule.
Effects of vibration: ~ The fluctuation that results by applying a sinusoidal vibration
along all three axes at a frequency between 10 to 60 Hz and an
acceleration of 0.2 m/s? is +(0.1% of rdg. + 1 digit) or less

General Specifications
Operating temperature range: -20 to 60°C
Operating humidity range: 20 to 80% RH for —20 to 40°C
10 to 50% RH for 40 to 50°C
5 to 30% RH for 50 to 60°C

External Dimensions
Units: mm
150.8

131

0 "

If not specified, the tolerance is +3%. However, in cases of less than 10 mm, the
tolerance is £0.3 mm.

L/ULEUU
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5.5 10-CH, Medium-Speed Universal Input Module

(MX110-UNV-M10) Specifications

Style number: S1

Type of measurement: DC voltage, thermocouple, 3-wire RTD, DI (contact, LEVEL)

Number of inputs: 10

Input method: Floating unbalanced input, insulation between channels (b
terminal common for RTD)

A/D resolution: 16 bits (+20000/£6000/0 to 60000)

Measurement range and accuracy:
The accuracy applies to standard operating conditions:
Ambient temp: 23 +2°C, ambient humidity: 55 £10% RH, supply
voltage: 90 to 250 VAC, power frequency: 50/60 Hz £1%, warm-
up time: at least 30 minutes, without adverse conditions such as

vibrations.
Measurement Rated Measurement Accuracy Highest
Input Range Measurement Integration Time: 16.67 ms InTeegarsaltliI:r:nfirrlrt\:c'l%u;gc%s Resolution
Type Range or More o (1 digit) (72}
20 mV —20.000 to 20.000 mV_[+(0.05% of rdg + 5 digits) +(0.1% of rdg + 25digits) 1V g
60 mV —60.00 to 60.00 mV +(0.05% of rdg + 2 digits) 10 yv g‘
200 mV —200.00 to 200.00 mV_[+(0.05% of rdg + 2 digits) 10 pv o
2V —2.0000 to 2.0000 V +(0.05% of rdg + 5 digits) +(0.1% of rdg + 10digits) 100 pv g_
6V —6.000 to 6.000 V +(0.05% of rdg + 2 digits) 1mV o
DC voltage |59 v —20.000 t0 20.000 V__[+(0.05% of rdg + 2 digits) 1mV =]
100 V —100.00 to 100.00 V__ [#(0.05% of rdg + 2 digits) 10 mV
60 mV (high res.) [0.000 to 60.000 mV _ [+(0.05% of rdg + 20 digits) +(0.1% of rdg + 100 digits) 1V
6 V (high res.) 0.0000 to 6.0000 V +(0.05% of rdg + 20 digits) +(0.1% of rdg + 100 digits) 100 pVv
1V —1.0000 to 1.0000 V__ [+(0.05% of rdg + 2 digits) +(0.1% of rdg + 10 digits) 100 pV
R™ 0.0 to 1760.0°C +(0.05% of rdg + 1°C) +(0.1% of rdg + 4°C)
s Except 0 to 100°C: 3.7°C, 100 to | Except 0 to 100°C: 10°C, 100 to
300°C: 1.5°C forR and S; 300°C: 5°C for R and S;
B 0.0 to 1820.0°C 400 to 600°C: 2°C, less than 400 to 600°C: 7°C, less than
400°C: not guaranteed for B 400°C: not guaranteed for B
+(0.05% of rdg + 0.7°C) +(0.1% of rdg + 3.5°C)
K™ —200.0 to 1370.0°C Except —200°C to —100°C: Except —200°C to —100°C: .
+(0.05% of rdg + 1°C) +(0.1% of rdg + 6°C) 0.1°C
ET —200.0 to 800.0°C
- J —200.0 to 1100.0°C___|+(0.05% of rdg + 0.5°C) £(0.1% of rdg + 2.5°C)
& T —200.0 to 400.0°C Except —200°C to —100°C: Except —200°C to —100°C:
g L2 —200.0 to 900.0°C +(0.05% of rdg + 0.7°C) for J and L| £(0.1% of rdg + 5°C) for J and L
§ U —200.0 to 400.0°C
O N3 0.0 to 1300.0°C +(0.05% of rdg + 0.7°C) +(0.1% of rdg + 3.5°C)
S2 w4 0.0 to 2315.0°C +(0.05% of rdg + 1°C) +(0.1% of rdg + 7°C)
8 @ KPvsAu7Fe 0.0 to 300.0K +(0.05% of rdg + 0.7K) +(0.1% of rdg + 3.5K) 0.1K
e 8 +(0.05% of rdg + 2.5°C) +(0.1% of rdg + 12°C)
5% PR40-20 0.0 to 1900.0°C Except 300 to 700°C: 6°C, Except 300 to 700°C: 25°C,
= é less than 300°C: not guaranteed | less than 300°C: not guaranteed
NiNiMo 0.0t01310.0°C +(0.05% of rdg + 0.7°C) +(0.1% of rdg + 2.7°C)
+(0.05% of rdg + 2°C) +(0.1% of rdg + 7°C)
WRe3-25 0.0 to 2400.0°C Except 0 to 200°C: 2.5°C, Except 0 to 200°C: 12°C,
more than 2000°C: more than 2000°C:
+(0.05% of rdg + 4°C) +(0.1% of rdg + 11°C) 0.1°C
+(0.05% of rdg + 2°C) +(0.1% of rdg + 8.5°C)
W/WRe26 0.0 to 2400.0°C Except 100 to 300°C: 4°C, Except 100 to 300°C: 12°C,
less than 100°C: not guaranteed | less than 100°C: not guaranteed
N (AWG14) 0.0 to 1300.0°C +(0.05% of rdg + 0.7°C) +(0.1% of rdg + 3.5°C)
+(0.05% of rdg + 0.5°C) +(0.1% of rdg + 2.5°C)
XK GOST —200.0 t0 600.0°C Except —200 to 0°C: Except —200 to 0°C:
+(0.2% of rdg + 0.7°C) +(1% of rdg + 2.5°C)

*1 R, S,B, K, E, J, T: ANSI, IEC 584, DIN IEC 584, JIS C 1602-1995
*2 L: Fe-CuNi, DIN43710/U: Cu-CuNi, DIN 43710
*3 N: Nicrosil-Nisil, IEC 584, DIN IEC 584

*4 W: W-5% Re/W-26%Re (Hoskins Mfg Co)
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5.5 10-CH, Medium-Speed Universal Input Module (MX110-UNV-M10) Specifications

Measurement Rated Measurement Accuracy M A Highest
Input Range Measurement Integration Time: 16.67 ms I easur_em:arr.it .c:‘.l.:sracy Resolution
Type Range or More ntegration Time: 1.67 ms (1 digit)
Pt100°1 —200.0 to 600.0°C 0 o 0
JPt100" —200.0 to 550.0°C #(0.05% of rdg + 0.3°C) +(0.1% of rdg + 1.5°C) ore
Pt100 (high res.) |—140.00 to 150.00°C . o
JPt100 (high res.) |~140.00 to 150.00°C | #(0.05% of rdg + 0.3°C) +(0.1% of rdg + 1.5°C) oore
Ni100 SAMA2 _ |-200.0 to 250.0°C
Ni100 DIN2 —60.0 to 180.0°C 9 o o
Ni120% 70.0102000°0 | (0.05% of rdg + 0.3°C) #(0.1% ofrdg +1.5°€) 01°¢
Pt50 —200.0 to 550.0°C
Cu10 GE™ —200.0 to 300.0°C
Cu10 L&N™ —200.0 to 300.0°C 9 o o
Cu10 WEED™ —200.0 to 300.0°C £(0.1% of rdg + 2°C) #(0.2% of rdg + 5°C) 0.1°¢
Cu10 BAILEY™ _[—200.0 to 300.0°C
J263B 0.0 to 300.0K +(0.05% of rdg + 0.3K) +(0.1% of rdg + 1.5K) 0.1K
Clu:10 2 %%;%2 -200.0 to 300.0°C
|- aipha=u. 9 o +(0.2% of rdg + 5°C °
RTD Cu10 at 20°C 2000 0 300.0°C +(0.1% of rdg + 2°C) (0.2% of rdg ) 0.1°C
(Measurement | alpha=0.00393
current: 1 mA) | Cu25 at 0°C -200.010300.0°C | (0.1% of rdg + 0.5°C £(0.2% of rdg + 2°C 0.1°C
aloha=0.00425 .Oto . (0.1% of rdg . ) +(0.2% of rdg )
g:lt;ii_ag 8(;‘?26035 —50.010150.0°C
=0.004: +(0.05% of rdg + 0.3°C) +(0.1% of rdg + 1.5°C) 0.1°C
Cu100at0°C _—|_50,0 t0 150.0°C
alpha=0.00425
Pt25(JPt100/4) | —200.0 to 550.0°C +(0.1% of rdg + 0.5°C) +(0.2% of rdg + 2°C) 0.1°C
Cu10 GE .
(high resolution) | 2000 t0 300.0°C
CUIOLEN 15000 to 300.0°C
(high resolution) +(0.1% of rdg + 2°C) £(0.2% of rdg + 5°C) 0.1°C
Cu10 WEED g 9
5 ' —200.0 to 300.0°C
(high resolution)
Cu10 BAILEY .
(high resolution) —200.0 to 300.0°C
PT100GOST —200.0 to 600.0°C +(0.05% of rdg + 0.3°C) +(0.1% of rdg + 1.5°C) 0.1°C
Cu100GOST —200.0 to 200.0°C +(0.05% of rdg + 0.3°C) +(0.1% of rdg + 1.5°C) 0.1°C
Cu50GOST —200.0 to 200.0°C +(0.05% of rdg + 0.3°C) +(0.1% of rdg + 1.5°C) 0.1°C
Cu10GOST —200.0 to 200.0°C +(0.1% of rdg + 2°C) +(0.2% of rdg + 5°C) 0.1°C
DI Level Vth=24V Threshold level accuracy: +0.1 V
Contact input ON for 100 Q or less, OFF for 10 kQ or more™

*1 Pt50: JIS C 1604-1989, JIS C 1606-1989/Pt100: JIS C 1604-1997, IEC 751, DIN IEC 751/JPt100: JIS C 1604-1989, JIS C 1606-1989
*2 SAMA/DIN
*3 McGRAW EDISON COMPANY
*4 Guaranteed accuracy range Cu10 GE: -84.4 to 170.0°C/Cu10 L&N: —75.0 to 150.0°C/Cu10 WEED: —-20.0 to 250.0°C/

Cu10 BAILEY: -20.0 to 250.0°C

*5 Measured using a measurement current of approximately 10 pA at 200 mV range. Threshold level is approximately 0.1 V.

Measurement interval, integration time, and filter:

. Burnout
Measurement Integ.]rahon Detection Filter Rejected Noise and Notes
Interval Time
Cycle
*1

100 ms 1.67 ms 1s 600 Hz and its integer multiples*?
200 ms

16.67 ms Rectangular 60 Hz and its integer multiples
500 ms 20' 50 Hz and its integer multiples

A tm*ss Measurement Automatically detects the power supply frequency and set

uto interval 16.67 or 20 ms
1s 36.67 ms Trapezoidal |50 Hz or 60 Hz and their integer multiples
2s 100 ms** Rectangular [10 Hz and its integer multiples
5s 200 ms*® )
Cos Fc = 5-Hz low-pass filter

10, 20, 30, 60 5 200 ms z low-pass i

*1 When the measurement interval is 100 ms, burnout is detected in one channel per measurement interval.
Therefore, if measurement is started in a burnout condition or after a burnout occurs, burnout cannot be
detected for up to 10 measurements (approximately 1 second).

*2 Because the power supply frequency noise is not rejected, measured values may fluctuate particularly for
temperature measurements using thermocouples. [f this happens, make the measurement interval longer, or
use the 4-CH High-Speed Universal Input Module.

*3 For DC power, set to 20 ms.

*4 When synchronizing time by SNTP, the integral time is set to 36.67 ms. Also in this case, noise of 50 Hz, 60
Hz, and their integer multiples is rejected.

*5 When synchronizing time by SNTP, the integral time is set to 100 ms. Also in this case, noise of 10 Hz and its
integer multiples is rejected.

Reference junction compensation:
Switch external/internal by channel, includes remote RJC function
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5.5 10-CH, Medium-Speed Universal Input Module (MX110-UNV-M10) Specifications

Reference junction compensation accuracy:
When measuring temperature greater than or equal to 0°C and
when the temperature of the input terminal is balanced
Type R, S, W: £1°C
Type K, J, E, T, N, L, U, XK GOST: £0.5°C
Type N (AWG14), PLATINEL, NiNiMo, WRe3-25,
W/WRe26: +1°C
Note: Type B and PR40-20 internal RJC is fixed at 0°C
Maximum input voltage: DC voltage at 1-V range or less, TC, RTC, and DI (contact):
+10 VDC (continuous)
Other measurement ranges: +120 VDC (continuous)
Normal-mode voltage: DC voltage, TC, DI (LEVEL): 1.2 times the range rating or less
(50/60 Hz, peak value including the signal component)
RTD 100 Q: 50 mVpeak
RTD 10 Q, 25 Q, 50 Q: 10 mVpeak
Normal-mode rejection ratio:
For integration time of 16.67 ms or more: 40 dB or more (50/60
Hz £ 0.1%)
For integration time of 1.67 ms: 50/60 Hz is not rejected.
The RTD and resistance ranges indicate the voltage conversion
value when current flows.
Common-mode voltage:600 VACrms (50/60 Hz), reinforced (double) insulation
Common mode rejection ratio (50/60 Hz +0.1%, 500 Q unbalanced between minus
measurement terminal and ground)
The RTD and resistance ranges indicate the voltage conversion
value when current flows.
When the integration time is 16.67 ms or more: 120 dB or more
When the integration time is 1.67 ms: 80 dB or more
Common-mode voltage between channels: 120 VACrms (50/60 Hz)

Noise rejection: Rejection by the integrating A/D converter and the use of low pass
filters

Input resistance: For DC voltage 1 V range or less and thermocouple range: 10
MQ or less

For DC voltage 2 V range or higher: Approx. 1 MQ

Insulation resistance: Between input and ground: 20 MQ or more (500 VDC)

Input bias current: 10 nA or less (except for burnout setting)

Withstand Voltage: 1000 VAC (50/60 Hz) for one minute between input terminals
3700 VAC (50/60 Hz) for one minute between the input terminal
and earth terminal

Input signal source resistance:

DC voltage, thermocouple: 2 kQ or less
RTD 50 Q, 100 Q types: 10 Q per line or less
RTD 10 Q, 25 Q types: 1 Q per line or less

Thermocouple burnout: Detection at a specified detection interval per measurement
interval and detection within the thermocouple range (detection
ON/OFF possible)

Up/Down setting is possible

2 kQ or less normal, 200 kQ or more disconnected

(shunt capacitance: 0.01 yF or less), detection current approx. 10
WA, detection time approx. 2 ms

Parallel capacity during RTD: 0.01 uyF or less

Power consumption:  Approx. 1.2 W

External dimensions: Approx. 57 (W) x 131 (H) x 151 (D) mm (including the terminal

cover)
Weight: Approx. 0.5 kg.
Terminal type: Clamp, terminal board is detachable

Applicable wire size:  0.14 to 1.5 mm? (AWG26 to 16)

IM MW100-01E
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5.5 10-CH, Medium-Speed Universal Input Module (MX110-UNV-M10) Specifications

Effects of Operating Conditions
The specifications below apply when the integration time is 16.67 ms or more.
Warm-up time: At least 30 minutes after power-up
Effects of ambient temperature:
The effect received by changes in 10°C increments of the ambient
temperature is
1(0.05% of rdg. + 0.05% of range) or less
However, for Cu10 Q: £(0.2% of range + 1 digit)
Effects of power fluctuation:
Meets the accuracy specifications for AC power supply in the
range 90 to 132 V and 180 to 250 V
Effects of magnetic field: The fluctuation in external magnetic fields for AC (50/60 Hz) 400 A/m is
$(0.1% of rdg. + 10 digits) or less
Effects from the signal source resistance:
Effect from fluctuation in DC voltage and thermocouple signal
source resistance of 1 kQ
DC voltage: 1V range or less +10 pV or less
2 Vrange or higher  +0.15% of rdg. or less
Thermocouple: +10 pV or less
RTD: Fluctuation per 10 Q change per line (3 lines all
same resistance) for 100 Q types: £0.1°C or less;
other than 100 Q types: +1.0°C or less;
fluctuation resulting from difference in resistance
between lead wires of 40 mQ (max. difference
among three wires): approximately 0.1°C (for
Pt100)
Effect of position: Horizontal with the feet at the bottom is the rule.
Effects of vibration: ~ The fluctuation that results by applying a sinusoidal vibration
along all three axes at a frequency between 10 to 60 Hz and an
acceleration of 0.2 m/s? is 1(0.1% of rdg. + 1 digit) or less

General Specifications
Operating temperature range: —20to 60°C
Operating humidity range: 20 to 80% RH for —20 to 40°C
10 to 50% RH for 40 to 50°C
5 to 30% RH for 50 to 60°C

External Dimensions

Units: mm
57 150.8
= =
0
o
® 0 00
Ju =T

If not specified, the tolerance is +3%. However, in cases of less than 10 mm, the
tolerance is £0.3 mm.
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5.6

30-CH, Medium-Speed DCV/TC/DI Input Module

(MX110-VTD-L30

Style number:
Type of measurement: DC voltage, thermocouple, DI (contact, LEVEL)
Number of inputs:
Module width:
Input method:
A/D resolution:
Measurement range and accuracy:

30
3 modules wide

Floating unbalanced input, insulation between channels

) Specifications
S3

16 bits (+20000/+6000/0 to 60000)

The accuracy applies to standard operating conditions:

Ambient temp: 23 +2°C, ambient humidity: 55 £10% RH, supply
voltage: 90 to 250 VAC, power frequency: 50/60 Hz +1%, warmup
time: at least 30 minutes, without adverse conditions such as

vibrations.
Measurement Rated Measurement Accuracy Highest
Input Range Measurement Integration Time: 16.67 ms In'ree;rsattlifr:n'l?irr::ﬁ%ug;cr)r,]s Resolution
Type Range or More T (1 digit)
20 mV —20.000 to 20.000 mV |+(0.05% of rdg + 5 digits) +(0.1% of rdg + 25digits) 1uV
60 mV —60.00 to 60.00 mV___|+(0.05% of rdg + 2 digits) 10 pv
200 mV —200.00 to 200.00 mV |+(0.05% of rdg + 2 digits) 10 uyv
2V —2.0000 t0 2.0000 V__ |£(0.05% of rdg + 5 digits) +(0.1% of rdg + 10digits) 100 pv
6V —6.000 to 6.000 V +(0.05% of rdg + 2 digits) 1mV
DC voltage 59 v —20.000 t0 20.000 V__|#(0.05% of rdg + 2 digits) 1 mV
100V —100.00 to 100.00 V. |+(0.05% of rdg + 2 digits) 10 mV
60 mV (high res.) [0.000 to 60.000 mV__ [+(0.05% of rdg + 20 digits) +(0.1% of rdg + 100 digits) 1uV
6 V (high res.) 0.0000 to 6.0000 V +(0.05% of rdg + 20 digits) +(0.1% of rdg + 100 digits) 100 pVv
1V —1.0000 to 1.0000 V__ |+(0.05% of rdg + 2 digits) +(0.1% of rdg + 10 digits) 100 pV
R 0.0 to 1760.0°C +(0.05% of rdg + 1°C) 1(0.1% of rdg + 4°C)
st Except 0 to 100°C: 3.7°C, 100 to | Except 0 to 100°C: 10°C, 100 to
300°C: 1.5°C forRand S; 300°C: 5°C for Rand S;
B 0.0 to 1820.0°C 400 to 600°C: 2°C, less than 400 to 600°C: 7°C, less than
400°C: not guaranteed for B 400°C: not guaranteed for B
+(0.05% of rdg + 0.7°C) +(0.1% of rdg + 3.5°C)
K" —200.0 to 1370.0°C Except —200°C to —100°C: Except —200°C to —100°C: .
+(0.05% of rdg + 1°C) +(0.1% of rdg + 6°C) 0.1°C
ET —200.0 to 800.0°C
_ JH —200.0 to 1100.0°C___[#(0.05% of rdg + 0.5°C) +(0.1% of rdg + 2.5°C)
oy T —200.0 to 400.0°C Except —200°C to —100°C: Except —200°C to —100°C:
£ L2 —200.0 to 900.0°C +(0.05% of rdg + 0.7°C) for J and L| £(0.1% of rdg + 5°C) for J and L
§ u —200.0 to 400.0°C
° O N3 0.0 to 1300.0°C +(0.05% of rdg + 0.7°C) +(0.1% of rdg + 3.5°C)
S W 0.0 to 2315.0°C +(0.05% of rdg + 1°C) +(0.1% of rdg + 7°C)
8 @ KPvsAu7Fe 0.0 to 300.0K +(0.05% of rdg + 0.7K) +(0.1% of rdg + 3.5K) 0.1K
hc! +(0.05% of rdg + 2.5°C) +(0.1% of rdg + 12°C)
530 PR40-20 0.0 to 1900.0°C Except 300 to 700°C: 6°C, Except 300 to 700°C: 25°C,
=Ko less than 300°C: not guaranteed | less than 300°C: not guaranteed
NiNiMo 0.0t01310.0°C 4(0.05% of rdg + 0.7°C) +(0.1% of rdg + 2.7°C)
+(0.05% of rdg + 2°C) +(0.1% of rdg + 7°C)
WRe3-25 0.0 to 2400.0°C Except 0 to 200°C: 2.5°C, Except 0 to 200°C: 12°C,
more than 2000°C: more than 2000°C:
+(0.05% of rdg + 4°C) +(0.1% of rdg + 11°C) 0.1°C
+(0.05% of rdg + 2°C) +(0.1% of rdg + 8.5°C)
W/WRe26 0.0 to 2400.0°C Except 100 to 300°C: 4°C, Except 100 to 300°C: 12°C,
less than 100°C: not guaranteed | less than 100°C: not guaranteed
N (AWG14) 0.0 to 1300.0°C +(0.05% of rdg + 0.7°C) +(0.1% of rdg + 3.5°C)
+(0.05% of rdg + 0.5°C) +(0.1% of rdg + 2.5°C)
XK GOST —200.0 to 600.0°C Except —200 to 0°C: Except —200 to 0°C:
+(0.2% of rdg + 0.7°C) +(1% of rdg + 2.5°C)
DI Level Threshold level accuracy: 0.1 V
Contact input ON for 100 Q or less, OFF for 10 kQ or more™

*1 R, S,B, K, E, J, T: ANSI, IEC 584, DIN IEC 584, JIS C 1602-1995
*2 L: Fe-CuNi, DIN43710/U: Cu-CuNi, DIN 43710
*3 N: Nicrosil-Nisil, IEC 584, DIN IEC 584

*4 W: W-5% Re/W-26%Re (Hoskins Mfg Co)

*5 Measured using a measurement current of approximately 10 pA at 200 mV range. Threshold level is approximately 0.1 V.
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5.6 30-CH, Medium-Speed DCV/TC/DI Input Module (MX110-VTD-L30) Specifications

Measurement Interval, Integration Time, and Filter:

. Burnout
Measurement Integ.]ratlon Detection Filter Rejected Noise and Notes
Interval Time Cycl
ycle

500 ms 1.67 ms 600 Hz and its integer multiples™

16.67 ms 60 Hz and its integer multiples
1s 20 ms Rectangular |50 Hz and its integer multiples

Auto™ Measurement Automatically detects the power supply frequency and set

interval 16.67 or 20 ms

2s 36.67 ms™ Trapezoidal |50 Hz or 60 Hz and their integer multiples
5s 100 ms™ Rectangular |10 Hz and its integer multiples
10, 20, 30, 60 s| 100 ms

*1 Because the power supply frequency noise is not rejected, the measured vales may fluctuate especially with
temperature measurement using thermocouples. In such cases, increase the measurement interval, or use
the 4-CH High-Speed Universal Input Module or the 10-CH, Medium Speed Universal Input Module.

*2 For DC power, set to 20 ms.

*3 When synchronizing time by SNTP, the integral time is the same as when the measurement interval is 1 s.

*4 When synchronizing time by SNTP, the integral time is set to 36.67 ms. Also in this case, noise of 50 Hz, 60
Hz, and their integer multiples is rejected.

Reference junction compensation:

Switch external/internal by channel, includes remote RJC function
Reference junction compensation accuracy:

When measuring temperature greater than or equal to 0 °C and

when the temperature of the input terminal is balanced

Type R, S, W: £1°C

Type K, J,E, T, N, L, U, XK GOST: +0.5°C

Type N (AWG14), PLATINEL, NiNiMo, WRe3-25, W/WRe26: +1°C

Note: Type B and PR40-20 internal RJC is fixed at 0°C
Maximum input voltage:DC voltage at 1-V range or less, TC, and DI (contact): +10 VDC

(continuous)

Other measurement ranges: £120 VDC (continuous)
Normal-mode voltage: DC voltage, TC, DI (LEVEL): 1.2 times the range rating or less

(50/60 Hz, peak value including the signal component)
Normal-mode rejection ratio:

For integration time of 16.67 ms or more: 40 dB or more (50/60

Hz £ 0.1%)

For integration time of 1.67 ms: 50/60 Hz is not rejected.
Common-mode voltage: 600 VACrms (50/60 Hz), reinforced (double) insulation
Common mode rejection ratio:

When the integration time is 16.67 ms or more: 120 dB or more

When the integration time is 1.67 ms: 80 dB or more

(50/60 Hz +£0.1%, 500 Q unbalanced between minus

measurement terminal and ground)
Common-mode voltage between channels: 120 VACrms (50/60 Hz)

Noise rejection: Rejection by the integrating A/D converter and the use of low pass
filters

Input resistance: For DC voltage 1 V range or less and thermocouple range: 10 MQ
or less

For DC voltage 2 V range or higher: Approx. 1 MQ

Insulation resistance: Between input and ground: 20 MQ or more (500 VDC)

Input bias current: 10 nA or less (except for burnout setting)

Withstand Voltage: 1000 VAC (50/60 Hz) for one minute between input terminals
3700 VAC (50/60 Hz) for one minute between the input terminal
and earth terminal

Input signal source resistance:

DC voltage, thermocouple: 2 kQ or less

Thermocouple burnout: Detection at a specifi ed detection interval per measurement
interval and detection within the thermocouple range (detection
ON/OFF possible)
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5.6 30-CH, Medium-Speed DCV/TC/DI Input Module (MX110-VTD-L30) Specifications

Up/Down setting is possible
2 kQ or less normal, 200 kQ or more disconnected
(shunt capacitance: 0.01 yF or less), detection current approx. 10
UA, detection time approx. 1.6 ms
Power consumption:  Approx. 1.2 W
External dimensions: Approx. 174 (W) x 131 (H) x 150 (D) mm (including the terminal cover)
Weight: Approx. 0.8 kg.
Terminal type: Clamp, or M3 screw terminal (if /H3 option is added)
Applicable wire size:  0.14 to 1.5 mm? (AWG26 to 16) (for clamp terminals)

Effects of Operating Conditions

The specifications below apply when the integral time is 16.67 ms or more.

Warm-up time: 30 minutes after power -up.

Effects of ambient temperature:
The effect received by changes of 10°C increments of the ambient
temperature is
+(0.05% of rdg. + 0.05% of range) or less

Effects of power fluctuation:
Meets the accuracy specifications for AC power supply in the
range 90 to 132 V and 180 to 250 V.

Effect of magnetic field: The fluctuation in external magnetic fields for AC (50/60 Hz) 400
A/m is £(0.1% of rdg. + 10 digits) or less

Effects from the signal source resistance:
Effect from fluctuation in DC voltage and thermocouple signal
source resistance of 1 kQ
DC voltage: 1V range or lower +10 pV or less

2V range or higher +0.15% of rdg. or less

Thermocouple: %10 pV or less

Effect of position: Horizontal with the feet at the bottom is the rule.

Effects of vibration: ~ The fluctuation that results by applying a sinusoidal vibration
along all three axes at a frequency between 10 to 60 Hz and an
acceleration of 0.2 m/s? is 1(0.1% of rdg. + 1 digit) or less.

General Specifications
Operating temperature range: —20 to 60°C
Operating humidity range: 20 to 80% RH for —20 to 40°C
10 to 50% RH for 40 to 50°C
5 to 30% RH for 50 to 60°C

External Dimensions
Units: mm
174 150

131

1o |1 1o b [N
) T A U

If not specified, the tolerance is +3%. However, in cases of less than 10 mm, the
tolerance is £0.3 mm.
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5.7 6-CH, Medium-Speed Four-Wire RTD

Resistance Input Module (MX110-V4R-M06)
Specifications

Style number: S2

Type of measurement: DC voltage, 4-wire RTD, 4-wire resistance, DI (contact, LEVEL)

Number of inputs: 6

Input method: Floating unbalanced input, insulation between channels

A/D resolution: 16 bits (+20000/+6000/0 to 60000)

Measurement range and accuracy:
The accuracy applies to standard operating conditions:
Ambient temp: 23 +2°C, ambient humidity: 55 £+10% RH, supply
voltage: 90 to 250 VAC, power frequency: 50/60 Hz 1%, warm-
up time: at least 30 minutes, without adverse conditions such as

vibrations.
Measurement Rated Measurement Accuracy M rement Accur. Highest
Input Range Measurement Integration Time: 16.67 ms easurement Accuracy Resolution
Type Range or More Integration Time: 1.67 ms (1 digit)
20 mvV —20.000 to 20.000 mV_| +(0.05% of rdg + 5 digits) £(0.1% of rdg + 25 digits) v
60 mV —60.00 to 60.00 mV__| #(0.05% of rdg + 2 digits) 10 pV
200 mV —200.00 to 200.00 mV | +(0.05% of rdg + 2 digits) 10 gV
DC voltage |2V —2.0000 t0 2.0000 V__| +(0.05% of rdg + 5 digits) +(0.1% of rdg + 10 digits) 100 pV
6V —6.000 to 6.000 V +(0.05% of rdg + 2 digits) TmV
20V —20.000 t0 20.000 V__| +(0.05% of rdg + 2 digits) 1TmV
100 V —100.00 to 100.00 V__| #(0.05% of rdg + 2 digits) 10 mv
60 mV (high res.) | 0.000 to 60.000 mV | +(0.05% of rdg + 20 digits) £(0.1% of rdg + 100 digits) 1V
6 V (high res.) 0.0000 to 6.0000 V__| +(0.05% of rdg + 20 digits) +(0.1% of rdg + 100 digits) 100 gV
1V —1.0000 to 1.0000 V__| +(0.05% of rdg + 2 digits) +(0.1% of rdg + 10 digits) 100 gV
Pt100™" —200.0 to 600.0°C . .
JPt1007 2000 t0 550.0°C___| #(0.05% of rdg + 0.3°C) #(0.1% of rdg +1.5°C) 0.1°C
Pt100 (high res.) |-140.00 to 150.00°C . .
JPt100 (high res.) | —140.00 to 150.00°C | +(0.05% of rdg + 0.3°C) (0.1% of rdg + 1.5°C) 0.01°C
Ni100 SAMA | -200.0 to 250.0°C
Ni100 DIN'2 —60.0 to 180.0°C . .
203 00 1 200.0°G £(0.05% of rdg + 0.3°C) +(0.1% of rdg + 1.5°C) 0.1°C
Pt50 —200.0 to 550.0°C
Cu10 GE™ —200.0 to 300.0°C
Cu10 L&N™ —200.0 to 300.0°C . .
Cu10 WEED™ _|-200.0 to 300.0°C +(0.1% of rdg + 2°C) #(0.2% of rdg + 5°C) 0.1°C
Cul0 BAILEY# _|-200.0 to 300.0°C
J263B 0.0 to 300.0K +(0.05% of rdg + 0.3K) +(0.1% of rdg + 1.5K) 0.1K
Cu10at20°C | _500,0 to 300.0°C
. | 2lpha=0.00392 +(0.1% of rdg + 2°C) £(0.2% of rdg + 5°C) 0.1°C
RTD Cut0at20°C | _500,0 to 300.0°C
(Measurement | alpha=0.00393
curient: 1mA) | Cuz5 210 = 5 |200.010300.0°C | £(0.1% of rdg + 0.5°C) £(0.2% of rdg + 2°C) 0.1°C
alpha=0u.
;:ﬁg_ag 23526035 -50.0 to 150.0°C
s +(0.05% of rdg + 0.3°C +(0.1% of rdg + 1.5°C °
Cu100at0°C | _50 0t 150.0°C (005% ofrdg ) (0.1% ofrdg ) ore
| alpha=0.00425
Pt25(JPt100/4) | -200.0 to 550.0°C +(0.1% of rdg + 0.5°C) £(0.2% of rdg + 2°C) 0.1°C
Cu10 GE R
(high resolution) | ~200-0 10 300.0°C
Cu10 L&N e
(igh resolution) | ~200.0 10 300.0°C . .
g +(0.1% of rdg + 2°C) +(0.2% of rdg + 5°C) 0.1°C
Cut0 WEED 200.0 to 300.0°C
(high resolution) | <°°° % '
CUul0BAILEY | 500 010 300.0°C
(high resolution)
Pt100 GOST —200.0 to 600.0°C +(0.05% of rdg + 0.3°C) £(0.1% of rdg + 1.5°C) 0.1°C
Cu100 GOST _|—200.0 to 200.0°C +(0.05% of rdg + 0.3°C) £(0.1% of rdg + 1.5°C) 01°C
Cu50 GOST —200.0 to 200.0°C +(0.05% of rdg + 0.3°C) £(0.1% of rdg + 1.5°C) 0.1°C
Cu10 GOST ~200.0 to 200.0°C +(0.1% of rdg + 2°C) £(0.2% of rdg + 5°C) 01°C

*1 Pt50: JIS C 1604-1989, JIS C 1606-1989/Pt100: JIS C 1604-1997, IEC 751, DIN IEC 751/JPt100: JIS C 1604-1989, JIS C 1606-1989
*2 SAMA/DIN
*3 McGRAW EDISON COMPANY
*4 Guaranteed accuracy range Cu10 GE: —84.4 to 170.0°C/Cu10 L&N: —75.0 to 150.0°C/Cu10 WEED: —20.0 to 250.0°C/

Cu10 BAILEY: —20.0 to 250.0°C
*5. 4-wire RTD, 4-wire resistance
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5.7 6-CH, Medium-Speed Four-Wire RTD Resistance Input Module (MX110-V4R-MO06) Specifications

Measurement Rated Measurement Accuracy M A Highest
Input Range Measurement Integration Time: 16.67 ms | teasutlfem(:_pt _c;:l:sr7acy Resolution
Type Range or More ntegration fime: 1.6/ ms (1 Digit)
RTD" Pt50072 —200.0 to 600.0°C
(Meast{rgrggnt +(0.05% of rdg + 3digits) (0.1% of rdg + 1.5digits) 0.1°C
;“:)e" - 0- Pt1000°2 —200.0 to 600.0°C
20Q .
(Measurement 0.000 to 20.00 Q +(0.05% of rdg + 7digits) +(0.1% of rdg + 25digits) 0.001 Q
current 1 mA)
200 Q .
Resistance | (Measurement | 0.00 to 200.00 Q +(0.05% of rdg + 3digits) +(0.1% of rdg + 15digits) 0.010Q
current 1 mA)
2kQ . -
(Measurement 0.0 t0 2000.0 Q +(0.05% of rdg + 3digits) +(0.1% of rdg + 10digits) 0.1Q
current 0.25 mA)
DI Level Vth=24V Threshold level accuracy: 0.1 V
Contact input ON for 100 Q or less, OFF for 10 kQ or more™
*1 Measured using a measurement current of approximately 10 pA at 200 mV range. Threshold level is approximately 0.1 V.
*2 The Pt500 resistance table is Pt100 x 5, and the resistance table for Pt1000 is Pt100 x 10
*3 4-wire RTD, 4-wire resistance.
Measurement interval, integration time, and filter:
Measurement Intet_:_lratlon Filter Rejected Noise and Notes
Interval Time n
100 ms N e 3
200 Ms 1.67 ms 600 Hz and its integer multiples o
16.67 ms |Rectangular |60 Hz and its integer multiples ‘-—;
500 ms 20 ms 50 Hz and its integer multiples Q
Auto™ Automatically detects the power supply frequency and set 16.67 or 20 ms o
1s 36.67 ms | Trapezoidal |50 Hz, 60 Hz and their integer multiples 3
2s 100 ms™ | Rectangular |10 Hz and its integer multiples
5s 200 ms™ )
C = - |
10,20, 30,60 200 ms 0s Fc = 5-Hz low-pass filter

*1 When the measurement interval is 100 ms or 200 ms, measured values may fluctuate (especially for temperature,
20 Q, and other measurements) since power supply frequency noise is not rejected. In such cases, set the

measurement interval to 500 ms or more.
*2 For DC power, set to 20 ms.

*3 When synchronizing time by SNTP, the integral time is set to 36.67 ms. Also in this case, noise of 50 Hz, 60 Hz, and

their integer multiples is rejected.

*4 When synchronizing time by SNTP, the integral time is set to 100 ms. Also in this case, noise of 10 Hz and its integer

multiples is rejected.

Maximum input voltage:

DC voltage at 1-V range or less, RTD, resistance, and DI (contact):

+10 VDC (continuous)

Other measurement ranges: +120 VDC (continuous)

Normal-mode voltage:

DC voltage, DI (LEVEL): 1.2 times the range rating or less (50/60

Hz, peak value including the signal component)

Resistance 2 kQ, RTD 100 Q, 500 Q: 1000 Q types: 50 mVpeak
Resistance 200 Q, RTD 10 Q, 25 Q: 50 Q types: 10 mVpeak

Resistance 20 Q: 4 mVpeak
Normal-mode rejection ratio:

For integration time of 16.67 ms or more: 40 dB or more (50/60

Hz £0.1%)

For integration time of 1.67 ms: 50/60 Hz is not rejected

Common-mode voltage: 600 VACrms (50/60 Hz), reinforced (double) insulation

Common mode rejection ratio (50/60 Hz £0.1%, 500 Q unbalanced between minus
measurement terminal and ground. The RTD and resistance
ranges indicate the voltage conversion value when current flows)
When the integration time is 16.67 ms or more: 120 dB or more

When the integration time is 1.67 ms: 80 dB or more

Common-mode voltage between channels:
DC voltage, DI: 120 VACrms (50/60 Hz)
RTD, resistance: 50 VACrms (50/60 Hz)
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5.7 6-CH, Medium-Speed Four-Wire RTD Resistance Input Module (MX110-V4R-M06) Specifications

Noise rejection: Rejection by the integrating A/D converter and the use of low pass
filters
Input resistance: For DC voltage 1V range or less: 10 MQ or less

For DC voltage 2 V range or higher: Approx. 1 MQ

Insulation resistance: Between input terminal and earth terminal: 20 MQ or more (500
VDC)

Input bias current: 10 nAor less

Withstand voltage: 1000 VACrms (50/60 Hz) for one minute between input terminals
(DC voltage and DlI)
620 VACrms (50/60 Hz) for one minute between input terminals
(RTD and resistance)
3700 VACrms (50/60 Hz) for one minute between the input
terminal and earth terminal

Input signal source resistance:
DC voltage: 2 kQ or less
Resistance and RTD ranges: 10 Q or less per line (same for all
ranges)

Shunt capacity: 0.01 yF or less (when using RTD and resistance ranges)

Power consumption:  Approx. 1.2 W

External dimensions: Approx. 57 (W) x 131 (H) x 151 (D) mm (including the terminal

cover)
Weight: Approx. 0.5 kg.
Terminal type: Clamp, terminal board is detachable

Applicable wire size:  0.14 to 1.5 mm? (AWG26 to 16)

Effects of Operating Conditions

The specifications below apply when the integration time is 16.67 ms or more.

Warm-up time: At least 30 minutes after power-up

Effects of ambient temperature:
The effect received by changes in 10 degree increments of the
ambient temperature is £(0.05% of rdg. + 0.05% of range) or less.
However, for Cu10 Q: +(0.2% of range + 1 digit)

Effects of power fluctuation:
Meets the accuracy specifications for AC power supply in the
range 90 to 132 V and 180 to 250 V

Effects of magnetic field: The fluctuation in external magnetic fields for AC (50/60 Hz)
400 A/mis £(0.1% of rdg. + 10 digits) or less

Effects from the signal source resistance: Effect from fluctuation in DC voltage signal
source resistance of 1 kQ

1V range or less +10 pV or less
2 V range or higher 10.15% of rdg. or less
RTD: Fluctuation from 10 Q change per line

1000 Q, 100 Q types: + 0.1°C or less
Other than 1000 Q, 100 Q types: + 1.0°C or less
Resistance: Fluctuation from 10 Q change per line: £1 digit or less
Effect of position: Horizontal with the feet at the bottom is the rule.
Effects of vibration: ~ The fluctuation that results by applying a sinusoidal vibration
along all three axes at a frequency between 10 to 60 Hz and an
acceleration of 0.2 m/s? is +(0.1% of rdg. + 1 digit) or less
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5.7 6-CH, Medium-Speed Four-Wire RTD Resistance Input Module (MX110-V4R-M06) Specifications

General Specifications
Operating temperature range: —20 to 60°C
Operating humidity range: 20 to 80% RH for —20 to 40°C
10 to 50% RH for 40 to 50°C
5 to 30% RH for 50 to 60°C

External Dimensions
Units: mm

57 150.8

UL

131

@ 0
| JUTEETT

If not specified, the tolerance is £3%. However, in cases of less than 10 mm, the

tolerance is £0.3 mm.
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5.8

4-CH, Medium-Speed Strain Input Module
(MX112) Specifications

Style number: S2
Number of inputs: 4
Input type: Strain gauge or strain gauge type sensors (static strain)

Input method: Floating balanced input isolated between channels (NDIS is non-
isolated)
Measurement range and accuracy:
The accuracy applies to standard operating conditions:
Ambient temp: 23+2°C, ambient humidity: 55£10% RH, supply
voltage: 90 to 250 VAC, power frequency: 50/60 Hz + 1%, warm-

up time: at least 30 minutes, without adverse conditions such as

vibrations.
One-Gauge Method Conversion
Input Measurement Rated Integration time: 16.67 ms or more Integration time: 1.67 ms
Range Type Measurement Measurement Resolution Measurement Resolution
Range Accuracy Accuracy

Strain 2000 uStrain +2000.0 uStrain +0.5% of range 0.1 pStrain +2% of range 1 uStrain !
20000 pStrain +20000 pStrain +0.3% of range 1 yStrain +1% of range 2 pStrain z
200000 pStrain | #200000 pStrain +0.3% of range 10 pStrain +1% of range 10 pStrain

*1 Display resolution is 0.1 pStrain

*2 Display resolution is 1 pStrain

AD resolution: Equivalent to + 20000 FS display
However, excludes 1.67 ms integration time

AD integration time:

Measurement Integration . . .
Interval Time Filter Rejected Noise and Notes
100 ms 1.67 ms 600 Hz and its integer multiples
16.67 ms Rectangular 60 Hz and its integer multiples
200 ms 20 ms 50 Hz and its integer multiples
Auto™ Automatically detects the power supply frequency and set 16.67 or 20 ms
500 ms 36.67 ms | Trapezoidal |50 Hz, 60 Hz and their integer multiples
1s 100 ms Rectangular |10 Hz and its integer multiples
2s 200 ms™ )
5.10,20,30,605 |200ms Cos Fc = 5-Hz low-pass filter

*1 When the measurement interval is 100 ms, measured values may fluctuate since power supply frequency

noise is not rejected. In such cases, set the measurement interval to 200 ms or more.
*2 For DC power, set to 20 ms.

*3 When synchronizing time by SNTP, the integral time is set to 100 ms. Also in this case, noise of 10 Hz and its integer

multiples is rejected.

Gauge connection method:

1-gauge (2 or 3 wire systems), opposing 2 gauge, adjacent 2- or

4-gauge

With clamp terminals, set on a channel basis with switches

Applicable gauge resistance: 100 to 1000 Q

120 Q for -B12; 350 Q, built-in resistance for -B35
Bridge voltage:
Applicable gauge factor:

Fixed at 2 VDC. Accuracy +5% compensated with internal Cal

Fixed at 2.0. Gauge factor can be compensated with the scaling

function
Balance adjustment: Automatic, digital calculation methods
Balance adjustment range:

+10000 pstrain (1 gauge method conversion)
Balance adjustment accuracy:

The measurement accuracy or less
Resistance accuracy for bridge:

1+0.01% +5ppm/°C

Input resistance: 1 MQ or more.
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5.8 4-CH, Medium-Speed Strain Input Module (MX112) Specifications

Allowable wiring resistance:
100 Q or less
Effect of wiring resistance:
NDIS 50 ppm of rdg. / Q (when using remote sensing wire)
Does not compensate for clamp wiring resistance. Depends on
the gauge resistance.
Allowable input voltage:
+10 VDC (between H-L) continuous
Allowable common-mode voltage: Channel-to-channel: 30 VACrms
Between input and ground: 250 VACrms (-B12, -B35), 30 VACrms
(-NDI)
However, NDIS connector shell is connected to earth potential.
Common mode rejection ratio :
When the integration time is 16.67 ms or more: 120 dB or more.
When the integration time is 1.67 ms: 80 dB or more
(voltage conversion value at 50/60 Hz +0.1%, bridge voltage of 2 V)
Normal mode rejection ratio:
For integral time of 16.67 ms or more: 40 dB or more (50/60 Hz +
0.1%)
For integral time of 1.67: 50/60 Hz is not rejected.
(voltage conversion value given a bridge voltage of 2 V)
Insulation resistance: Between input and earth 20 MQ or more (500 VDC)
Withstand voltage*: Between input and earth 2300 VAC for one minute
Channel-to-channel: 30 VACrms or less
Power consumption:  Approx. 3 W (one module)

Weight: Approx. 0.5kg.

External dimensions: Approx. 57 (W) x 131 (H) x 151 (D) mm (including the terminal
cover)

Terminal type: -B12, -B35: Clamp, terminal board is detachable

-NDI: NDIS, detachable by channel
Applicable wire size: 0.14t0 1.5 mm? (AWG26 to 16) (excluding -NDI)
* Does not apply to the NDIS terminal.

Effects of Operating Conditions

The specifications below apply when the integration time is 16.67 ms or more.
Warm-up time: At least 30 minutes after power-up
Effects of ambient temperature:
The effect received by changes in 10°C increments of the ambient
temperature is
1(0.1% of range) or less
Effects of power fluctuation:
Meets the accuracy specifications for AC power supply in the
range 90 to 132 V and 180 to 250 V
Effects of magnetic field:
The fluctuation in external magnetic fields for AC (50/60 Hz) 400
A/m is +2% of range or less
Effect of position: Horizontal with the feet at the bottom is the rule.
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5.8 4-CH, Medium-Speed Strain Input Module (MX112) Specifications

General Specifications

Operating temperature range:
Operating humidity range:

External Dimensions

-B12, -B35

57

150.8

—20 to 60°C

20 to 80% RH for —20 to 40 °C
10 to 50% RH for 40 to 50 °C

5 to 30% RH for 50 to 60 °C

Units: mm

133.8

@r

131

If not specified, the tolerance is +3%. However, in cases of less than 10 mm, the

tolerance is £0.3 mm.

4.8

131

I — — —
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5.9

10-CH, Pulse Input Module (MX114)

Specifications
Style number:
Number of Inputs:
Input type:

Measurement interval:

Input types:

S3
10

Pull up internally at approx. 5 V/approx. 5 kQ, non-isolated

between channels

Select 100 ms, 200 ms, 500 ms, 1s,2s,5s,10s,20s,30s, or

60 s.

Contact (non-voltage contact, open collector), LEVEL (5-V logic)
Rated measuring range:

0 to 30000

However when using the SNTP time synchronization function,
the measurement interval becomes that when the next time
synchronization is executed, and the rated measuring range at

that time must not be exceeded.

Set Measurement Measurement Interval When Time Synch.
Interval Executed

2s 1sto3s

5s 4stobs

10s 9sto11s

20s 18sto22s

30s 27sto33s

60 s 54 sto 66 s

Measurement accuracy:

Resolution:
Filter:

Measurement mode

Input range:

Count * 1 pulse (note that time axis accuracy (time accuracy) is

not included).

For integration computation, the following accuracies are added.
Computation start: + no. of integrations in the MATH interval
Computation stop: + no. of integrations in the MATH interval

1

First-order lag filter (digital filter):
Measurement interval of 5 s or less:

Measurement interval of 5 s or more:

Chattering filter (analog filter)
Turn on to remove chattering (of up to 5 ms)
Can be turned ON/OFF on individual channels.

RATE (count instantaneous mode):

The wider of the ON/OFF
width of the interval of
approximately 75-90% of
the measurement interval.
The wider of the ON/OFF
width of approximately 4.5
seconds.

Outputs the input number of pulses at the specified interval.

10000 count/s or less

(plus over if the count within the measurement range exceeds

31500)

Minimum input pulse width: 40 us
Contact (non-voltage contact or open collector):
Counts when changing from contact open (100 kQ or more) to

Input threshold level:

Hysteresis width:

contact close (100
LEVEL (5 V logic):

Q orless)

Counts when changing from 1 V or less to 3 V or more.

Approximately 0.1 V
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5.9 10-CH, Pulse Input Module (MX114-PLS-M10) Specifications

Contact/transistor rating:
Contact with a rating of 15 VDC or more, and 30 mA or more
Transistor with a rating of Vce > 15, and Ic > 30 mA
Maximum input voltage:+ 10 V
Insulating resistance: Input terminals to ground: 20 MQ or more (500 VDC)
Withstand voltage: Input terminal to ground: 2300 VAC (50/60 Hz), for one minute
Maximum common mode voltage:
250 VACrms (50/60 Hz)
Terminal type: Clamp
Power consumption:  Approx. 1.5 W
Applicable wire size:  0.14 to 1.5 mm? (AWG26 to 16)
External dimensions: Approx. 57 (W) x 131 (H) x 151 (D) mm (including terminal cover)
Weight: Approx. 0.5 kg.

General Specifications
Operating temperature range: -20 to 60°C
Operating humidity range: 20 to 80% RH for —20 to 40°C
10 to 50% RH for 40 to 50°C
5 to 30% RH for 50 to 60°C

External Dimensions

| 1|0
1l o ! ™

If not specified, the tolerance is +3%. However, in cases of less than 10 mm, the
tolerance is £0.3 mm.
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5.10 10-CH, High-Speed Digital Input Module
(MX115) Specifications

Style number: S1(-D05), S2(-D24)

Input type: -D05: Contact (non-voltage contact, open collector) and LEVEL
(5-V logic)
-D24: LEVEL (24-V logic)

Number of inputs: 10

Input format: -D05: Pull up at approx. 5 V/approx. 5 kQ, non-isolated

between channels
-D24: No isolation between channels
Measurement interval: ~ Select 10 ms, 50 ms, 100 ms, 200 ms, 500 ms, 1s,25s, 5, 10
s,20s,30s,0r60s
Filter Measurement interval of 5 s or less: Use the wider of the ON/
OFF width of the detection period (approximately 75% to 90%
of the measurement interval)
Measurement interval of 5 s or more: Use the wider of the ON/
OFF width of approximately 4.5 s
Minimum detection pulse width:  Twice the sampling interval or more
Input threshold level: -D05: Contact (non-voltage contact, open collector):
100 Q or less, ON, 100 kQ or more, OFF
LEVEL (5-V logic): OFF at 1 V or less and ON at 3 VV or more
-D24: LEVEL (24-V logic): OFF at 6 V or less and ON at 16 V
or greater
Hysteresis width: -D05: Approx. 0.1 V -D24: Approx. 1.5V
Contact transistor rating: 15 VDC or greater and 30 mA or greater
Transistor with a rating of Vce > 15 VDC and Ic > 30 mA

Maximum input voltage: -D05: +10V -D24: £50 V

Insulation resistance: Between input terminals and ground: 20 MQ or more (500
VDC)

Withstand voltage: 2300 VAC (50/60 Hz) for one minute between input and earth

Maximum common mode voltage: 250 VACrms (50/60 Hz)

Terminal type: Clamp

Power consumption: Approx. 1.5 W

Applicable wire size: 0.14 to 1.5 mm? (AWG26 to 16)
External dimensions: Approx. 57 (W) x 131 (H) x 151 (D) mm (including the terminal

cover)
Weight: Approx. 0.5 kg.
General Specifications
Operating temperature range: —20to 60°C
Operating humidity range: 20 to 80% RH for —20 to 40°C
10 to 50% RH for 40 to 50°C
5 to 30% RH for 50 to 60°C
External Dimensions ,
Units: mm
57 150.8
=T =

131

© ! ™

If not specified, the tolerance is +3%. However, in cases of less than 10 mm, the
tolerance is £0.3 mm.
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5.11 8-CH, Medium-Speed Analog Output Module
(MX120-VAO-M08) Specifications

Style number: S2

Number of outputs: 8

Update interval: 100 ms minimum (not synchronized to the measurement interval)
Output types: DC voltage, DC current (external 24-V power supply required

when using current output)
Rated output range:  Voltage: —10to 10 V
Current: 0 to 20 mA sourcing (for 1 to 5 V output, 4 to 20 mA is
output)
Maximum allowable output range:
Voltage: —11 to 11 V Current: 0 to 22 mA

Load impedance: Voltage: 5 kQ or more Current: 600 Q or less.

Accuracy: 1+0.2% of F.S. at the rated output range or less (F.S. =10 V or
20 mA). However, for current output, accuracy is met at 1 mA or
more.

The accuracy applies to standard operating conditions:
Ambient temp: 23 +2°C, ambient humidity: 55 £10% RH, supply
voltage: 90 to 250 VAC, power frequency: 50/60 Hz +1%, warm-
up time: at least 30 minutes, without adverse conditions such as
vibrations.

Output resolution: 12 bits of F.S. or more
Resolution —10.000 V to 10.000 V (1 mV resolution)

0.000 mA to 20.000 mA (1pA resolution)

Effects of ambient temperature:
+(50 ppm of Setting + 50 ppm of F.S.) per degree 1°C or less
(F.S. =10V or 20 mA)

External power supply:24 V +10% (required when using current output)
Connect a device with capacity of 250 mA or more.

Insulation resistance: Between output terminals and earth terminal: 20 MQ or more

(500 VDC)
Across output terminals: non-isolated (- terminal common
potential)

Withstand voltage: 2300 VAC (50/60 Hz) for one minute between the output terminal
and earth.
Across output terminals: non-isolated (-terminal common
potential).

Power consumption:  Approx. 2.5 W (not including power consumption of external
power supply).

Terminal type: Clamp, attached and removed in units of 4 channels

Applicable wire size: 0.08 to 2.5 mm? (AWG28 to 12)
External dimensions: Approx. 57 (W) x 131 (H) x 151 (D) mm (including the terminal

cover)
Weight: Approx. 0.5 kg.
General Specifications
Operating temperature range: —20 to 50°C
Operating humidity range: 20 to 80% RH for —20 to 40°C

10 to 50% RH for 40 to 50°C
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5.11 8-CH, Medium-Speed Analog Output Module (MX120-VAO-M08) Specifications

External Dimensions

2l
o ! ™

If not specified, the tolerance is +3%. However, in cases of less than 10 mm, the
tolerance is £0.3 mm.

Output Span Setting

Limit value of V. mode and mA mode

Modes Output . Setting span Setting span Output .
lower limit "' lower limit upper limit upper limit 2

V mode -11[V] -10[V] +10[V] +11[V]

mA mode O[mA] 0[mA] 20[mA] 22[mA]

*1 —OVER, preset value
*2 + OVER, preset value

Handling Abnormal Data

Abnormal Data Types Output value

Data upon startup Preset value or previously held value can be selected
Data upon error occurrence Preset value or previously held value can be selected
+OVER 5% of output Full Span

-OVER —5% of output Full Span

+OVER conditions

* When the input channel is tOVER in the case of transmission output
* When outside the range of voltage —11 V to +11 V, or current 0 mA to 22 mA (accuracy
assured at 1 mA or more)
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5.12 8-CH, Medium-Speed PWM Output Module

(MX120-PWM-M08) Specifications

Style number: S2
Number of outputs: 8
Update interval: 100 ms minimum (not synchronized to the measurement interval)
Output interval: 1 ms to 300 s (can be set channel by channel)
However,

1 ms interval setting range: 1 ms to 30.000 s (can be set in
units of 1 ms)
10 ms interval setting range: 10 ms to 300.00 s (can be set in
units of 10 ms)
Output types: Pulse width:
Update timing: After receiving change command, duty is changed from falling of
the next interval
Pulse interval accuracy: +100ppm of Setting
External power supply:4 to 28 V
Insulation resistance: Between output terminals and earth terminal: 20 MQ or more (500
VDC)
Across output terminals: non-isolated
Withstand voltage: 2300 VAC (50/60 Hz) for one minute between the output terminal

and earth
Across output terminals: non-isolated
Duty resolution: 1 ms interval setting range: 12000

10 ms interval setting range: 60000
Set at 0 to 100.000% (0.001% resolution)

Duty accuracy (at a load resistance 100 Q or less):
For 1 ms interval setting range, +0.017% or +2 ps whichever is
longer
For 10 ms interval setting range, £0.0035% or +2 us whichever is
longer
When the load resistance is greater than 100 Q, the output duty
can shift.

Output format: External power supply sourcing

ON resistance: 2 Q or less, when output current is 200 mA or more.

Output capacity: 1 A/ch max, however, 4 A or less total for all modules " ?

*1 A 1A current limit circuit is built in to the output circuit. Once the current limit circuit is ON,
the circuit continues to operate unless the external power supply is turned OFF (maintains
the output OFF status)

After turning OFF external power supplies, check the load, then start up the external power
supply again.

*2 This module has a built-in fuse. The built-in fuse protects against fires or abnormal
emissions of heat due to load short-circuiting or other abnormalities.

Power consumption:  Approx. 2.5 W (not including power consumption of external
power supply)

Terminal type: Clamp, attached and removed in units of 4 channels

Applicable wire size:  0.08 to 2.5 mm? (AWG28 to 12)

External dimensions: Approx. 57 (W) x 131 (H) x 151 (D) mm (including the terminal
cover)

Weight: Approx. 0.5 kg.
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5.12 8-CH, Medium-Speed PWM Output Module (MX120-PWM-M08) Specifications

General Specifications
Operating temperature range: —20 to 50°C
Operating humidity range: 20 to 80% RH for —20 to 40 °C

10 to 50% RH for 40 to 50°C

External Dimensions

Units: mm

57 150.8

131

o ! ™

If not specified, the tolerance is +3%. However, in cases of less than 10 mm, the
tolerance is £0.3 mm.

Handling Abnormal Data

Abnormal Data Types Output value

Data upon startup Preset value or previously held value can be selected
Data upon error occurrence Preset value or previously held value can be selected
+OVER Duty: +5% of the output Full Span

-OVER Duty: —5% of the output Full Span

+OVER conditions

When duty exceeds 0.000 to 100.000%
When the input channel is +OVER in the case of transmission output

IM MW100-01E
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5.13 Operations Common to the 8-CH Medium-
Speed Analog Output Module and the 8-CH
Medium Speed PWM Output Module (MX120)

Settings Related Specifications (by Module)

Setting channel

(Module) Setting Contents Settings Remarks
Output Channel  Span Setting  AQ(V) ~10.000 to 10.000vV — The output range
(AO, PWM) range AO(MA)  0.000 o -20.000 mA for a}rb'ltrary output
is within the range
PWM 0.000 to 100.000% on the left
Preset value  AO(V) -11.000 to 11.000V ~ — —
Setting AO(mA) 0.000 to 22.000 mA
range PWM 0.000 to 100.000%
Setting span (minimum and maximum) Yes —
specified in reverse
Setting span (minimum, maximum) No —

same value specification

Overview of Output Operation When Setting Holding of Previous Value of

Transmission Output
Previous value
(held)

Previous value

Value held
Output value T T
Power ON Measurement Measurement Measurement
start stop restarts
(or Transmission output (or Transmission output
execute disabled) execute enabled)
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5.14 10-CH, Medium-Speed Digital Output Module
(MX125) Specifications

Style number:
Number of outputs:
Contact mode:
Update interval:
Contact capacity:
Contact life*:

Insulation resistance:

Withstand voltage:

S1

10

A contact (SPST)

100 ms minimum (not synchronized to the measurement interval)

250 VDC/0.1 A, 250 VAC/2 A, or 30 VDC/2 A (resistance load)

100,000 times at rated load (typical)

20,000,000 times at no load (typical)

* The contact life varies depending on the load conditions and the
environment in which it is used.

Between output terminals and earth terminal: 20 MQ or more (500

VDC)

Between output terminals: 20 MQ or more (500 VDC)

2300 VAC (50/60 Hz) for one minute between the output terminal

and earth

2300 VAC (50/60 Hz) for one minute between output terminals

Maximum common-mode voltage:

Power consumption:
Terminal type:

Applicable wire size:
External dimensions:

Weight:

General Specifications

250 VACrms (50/60 Hz)

Approx. 2 W (when all relays are turned ON)

Clamp, attached and removed in units of 5 channels

0.08 to 2.5 mm? (AWG28 to 12)

Approx. 57 (W) x 131 (H) x 151 (D) mm (including the terminal
cover)

Approx. 0.5 kg.

Operating temperature range: —20 to 50°C
Operating humidity range: 20 to 80% RH for —20 to 40°C

External Dimensions

10 to 50% RH for 40 to 50°C

Units: mm
57 150.8
= o =
[
o
® 0 i
JU I====1 1]

If not specified, the tolerance is +3%. However, in cases of less than 10 mm, the

tolerance is £0.3 mm.
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Appendix

Appendix 1 Supported Characters

Lower 4 bits

When entering characters on the MW100 from a browser, the following characters can
be used. There are limits to which characters can be used depending on the type of
entry item. For information on the characters can that can be used in communication
commands, see the MW7100 Communication Command Manual (IM MW100-17E).

Upper 4 bits
0o|/1/2|3|4|5|6|7|8|9|A|B|C|D|E]|F

0 SPlol@|P p
1 ' 1A | Q|a]|q
2 2 | B|R|b|Tr
3 # |3 |C | S |c |s
4 4 |D | T |d |t
5 % |5 |E|U/|]e|u
6 & |6 |F |V |f |V
7 7G| W|g|w
8 (|8 |H | X |h|Xx
9 Y 9 |1 Y | i |y
A * J | Z|j |z
B + K| T[ |k |{
C < | L I |
D - =M |1 |m]|}
E > N[~ |n |~
F / O|_|o

User Specified Strings
Alphanumeric English characters can be entered.

Passwords

Alphanumeric English characters can be entered. However, the following characters may
not be used.

Space (blank) and asterisk (*)

Host Name, Domain Name, and Server Name
Alphanumeric English characters and hyphens (-), periods (.), and underscores (_) can
be used.

File Name
Alphanumeric English characters and “#”, “%”, “(", “)", “-*, “@”, and “_" can be used.
However, the following character combinations may not be used.

AUX, CON, PRN, NUL, COM1 to COM9, and LPT1 to LPT9

IM MW100-01E
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Appendix 2 Setting Data Communication That Uses
Modbus Protocol

This section descries the procedure for data transmission and reception based on a
configuration in which two MW100s are connected for Modbus communications (Modbus/
TCP) over an Ethernet. Note that the MATH function (/M1 option) is required to use the
Modbus client function.

Setup Procedure
The following shows the procedures for entering settings, from connecting to the Ethernet
to applying the data acquired via Modbus communications. For detailed instructions and
specifications on each function, see the MW100 Data Acquisition Unit User’s Manual (IM
MW100-01E).

Connect the MW100s to the Ethernet.
Connect to Ethernet » See section 2.6

Enter Ethernet Communication Settings
Enter Ethernet settings » See section 3.2

| » See IM MW100-76E for how to check the connection.

Server Enter Server Settings
. Enter Server Settings P See “Server Settings” in section 3.14
Settings o
I ] ] Enable the client function.
Enter Client Settings, 1 » See section 3.2, “Modbus Client Settings, 1.”
Client . . Enter the destination server.
Settings Enter Client Settings, 2 » See section 3.2, “Modbus Client Settings, 2.

i i Enter register settings.
Enter Client Settings, 3 » See section 3.2, “Modbus Client Settings, 3.”
- | P See section 5.2 for details on registers.

Enter MATH channel Apply data acquired via Modbus communications.
settings > See section 3.6 for the settings.
P See section 1.15 regarding communication input channels.

Example System
In this example, the system comprises one client MW100 and one server MW100
connected via Ethernet.

MW100 (Client) MW100 (Server)
[EEE [Fai
o Jlo llo l::' o o jllo Jlo llo |lo l:J
IIHIIIIL IIHIIIIL IIHIIII'LJIIII- JIIIIIIIIIL_‘ IIHIIIIL IIHIIIIL IIHIIIIL IIHIIIIL IIHIIIIL IIHIIIILJIIII. JlllllllllL
IP: 192.168.1.100 IP: 192.168.1.101
Modbus service port: 502
Ethernet READ

Direction of data
WRITE
The MW100 set up as the client in the above system diagram is referred to as the
MW100 client. Likewise, the MW100 set up as the server is referred to as the MW100
server.
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Appendix 2 Setting Data Communication That Uses Modbus Protocol

Setup Example
Data is sent and received between the MW100 client and MW100 server. The MW100
client loads and displays measured data from measurement channels 001 to 004 of
the MW100 server, and also writes that data to the MW100 server. The following is an
example in which the data written to the MW100 server is displayed.

Measured data READ request

f Ethernet
Computed data
MW100 WRITE request MW100
Client Server
|
|Com. input ch.*| = |MATH channel| | Hold register | | Input register |
ICom. input ch.*I IMeas. channeII
Measured data received from *
the MW100 server is displayed. MATH channel
L
Computed data from
the MW100 client is '\D":tzsured

Y written to registers
and displayed

VW VW

* Com. input ch. : Communication input channel

Data in the Example

The data that is sent and received in this setting example is as follows.

1. Measured data from measurement channels 001 to 004 of the MW100 server are
written to communication input channels C001 to C004 of the MW100 client as 32-bit
floating point (float) type data.

For READ (client loads data from server)

MW100 Client MW100 Server

Communication Input
Channel Input Register

C001

31001 Lower byte of measured data of measurement channel 001
31002 Upper byte of measured data of measurement channel 001

C002 31003 | | Lower byte of measured data of measurement channel 002

A=
HEER

31004 Upper byte of measured data of measurement channel 002

31007 Lower byte of measured data of measurement channel 004

C004

31008 Upper byte of measured data of measurement channel 004

Input register numbers starting from 31001 are specified
to acquire 32-bit floating point type measured data.

“Float-Little” is selected for the register data type because the 32-bit floating
point type measured data is received in the order lower byte, upper byte.

IM MW100-01E App-3
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Appendix 2 Setting Data Communication That Uses Modbus Protocol

2. Computed data from MATH channels A0O01 to A004 of the MW100 client are written to
communication input channels C001 to C004 of the MW100 server.
For WRITE (client writes data to the server)

MW100 Client

MATH Channel

MW100 Server

Hold Register

40001
40002
40003
40004

40007
40008

Lower byte of communication input channel C001
Upper byte of communication input channel C001
Lower byte of communication input channel C002

Upper byte of communication input channel C002

Lower byte of communication input channel C004

Upper byte of communication input channel C004

Hold register numbers assigned to the communication input
channels starting from 40001 are specified on the MW100.

“Float-Little” is selected for the register data type because
the MATH channel data is received in the order lower byte, upper byte.

Client/Server Settings for READ

The screens in the explanations below were generated under firmware version R3.04.

Server Setti

Server-Side Settings

ngs

Set the MW100 server as the server device.

Top > Communication Setting > Server Setting

Timeout 1rin
Modbus Delay Response off 2

Client-Side Settings

Sever

MODEUS

TP on =

HTTE |

SNTF on i3

GENE on_~|[pe3ta

DIAG on_~|pesir
Apply

Client Setteing 1

Application timeout setting
When set to Modbus server, the timeout value is fixed to 30 s
regardless of whether the check box is selected.

Turn on Action on the server
Turn the Modbus server action “ON.”

Enter the server port number
Enter the Modbus server port number. Use the default value

unless otherwise necessary. In the example, the default value
is “502.”

Set the MW100 client as the client device.

Top > Communication Setting > Modbus Client Setting 1
N ()

Cycle

Connection Timeout 5
Wait Tine s

Select
The setting is applied on the client device.

Set according to network environment
e Cycle:
Select a cycle appropriate for the unit's performance.
e Connection:
Disconnect when no response is received from the server.
e Connection Timeout:
Enter the time to wait before disconnecting.
o Wait Time:
Enter the time to wait between disconnection and sending
of commands.

App-4
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Appendix 2 Setting Data Communication That Uses Modbus Protocol

Client Setting 2
Enter settings for the destination server.

Enter the IP address of the server
Enter the IP address or host name of the destination
server. In the example, an |IP address of

i 192768 1 100 0 “192.168.1.101” is entered.
o2 b2 |
03 502
_;1— Enter the server port number

i i Enter the port number of the destination server.
05 o012 In the example, “502” is entered.
06 502
o7 502
05 502
09 502
10 502

Apply
Client Setting 3

Enter settings for registers to be used for receiving data. For data types, see “Register
Data Types.”

Select the register function (read
or write)

If the client will be reading from the
server, select “Read.”

Float - Little > Icom

Flost —Litle =] [A0D1 AT

]

Enter the server unit number

Only Modbus/TCP connections are used in the

example, therefore the default unit number of “255”

is used.

Ll i

Apply

« for Read

001 Read =1

Enter the number of the destination
server

Enter the number set in Client Setting 2.
In the example, “1” is entered.

Channcl
- Enter the communication input

255

001 Float - Little _=|j=001 con1 channels on which to read by the

02 wiite =] [1
el

255

40001 Float | Litte =] [A001 001 client

003 Off

=TI In the example, the client will read on
communication input channels “C001” to “C001.”

Select the data type for the registers on the
destination server that will be read.

In the example, “Float-Little” is entered indicating that the
register data type is 32-bit floating point and the order is
lower byte, upper byte.

Enter the number of the first input register on
the destination server that will be read.

For example, if the MW100 is specified as the Modbus
server, measured data from measurement channels 001
to 001 is read as 32-bit floating point (Float), and “31001”
is entered.

MATH Channel Settings

In order to display data loaded to the communication input channels from the MW100
server, enter the communication input channel numbers in the MATH channel expression
entry area.

Top > Charmel Setting > MATH Charnnel Setting

IM MW100-01E
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Appendix 2 Setting Data Communication That Uses Modbus Protocol

Client/Server Settings for WRITE
The screens in the explanations below were generated under firmware version R3.04.
Server-Side Settings

Server Settings
Set the MW100 server as the server device. These are the same as the server-side
settings for READ.

MATH Channel Settings

In order to display data written to the hold registers from the MW100 client, enter the
communication input channel numbers in the MATH channel expression entry area.
These are the same as the MATH channel settings for READ.

Client-Side Settings

Client Setting 1
Set the MW100 client as the client device. These are the same as the client-side settings
for READ.

Client Setting 2
Enter settings for the destination server. These are the same as the client-side settings
for READ.

Client Setting 3
Enter settings for registers to be used for sending data.

Top > Communication Setting > Madbus Client Setting 3

Select the register function (read

or write
— ___ If the olier)1t will be writing to the server,
mw select Write.
002 Write Float - Little EIADIM AD01
o3 of zu
04 of zu
05 of zu
o6 of zu
07 of zu
i) of zu
i) of zu
10 of =
Apply
« for Write Enter the number of the

destination server
Enter the number set in Client Setting 2.

m1 T R | e eS| In the example, “1” is entered.
[ Wiite =]||1 =3 40001 Float - Little IAom A0 Enter the channels on the client
= that will be written to the
destination server
In the example, “A001” to “A004” is

entered since computed data from MATH
channels 001 to 004 are written.

Select the data type for the hold
registers of the destination
server.

In the example, “Float-Little” is entered
indicating that the register data type is
32-bit floating point.

Enter the number of the first hold
register that is written to on the
destination server.

For example, if the MW100 is specified
as the Modbus server, the hold register
is written to communication input channel
C001, and “40001” is entered.
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Appendix 2 Setting Data Communication That Uses Modbus Protocol

Starting Communication
Starting Measurement and Computation
MATH channels must be displayed to show transmitted data. After starting measurement,
start computation.

Displaying Data
When data is sent/received via Modbus communication, the following waveform is
displayed on the monitor screen of a Web browser.

* Displaying MW100 Client Data (Trend)

Top > M

Rec Start
Math Reset Math Clear
[Group] : [MATH v

>
T
T

Computed data (data received via Modbus communications)

xipuaddy

* Displaying MW100 Server Data (Trend)

[Group] : | Group01 v = [Group] :[MATH ~ £ B[] R BT
100 msec © QW' H=o| i0mse @R ' Hoo

Measured data Computed data (data received via Modbus communications)
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Appendix 2 Setting Data Communication That Uses Modbus Protocol

Checking the Communication Status
You can view log information to check the status of Modbus communications.

Top > System Setting > Log Information

Log Information Operation Error Log ~ 20
Operation Error Log ]
Time Stamp Alarm Surnrany

Strain Input Initial Balance
Recording Log
Recording Status
Message Summary

B e v N

Modbus Client Log

Morbus Client Cormmand Status Modbus communication log information

mnggm a‘*af;' Cﬁnneﬂ‘ﬂn%‘uﬁ You can check the status of communication and
ocbus Waster Log . . . .

Marbus Master Command Status othe_r mformgmon by selgctmg items here.

Modkus Master Cannection Status For information about displayed contents, see

Madous 2;:;1;;9 the MW100 Communication Command Manual

(IM MW100-17E).

Register Data Types
The figure below describes specification of data types for registers used during Modbus
communications. Registers are fixed to 16-bits in length. Data longer than 16 bits
are stored using multiple registers. In this case, the data sequence (Endian) must be
specified. The MW100 can process 32-bit data. Specify “Little” to store data from the
least significant byte, and “Big” to store data from the most significant byte.

. . Data Type
Register | Assignment Data Type Specification
| 30001 |Signed integer | (16bit) [Int1t6 |- Int16
| 30001 [Unsigned integer| (16bit) |uint16 |- UInt16

30001 | Signed integer (Lower 16bit) Int32 |- Int32 - Little
30002 (Upper 16bit)

30001 | Signed integer (Upper 16bit) Int32 |- Int32 - Big
30002 (Lower 16bit)

30001 |Unsigned integer| (Lower 16bit) Uint32 |- UInt32 - Little
30002 (Upper 16bit)

30001 |Unsigned integer| (Upper 16bit) UInt32 |- UInt32 - Big
30002 (Lower 16bit)

31001 Floating point (Lower 16bit) Float |- Float - Little
31002 |real number (Upper 16bit)

31001 Floating point (Upper 16bit) Float  [-—-- Float - Big
31002 |real number (Lower 16bit)

* MWA100 data are all Little Endian, and assigned to Modbus registers. When loading MW100
data, specify “Little.”

For the available MW100 register numbers, Modbus protocol specifications, and other
information, see "Modbus Protocol Specifications" in section 5.2 of the MW100 User’s
Manual (IM MW100-01E).
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Appendix 3 Using the Event Action

This section introduces an example in which the event action function is used to save the
data.

» Saving data on the hour

» Acquiring periodic data (periodic report)

* Diving the data on each event

Saving Data on the Hour

Data is saved on the hour by setting the event to Timer and action to Memory Save. In
this example, data is saved at hour 0 using Memory Save.
» Setting the event action
Event: Timer, action: Memory Save, event detection: Edge
+ Setting the Recording
Recording start action: Direct, recording stop action: Fullstop or Rotate,
data length: 8 h
» Setting the timer
Timer type: Absolute, Reference time: 0:00, 8 h interval

Start Stop Start

1 I I I : 1
| | | H |

0:00 8:00 16:00 000  Time (s)

[ I I I ] [ I

A
T Division by the data length
Division by memory save

Acquiring Periodic Data

Create a file containing a single data value by setting the event to Timer and action to
Trigger. This is used to record data periodically (period reporting).
» Setting the event action
Event: Timer, action: Trigger, event detection: Edge
» Setting the Recording
Recording start action: Trigger (pretrigger 100%), measurement interval: 1 min,
recording interval: 10x
Recording stop action: Fullstop or Rotate, data length: 10 min
» Setting the timer
Timer type: Absolute, Reference time: 0:00, 1 h interval

Start ~ Trigger v ~ Stop Start +
: | | | b | o
' T T T ! ! >
1:00 2:00 3:00 400  Time(s)
- O - T
T A A A

File containing a single data value

In the recording interval setting above, one data value is recorded every 10 minutes. To
record the data to the file on the hour, start the recording at 0:00, 0:10, 0:20 and so on (at
any of the 10 minute intervals). If you start the recording at 0:03, the data is recorded at
0:53, 1:53, 2:53, and so on.

IM MW100-01E
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Appendix 3 Using the Event Action

Diving the Data on Each Event

Data is divided by setting the input/output event and the action to Memory Save.

» Setting the event action
Event: DI, Alarm, Relay, UserKey, etc. Action: Memory Save
Event detection: Edge

» Setting the Recording
Recording start action: Direct, recording stop action: Fullstop or Rotate, data length:
arbitrary (long time)

Start DI Relay User Key

-
-

Time (s)

[ I I I
Divide
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Appendix 4 E-Mail Format

In the explanations that follow, CRLF means “carriage return/line feed.”
A user-defined character string can be attached to the subject of each mail.

Alarm Notification E-mail Format
e Subject

Subject: [Alarm Summary]
¢ Syntax

CRLF

Alarm SummaryCRLF

DATE yy/mo/ddCRLF

TIME hh:mi:ssCRLF

CRLF
<Alarm Summary>CRLF
cc 1q aaaCRLF

CRLF
<CH_Data>CRLF
ccc*ddddddd  [uuuuuu] CRLF

Measurement ch no. (001 to 060, SKIP channels not output)
MATH ch no. (2001 to A300, OFF channels not output)

H (upper limit alarm), L (lower limit alarm), h (differential upper limit
alarm), 1 (differential lower limit alarm), R (upper limit on rate-of-
change alarm), r (lower limit on rate-of-change alarm), T (delay

Measured data (measurement channel, includes decimal point and
minus sign, all space filled in to the left when 6 characters or fewer)

CRLF
ENDCRLF
CRLF
vy Year (00 to 99)
mo Month (01 to 12)
dd Day (01 to 31)
hh Hour (00 to 23)
mi Minute (00 to 59)
Ss Seconds (00 to 59)
* Tab
ccc
mmmim
1 Alarm level (1 to 4)
q Alarm type (H, L, h, 1, R, r, T, t)
upper limit alarm), t (delay lower limit alarm)
aaa Alarm status (off, on)
ddddddd
eeceeeeeee

Computed data (MATH channel, includes decimal point and minus
sign, all space filled in to the left when 8 characters or fewer)

IM MW100-01E
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Appendix 4 E-Mail Format

uuuuuu Unit information (output using 6 chars., left justified)
mv__ :mV
\Y 'V
~"C°C
XXXXXX: (user specified char. string)
B Blank
Nofte

If measured / computed data results in an error (+Over, —Over, Invalid, or lllegal), the errors are
sent without the values.

Report Notification E-mail Format (/M3 option)

¢ Subject
Subject: [Report Data]
¢ Syntax
CRLF
Report DataCRLF
<Time>CRLF
DATE yy/mo/ddCRLF
TIME hh:mi:ssCRLF
CRLF
<ttttttt Report Data>CRLF
Start Time:*ssssssssssssssssSsCRLE
CRLF
Ch*Max*Min*Ave*Sum*Inst CRLF
CCC*Xrrrrrrrrr* rrrrrrrrr * rrrrrrrrr * eececeeceeeececeee *
rrrrrrrrr * [uuuuuu (bbbbbb) ] *kkkkkkCRLF
mmmm* rrrrrrrrr * rrrrrrrrr * rrrrrrrrr * eececeeeceeeceeee *
rrrrrrrrr * [uuuuuu (bbbbbb) ]*kkkkkkCRLF

CRLF

EndCRLF

CRLF
1% Year (00 to 99)
mo Month (01 to 12)
dd Day (01 to 31)
hh Hour (00 to 23)
mi Minute (00 to 59)
ss Seconds (00 to 59)
ttttttt Report type information (Hourly, Daily, Weekly, Monthly)
* Tab

SSSSSSSSSSSSSSSSS
Report start date/time (yy/mo/dd_hh: mi: ss)

Report stop date/time (yy/mo/dd_hh: mi: ss)

kkkkkk Report status (error (Er), over (Ov), or power failure (Pw)) (omitted if
none)

ccc Measurement channel numbers

mmmm Computation channel numbers
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Appendix 4 E-Mail Format

rrrrrrrrr Report data (excluding integral value, sends in the order maximum/

minimum/average/instantaneous value, includes decimal point and
minus sign, all space filled in to the left when 8 characters or fewer)

eeceeeeceeeeeee

uuuuuu

bbbbbb

Integral data (includes exponent display (e.g.: -4 .000000E+19),
decimal point, minus sign, and E, all space filled in to the left when
12 characters or fewer)

Unit information (output using 6 chars., left justified)

mv :mV
\Y 'V
~C :°C

xxxxxx: (user specified char. string)
Sum scale information (omitted when none)
Blank

File Creation Notification E-mail Format

* Subject
Subject:

¢ Syntax
CRLF

[File End]

File EndCRLF
<Time>CRLF

DATE yy/mo/ddCRLF
TIME hh:mi:ssCRLF

CRLF

<File Name>CRLF

£1/fnCRLF

CRLF

ENDCRLF

CRLF
Yy Year (00 to 99)
mo Month (01 to 12)
dd Day (01 to 31)
hh Hour (00 to 23)
mi Minute (00 to 59)
ss Seconds (00 to 59)
fl Folder name
fn File name

Blank

IM MW100-01E
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Appendix 4 E-Mail Format

Media Remaining Space Notification E-mail Format

¢ Subject

Subject: [Media Remain]
Syntax

CRLF

Media RemainCRLF
<Time>CRLF

DATE yy/mo/ddCRLF

TIME hh:mi:ssCRLF

CRLF

<Media Info>
aaaaaaa K byte totalCRLF
bbbbbbb K byte freeCRLF

CRLF

ENDCRLF

CRLF
vy Year (00 to 99)
mo Month (01 to 12)
dd Day (01 to 31)
hh Hour (00 to 23)
mi Minute (00 to 59)
Ss Seconds (00 to 59)

aaaaaaa Media capacity [KB] (0000000 to 9999999)
bbbbbbb Media total capacity [KB] (0000000 to 9999999)
Blank

Power ON Notification E-mail Format

¢ Subject

Subject: [Power Failure]
Syntax

CRLF

Power FailureCRLF
<Power_ Off>CRLF
DATE yy/mo/ddCRLF
TIME hh:mi:ssCRLF
CRLF

<Power On>CRLF
DATE yy/mo/ddCRLF
TIME hh:mi:ssCRLF

CRLF

ENDCRLF

CRLF
vy Year (00 to 99)
mo Month (01 to 12)
dd Day (01 to 31)
hh Hour (00 to 23)
mi Minute (00 to 59)
ss Seconds (00 to 59)

Blank

App-14
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Appendix 4 E-Mail Format

System Error Notification E-mail Format

¢ Subject

Subject: [ERROR]

e Syntax

CRLF

ERRORCRLF
<Time>CRLF

DATE yy/mo/ddCRLF
TIME hh:mi:ssCRLF
CRLF

<ERROR Message>CRLF

nnn_mmmmmmmCRLE

CRLF

ENDCRLF

CRLF
vy Year (00 to 99)
mo Month (01 to 12)
dd Day (01 to 31)
hh Hour (00 to 23)
mi Minute (00 to 59)
ss Seconds (00 to 59)
nnn Error number
mm- -mm  Error message

Blank

Periodic Report Notification E-mail Format

¢ Subject

Subject: [Periodic Datal]
Syntax

CRLF

Periodic DataCRLF
<Time>CRLF

DATE yy/mo/ddCRLF

TIME hh:mi:ssCRLF

CRLF

<CH_ Data>CRLF
ccc*ddddddd  [uuuuuu] CRLF

CRLF

ENDCRLF

CRLF
vy Year (00 to 99)
mo Month (01 to 12)
dd Day (01 to 31)
hh Hour (00 to 23)
mi Minute (00 to 59)
ss Seconds (00 to 59)
* Tab
ccc Measurement ch no. (001 to 060, SKIP channels not output)

IM MW100-01E
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Appendix 4 E-Mail Format

mmmm Computation channel no. (A001 to A300, OFF channels not output)

i Minus sign (omitted if +)

ddddddd Measured data (measurement channel, includes decimal point and
minus sign, all space filled in to the left when 6 characters or fewer)

eeceeceeeece Computed data (MATH channel, includes decimal point and minus
sign, all space filled in to the left when 8 characters or fewer)

uuuuuu Unit information (output using 6 chars., left justified)
mv__ :mV
\Y Y
~C :°C
xxxxxx: (user specified char. string)
- Blank
Nofte

If measured / computed data results in an error (+Over, —Over, Invalid, or lllegal), the errors are
sent without the values.

Test E-mail Format

¢ Subject
Subject: [Test]

* Syntax
CRLF
TestCRLF
<Time>CRLF
DATE yy/mo/ddCRLF
TIME hh:mi:ssCRLF

CRLF

ENDCRLF

CRLF
8% Year (00 to 99)
mo Month (01 to 12)
dd Day (01 to 31)
hh Hour (00 to 23)
mi Minute (00 to 59)
ss Seconds (00 to 59)

Blank
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Appendix 5 Retrieving Files Using WebDAV

File Operation

The MW100 communication service contains the WebDAV function. This function is used
to operate the files on the CF card that is attached to the MW100 or retrieve the files.
This section explains the method using a browser. Internet Explorer is used for the

browser.
Another method is to use Create a new connection from My Network Places.

You can perform file operations such as move and copy in the same manner as normal
files.

Connection Using a Browser

Connect the MW100 to the PC and configure the network.

For Windows 2000 and Windows XP
1. Start the browser.
2. On the File menu, choose Open.

3. In the Open dialog box, type the IP address or host name.
Example) When the IP address of the MW100 is 192.168.1.100
If the OS is Windows XP: http://192.168.1.100/?
If the OS is not Windows XP: http://192.168.1.100/

oeen 2| x

Type the Intemet address of a document or folder, and

PS
\;‘) Intemet Explorer will apen it o you.

gW"l hitpf192.168.1.100)7 j
I {pen as Wieh Foided

0| Cencdl || Brawse. |

4. Select the Open as Web Folder check box.
5. Click OK. The folder opens.

=lojx|
Fle Edit View Favories Tools Help ‘ ir

Qe - ) - ¥ | ) ssarch || Foldars ‘v

| address 31 152.168.1.100 S B ks »

0 O 8 E

canfig data clarmig bt recordig.bxt

Other Places ®

8 web Folders

123 My Documen ts
[ Shared Documents
€ My Netwark Places

IM MW100-01E
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Appendix 5 Retrieving Files Using WebDAV

For Windows Vista

1. To use the WebDAV function, you must apply the patch provided by Microsoft.
Download the file from their Web site and apply (install) the patch.
There is a link to the Microsoft Web site on the Yokogawa MW100 Web site.

2. Right click the Start menu and select Explorer.

The Windows Explorer opens.

Open
Explore
Search...

Properties

Open All Users
Explore All Users

3. In the Explorer, right-click Computer and select Map Network Drive...

The Map Network Drive window is displayed.

= |

<)

()=[&» Networc

Network discovery and file sharing are tured off. Network computers and devices are not

Favorite Links Name Category  Workgroup  Network o
[E Documents
B Pictures
Expand
B Music
More 3 Explore
Folders Open
g4 DVD R\ Map Metwork Drive.
! wme Remov Disconnect Network Drive...
> e Remoy
b amn REmow Delete
> e Remoy Properties
& Network

- [ Control Panel D

& Recycle Bin S

+ [+ ][ search

ble. Click to change.

2]

4. Click, “Connect to a Web site that you can use to store your documents and

pictures.”
The Add Network Location window appears.

(©)] €3 Map Network Drive
What network folder would you like to map?
Specify the drive letter for the connection and the folder that you want to connect to:
Folden || ~ | Browse..
Example: \\serverishare
|| Reconnect at logon
Connect using a different user name.
Connect to a Web site that you can use to store your documents and pictures.

App-18

IM MW100-01E



Appendix 5 Retrieving Files Using WebDAV

5. Click the Next button.
The Connect to the Internet and Add Network Location windows appear.

=

) Add Network Location

Welcome to the Add Network Location Wizard

This wizard helps you sign up for 2 service that offers online storage space. You can use this space
to store, organize, and share your documents and pictures using only a web browser and Intemet
connection.

You can also use this wizard to create a shortcut to a website, an FTP site, or other network location.

6. Click the Cancel button in the Connect to the Internet window to close it.

7. Select the Add Network Location window. Click Select Choose a custom network
location, then click the Next button.

@ Add Network Location

Where do you want to create this network location?

Choose a custom netwark location
o, Specify the address of a website, network location, or FTP site

Xipuaddy

8. Enter the IP address of the MW100 in the Internet or network address box, then

click the Next button.
If the MW100’s IP address is 192.168.1.10, enter http://192.168.1.10/.

=

@ Add Network Location

Specify the location of your website

Type the address of the website, FTP site, or network location that this shorteut wil open.

Intemet or network gddress:
http://192.168.1.104 - Browse.

View examples
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Appendix 5 Retrieving Files Using WebDAV

9. Enter the WebDAV name in the “Type a name for this network location” box, then

click the Next button.
Use an easy-to-identify name.

@ Add Network Location

What do you want to name this location?
Create a name for this shortcut that will help you ezsily identify this network location:
hitp://192168.1.10.

Type a name for this network location:
MWL00 Web Folder

10. Click the Finish button.

.\_) Add Network Location

Completing the Add Network Location Wizard
You have successfully created this network location:

WG Web Foided

Ashertcutfor this location will appear in Computer.

[7] @pen this network location when I click Finish.

Settings complete.

If you open the Explorer and select a Web folder, the folder opens.
[EIEIEXS)

2]

e
SIS [E» Computer » Web Folders » MWI00 Web Folder » + [+ ][search

—— Name Internet Address  Size Type Modified
El Documents j [ j [ j E,
[E Pictures
B Music config data manual report
More »
Folders v

& DVD RW Drive (E)
e Removable Disk (F
= Removable Disk (¢
= Removable Disk (-
= Removable Disk (:
1 MW100 Web Folde|
28 Web Folders
1= MW100 Web Fol
3 config 3
(1 data 1
3 manual
(2 report
¥ Network
[E Control Panel
18] Recycle Bin
4 ftems
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Appendix 6 Network Terminology

Network Terminology

Term Description

IP address An ID that is assigned to each PC or communication device on an IP network such as the internet or
an intranet. The address is a 32-bit value expressed using four octets in decimal notation (each 0 to
255), each separated by a period as in 211.9.36.148.

Subnet mask TCP/IP networks such as the Internet are often divided up into smaller networks called sub
networks. The subnet mask is a 32 bit value that specifies the number of bits of the IP address used
to identify the network address.

Default gateway A representative router or computer that is used when accessing a computer outside its own
network. If the IP address of the access destination does not specify a specific gateway, data is sent
to the host designated as the default gateway.

DNS Abbreviation for Domain Name System.
A computer that converts the domain name, which is the name of the computer on the Internet, to
four octets called the IP address. Each name server contains a mapping table of domain names and
IP addresses in the network that the server manages and responds to external inquiries.

DHCP Abbreviation for Dynamic Host Configuration Protocol.
A protocol that automatically assigns required information such as an IP address to the computer
that is temporarily connecting to the Internet. The DHCP server provides the information to the
computer (client) that access the server. If the client finishes the communication, the server
withdraws the address and assigns it to another computer.

HTTP Abbreviation for HyperText Transfer Protocol.
A protocol used to exchange data between the Web server and the client (Web browser, etc.).
HTML documents and image, sound, video files that are linked to the document can be exchanged
including the expression information.

SNTP Abbreviation for Simple Network Time Protocol.
One of the protocols used to synchronize the computer clock via the TCP/IP network. It is an
abbreviated version of NTP. NTP is a protocol that constructs time information servers in a hierarchy
and synchronizes the clock by exchanging information. SNTP omits the complicated sections of the
NTP specifications and specializes in the application of the client querying the time to the server.

SMTP Abbreviation for Simple Mail Transfer Protocol.
A protocol used to transmit e-mail on the Internet. It is used to exchange mail between servers and
used by the client to send mail to the server.

FTP Abbreviation for File Transfer Protocol.
A protocol used to transfer files over the TCP/IP network such as the Internet.
POP3 Abbreviation for Post Office Protocol version 3

A protocol used to receive mail from a server storing e-mail on the intranet or Internet. POP3 is
currently the most popular protocol.

POP before SMTP One of the user authentication methods used when sending e-mail. Access to the SMTP server is
granted by accessing the specific POP3 server first before sending the e-mail.
PASV mode Passive (PASV) mode of the file transfer protocol FTP (method by which the FTP server notifies the

port for making the connection).
This mode is required when transferring files across a firewall. Check with your network
administrator on whether PASV mode is necessary.

WebDAV Abbreviation for Distributed Authoring and Versioning protocol for the WWW.
Specifications that expands HTTP used to transfer files on the WWW so that the files and folders on
the Web server can be managed from the client (Web browser). It allows (1) the document created
on the client to be transmitted to the server for disclosure, (2) the list of folders and files on the
server to be retrieved, and (3) the files and folders to be copied, moved, and deleted.

IM MW100-01E App-21
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Appendix 7 Using the Broken Line Data of Decimal
Values

Because the output value of a program channel is an integer, an expression is used to
output decimal values.

e Setting Example
A001=P01/K01
Here, MATH channel is A0O01, program channel is PO1, and calculation constant is
KO1.

A001
Y: Output value

(30,2.2) (40,2.2)

(10, 1.5)
(20, 1.5)

(0, 0.0) (50, 0.0)
X: Time (s)

* Entry Example
Set the calculation constant as KO1=10.
The broken line data P01 is as follows:
(0.0), (10.15), (20.15), (30.22), (40.22), (50.0), (-1.0)
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Appendix 8 Saving Data to the CF Card

Write Timing
Write Timing
You can check the time when data is written to the CF card using the recording status in
the log information.
— File types
1-3: measurement group number, M: computation, T: thinned data, R: report
Recording statuses
run: recording, wait: trigger-wait recording, stop: stopped
Write operation type
write: Writing data
create: Creating file — Write timing
<ecor* Status *
1 = run mext = write 07/10/25 10:15:00:
2 = stop i !
3 = stop E \
M = stop i !
T = stop . ]
R = stop e ! — No. of channels
. Data length/
Data File no. of write operations
Folder = DATA/DATA0000
1 = X2510005.MXD direct rotate (100mS) 60CHs 30M/ 8cells 4233KB
Recording interval —T File size —T
Write interval
When data is saved to the CF card, the data is written several times in sections. The
writing interval can be read from the recording status of the log information or the
recording log.
Recording start time
07/10/25(10:00:00).Record start 1 L
07/10/25 10:00:05 Mode | rotate -D- Recording interval
07/10/25 10:00:05 ((100ms)) (30M/ 8cells ) Data length/write count
07/10/25 10:00:05 (6OCHS ) ( 4233KB )—— File size (when completed)
07/10/25 10:00:06 Create| X2510005
Number of channels
In this recording log example, a file of 30-minute data length (30M) is written 8 times (8
cells) to the CF card.
30 minutes/8 times = 3 minutes 45 seconds
The time when data is written to the CF card is every 3 minutes and 45 seconds from the
recording start time at 10:00.
IM MW100-01E App-23
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Appendix 8 Saving Data to the CF Card

The data save operations is as follows:

Start Length of one data writing

Data length

Data writing
time

»

/ ---------------- 4= | ‘_-_-_-_-_-_-_-_; Time (s)
--------------- ettt} | A i

........

1 2 3 4 5 6 7 8 Next file

1st data writing 8th data writing

! ) File complete
File generation start

Replacing the CF Card While Recording

You can replace the CF card while recording is in progress. Replace the CF card while
the access indication to the CF card is not showing. An access forewarning is indicated
before the CF card is accessed.

The data save operation when the card is replaced between data write intervals is as

follows:
Start Length of one data writing Replace the CF card * For Fullstop
[ Data write time
/ ___________________ Time (s)

CF card 1 [ T

File 1 N S
CF card 2 [ [

File 2 File 3

If the data write interval arrives while the CF card is being replaced (CF card removed
from the MW100), the write length of data drops out.

The data save operation if the data write interval arrives while the CF card is being
replaced is as follows:

Length of one Remove the CF * For Fulistop
data writing card Insert the CF card

/ ___________________ Time (s)

CF card 1 [ _ ]

CF card 2 [ [
File 2 File 3

Write length of data drops out because the
data could not be written

You can join files divided by replacing the CF card on the MW100 Viewer. The files

that can be joined are those when the recording start operation is direct, and when the
recording start operation is trigger and the action becomes true (post trigger). If a portion
is lacking, the remaining portion can still be joined. For details, see the MW100 Viewer
Software User's Manual (IM MW180-01E).
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Appendix 8 Saving Data to the CF Card

Write Count

When data is saved to the CF card, the data is written several times in sections.
The write count can be calculated in advance.

Equation
The relationship between the data length and write count is as follows:

Data length = write length x write count

Because the write length is designed not to exceed the storage time (one-half the time
that can be stored in the internal memory), write length is less than the storage time.
Here, the storage time is derived from the storage data size and recording interval as
follows:

One-half the internal memory size

x recording interval
Storage data size g

Storage time =

The storage data size is given by

Storage data size = measured data + MATH data + thinned data
Measured data: Time information 16 bytes + measured data 4 bytes x number of
recorded measurement channels
MATH data: Time 16 bytes + MATH data 6 bytes x number of recorded MATH
channels
Thinned data: Time 16 bytes + thinned data 6 bytes x number of thinning recording
channels

Thus, the write count N is given by

Data length [s]
One-half the internal memory size [byte]
Storage data size [byte]

Write Count N >

x recording interval [s]

However, the write count N is a number that divide the data length evenly.

Calculation of the Write Count
Given a recording interval of 100 ms, 60 measurement channels, and 30 minute data
length, the write count is calculated as follows:

The storage data size is given by
Storage data size [byte] = 16 + 4 x 60 [ch] = 256

Because the write length is designed to be less than a half the internal memory size of 1.25
Mbyte (when not using multi interval), the write count N is given by

30 min x 60
Write Count N > =7.03
1.25 Mbyte / 2
w x 100 ms

256 bytes

In this example, data is written 8 times (30 minutes/8 = 3 minutes 45 seconds).

IM MW100-01E
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